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Audience

Preface

Oracle Retail Administration Guides are designed so that you can view and understand
the application’s “behind-the-scenes” processing, including such information as the
following:

= Key system administration configuration settings
= Technical architecture
= Functional integration dataflow across the enterprise

= Batch processing

This document is intended for the users and administrators of Oracle Retail Predictive
Application Server. This may include merchandisers, buyers, and business analysts.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation accessible
to all users, including users that are disabled. To that end, our documentation includes
features that make information available to users of assistive technology. This
documentation is available in HTML format, and contains markup to facilitate access by
the disabled community. Accessibility standards will continue to evolve over time, and
Oracle is actively engaged with other market-leading technology vendors to address
technical obstacles so that our documentation can be accessible to all of our customers.
For more information, visit the Oracle Accessibility Program Web site at

http:/ /www.oracle.com/accessibility /.

Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an otherwise
empty line; however, some screen readers may not always read a line of text that consists
solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation

This documentation may contain links to Web sites of other companies or organizations
that Oracle does not own or control. Oracle neither evaluates nor makes any
representations regarding the accessibility of these Web sites.

Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For
information, visit http://www.oracle.com/support/contact.html or visit
http:/ /www.oracle.com/accessibility /support.html if you are hearing impaired.

Related Documents

For more information, see the following documents in the Oracle Retail Predictive
Application Server Release 13.2 documentation set:

= Oracle Retail Predictive Application Server Release Notes
= Oracle Retail Predictive Application Server Licensing Information
= Oracle Retail Predictive Application Server Installation Guide
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= Oracle Retail Predictive Application Server Administration Guide for the Fusion Client
— Volume 2

= Oracle Retail Predictive Application Server User Guide

= Oracle Retail Predictive Application Server User Guide for the Fusion Client
= Oracle Retail Predictive Application Server Online Help

= Oracle Retail Predictive Application Server Online Help for the Fusion Client
= Oracle Retail Predictive Application Server Configuration Tools User Guide
= Oracle Retail Predictive Application Server Configuration Tools Online Help

Customer Support

To contact Oracle Customer Support, access My Oracle Support at the following URL:
https:/ /support.oracle.com

When contacting Customer Support, please provide the following:

= Product version and program/module name

= Functional and technical description of the problem (include business impact)

= Detailed step-by-step instructions to re-create

=  Exact error message received

= Screen shots of each step you take

Review Patch Documentation

When you install the application for the first time, you install either a base release (for
example, 13.2) or a later patch release (for example, 13.2.1). If you are installing the base
release and additional patch and bundled hot fix releases, read the documentation for all
releases that have occurred since the base release before you begin installation.
Documentation for patch and bundled hot fix releases can contain critical information
related to the base release, as well as information about code changes since the base
release.

Oracle Retail Documentation on the Oracle Technology Network

Documentation is packaged with each Oracle Retail product release. Oracle Retail
product documentation is also available on the following Web site:
http:/ /www.oracle.com/technology /documentation/oracle_retail.html

(Data Model documents are not available through Oracle Technology Network. These
documents are packaged with released code, or you can obtain them through My Oracle
Support.)

Documentation should be available on this Web site within a month after a product
release.

Conventions

Navigate: This is a navigate statement. It tells you how to get to the start of the procedure
and ends with a screen shot of the starting point and the statement “the Window Name
window opens.”

This is a code sample
It is used to display examples of code
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Overview

Introduction

All RPAS-based products require setup and the following administration activities to be
performed:

Domain administration

User account management

User and workbook template administration
Hierarchy maintenance

Measure analysis

Workbook auto build maintenance

Translation administration

System Administration Workbooks

Using the administration workbooks, designated employees manage other employees’
use of the Oracle Retail Predictive Solutions. System administrators use the
administration workbooks to perform the following:

Set up and maintain users and user groups.
Manage user access to specific workbook templates and individual measures.

Edit the contents of translation tables to support multiple-language use of the
application.

Specify the type, frequency, and format of workbooks in the automatic build queue.

Workbook and Wizard Descriptions

RPAS contains the following workbooks and wizards to administer the system:

User Account Management wizards — A group of wizards for setting up and
maintaining users and user groups.

Security Administration workbook — A workbook for setting up and maintaining
user/template, user/measure, and template/measure access rights.

Translation Administration workbook — A workbook for managing the foreign
language translation of strings and label text throughout the application.

Workbook auto build maintenance — A workbook for managing the workbook auto
build queue.
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General Workbook Procedures

Change a Workbook’s Calculation Method
There are two types of calculation modes that can be set in the RPAS Client:

1. “Deferred” calculation mode (the most common) allows the user to make multiple
edits in a workbook before recalculating the data. In this mode, the edits are
effectively “queued” and executed once Calculate is selected.

2. “Automatic” calculation mode forces the workbook to be recalculated every time a
cell is changed. This forces immediate communication from the worksheet back to
the database. In this mode, there may be a pause between one data change and the
user’s ability to effect the next change.

For efficiency and usability purposes, Oracle recommends that operation be run in
“deferred” calculation mode.

Set the Workbook to Deferred Calculation Mode

Click the Edit menu, and select Manual Calculation.

Return the Workbook to Automatic Calculation Mode
Click the Edit menu, and select Automatic Calculation.

Send the Queue of Data Changes to the Server
Click the Edit menu, and select Calculate Now.

Refresh and Export Data

Refresh the Data in a Worksheet

The Refresh feature allows the user to update a workbook with the data that is currently
stored in the domain. This lets the user work with the most current data without having
to rebuild the workbook. However, refresh rules in the configuration governs the refresh
process. Please see the RPAS Configuration Tools User Guide for more information on
setting up refresh rules.

Export the Current Worksheet View to an Output File
Navigate: From the File menu, select Export Sheet. The Save As dialog box displays.

1. In the Save In field, select a directory to save the export file.

2. In the File Name field, type a name for the export file.

3. Click the Save As Type list, and select a file type for the export file.
4. Make a selection for each of the following;:

a. Delimiter — Specify the character that is used to separate information in the
output file. Standard choices are Tab, Comma, or Space; but different delimiters
can be specified by selecting the Other radio button.
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b. Labels — Specify the format of the label headers across the top of the cells in the
output file. The options are:

— Do Not Include — No labels provided

— Include Once — One label placed across the top of each section of related
cells

— Repeat — A separate label, repeated as necessary, appears atop each cell

— Descriptions — Specify whether to identify dimensional positions in the
output file with concise system names (for instance, SKU00012) or the
descriptive labels (for instance, Cashmere Sweater — L — beige) assigned to
each position

5. Select Save to export the file.
6. Click OK.

Insert Measures into an Open Worksheet

Given the necessary access rights, the user can insert a measure or group of measures
into a workbook that is already open. This functionality reduces the need to rebuild a
workbook whenever a view of currently unrepresented measures is required. The ability
to insert new measures into open workbooks is particularly useful when establishing
access to alerts.

Use the following procedure to select a measure or group of measures to be inserted in a
workbook that is currently open.

Note: A worksheet must be open and active for the Insert
Measure menu option to be enabled. Any measure(s) that
are to be inserted in the workbook will be placed on the
currently active worksheet.

Navigate: From the Edit menu, select Insert Measure.
1. Select the desired measure(s) in the Insert Measures list box.
2. Click OK.

Note: Measures with writeable access that are added to the
workbook using Insert Measure can be edited in the
workbook. However, these measures have no commit rule,
thus user edits cannot be committed to the domain.
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Global Domain

Global Domain

Overview

“Global Domain” is a type of domain structure that provides users with the ability to
view data from multiple domains and to administer common activities of an RPAS
domain and solution.

Domains can be built in one of two methods:

= Simple domain - This is the traditional, stand-alone domain that has no visibility to
other domains.

= Global domain — This is a domain environment that contains two or more “local”
domains (or “sub-domains”) and a “master” domain that has visibility to all local
domains that are part of that environment.

Using a Global Domain environment has two primary functional benefits. The first
feature allows users to have a global view of data in workbooks. Users can build
workbooks with data from local domains, refresh global workbook data from local
domains, save global workbooks, and commit the data from global workbooks to the
individual local domains.

“Local” domains are typically organized (“partitioned”) along organizational structures
that reflect user roles and responsibilities. Most users will only work within the local
domain(s) that contain their area of responsibilities, and they may not need to be aware
of the Global Domain environment. For performance and user contention reasons, Global
Domain usage should be limited to relatively infrequent processes that require data from
multiple local domains.

The other primary feature of Global Domain is centralized configuration and
administration. Most of the mechanisms that are required to build and administer a
domain have been centralized and they need only be run in the “master” domain, which
either propagates data to the local domains or stores the data centrally so that the local
domains reference it in the master domain.

Note: For a Global Domain environment to function
properly, all local domains must be structurally identical.

Measure Data

In a global domain environment, measure data can be physically stored in two different
ways:

1. across the local domains

2. in the master domain

Measure data that is stored in local domains is split across domains based on a pre-
determined level of a given hierarchy. This level is defined during the configuration
process, and it is referred to as the “partition” level.

The base intersection of a measure (for instance, what dimensions a measure contains)
determines whether data is stored in the local domains or in the master domain. The data
will be stored in the master domain if the base intersection of a measure is above the
“partition” level or if it does not contain the hierarchy on which the Global Domain
environment is partitioned. This type of measure is referred to as a “Global Domain
measure,” or a “Higher Base Intersection measure.”
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Consider a global domain environment where the partition-level is based on the
Department dimension in the Product hierarchy. Data for measures that have a base
intersection in the Product hierarchy at or below Department are stored in the local
domain based on the Department to which the underlying position in the Product
hierarchy belongs. Other hierarchies are irrelevant for this discussion.

However, measures that have a higher base intersection in the Product hierarchy than
Department (for instance, Division) or measures that do not contain the Product
hierarchy (such as a measure based at Store-Week) cannot be split across the local
domains. These measures will reside in the master domain and will be accessed from
there when these measures are required in workbooks.

All measures will be registered in the master domain, and they are automatically
registered in all local domains. RPAS automatically determines where the measure needs
to be stored by comparing the base intersection of the measure against the designated
partition-level of the Global Domain environment.

The physical location of the measure data will be invisible to the user after the measure
has been registered. However, administrators must know where data for each measure is
to be stored (master vs. local) as the data must be loaded in the proper location.

CSV File Format

For those utilities that use a comma-separated value (CSV) file, the following formatting
applies for any commas or double quotation marks in the data:

= If the data does not contain any commas or double quotation marks, it does not need
any special formatting.

= If the data contains a comma, the string must be enclosed between opening and
closing double quotation marks.

= If the data contains quotation marks, the string must be enclosed between opening
and closing double quotation marks and any embedded quotation marks need to be

paired.
The following table shows examples of the formatting.
Data Formatted Data
Item 001 Item 001
Item 001, Soda “Item 001, Soda”
“Large Screen” TV “Large Screen”” TV”
Item 002, “Generic Brand” Cereal | “Item 002, “”Generic Brand”” Cereal”
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DomainDaemon

The RPAS DomainDaemon is a process that is used to enable the communication channel
between RPAS Clients and RPAS domains.

The DomainDaemon runs on the server side and waits for requests from RPAS Clients on

Usage

a given port. Once DomainDaemon receives a request from a client, it starts a server
process that the client connects to. From this point, the client and server communicate
directly. The system administrators may choose to have one single DomainDaemon
process for all of the users, or they may choose to have separate processes per domain,

per enterprise, and so on.

Domain Administration

The DomainDaemon is installed in the [RPASDIR]/bin directory. [RPASDIR] stands for
the full path to the directory where the RPAS Server is installed. The system

administrators can start, stop, and monitor the DomainDaemon processes by using

scripts that are provided in this directory.

The following table provides descriptions of the arguments used by the DomaimDaemon

utility.

Argument Description

—version Prints the RPAS version, revision, and build
information of the utility.

-start Starts a DomainDaemon on the specified port.

—-port portNum The portNum must be between 1025 and 65535
(inclusive). If portNum is set to auto, it will find any
free port.

-loglevel This option enables additional logging.

Note: The —debug option has been deprecated.
Instead of using —debug, please use —-loglevel to add
additional logging.

—timeout milliseconds

Specifies the number of milliseconds to wait for the
server to start. A value of -1 means no timeout.

-server serverProgramName

Specifies the name of the RPAS database server
program. Defaults to RpasDbServer.

-no_auto_add

Disables the registering of domains in response to
client requests to start a RPAS database server.

-stop Stops the DomainDaemon on the specified port.
-ping Reports the status of a DomainDaemon process.
-showDomains Shows all domains managed by this daemon.

-add pathToDomain

Adds the specified domain to the list of domains
managed by a DomainDaemon.
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Argument Description

-activate pathToDomain Reactivates a previously deactivated domain. Specify
the port number and the complete path to the domain.

-deactivate pathToDomain Marks a domain as temporarily unavailable.
Deactivating a domain also terminates all user
sessions in that domain. A message will be displayed
in the client to notify users when this occurs. Domains
are most commonly deactivated before beginning a
routine nightly /weekly batch process. This ensures
that no users make updates to the system during these
processes. Specify the port number and the complete
path to the domain.

-remove pathToDomain Removes the specified domain from the list of
domains managed by a DomainDaemon.

-showActiveServers Shows all active server processes. Specifying a port
number is required.

For each active server, the DomainDaemon shows the
process ID, domain, and user ID.

-stopActiveServers Stops all active servers. Specify a port number and a
process ID.

-stopServer processld Stops the server using the specified processed.

-stopUser userld Stops the server using the specified userld.

Starting the DomainDaemon

In order to start the DomainDaemon, execute the script called DomainDaemon in the
installation directory. The port number where the DomainDaemon will be running must
be passed in as an argument. The port number must be between 1025 and 65535. If auto
is specified instead of a number, the DomainDaemon is started on any available port.

Note: In the following examples, [RPASDIR] stands for the
full path to the directory where the RPAS Server is installed.

Example:

Issuing the following command from a UNIX shell will start a DomainDaemon on port
55278:
([RPASDIR]/bin)$ DomainDaemon —port 55278 —start &

Monitoring the DomainDaemon

The —ping argument can be used to see whether a DomainDaemon is active. The port
number must also be passed as an argument. If the DomainDaemon is active on the port,
a message will be printed, and the script will return true. Otherwise, the script will return
false.

Example:

([RPASDIR]/bin)$ DomainDaemon —port 55277 —ping
DomainDaemon on port 55277 is alive.
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Stopping the DomainDaemon
Use the —stop argument to stop the DomainDaemon running on a given port.

Example:
([RPASDIR]/bin)$ DomainDaemon —port 55277 —stop

Losing a Client-Server Connection

The connection between the RPAS Client and the RPAS Server can be lost for any
number of reasons, but most commonly when the user’s computer crashes or the
network connection is lost.

If an RPAS Client-Server connection is lost, the user’s work is guaranteed to be saved up
to the last calculation; all deferred calculations are lost. Upon subsequent login, the user
can access either the last version of the original workbook explicitly saved by the user or
the auto-saved version of the workbook that was being worked on when the connection
was lost.

If the user tries to log in after recently losing the connection or from a different instance
of the RPAS client, the user is prompted to either terminate all existing sessions and start
a new session, or start a new concurrent user session. If the user chooses to terminate the
existing session, the RPAS server gracefully terminates the existing session and then logs
the user in and starts up a new session.

Graceful Termination of the Existing Session

If a connection has been lost and the previous session has not timed out or a session for
the user is running from a different instance of the RPAS client, the user can use the
RPAS client to gracefully terminate the existing session and log in to a new session.
Graceful termination includes the completion of any pending processes and custom
menu or rule group processing in the existing session, followed with an auto-save of the
workbook and subsequent termination of the server process.

Graceful termination of an existing session could take an arbitrarily long time. This time
is equal to the sum of the time taken to complete any running calculations and then save
the workbook.

When the RPAS server times out waiting on a request from the RPAS Client, it gracefully
terminates, irrespective of whether the user tried to log in again.

If for any reason the client server connection is lost before the new login occurs, RPAS
asks users if they want to resume the previous session or terminate it and start a new
one. However, it will not start another session for the user until the user regains
connectivity and tries to log in again.

There is a limit on the number of login sessions per user. By default, the maximum
number of concurrent login sessions per user is five. This limit can be altered by an
administrator using the Security Administration workbook.

Autosave of Workbooks

When an RPAS Server session terminates automatically, either due to re-login or a server
timeout, it auto-saves the workbook that is currently open by the session. An auto-saved
workbook includes all of the user’s work up to the last calculation. If the user had some
pending calculations, that is, edits were made in the client but calculation was not
performed, all the edits are lost.
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When a workbook is auto-saved, the original workbook is kept in the same state it was in
the last time it was explicitly saved by the user. A new workbook is created for the user
with the name of the original workbook suffixed with ‘_autosave’ and added to the
user’s Most Recently Used list. Upon subsequent login, the user can view both the
original workbook and auto-saved workbook in the workbook list.

RPAS administrators can impose a limit on the number of workbooks a user can create
for a particular workbook template. When such a limit has been imposed, the auto-save
feature allows the user to exceed that limit by one. This allows the user to operate at the
limit without the fear of losing any work because of a connection failure or computer
crash. However, when the limit is exceeded due to an auto-save, the auto-save feature is
disabled for the user for the workbook template on which the limit has been imposed.
The auto-save feature is disabled until the user deletes one or more of the workbooks for
that template in order to bring the user at or below the limit. It is not required that the
user delete the original or the auto-saved workbook. Once the user is back at or below
the limit, the auto-save feature is automatically enabled. Note that if a user exceeds the
limit, the RPAS Client will inform the user of this situation every time the user attempts
to open a workbook for the given template.

Environment Variables

RPAS includes a number of environment variables that are set at the system level in
UNIX. At the system level, the variables are applicable to all RPAS Servers
(DomainDaemons) that are run on the system.

The common syntax for setting these variables is as follows:

Export ENVIRONMENT_VARIABLE=XXXXXX

ENVIRONMENT_VARIABLE is a defined variable that is recognized by RPAS. XXXXXX is an
appropriate value for the variable, which could be a string, Boolean, or numeric data
type. If the value represents time, this number normally represents time in milliseconds.

Note: The DomainDaemon must be restarted after setting
any environment variables. An example of how this process
is completed is as follows:

DomainDaemon —port 55123 -start -debug &

10 Oracle Retail Predictive Application Server



Environment Variables

Lock Timeout Variable

When performing certain operations, it is possible for two or more users to be
“contending” for access to the same database (.gem file), which happens most commonly
when two users attempt to simultaneously commit/save the same data back to the
domain. By default, RPAS is set up to wait one minute before returning a lock contention
error when this situation occurs.

If desired, an administrator can override this default value by setting the
“RPAS_LOCK_TIMEOUT” environment variable. This variable is set to the number of
milliseconds to wait for a file lock before returning a lock contention error. As with any
environmental variable, the variable must be set prior to starting the process that uses
that variable. The variable was introduced for use with the RPAS database server, which
means that the variable is set for the DomainDaemon.

For example, the two lines below indicate how an administrator would tell RPAS to wait
two minutes before returning a lock contention error with the RpasDbServer after
launching the client and logging in. Any client that connects to that domain daemon
would see lock contention after a two minute delay:

Export RPAS_LOCK_TIMEOUT=120000

The RPAS _LOCK TIMEOUT environment variable is also used to handle issues with firewalls
and the RpasDbServer. The RpasDbServer now checks RPAS_LOCK_TIMEOUT to determine
what should happen when it has been idle for a period of time. Like any environmental
variable that RpasDbServer uses, this environmental variable must be set prior to starting
the DomainDaemon.

The environmental variable RPAS REQUEST TIMEOUT should be set to a value that is the
number of seconds of idle time that should pass before the RpasDbServer sends a “Server
has timeout waiting for a request” exception to the client and exits. In this case, idle time
is the time waiting for a request. If this variable is not present or is set to zero, then the
RpasDbServer will never time out.

On the client side, the exception sent from the server will appear as a warning dialog box
only after some new action is initiated. With the client, there will be additional warning
dialog boxes displayed to the user.

Log File Backups

The RPAS_LOG_BACKUPS environment variables allow an administrator to define the
number of log file backups to retain for a given user. A log file is created each time for
each session that a user has with the RPAS Client.

The environment is set by executing the following command:
Export RPAS_LOG_BACKUPS=X

Xis an integer value that represents the number of backup log files to keep for each user.

Profiling Logging
The following two environment variables may be setup to control profiling logging:
= RPAS_PROFILING_ENABLE

The RPAS_PROFILING_ENABLE environment variable, when set to true, allows profiling
data to be written to the profiling log file. This flag does NOT affect writing to
general RPAS log file, which is controlled solely by loglevel.

= RPAS_PROFILING_PATH
The RPAS_PROFILING_PATH environment variable defaults to "rpasProfile.log" if not
present. This variable specifies the profiling log file name. It can be overridden
programmatically in the constructor of the profiling timer.
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Date and Time Setting

The RPAS_TODAY_STATIC environment variable affects how date and time and the
RPAS_TODAY environment variable are handled. The setting of RPAS_TODAY_STATIC
affects the date and time that is returned by the DateTime::now() function.

= If RPAS_TODAY_STATIC is set to true, all calls to DateTime::now() return the same
date and time as the first call made to the DateTime::now() function. The same date

and time is returned no matter how many times the DateTime::now() function is
called.

For example, RPAS_TODAY_STATIC is set to true and RPAS_TODAY=20090530. If a
call is made to DateTime::now() at 10:30 pm, it returns a date and time of 5/30/2009
10:30:00 pm. If another call is made 10 minutes later to DateTime::now(), a date and
time of 5/30/2009 10:30:00 pm is also returned.

= If RPAS_TODAY_STATIC is set to false, a call to DateTime::now() returns the current
date and time.

For example, RPAS_TODAY_STATIC is set to false and RPAS_TODAY=20090530. If
a call is made to DateTime::now() at 10:30 pm, it returns a date and time of
5/30/2009 10:30:00 pm. If another call is made 10 minutes later to DateTime::now(), a
date and time of 5/30/2009 10:40:00 pm is returned.

= User level environment variable TZ (time zone) needs to be set for the user who
starts the RPAS server processes (DomainDaemon, RPAS ODBC Server) or runs
RPAS utilities (like printMeasure). A missing TZ will cause the system to
misinterpret the date value stored in RPAS. For example, on a Linux system, the
default DATE type measure NA value of 0001/01/01 would be interpreted as
7295/12/31 23:00:00.000 if TZ were not set.

If the user is in time zone EST5EDT, use the command “export TZ=EST5EDT” to set
TZ. It is suggested that the command be added to user’s login script (for example,
.profile).

Database Settings

These variables are used for RPAS B-tree storage performance.

RPAS_PAGE_SPLIT_PERCENTAGE

This variable sets the page split percentage. The page split percentage determines the
percentage of low order keys to keep in the low order page of the B-Tree when a full
page is being split to accommodate data for a new key. It is expressed as a number
between 1 and 100.

RPAS stores non-NA values only. If an operation (load or calculation) causes a value to
be non-NA, RPAS tries to store it on a page and, if the page is full, it causes it to split.
Page splitting is an expensive operation, that is, it takes a significant amount of
processing time and if it happens too often, it can significantly slow down the load or
calculation process causing the splits. For efficient storage and to prevent pages from
being split very often, it is recommended that the value be kept between 50 and 90. If this
environment variable is unavailable, RPAS uses a page split percentage of 90.
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RPAS_PAGE_SIZE

This variable sets the page size for the RPAS B-Tree. Valid values are 4K, 8K, 16K, 32K,
and 64K. RPAS automatically uses a page size of 2K for arrays where the logical size of
the dimension space is less than 1000 cells, and a page size of 4K for arrays where the
logical size of the dimension space is between 1000 and 200,000 cells. For all other
dimension space sizes, RPAS uses a page size of 8K or the value of this environment
variable.

Since RPAS caches page data during all its processes, it is recommended that large page
sizes are used when dimension spaces are large and when it is known that most
processing happens in an unraveling order of positions. This is always the case when
processing is driven by the innermost dimension. In most RPAS domains, dimensions of
the Calendar hierarchy are the innermost dimension for most arrays.

RPAS_PROCESSES

This variable is used when doing batch measure registration. The default valueis 1. If a
user specifies a value less than 1, it will override to 1. If a user specifies a value greater
than the number of subdomains, it will be override to the number of subdomains in the
global domain. If this variable is set to a number greater than 1 when doing a measure
registration in a global domain, RPAS will spawn off that number of parallel processes to
register or unregister measures in each local domain.

Centralized Administration

Note: If a solution is built in a Global Domain environment,
most administrative activities can only be performed in the
“master” domain. This applies to RPAS administrative
workbook templates and wizards as well as RPAS utilities
that are run on the backend against the domain.

Administrative Workbook Templates and Wizards

The following list includes the standard RPAS workbook templates and/or wizards that
have been centralized. It can only be run in the master domain of a Global Domain
environment. See the individual sections for additional information.

= Alert Manager window — Results of the alert finder run on the global domain are
collated and displayed in this window.

1. This applies to all alerts registered in the global domain.
2. Results are based on data from all the individual local domains.
3. Results are consolidated (added together) to display a single result per measure.

= Alert Manager workbook template — This template is used to build alert workbooks
from the Alert Manager dialog window. Data will be retrieved from the local
domains.

= Measure Analysis — This is used to analyze measure data from local domains.

=  Security Administration — This is used to set security by template, measure, and
positions. This workbook template can only be used in the master domain, and it is
disabled for use in local domains.

= User Administration — User information will be set up and maintained in the global
domain, but it will be replicated to the local domains. Updates are effective

immediately after the changes are committed. This workbook template can only be
used in the master domain, so it is disabled for use in local domains.
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= Translation Administration — This is a template that is used to modify the labels of
translatable data in RPAS. This workbook template can only be used in the master
domain, so it is disabled for use in local domains.

= Hierarchy Maintenance — This is used to set up and maintain positions of user-

defined dimensions. User-defined dimensions must be registered in the Global
Domain by using the reguserdim utility.

RPAS Utilities

Please refer to the usage or syntax section on each utility for detailed information.

Domain Upgrade

Upgrade a Simple or Global Domain Environment

RPAS supports the upgrade of RPAS 11.0.x, 11.1.x, and 12.x environments to RPAS 13.

Note: See the solution-specific Installation and
Administration Guides for potential solution upgrade
limitations.

This similar process should also be followed when upgrading between minor (patch)
releases of RPAS (for example, RPAS 12.1.1 to RPAS 12.1.2). The following overview of
this process calls out upgrade steps that are unique to upgrading to a major or minor
release.

Upgrade Process Overview

The following is a high level description of the process that must be followed to upgrade
an RPAS domain and configuration.

1. Acquire the new version of the platform, which includes the following key
components:

= RPAS Server

= RPAS Client

= RPAS Configuration Tools

Create a backup copy of any domains that will be upgraded.

Commit any existing workbooks that have not yet been committed (if commit is
required).

RPAS does not guarantee the upgrade of existing saved workbooks or styles as part
of the upgrade process from one major release or patch to the next. If users are

unable to build workbooks after upgrading a domain, system administrators must
delete all the existing style and user/selections folders to correct the problem.

4. Remove from the auto-workbook queue (wbbatch utility) any -commit and

-refresh scheduled batch jobs. If upgrading an 11.0.x environment to 12.1.x (or later),

all -build scheduled batch jobs should also be removed from the queue.

Note: Skip this step if upgrading a 12.1 or newer
environment.

5. Run the convertDomain utility on existing domains. In global domain environments
this utility is only executed from the master domain.
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Note: Skip this step if upgrading a 12.1 or newer
environment.

6. Run the upgradeDomain utility on existing domains. In global domain environments
this utility is only executed from the master domain.

7. Upgrade existing configurations (see the Upgrade Configurations section for more
information on this step).

8. Run the rpasinstall utility with the -patchinstall argument.

convertDomain

Notes: When using the —updatestyles flag, deleting existing
styles is not necessary.

After running the upgradeDomain utility, the patch
installation (via rpaslnstall) must be run over the domain
even if there are no configuration updates. This is done to
ensure that configuration within the domain is in synch with
any changes made as the result of the RPAS and Tools
upgrade.

Migrating data from 11.0, 11.1, and 12.0 versions of RPAS to RPAS 12.1 (or newer
versions) requires the convertDomain utility. It contains the necessary functions to read
the pre-12.1 database and array formats and writes to the new 12.1 formats. It processes
both simple and global domains, regardless of subdomain locations, optionally removes
the previous .gem files, and recovers from a partial conversion. Upon successful
completion, it will tag the domain as converted, which is visible in the domain history
and visible with the domaininfo utility.

Usage

convertDomain -d domain [-loglevel level] [-purge] [-forcetag]

The following table provides descriptions of the arguments used by the convertdomain

utility.

Argument

Description

—d path

Path to the domain being converted.

—-purge

Inclusion of this argument indicates that existing
(Acumate) .gem database files should be removed
after conversion to reduce the space required for the
process. The .gem file will be removed immediately
after it has been converted.

—forcetag

This argument indicates that the domain should be
tagged as converted even if some databases/arrays
could not be converted.

The conversion process is done directly to the simple or global domain path specified
with the —d argument. A copyDomaiin is not automatically performed beforehand by the

utility.
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The process works by first opening the “R_SUBDOMAINPATH%1” array in the
“data/configmeasdata” database. If this fails then it is assumed that the domain is a
simple domain and not a global one. If it succeeds then the subdomain paths are read
from the array. Next the process searches for all .gem files in the subdomains and the
master, recursively and converts each one. The order of the conversion should not be
considered “predictable”; there is no assurance that subdomains will be converted in
order, or that the master will be converted first or last. In order to ensure recoverability
the “data/configmeasdata” database is not removed until the entire domain has been
converted. Finally, if no errors occurred during conversion (or the —forcetag option is
supplied) then the new domain is tagged with the “CONVERT” tag and time stamped.

Note: upgradeDomain is not called by this process. It must be
called separately. This allows the user to specify additional
parameters to upgradeDomain. Once the domain has been
converted and upgraded it is ready for use.

In the case of a partial domain conversion it is possible to restart convertDomain.
Currently every database will be reconverted unless the —purge option is specified. In that
case the conversion will restart with the last database that was being converted. There is
no current way to skip converted databases if —purge was not used, nor can individual
databases be converted.

upgradeDomain

Usage
upgradedomain -d domainPath [OPTIONS]
The following table provides descriptions of the arguments used by the upgradedomain

utility.

Argument Description

—d path Path to the domain being upgraded.

—verbose Optional parameter to show the detail about each
change that is applied to the domain.

-n Optional parameter to report which changes would be
applied without applying the changes.

—-purgeWorkbooks Required parameter that purges all existing
workbooks and clears the workbook batch queue.

-ignoreSharedNames Allow upgrade even if dimensions and hierarchies
share names

-apptag Indicate the application and version associated with
this upgrade. Parameter must be APP:VERSION.

Note: An administrator can also run the Domain
Information utility to verify the upgrade process as shown
below.

domaininfo —d pathtodomain —domainversion
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Upgrade Configurations

Once the RPAS Configuration Tools have been installed and the domains have been
upgraded, an administrator should upgrade existing configurations to version 13 or the
latest version 13 patch.

1. Launch the new version of the Configuration Tools; open the existing configuration
using File-Open. Select the configuration and click OK. A message box appears
prompting you to convert the configuration.

Convert thiz configuration? B4

‘r'our configuration iz zaved in an old format, and must be converted to be used in this version of the Tools.
Wwhould youl like to corvert oy

2. Click Yes. The Backup Location message box appears. Click OK to continue.

Choosze a backup location

'ou will how be prompted For a lozation to back up
wour old workzpace. Pleaze click OF to continue.

3. The administrator must now specify a location to store the backup of the current
(non-upgraded) configuration. Use the browser to identify a location and enter the
back-up configuration name. The backup may be stored in the same location as the
configuration being upgraded only if the name of the backup is changed from its
original name.

The Successful Conversion dialog box appears if the configuration was converted
without any issues.

Successful Conversion E2

Your configuration was converted and will now be opened.
A backup of your old warkzpace has been zaved in the location you specified.

4. The upgraded configuration will now be open in the Configuration Tools. Changes
can now be made to the configuration. Note that if changes are made the domain
must be updated through the normal patch install process.

Note: If upgrading RDF, Grade or Curve see “Upgrade
Application Configurations” for additional steps to complete
the application upgrade.
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Command-line Support for Configuration Upgrading

The RPAS Configuration Tools also provides command-line support to upgrade
configurations. The Configuration Converter is a standalone utility that converts a
configuration that was originally created and saved in a prior release of the
Configuration Tools. Only configurations created in a prior major release need to be
converted. Configurations saved in previous versions of the same major release, but in
different minor releases, do not need to be converted. See the RPAS Configuration Tools
Guide for more information on using the Configuration Converter (RpasConverter.exe)
via the command-line.

Note: If upgrading RDF, Grade, or Curve see “Upgrade
Application Configurations” for additional steps to complete
the application upgrade.

Upgrade Application Configurations

Applications such as RDF, Curve, and Grade are configured using a plug-in architecture
in the RPAS Configuration Tools. This architecture allows for the automation of most
configuration activities for the solution. The plug-in requests specific information from
the configuration administrator and the solution auto-generation tool automatically
generates the solution configuration. Prior to each patch or upgrade to a major release,
the auto-generation tool should be executed to ensure the solution configuration is
updated with the base configuration changes for the application. Updating the solution
configuration for each application should be done in the following order:

Curve
RDF

RDEF Clone
Promote
Grade

See the RDF, Curve, or Grade Configuration Guides for more information on the auto-
generation process for each application.

a kN2
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rpasinstall

Usage
rpasinstall <arguments>

The following table provides descriptions of the arguments used by the rpasinstall

utility.

Argument Description
—fullinstall Required argument.
—-patchinstall Required argument.
-testinstall Required argument.

-ch config_home

Required argument. Path to the directory containing
the configuration file.

-cn config_name

Required argument. The name of the configuration.

—-in input_home

Required argument. Path that includes the directory
containing the input files for the domain to be created.

If this directory includes a users.db file, then the users
and groups within that file will be added upon
domain creation. For more information, see Managing
Users — usermgr.

-log log_name

Required argument. Path that includes the name of
the log file to be created or updated.

-configdir config_directory

The path to the directory containing the xml files used
by RPAS. This is a required argument if the user
wants to supply globaldomainconfig.xml or
calendar.xml.

-dh domain_home

The path to directory in which the domain will be
created. Use if and only if a globaldomainconfig.xml is
not used.

-p dim_name

The partitioning dimension. Use if and only if global
domain is being implemented without the use of
globaldomainconfig.xml.

-rf function_name

The filename of the function to be registered. This
pairing may be repeated for multiple functions. This
argument is not required if there are no functions to
be registered.

-updatestyles

Imports configured style information into the domain.
This option is automatically set in a full install. Failure
to use this flag in a patch install will result in changes
to configured styles not being imported into the
domain.
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Security and User Administration

Functional Overview

This chapter describes the security model in RPAS, which includes workbook templates,
workbooks, measures, and positions. The levels of security are defined as measure level,
position level, and workbook level.

This chapter also describes user administration and security administration.

Note: If a solution is built in a Global Domain environment,
it is only required and possible to perform the
administrative activities included in this section in the
“master” domain.

User Logon Security
User accounts may be marked as locked out by the domain administrator.

This will prevent the user from logging in to the RPAS Client. The account remains
locked out until the administrator re-enables the account.

Account lockouts may be set or cleared by the domain administrator by using the User
Management utility.

The account may be marked as must change password.

This is useful for brand-new accounts. The user will be allowed to logon with the current
password and then forced to select a new password.

Must change password may be set or cleared by the domain administrator using the
User Management utility.

Account Lockout may be enabled for a domain.

The domain administrator selects a number of failed logon attempts after which the User
account will be marked as locked out. The account will remain locked out until the
administrator re-enables it.

Account Lockout can be enabled through the domainprop utility by using the
—lockAccount flag.

Password expiration may be enabled for a domain.

The domain administrator selects a number of days after which passwords expire. When
the user logs in, the system requires a new password to be entered if the configured
number of days has passed since this user entered a new password.

Password expiration can be enabled through the domainprop utility using the
—expirePassword flag.

Password history may be enabled for a domain.

The domain administrator selects a number of passwords to save. When the user attempt
to change passwords, the system will not permit any password already stored in the
password history to be used again.

Password history may be enabled through the domainprop utility using the
—passwordHistory flag.
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Measure Level Security

Measures have access rights; which are read-write, read-only, or denied. Measures that
are read-write or read-only may be selected in the extra measures and insert measure
dialogs. RPAS ensures that read-only measures are not editable by the user and the
presence of read-only measures does not affect the ability to commit a workbook.

Measure security can be specified and changed through the Security Administration
workbook. The Measure Rights worksheet allows Read Only, Deny, or Read /Write
access to a measure to be specified for each user. These measure rights only apply to the
Measure Analysis Workbook.

A workbook template overrides the default security of a measure, but it can only narrow
the security of the measure. For example, a measure could have default read-write access
for a user and a template could specify that all users have read-only access to the
measure when a workbook is built. However, if the default measure security was read-
only, the template could not expand the security of that measure to read-write. Measures
that are explicitly made read-only by a workbook template will not be expanded to read-
write access by RPAS.

Note: Refer to the RPAS User Guide from more information
on the Measure Analysis workbook.

Position Level Security

Position Level Security allows access control for dimensions on a position-by-position
basis. This capability is completely optional. If position level security is not explicitly
defined and configured, all users in a domain have access to all positions in all
hierarchies. Once position level security is defined, access to a position can be granted or
denied for individual users, users in a group, or for all users.

Position level security can be defined at levels (dimensions) at or above base (such as
class in the product hierarchy) in any hierarchy other than calendar. As positions are
added at a level/dimension lower in the hierarchy than where the position level security
is maintained, access to those positions is automatically granted if a user has access to the
“parent” position. In other words, if security is maintained at the subclass level, users are
automatically granted access to all the SKUs in a given subclass if they have access to that
subclass. This includes those that were added after security was established.

Exactly one dimension in each hierarchy can be defined as the security dimension for the
hierarchy. If a security dimension is defined for the hierarchy, all dimensions in the
hierarchy have position level security enabled, but position security is set at or above the
designated dimension. For instance, if the “class” dimension is designated as the security
dimension, an administrator can maintain access to positions in the class dimension or at
any level above class.

To specify the security dimension for a hierarchy, use the RPAS Configuration Tools or
the hierarchyMgr utility.
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After a security dimension is defined for a hierarchy, all users in the domain default to
having access to all positions in any dimension in the hierarchy. Additionally, users
automatically have access to newly added positions to a domain. Worksheets in the
Security Administration workbook are used to control position access for individual
users, user groups, or all users (referred to as “world” or default access). There are three
worksheets in this workbook for each hierarchy with a defined security dimension. The
default worksheet controls access to positions for all users (for instance, Prod Security
Default); one worksheet controls access to positions by user group (for instance, Prod
Security Group); and the last worksheet controls access to positions by individual users
(for instance, Prod Security User).

Access must be granted at all levels for a user to have access to a position. This means
that a position must have a value of true at the levels default/world, group, and user.
The following table demonstrates how access is granted or denied based on all
combinations of settings:

Security set by Position Based on settings on left,

Denied = False user is Granted or Denied
access

Granted = True

User User Group World Resulting Access

Denied Denied Denied Denied

Denied Denied Granted Denied

Denied Granted Denied Denied

Granted Denied Denied Denied

Denied Granted Granted Denied

Granted Denied Granted Denied

Granted Granted Denied Denied

Granted Granted Granted Granted

Position level security is used when a user selects positions in the wizard process before
building a workbook. Only positions to which a user has access are available for selection
in the 2-tree, which are then included in the build of the workbook.

Workbook Security

Currently, workbook access is either granted or denied. If users have been granted access
to a workbook, they can open, modify, and commit the workbook. No distinction is made
between read-write-commit, read-write, and read-only access. Workbook access is
automatically granted to the user that built it, and it may be shared with multiple groups
or the world.

Note: A user must have access to the workbook template in
order to access the workbook, even if the workbook has
world or group access rights.

Security and User Administration 23



User Administration

Users with administrator status automatically have access to all workbook templates. By
default, administrators have access to all workbooks that are saved with world access. If
a workbook is saved with group access, administrators can only access the workbook if
they are members of the default user group of the user who saved the workbook.

Another aspect of workbook security is the ability to set limits for the number of
workbooks that a user can have saved at any given time. Limits can be set for a user per
template, for a user group per template, or for a template for all users. The limits are
evaluated in the above order, which means that a limit defined at user-template
overrides any values defined at group-template or template. If the above limits are not
defined, the default value is one billion.

The limits are checked when the workbook build process is initiated. When the limit is
reached, an error message displays informing the user that the workbook build process
cannot complete because the limit has been reached. The message also lets the user know
what that limit is. The wizard process then terminates.

Administrative users have full access to all workbook templates regardless of the access
rights that other admin users may assign to them in the Security workbook. The
administrative user can build the Security workbook to change the access right back, so
the nominal assignment does not matter for administrative users.

Non-administrative users so not have access to Security template and User
Administration template groups even if the administrator inadvertently assigns them
access rights.

User Administration

Overview

User administration is the process by which administrators add and/or delete authorized
system users, create and/or delete user groups, and edit user profiles. These tasks are
performed through completion wizards on the User Administration tab. The following
procedures are discussed in this area:

= Access the User Administration tab
= Add auser

= Add a user group

= Delete a user

= Delete a user group

= Edit a user’s profile

Once users and user groups are set up, access permissions to workbook templates and
measures within workbooks can be assigned through Security Administration. Security
Administration also supports modification of the label, default workbook template,
and/or Admin status associated with individual users.

Access the User Administration Tab

1. Select New from the File menu. The New dialog box appears.
2. Select the User Administration tab.
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Add a User

a kN

10.
11.

12.

13.
14.

From the File menu, select New.

Click the User Administration tab.

Select Add User

Click OK.

In the ID field, type the ID string that the user will use for logging on.

Note: Each user ID must begin with a letter and contain no
spaces (the underscore character is acceptable).

In the User Label field, type a label that describes the user (for example, the user’s
full name). This identifying label appears in various locations throughout the
application. For example, labels appear on the File — Open dialog box to identify the
owner of a given workbook, and on the Forecast Approval worksheet to specify
which user approved a given forecast.

In the Default Group field, select the user group to which the user will belong.

If a user will belong to more than one group, select the additional groups from the
list in the Other Groups field.

In the Password field, type a password for the user.
In the Password Verification field, type the same password.
If the user should have Admin status, check the Administrator box.

Note: Admin status enables users to perform the Format
menu option Save Format/Admin, which creates new
system-wide default styles for workbook templates. If
unsure whether a user should be granted this ability, note
that a user’s Admin status can later be modified on the Users
worksheet of the User and Template Administration
workbook.

Note: Granting users Admin status gives them access to all
workbook templates, but it does not automatically give them
access to all workbooks.

If the user must change his or her password when logging on for the first time, check
the Force Password Change box.

Check the Lock User Account box to temporarily disable the user’s account.
Click Finish to add the new user to the database.

Workbook template and measure access rights can now be assigned to the user. To do so,
access the User and Template Administration workbook.
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Add a User Group

User groups provide an intermediate level of security to workbooks that were created
and saved by specific users. When new users are assigned to the system, they must be
assigned to existing user groups. User groups should consist of individuals with similar
job functions or responsibilities. In the Oracle Retail Predictive Planning Suite, the user
group corresponds to the user’s planning role.

In the Group Name field, type a name for the group.

1. Select New from the File menu.

2. Click the User Administration tab.
3. Select Add User Group.

4. Click OK.

5.

6.

In the Group Label field, type a descriptive label for the group. This label is
displayed when referring to the group throughout RPAS.

7. Click Finish to add the user group to the database.

Delete a User

If a user profile is no longer needed, it should be deleted from the system in order to
maintain system security.

From the File menu, select New.
Click the User Administration tab.
Select Delete User.

Click OK.

Select the name of the user to delete.

o o rwbhd=

Click Finish to delete the user from the system.

Delete a User Group

If a user group no longer exists, the group should be deleted from the system as soon as
possible to maintain system security.

Note: Before you can delete a user group, all users must be
removed from the group. For each user in the group, you
must either delete the user or change the default user group
assignment for the user.

From the File menu, select New.
Click the User Administration tab.
Select Delete User Group.

Click OK.

Select the user group to delete.

o o pwbhd=

Click Finish to delete the user group from the system.

26 Oracle Retail Predictive Application Server



Password Policy Administration Workbook

Edit a User

From the File menu, select New.
Click the User Administration tab.
Select Edit User.

Click OK.

Select the user to edit.

Click Next.

Make the necessary changes to the user’s profile. The administrator can change
anything except the User Name. See Add a User for details.

Noakrowbd=

8. Click Finish to save the changes.

Password Policy Administration Workbook

Using the Password Policy Measures Settings worksheet, administrators can configure
password complexity and settings in order to ensure the account security of users and
other administrators. With this worksheet, administrators can set the required password
complexity, the number of allowable password attempts, the expiration time of a
password, and the length of time a user is locked out of the system after failed password
attempts. The measures used to control these settings are described in the table below.

Note: The requirements set in the workbook are
automatically applied when the user logs in. If a user’s
password does not meet the requirements, the user is
prompted to change it.

© Password Policy Measures Settings

Pazsword Attempts 5
Paz=word Expiration Time 50
Paz=word Fail Delay 1
Password Failure Lockout Time for Administrators 15 minutes
Paz=word Failure Lockout Time for Users 15 minutes
Paz=word Minimum Length &
Pazzword Reguires Mixed Caze =i
Pazzword Requires Number i
Paz=word Reguires Symbol o
Pazzword Reuze Time 365

Meazure | € b
—

Password Policy Measures Settings
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Measure Description Allowable Values | Default Value
Password Attempts The number of consecutive failed | Choose from the |5
login attempts (due to an invalid | set values in the
password) before the account is picklist: 0, 1,2, ...,
locked. 10
Choose 0 if you do
not want to lock
the account.
Password Expiration The number of days that a 1 or greater 90 (days)
Time password is valid for an account.
Once the time passes, the user can
to log in, but is prompted to enter
a new password.
Password Fail Delay The number of seconds the server |0 to 600 seconds |1 second
waits before replying to the client
that a login failed (due to an
invalid password).
Password Failure The amount of time that an Choose from the 15 minutes
Lockout Time for administrator account is locked set values in the
Administrators after consecutive failed login pick list: 15 min,
attempts. Once this time passes, 30 min, 1 hour, 1
the account is unlocked and the day
administrator can attempt to login
again.
Password Failure The amount of time that a user Choose from the 15 minutes
Lockout Time for Users | account is locked after consecutive | set values in the
failed login attempts. Once this pick list: 0, 15 min,
time passes, the account is 30 min, 1 hour, 1
unlocked and the user can attempt | day
to login again. Choose 0 if you do
not want to
unlock the
account.
Password Minimum The minimum number of 1to 31 6
Length characters that a password can
contain. (The maximum number of
characters is 31.)
Password Requires If this measure is set to true, then | True, false True
Mixed Case the password must contain both a
lowercase and an uppercase letter.
(Passwords must always contain a
letter.)
Password Requires If this measure is set to true, then | True, false True
Number the password must contain a
numeric digit.
Password Requires If this measure is set to true, then | True, false False

Symbol

the password must contain a non-
alphanumeric character.
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Measure Description Allowable Values | Default Value

Password Reuse Time | The number of days that must 0to 10,000 days. | 365 days
pass before a password can be

Select 0 to place
reused for an account.

no restrictions on
reusing
passwords.

Security Administration Workbook

Overview

The Security Administration workbook is only available to system administrators. After
users and user groups are created, the administrator may set up and maintain access
permissions to workbook templates and measures within those workbook templates.
This workbook allows the administrator to determine which templates individual users
can access, as well as the measures that users can access while manipulating workbooks
in the system. The user can also specify and restrict the measures that are available to be
added to a given workbook template. Setting access permissions in this way provides a
high degree of measure security, because users can be restricted to viewing and editing
only certain relevant measures.

All administrative users have full access to all workbook templates regardless of the
access rights that they were assigned in the Security workbook by other administrative
users. The administrative user can build the Security workbook to change the access right
back, so the nominal assignment does not matter for admin users.

The Security Administration workbook has one or more worksheets for each of the
following:

*  Workbook Template Rights worksheet

*  Workbook Template Measure Rights worksheet
* Measure Rights worksheet

= Dimension Modification Rights

= Position Level Security

=  Workbook Template Limits

* Max Domain Session Limit worksheet

*  Max User Session Limit worksheet

Security Template Administration also allows the administrator to modify the label,
Admin status, and/or default workbook template associated with each user. You also
access this workbook template to modify the labels associated with user groups,
workbook templates, and workbook template groups. Using this workbook, the
administrator can:

= Assign and modify access rights of each user to all workbook templates.
User/template permissions are set in the Workbook Template Rights worksheet.

*  Determine which optional measures are to be accessible through individual
workbook templates. Template/measure permissions are set in the Workbook
Template Measure Rights worksheet.

=  Assign/restrict user access to individual measures. User/measure permissions are
established in the Measure Rights worksheet.

Security and User Administration 29



Security Administration Workbook

Workbook Template Rights Worksheet

The Workbook Template Rights worksheet is for setting and maintaining access
permissions of each user to specific workbook templates.

The worksheet contains a checkbox for each available workbook template and user
combination. A checkmark in the cell indicates that the user has access rights to that
specific template.

To grant a user access rights to a workbook template, put a checkmark in the checkbox in
for that workbook template.

To deny a user access rights to that specific workbook template, leave the checkbox blank
or clear the checkmark.

After changing a user’s profile, the changes must be committed to the database in order
for them to take effect.

The "Read Only" permission on a template applies only to actual workbooks created by
the template. For templates that do not generate a workbook, but only run through a
wizard process for other purposes, the "Read Only" permission for a user on that
template will not prevent them from running through the wizard. This applies to
standard RPAS templates, such as Add User and Delete User, but it may also apply to
various application-specific templates.

Workbook Template Measure Rights Worksheet

The Workbook Template Measure Rights worksheet allows administrators to determine
which registered measures will be available for optional inclusion in newly built
workbooks.

When a measure is initially registered as a public measure, all templates default to
having access to that measure. This means that it is possible for this measure to be added
to a workbook template, even if it is not one of the standard measures displayed when a
workbook of that type is built. Some new workbook wizards include a dialog that
prompts users to select any additional measures to be included in the workbook build.
By default, all newly registered measures are included on this list of available additional
measures. The other method of inserting new measures into a workbook is via the Insert
Measure command.

The Workbook Template Measure Rights worksheet is used to modify template/measure
permissions, which allows only certain templates to optionally include specified
measures in new workbook builds.

This worksheet contains a pick list for each available workbook template and registered
measure combination. Three security options are available: Denied, Read-only, Full
Access. Setting a value to Read-only or Full Access will allow users access to the
workbook template. Full Access indicates that the user may edit data in the workbook.
However, Denied or Read-only measure rights could prevent the user from committing
data.

Measure Rights Worksheet

The Measure Rights worksheet allows the administrator to restrict user access to
individual measures on a user-by-measure basis. User/measure permissions are initially
determined by the system by integrating the current user/template and
template/measure settings and applying the following rule: “A user cannot have access
to any measure that is not available in at least one template to which the user has access.”

Permissions can be made even more restrictive on a user by measure basis by using the
Measure Rights worksheet to deny users access to measures that they would normally be
permitted to edit.
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The worksheet contains a drop-down list for each available user and registered measure
combination. Three security options are available: Denied, Read-only, Read /Write.
Denied prevents the user from viewing data. Read-only allows the user to view the data.
Read /Write allows the user to edit data values. However, a commit rule must be
configured for a measure for data to be committed to the RPAS datastore.

Selecting a security option does not affect any measures already included in the
workbook. The selected security option is used only while inserting the measure into an
already built and open workbook.

Note: The Measure Rights worksheet contains only public
measures; that is, measures that can be optionally included
in a worksheet, depending on choices made in a new
workbook wizard. Measures that are registered as private
measures will not appear in this worksheet. If there are no
public measures available to be displayed in this worksheet,
the worksheet will not be built.

Dimension Modification Rights Worksheet

The Dimension Modification Rights worksheet allows the administrator to determine
which dimensions, if any, a user can modify. The worksheet contains a checkbox for each
available user and dimension combination. A checkmark in the cell indicates that the
user is permitted to modify the specified dimension.

After changes are made to a user’s dimension modification rights, they must be
committed before they take effect.

Position Level Security Worksheets

The position-level security worksheets are used to grant or deny access to positions for
individual users, user groups, or all users. Position-level security is set for a specific
dimension of a hierarchy (other than calendar). See the RPAS Configuration Tools User
Guide for more information on setting position-level security dimensions.

For each hierarchy/dimension that has position-level security enabled (normally just a
single hierarchy/dimension), there are three worksheets: one each for user, user group,
and world/all users.

After changes are made to position-level security, they must be committed before they
take effect.

Workbook Template Limits Worksheets

The Workbook Template Limit worksheets are used to limit the number of workbooks
that the user can have saved. Limits can be set for a user per template, for a user group
per template, or for a template for all users. The limits are evaluated in the above order,
which means that a limit defined at user-template will override any values defined at
group-template or template. If the above limits are not defined, the default valueis 1
billion, but it is not displayed in the workbook.

The limits are checked when the user begins the workbook build process. If the limit has
been reached, an error message appears that informs the user that the workbook build
process cannot complete because the limit has been reached. The wizard process then
terminates.

Max Domain Session Limit Worksheet

The Max Domain Session Limit worksheet is used to limit the number of user sessions
that can be attached to a single domain by all users of that domain. The limit is set at the
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domain level. In a global domain environment, the same limit is applied individually to
each local domain and the master domain.

This limit is checked during user login. If the limit has been reached, an error message
appears to inform the user that the login has failed due to this limit being reached.

32 Oracle Retail Predictive Application Server



Security Administration Workbook

Max User Session Limit Worksheet

The Max User Session Limit worksheet is used to limit the number of concurrent user
sessions that can be attached to a single domain by the same user at the same time. The
limit is set per user so that admin can control the maximum number of concurrent
sessions that are allowed for an individual user. In a global domain environment, the
same limit is applied individually to each local domain and the master domain.

This limit is checked during user login. If the limit has been reached, an error message
appears to inform the user that the login has failed due to this limit being reached.

Using the Security Administration Workbook

Note: These tasks are performed through the Security
Administration workbook. This workbook is only available
to system administrators.

Access Security Administration
1. From the main menu, select File - New. The New dialog box appears.

2. Select the Administration tab to display a list of workbook templates for
Administration.

3. Highlight Security Administration.
Click OK.

Set or Modify User Access to Workbook Templates
1. From the File menu, select New.

Click the Administration tab.

Select Security Administration.

Click OK.

On the Workbook Template Rights worksheet, select each template for which a user’s
access rights require modification. Set to Denied, Read-only or Full Access.

o N

6. Changes must be committed to the master database before they take effect. To
commit the changes, select Commit Now from the File menu.

Save the workbook by selecting Save from the File menu, if desired.
8. To close the workbook, select Close from the File menu.

Set Measure Availability for Workbook Templates
1. From the File menu, select New.

Click the Administration tab.

Select Security Administration.

Click OK.

On the Workbook Template Measure Rights worksheet, select each registered
measure that should be available for inclusion in the associated workbook template.
For measures that should not be included in the associated template, make sure there
is no check mark.

o ke N

6. Changes must be committed to the master database before they take effect. To
commit the changes, select Commit Now from the File menu.

Save the workbook by selecting Save from the File menu, if desired.
8. To close the workbook, select Close from the File menu.
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Assign or Restrict User Access to Measures
1. From the File menu, select New.

Click the Administration tab.

Select Security Administration.

Click OK.

On the Measure Rights worksheet, for each measure that a user should have access
to, select either Read Only or Read/Write from the drop-down list. For measures to
which the user should not have access, make sure Denied is selected.

o e NbN

6. Any changes made must be committed to the master database before they take effect.
To commit the changes, select Commit Now from the File menu.

7. Save the workbook by selecting Save from the File menu, if desired.
8. To close the workbook, select Close from the File menu.

Change User Ability to Modify Dimensions
1. From the File menu, select New.

Click the Administration tab.

Select Security Administration.

Click OK.

On the Dimension Modification Rights worksheet, select each dimension for which
the user needs modification rights. For dimensions that the user should not be able to
modify, make sure there is no check mark.

o ke N

6. Any changes made must be committed to the master database before they take effect.
To commit the changes, select Commit Now from the File menu.

7. Save the workbook by selecting Save from the File menu, if desired.
8. To close the workbook, select Close from the File menu.

Set or Modify Access to Positions (if position level security has been enabled)
1. From the File menu, select New.

Select the Administration tab.

Select Security Administration.

Click OK.

Select the worksheet for which security needs to be set or modified: User, User
Group, or World.

o kN

6. DBy default, the dimension (level) at which position level security is enabled will be
displayed. To manage security at a level above the designated level (only levels
above are possible), right-click and Select Rollup to view the available dimensions.

7. To grant access to a position, click the checkbox of the cell.

Note: A user must have access at the User, User Group, and
World levels to have access to a position.

8. Changes must be committed to the domain before exiting in order for them to take
effect.
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Limit the Number of Workbooks that a User Can Save

1.

o e NbN

From the File menu, select New.
Select the Administration tab.
Select Security Administration.
Click OK.

Select the worksheet for which the limit will be set: User / Template, Group /
Template, or Template.

Set the values as necessary.
Commit the data to the domain before exiting.

Set or Modify the Maximum Domain Session Limit

1.

a ke N

From the File menu, select New.
Select the Administration tab.
Select Security Administration.
Click OK.

On the Max Domain Session Limit worksheet, modify the scalar measure Maximum
Domain Session Limit value with a valid integer value.

Changes must be committed to the master database before they take effect. To
commit the changes, select Commit Now from the File menu.

To save the workbook, select Save from the File menu.
To close the workbook, select Close from the File menu.

Set or Modify the Maximum User Session Limit

1.

o ke N

From the File menu, select New.
Select the Administration tab.
Select Security Administration.
Click OK.

On the Max User Session Limit worksheet, modify the Maximum User Session Limit
measure per user.

Changes must be committed to the master database before they take effect. To
commit the changes, select Commit Now from the File menu.

To save the workbook, select Save from the File menu.
To close the workbook, select Close from the File menu.
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Hierarchy Maintenance

Overview

Hierarchy Maintenance Workbook

Oracle Retail Predictive Solutions provide the ability to set up and maintain user-named
and user-defined dimensions within hierarchies. Hierarchy Maintenance is the means by
which custom-created dimensions within a hierarchy can be established and maintained
through the application interface in order to meet individual business needs.

When Oracle Retail Predictive Solutions are installed, implementation scripts define the
dimensions and hierarchical structures specific to the customer’s organization. For
example, the system can be built to recognize that SKUs roll up into styles, styles roll up
into product classes, and so on within the product hierarchy. Occasionally, you might
want to group products according to some ad hoc personal design to suit a particular
business need. You can group arbitrary items in a hierarchy to use in functions such as
forecasting, replenishment, and measure analysis. These user-defined groupings act as
normal dimensional levels. In other words, they allow the user to roll data up from lower
levels of aggregation along the hierarchical paths that you define.

For example, suppose experience has shown that the accuracy of forecasts for your top 50
products (A products) reflects the relative accuracy of all forecasts. Therefore, you would
like to group elements within a user-defined dimension as the top 50 products by
designating them ‘A Products.” Then, when you select products in a wizard or look at
data in a worksheet, you can change the rollup to your user-defined dimension to see
your top 50 products grouped together.

Note: Your collection of 50 products may comprise elements
from a wide range of product classes or departments, and
your grouping scheme may have little to do with the normal
dimensional relationships of these items in the product
hierarchy.

The group of items you designate as ‘A Products’ may
change over time as consumer preferences change. From this
example, you see that user-defined dimensions can be used
to create any ad hoc groupings to provide additional
support in analyzing, selecting, or summarizing data in
Demand Forecasting. The Hierarchy Maintenance interface
allows you to change the nature of the groupings as
required.

The number and names of user-definable dimensions are set
by your company when an RPAS-based solution is initially
installed. The positions within each dimension and their
associated labels can be altered and maintained through the
hierarchy maintenance process.

Hierarchy Maintenance 37



Overview

Keep in mind that any hierarchy in RPAS can have user-defined dimensions within it as
long as they are set up by your company at the time of installation. The examples in this
section refer to the Product hierarchy, but other hierarchies could be maintained in the
same way.

Hierarchy Maintenance Example

Suppose you want to designate SKUs in your product hierarchy as either A, B, or C
products so that you can group these items together when you view information, such as
forecasting, replenishment, or measure analysis reports.

To do this, you need to maintain a user-defined dimension that will allow you to map the
SKUs to the various positions of your classification scheme (A, B, or C). The user-defined
dimension used in the following example is named Product Status. To maintain this user-
defined dimension, use the Hierarchy Maintenance Wizard.

Hierarchy Maintenance Wizard

The first step in maintaining hierarchies is to access the Hierarchy Maintenance Wizard.
In this wizard, select the SKUs that will be mapped to the various positions of the user-
defined dimension. Responses to prompts in the wizard are used to format a new
Hierarchy Maintenance workbook.

Hierarchy Maintenance Worksheet

The Hierarchy Maintenance worksheet displays the position assignment fields for the
selected custom dimension. Edit the cells associated with the custom dimension as
required.

Returning to the example dimension Product Status, you want to classify each selected
SKU in your workbook as an A Product, a B Product, or a C Product. This example
provides only three positions, or values, in the Product Status dimension; however, you
can enter any character string in an individual SKU’s Product Status cell. This new string
will be treated as a separate user-defined grouping. If this is the first time a particular
SKU has been mapped to the Product Status dimension, the label assigned to that SKU
will not yet be defined. The Product Status field is automatically filled with “Unassigned.’

Assign labels to each product with regard to the Product Status dimension. In the
following example, products that were previously ‘Unassigned’ are now designated as A,
B, or C Products.

|II|| SHL to Product Status Worksheest

E Procluct Statuz I_‘

3001-01 Turtleneck Swesber 20-5 | Product —
3001.02 Turtheneck Swesber 20.M A, Procluct

300103 Turthenwack Swnasbar 20-L C Product

3041-07 Cashmere Swomter 42-5 B Product

3041-08 Cashmere Swrember 42-M A Prochact

3041-09 Cashmere Swesber 42-L € Product

B031-02 Sports Pigue 17-8 C Product

B031-03 Sports Pigua 17-L B Product

6053-05 Swealshirl 20-M Urrazsigned

B053.06 Swvealzhird 20.L Uria=signed -
Pracuct [ 4] | 3
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Note: The Oracle Retail Predictive Solutions system is case-
sensitive when a new position name (label) is entered in the
Hierarchy Maintenance workbook. After the workbook is
committed, the typing of the group name is not case-
sensitive. For example, "B Product” can later be entered as "b
product” after the "B Product” group label has been
committed.

After making the A, B, or C Product designations for the selected SKUs, you must
commit the workbook for any changes to take effect.

For this example, labels have now been assigned to the various positions within the
Product Status dimension, and selected products in the product hierarchy have been
classified with regard to the custom dimension. Demand Forecasting treats Product
Status, a user-defined dimension, as a normal dimensional level within the product
hierarchy.

The following figure displays the results when, in a wizard, access a quick menu and
change the rollup to the Product Status dimension. The products shown here are
classified according to the position values (A Product, B Product, or C Product) that were
assigned while maintaining the Product Status dimension.

Selected Products | Selecgicunsl

EA Product

— ® 3001-01 Turtleneck Sweater 20-5
— ® 3001-02 Turtleneck Sweater 20-w
— ® 3041-08 Cashmere Sweater 42-w
— ® 3053-05 Sweatshirt 20-M

— ® 3053-06 Sweatshirt 20-L

EB Product

— ® 3041-07 Cashmere Sweater 42-5
— ® 3031-03 Sports Pigue 17-L

B Product

— ® 3001-03 Turtleneck Sweater 20-L
— ® 3041-09 Cashmere Sweater 42-1L
— & 3031-02 Sports Pigue 17-M

I ame | Action |
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Access Hierarchy Maintenance

o e NN

10.
11.

Note: If a solution is built in a Global Domain environment,
it is only required and possible to perform all the
administrative activities in this section in the “master”
domain.

Select Open from the File menu to bypass the Hierarchy Maintenance wizard, and
open an existing Hierarchy Maintenance workbook, or select New from the File
menu.

Select the Administration tab to display the list of Administration templates.
Select Hierarchy Maintenance.
Click OK.

Select the hierarchy to specify a user-defined dimension (for example, Product or
Location). Only the hierarchies that have been set up to contain user-defined
dimensions are represented here.

Click Next.

Select the user-defined dimension to be updated. The number and names of available
custom dimensions are set at installation.

Click Next.

On the Available side of the selection wizard, choose the items to be mapped to
positions within the custom dimension.

Click the right arrow button to move them to the Selected side.
Once all items to appear in your workbook have been selected, click Finish.

Maintain a User-Defined Dimension within a Hierarchy

Use this procedure to assign product or location items to custom-defined positions
within a specialized dimension. Custom-created dimensions are distinct from those in
the standard hierarchical roll-ups configured in the system implementation. Users can
use these dimensions like normal Demand Forecasting levels, aggregating data along
these new hierarchical paths.

1.

o kN

10.

Select New from the File menu.

Select the Administration tab to display the list of Administration templates.
Select Hierarchy Maintenance.

Click OK.

Select the hierarchy to specify a user-defined dimension (for example, Product or
Location). Only the hierarchies that have been set up to contain user-defined
dimensions are represented here.

Click Next.

Select the user-defined dimension to be updated. The number and names of available
custom dimensions are set at installation.

Click Next.

On the Available side of the selection wizard, choose the items to be mapped to
positions within the custom dimension.

Once all items to appear in your workbook have been selected, click Finish.
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11. The Hierarchy Maintenance workbook is displayed. In the position assignment field
for the custom dimension, assign a value to each product or location position in the
workbook. Enter any text string in a cell. Each unique string will be treated as a
separate user-defined position within the custom dimension.

12. Select Commit Now from the File menu to commit the changes to the master
database. If desired, the user may also save the workbook by selecting Save from the
File menu.

13. To close the workbook, select Close from the File menu.
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Overview

Measure Analysis Workbook

The Measure Analysis workbook template allows the user to view data associated with
any registered measure in the Oracle Retail Predictive Solutions applications, such as
actual sales data for specified product/location/calendar combinations. The user may
also use the Measure Analysis workbook to edit values for writeable measures, however
commit capability is only allowed to administrative users.

Although a common use of the Measure Analysis workbook is to view actual sales data,
the workbook is not restricted to presenting sales data alone. The user can view any data
loaded into the Oracle Retail Predictive Solutions master database, such as selling prices,
shipments, and orders. The Measure Analysis Wizard provides a list of all stored
measures that have an “Insertable” measure property set to true (see the RPAS
Configuration Tools User Guide for more information on measure properties). The user
simply chooses the measures to be displayed in the new workbook.

Note: Due to its dynamic nature, formatting settings cannot
be saved in the Measure Analysis workbook.

Measure Analysis Wizard

The Measure Analysis Wizard guides the user through the process of creating a new
Measure Analysis workbook in which the user can view selected measure data.
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Measure Analysis Worksheet

The Measure Analysis worksheet allows the user to view the chosen measure data for the
positions selected from the measure’s associated hierarchies. Each Measure Analysis
worksheet is displayed at a different dimensional intersection, depending on the measure
selections made in the wizard. This dimensional intersection is shown in the worksheet

title bar.
© STR ITEMWEEK Window M=E3
Location | Measu re| Calendar
Boston h’l.feekhr Sales - Regular || Hl«l»l Nl

1142008 1112008 | 1MEB2008 /2502008 2M/2008

1000001 0Leather Loafer - Black 6 B Tirro0 156.00 418.00 547.00 564.00
1000001 1Leather Loafer - Black 6.5 B T61.00 401.00 520.00 352.00 332.00
1000001 2Leather Loafer - Black 7 B T65.00 351.00 285.00 325.00 573.00
1000001 3Leather Loafer - Black 7.5 B 685.00 412.00 432.00 382.00 433.00
1000001 4Leather Loafer - Black & B 382.00 275.00 324.00 42200 311.00
10000015Leather Loafer - Black 8.5 B 620.00 238.00 535.00 453.00 473.00
10000015Leather Loafer - Black 9 B 515.00 368.00 529.00 398.00 376.00
Product| < »

Example of Measure Analysis Worksheet

The example above shows a Measure Analysis worksheet that displays Weekly Sales
data for several items in a particular store. The location/product/calendar dimensional
intersection of this worksheet, as shown in the title bar, is STR (Store), ITEM, WEEK. The
Weekly Sales measure, because it is registered as a read /write measure, can be edited in
this worksheet. However only an administrative user can commit overwrites to writeable
measures in this workbook.

Access Measure Analysis

1. Select Open from the File menu to bypass the Measure Analysis wizard and open an
existing Measure Analysis workbook, or select New from the File menu.

On the Analysis tab, select Measure Analysis.
Click OK.

Review and Edit Sales or Other Registered Measure Data

1. To open an existing Measure Analysis workbook: select Open from the File menu,
double-click on the workbook to be opened, and go to step 8.

OR

To open a new workbook, select New from the File menu.
On the Analysis tab, select Measure Analysis.

Click OK.

The Measure Analysis Wizard opens and prompts the user to select the measures to
be displayed in the new workbook. Use Ctrl-Click and/or Shift-Click to select
multiple measures.

5. Click Next.
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For each hierarchy specified in the base intersection of the measure(s) selected, the
user will see a hierarchy wizard from which to select positions to view. Repeat this
step for each hierarchy wizard.

Click Next.
Click Finish to open the Measure Analysis workbook.

On the Measure Analysis Worksheet(s), view the stored data associated with the
measures and hierarchy positions selected in the wizard. Make any changes as
required. Administrative users may commit changes.
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Workbook Auto Build Maintenance

The Workbook Auto Build feature allows users to set up workbook builds to take place
on a regular basis during nightly batch runs. Workbooks to be built in this way are added
to the auto build queue. Because the workbook build process is automated, users are
spared the processing time required to regularly enter the same wizard selections each
time a new workbook is built. And because the build process occurs overnight, users are
spared the wait time associated with constructing new workbooks.

The Workbook Auto Build feature works through the Workbook Auto Build
Maintenance Wizard.

Workbook Auto Build Maintenance Wizard

The Workbook Auto Build Maintenance wizard steps the user through the processes of
adding and/or deleting workbooks from the auto build queue.

Accessing the Auto Build Maintenance Workbook

P ODbd =

Select New from the File menu.

Select the Administration tab.

Highlight Auto Workbook Maintenance.
Click OK.

Add a Workbook to the Auto Build Queue

Workbooks in this queue are designated to be built automatically on a specified regular
basis as part of the nightly batch run.

1.
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Select New from the File menu.

Select the Administration tab.

Highlight Auto Workbook Maintenance.
Click OK.

From the task list, select Add Workbook.
Click Next.

Select a workbook template type.

Click Next.

Select an owner for the workbook.

. Click Next.
. Fill in the workbook Build Label, the Build Frequency (in days) with which the

workbook should be built, and the Next Build Date.

. Specify the Saved Access for the workbook: select User, Group, or World.
. Select the group that owns the workbook. Choose from the list of groups to which

the user belongs.

. Click Next to initialize the wizard for the workbook template selected in step 5

above. The choices made are saved under the name specified for the Build Label.
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Delete a Workbook from the Auto Build Queue
1. Select New from the File menu.

Select the workbook or workbooks to delete from the auto build queue.
Click Finish to delete the workbooks from the Auto Workbook Build queue.

2. Select the Administration tab.

3. Highlight Auto Workbook Maintenance.

4. Click OK.

5. From the task list, select Delete Workbooks.
6. Click Next.

7.

8.
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Internationalization

Internationalization is the process of creating software that can be translated more easily.
Changes to the code are not specific to any particular market. This section describes
configuration settings and features of the software that ensure that the base application
can handle multiple languages.

Oracle Retail applications have been internationalized to support multiple languages.

Translation

Translation is the process of interpreting and adapting text from one language into
another. Although the code itself is not translated, components of the application that are
translated include the following:

=  Graphical user interface (GUI)

= Error messages

The following components are not translated:

= Documentation (online help, release notes, installation guide, user guide, operations
guide)

= Batch programs and messages

* Logfiles

* Configuration tools

= Reports

* Demonstration data

= Training materials

The user interface has been translated into:

= Brazilian Portuguese

= Dutch

= French

* German

=  Greek

* Hungarian

= Jtalian

= Japanese

= Korean

= Polish

* Russian

= Simplified Chinese

= Spanish

= Swedish

= Traditional Chinese
=  Turkish
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Translation Administration

Note: For information on the translation of position labels,
see “Position Label Translation”.

Every product, location, and calendar position can be presented in multiple languages, as
can messages presented through the client. However, before translated strings can be
viewed in the client, the following processes must be followed to setup the environment
to support multiple languages.

1.

Build the domain(s) with the Multi-Language setting enable in the Configuration
Tool properties.

To install the translated client .dll, copy the file <language>.dll to C:\Program
Files\Oracle\RPAS Client\ (or user’s client Path). A file named foundation.exe must
be in the same directory. The <language>.dll contains translated user interface
information—the menus, dialogs, buttons, etc.

By default, the language of the RPAS Client is determined by the language of the
client-side operating system. You can override this behavior by setting the Language
entry in the Options section of the foundation.ini file, like this:

[Options]

Language=10

The foundation.ini file is found in one of the following places. When RPAS searches
for the file, it searches in the following order:

a. Look in the user's "Application Data' folder:

—  For Microsoft Windows XP:
C:\Documents and Settings\ <user>\ Application Data\Oracle Predictive
Solutions

— For Microsoft Windows Vista:
C:\Users\ <user>\ AppData\Local\Oracle Predictive Solutions

Look in the same folder as the currently loaded foundation.exe file.
Look in the current working folder, which can be one of the following:
— The debugger's setting, if started by debugger
— The same folder as the foundation.exe file, if started manually
— ./winnt/system32, if started from automation

d. C:\Windows

If the file is not found, it is created at the location in step a.

If the RPAS Client cannot find the library for the language you specify, it will default
to English. The following languages are currently released:

Language Code
Brazilian Portuguese 22
English 9
French 12
German 7
Italian 16
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5.

Language Code
Japanese 17
Korean 18
Russian 25
Simplified Chinese 2052
Spanish 10
Traditional Chinese 1028

Next, place the solution and RPAS .ovr files for the language selected into the ‘input’
directory of your domain. The .ovr files are found in RPAS_HOME/translations. The
input directory should also contain the Ings.dat file that will be loaded prior to
loading the .ovr files. If not packaged with the language .ovr files, the current
Ings.dat file will be in the “input/processed” folder of the domain. Move it back to
the ‘input’ folder and remove the timestamp extension. Then reload the hierarchy
using loadHier -d /path -load Ings. Make sure that the language you are loading
exists in the Ings.dat file before loading it. Load each .ovr file within the input
directory by using the loadmeasure utility (for example, loadmeasure —d /path —
measure r_msglabel).

Note: The files will be removed from your ‘input’ folder
when they are loaded. So, any file that is left in this directory
still needs to be loaded.

Note: For Japanese, Korean, Chinese Simplified /Traditional,
Russian, you will need to reboot your machine in each of
these languages to properly see text.

Note: The translated .ovr files are released in UTF-8
encoding. Any changes to these files should be made with a
UTF-8 capable editor and saved without BOM (Byte Order
Mark).

The .ovr files consist of three data columns, as shown below.
Gub_mean_ SPANISH Media méxima

The data is populated on a specific column and has definite
width. When making any change to this data, you must
ensure that the new data abides by the predefined width and
position for that data for the file.

In Regional Options, set the default language to match. On Windows 2000, you set
both Your Locale" and Set Default under Language settings for your system. On
Windows XP, set the Standards and formats list to the desired language. Set
Location to the appropriate country. Click on the Advanced tab and set Language
for non-Unicode programs to the appropriate language.
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Translation Administration Workbook

The Translation Administration workbook contains worksheets for translating text used
in measure labels, workbook template names, template group names, user group labels,
and general areas (for instance, wizard instructions, and error messages).

Note: RPAS and solution-specific messages to the user
should not be modified. If changes are made to these
messages they may be overwritten when patching occurs.

Hierarchy Labels Worksheet

The Hierarchy Labels worksheet allows the user to view and edit the translations of
hierarchy labels. Translations are supported for each of the system’s allowable alternative
languages.

Dimension Labels Worksheet

The Dimension Labels worksheet allows the user to view and edit the translations of
dimension labels. Translations are supported for each of the system’s allowable
alternative languages.

Workbook Template Group Labels Worksheet

The Template Group Translations worksheet allows the user to view and edit the
translations of template group names. Translations are supported for each of the system’s
allowable alternative languages. Translations in this worksheet affect the labels on the
tabs that appear in the File - New dialog (for example (in English), Administration,
Analysis, and Predict).

Workbook Template Labels Worksheet

The Template Translation worksheet allows the user to view and edit the translations of
workbook template names. Translations are supported for each of the system’s allowable
alternative languages.

Measure Labels Worksheet

The Measure Translations worksheet allows the user to view and edit the translations of
measure labels. Translations are supported for each of the system’s allowable alternative
languages.

Measure Descriptions Worksheet

The Measure Descriptions worksheet allows the user to view and edit the translations of
measure descriptions. Translations are supported for each of the system’s allowable
alternative languages.

User Group Labels Worksheet

The User Group Translations worksheet allows the user to view and edit the translations
of user group labels. Translations are supported for each of the system’s allowable
alternative languages. The list of user groups includes the Administration, Default, and
Internal user groups, plus any other user group names set up by the system
administrator. For products in the Oracle Retail Predictive Planning Suite, the list of user
groups also includes the various planning roles.
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Message Labels Worksheet

The Message Labels worksheet allows the user to view and edit the translations of
messages displayed to users in the RPAS Client. Translations are supported for each of
the system’s allowable alternative languages.

RGRP Labels Worksheet

The RGRP Labels worksheet allows the user to view and edit the translations of rule
group labels displayed to users in the RPAS Client. Translations are supported for each
of the system’s allowable alternative languages.
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Commit as Soon as Possible

Commit As Soon As Possible (Commit ASAP) allows users to schedule the commit
process of workbook data so that it executes as soon as all the system resources are
available. Commit ASAP is an option in the File menu of the RPAS Client. Procedures for
using Commit ASAP are provided in the RPAS User Guide.

Commit ASAP takes a copy of the data to be committed. Unlike Commit Later, which
adds a workbook commit process to a queue that is run in batch, the data that is
eventually committed is the data that was present at the time the commit instruction was
issued. With Commit Later, if the user makes further changes to the workbook and saves
that workbook before the batch commit process is run, those changes will also get
committed.

Using Commit ASAP

After attempting to commit a workbook using Commit ASAP (File\Commit ASAP), the
user will see a message in the client that the workbook has been scheduled for a commit.
The user can continue with his/her work. The system will then try to commit the
workbook as soon as it can, taking into account any other scheduled commits. If the
commit cannot be done prior to the domain’s Commit ASAP deadline, it will be canceled
and listed as failed.

There are four states for commit processes to be added to the Commit ASAP queue.

* Pending — The commit process is queued up to take place at some point in the future.
* Committing — The workbook is currently being committed.

*  Success — The commit succeeded.

= Failed - The commit failed.

The status of each commit ASAP process can be viewed by using a dialog window called
“Commit Status” from the File menu. This dialog window displays all of the Commit

ASAP processes with their respective status for all processes that have not been purged
(see below). This dialog can be used to sort the tasks based on any of the columns.

Entries can be filtered in a variety of ways. If the checkbox All Users is not checked, the
user will only be able to view his/her entries. If it is checked, you will see the entries for
all users. The checkboxes in the Status To Display group allow you to filter the output so
that the user sees only the processes with the specified statuses. The window can be
updated by using the Refresh button. The dialog remembers the settings based on the
last use.

Note: If a user attempts to commit a workbook ASAP that
already has a process in the queue, the original processes
will be removed from the queue. That means that there can
only ever be one pending commit ASAP in the queue for a
given workbook/user /template name combination.

Note: Workbooks must have been saved at least once before
attempting a Commit ASAP. A workbook has not been
saved if the label says “untitled.”
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Managing the Workbook Queue — showWorkbookQueues

The RPAS utility showVorkbookQueues is used for viewing the status of Commit ASAP
processes and for purging entries in the Commit ASAP status window. The usage of this
utility follows below.

The purge option requires a date before which entries will be removed, as well as
specification for which entries to remove: succeeded, failed, or both.

Usage

showWorkbookQueues -version

showorkbookQueues -d domainPath —show
[all|pending|waiting|working]success|failed]*

showWorkbookQueues -d domainPath -purge date [success | failed]*

The following table provides descriptions of the arguments used by the
showWorkbookQueues utility.

Argument Description

—version Prints the RPAS version, revision, and build information of
the utility.

-d domainPath Specifies the path to the domain.

-show Lists the contents of the queue in the order in which the

parameter is specified. Possible values: all, pending,
waiting, working, success, and failed.

all Used with the —show parameter. This lists all of the
workbooks in all statuses.

pending Used with the —show parameter. This lists all workbooks
that are waiting to be committed.

waiting For Oracle Retail development use only.

success Used with the —show parameter. This lists all workbooks

that have been successfully committed.

failed Used with the —show parameter. This lists all workbooks
that did not successfully commit.

-purge date Purges entries in the Commit ASAP status window.
Entries before the date provided will be removed.

The date should be a string of the following DateTime
format: YYYYMMDDHHmMm

For example “200406071529” equals June 7, 2004 3:29 PM.

Administrator must select to purge commit processes that
either succeeded or failed.
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Commit ASAP Settings — configCommitAsap

There are two settings for Commit ASAP that are managed by an administrator. Both are
set using the utility configCommitAsap.

Usage

Maximum number of simultaneous commit processes (property MaxProcesses,
default value is 4).

Deadline for which all pending processes must be completed, after which they will
be cancelled and marked as failed.

This deadline will likely be used by administrators before beginning nightly batch
processes (property deadline, default value is 00:01 [meaning 12:01 AM], in 24-hour
time).

A commit process that starts before the deadline is reached will be processed.
Commit requests that were in the queue before the deadline that did not get
processed will be cancelled and marked as failed. Commit requests added to the
queue after the deadline will use the deadline of the following day.

configCommitAsap -d pathToDomain [-maxProcs numProcs]
[-deadline time] [-display]

The following table provides descriptions of the arguments used by the configCommitAsap
utility.

Argument Description

—version Prints the RPAS version, revision, and build

information of the utility.

-maxProcs numProcs Sets the maximum number of concurrent commit

processes where NUMProcs is an integer greater than 0.

Workbooks can be committed in parallel if they do not
require access to the same measure databases.

If they do share databases, they will be committed
sequentially.

-deadline time The time of the day when all outstanding commit

ASAP operations will timeout.

If a commit ASAP operation is submitted after this
time, it will not timeout until the deadline time on the
next day.

This string must have the following format:
HH:MM
For example “13:30” refers to 1:30 PM.

-display Displays the current commit ASAP settings.

-loglevel level Use this argument to set the logger verbosity level.

Possible values: all, profile, information, warning,
€rror, or none.

-noheader To disable timestamp header use.
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Logging and Technical Information

Alog file is available in the Commit ASAP directory that should be checked if a user
reports an error with a Commit ASAP submission. The file is named rpasServer.log and
is in the following directory: <Path to domain>/commitAsapQueue.

Another log file is generated for each Commit ASAP process and stored in a user’s
directory (users/<userid>/asapLogs). The format of the log file name is “orig_<original
workbook name>asap_<temporary workbook name>.log.” RPAS creates a temporary
workbook in this process to capture the snapshot of the data that needs to be committed.
Temporary workbooks are never viewed by a user. An administrator can use this log if
something does not properly commit.

Note: These “snapshot” workbooks cannot be viewed or
used in the RPAS Client.

An example of this log file is orig_t1_asap_t5 where “t1” is the name of the original
workbook and “t5” is the name of the snapshot workbook.

The following directories are used to store the copies of the workbook as they are
processed through the system:

= pending directory — Contains one file per submitted commit ASAP that has not yet
been processed. These files are, in general, binary and cannot be easily read.

* working directory — Contains one file per submitted commit ASAP that is currently
in the commit process.

= success directory — Contains one file per submitted commit ASAP that has
successfully completed its commit process.

» failed directory — Contains one file per submitted commit ASAP that either had a
failure during its commit process or could not be committed prior to the deadline.

* unknown directory — If the Commit ASAP process detects a corrupted queue file, a
message gets logged and the file gets moved into the unknown directory.
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Batch Processes and RPAS Utilities

Included with an RPAS installation is a collection of stand-alone executables and scripts
that are used for a variety of operations. RPAS utilities are run directly against a domain.
If in a Global Domain environment, most utilities can only be run on the master domain.
RPAS utilities can be categorized into the following groupings:

* Hierarchy management — the loading and refreshing of hierarchies, and the process
of updating the data structures in the domain to reflect hierarchy changes

= Measure data — utilities for loading, exporting, and moving data within and between
domains

= Miscellaneous — a variety of utilities for performing certain procedures in batch and
for setting a number of parameters on an environment/domain

* Information RPAS utilities — a variety of utilities that retrieve information about a
domain, data, the RPAS Server code, or an object used by the server

RPAS Utilities Logging Options

Log Levels

RPAS has a number of applications used to control or process data. Currently there are
no unified methods for logging output, controlling the level of logging, or directing
logging to a particular file. Instead each utility has its own methods, although many are
similar. The current behavior for each utility follows.

This is a list of the standard log levels, controlled by the —loglevel option. Not all
programs use these levels, but most do. Default logging level is “Warning,” which means
that any log messages that are specified as a warning or higher will be output:

= All - Forces all log levels to be output
= Profile — Performance profiling information

= Audit - User-specific domain and workbook activities. These activities include the
following:

— Workbook build, calculation, save, commit and custom menu operations
— User login and logout to domain

= Information — General status messages that are not problematic. Outputs status and
progress of the operation, in addition to the error and warning messages.

= Warning — Messages indicating a potential problem, but not one that is fatal. Outputs
warning messages, in addition to error messages.

=  Error — Messages relating to a fatal problem. Outputs only error messages.
* None — No messages. There should be no output if the utility successfully executes.

Each of the lines that contain the above types of feedback is normally preceded with a
code that indicates what type of information is being output. Each code should have an
angle bracket (“<”) in front of it.

= Eindicates that the message is an error.

* W indicates that the message is a warning.
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= Iindicates that the message is informational.

= U indicates that the message is audit-relevant information.

= Pindicates that the message is a performance profile.

Note: Audit information related to workbook activities gets
recorded in rpas.log under each user’s working directory.
Information related to domain activities, such as user sign-
on and sign-off, gets recorded in DomainDaemon.log.

Utilities with Standard Logging

A number of utilities allow for the —loglevel option to control which messages are output
to the screen. There is no way to log to a file directly. The table below displays the

utilities that can use the -loglevel option.

= alertmgr

=  checkDomain

= checkParents

= configCommitAsap

= createdb

= createGlobalDomain
= dattrmgr

= dbdiff

= dimensionMgr

=  domaininfo

= Idrule
= listDb
=  mapData

=  moveDomain
= printArray

= printMeasure

Scripts

regfunction
regmeasattr
regmeasure
regtemplate
regTokenMeasure
reguserdim
rpasverison
rtkappcnfgmeas
showWorkbookQueues
syncNAValue
updateArray
updatestyles
upgradeDomain
usermgr

wbmgr

Shell scripts cannot use standard logging, but may execute the following programs that

use it:

convertDomain
All output to the screen.

createRpasDomain

The —v option controls the type of messages sent to the screen.

Utilities with Special Logging

These utilities may use standard logging with additional features, or may use entirely

different logging methods.
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DomainDaemon

The DomainDaemon uses standard logging. Logs output to a file (see below). The file is
created either in the current working directory or in the directory specified by the
“RPAS_LOG_PATH” environment variable.

The file name depends on the “RPAS_LOG_BACKUPS” environment variable. If it is set
to 1 or greater, then:

The log file name is “Daemon_Dyyyymmddhhmmbxx.log” where “yyyy” is the current
year, “mm” is the current month, “dd” is the current day, “hh” is the current hour, “mm”
is the current minute and “xx” is some number used to make the file name unique.

The number of these log files will be limited to the number provided in the
environmental variable “RPAS_LOG_BACKUPS”.

Otherwise, the log file name will be Daemon.log. Any existing log file is renamed to
Daemon.old.

At midnight the current log file is closed and a new one opened, with naming as above.

RpasDbServer

This should only be started from the DomainDaemon as a part of a client request to start
an RPAS session. The logging level is controlled by the client’s “RPAS_LOG_LEVEL”
environment variable. If not set then it defaults to logging messages at the “warning”
level.

This utility creates log files in the “domain/users/client” directory, where domain is the
current domain path and client is the current client. The actual file name used will be
either “rpas Dyyyymmddhhmmbxx.log” or rpas.log base on the environmental variable
“RPAS_LOG_BACKUPS” (c.f. DomainDaemon, above).

loadHier

The loadHier utility uses standard logging. This utility performs part of its processing in
child processes; see the entry for reshapeArrays as well. Any log messages generated by
reshapeArrays will go to the log file reshapeArrays.log in the current working directory.
loadHier provides a list of all hierarchy positions that have been changed since the
previous hierarchy load. The resulting directory name is:
"<utility><YYMMDDHHMISS><pXXXXX><bYY>"

where utility is the name of the program (for example, -loadmeasure), followed by a
time/date stamp, then the process id (pXXXX), and then a 2 digit number to avoid
conflicts (bYY).

If there are any problems loading specific records that belong to the partition hierarchy,
they are reported in the format as shown below. Note that the record is completely
reproduced in this error report in the log.

<E 2008Jul02 12:04:52.196> Could not find position '90000044' in line number 3:
'2001052090000044 1000 7 . Skipping!
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Problems with records along non-partition hierarchies are reported as shown in the
following:

<12008Jul02 12:04:55.482> MeasureLoader::loadDataFromFile() Loading ".ovr' file
'/vol.nas/u09/rpasqc/qc_testing/aix/1208rc2_test/RDF_12/ldom1/input/psal.ovr’

<D 2008Jul02 12:04:55.514> Error on line 1: '2001031110000044 STR1000 8
" Position name: STR_STR1000 not found.
<D 2008Jul02 12:04:55.514> Error on line 2: '2011041510000044 1000 9

" .Position name: DAY20110415 not found.
<D 2008Jul02 12:04:55.964> 2 lines had problematic data.

locked
Messages are sent only to the screen.

mace

The mace utility uses standard logging. The —debugRuleEngine option logs some messages
to the file mace.log in the current working directory.

positionBufferMgr

Uses standard logging. The reshapeArrays process is spawned as a child. See its entry for
details.

reconfigGlobalDomainPartitions

Uses standard logging. The reshapeArrays and loadHier processes may be spawned as
children. See their entries for additional details. When the loadHier utility is started as a
child process it remaps the screen output of to the log file loadHier.log contained in the
current working directory.

renamePositions

Uses standard logging. The —log option overwrites the default log file name of hierName
and Rename.log in the current working directory. The —loglevel parameter does not
control the types of messages written to this log file.

regmeasureServer

This application should only be started from the RPAS libraries to process measure
registration/deregistration. Each process creates a log file in a newly created directory in
the domain “output” directory. The newly created directory name will be formatted as
“regServerYYYYMMDDHHMIbXX”, where YYYY is the year, MM is the month, DD is
the day, HH is the hour, Ml is the minute, the character ‘b’, and XX is two digits used to
make the directory name unique. The RPAS libraries will attempt to create at most eight
directories for any single application.

reshapeArrays

The reshapeArrays utility is used to make arrays conform to the current hierarchies in the
domain. Any positions added to dimensions as a result of running loadHier are added to
arrays that have this dimension. Any positions removed from dimensions are removed
from the arrays that have this dimension. reshapeArrays updates the arrays to reflect
these changes made in the hierarchies.
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Utilities with Multi-Process Logging

Some utilities are based on the multi-processes domain utility framework. These utilities
send messages to the screen and a log file master.log. Any child processes output
messages to a log file in the domain/output directory named subdomain0000.log where
the number indicated the sub-domain being processed. This directory will contain all log
files created during the run of that utility. This change has been updated so that the
controlling process logs to the screen as well as to a file in that directory. The newly
created directory name is formatted as “APPNAMEYYYYMMDDHHMIbXX”, where
APPNAME is the utility name, YYYY is the year, MM is the month, DD is the day, HH is
the hour, Ml is the minute, the character ‘b’, and XX is two digits used to make the
directory name unique. The framework will attempt to limit the number of directories
created for any single utility to eight. The parameter -loglevel can be used to control the
type of messages send to the screen and log file.

These utilities are as follows:

= defrag

= exportData

* Joadmeasure

= reshapeArrays

* reconfigGlobalDomainPartitions
= updatedpmpositionstatus

* copyDomain

= wbbatch

domainprop
The domainprop utility only provides logging to the screen.

hierarchyMgr
The hierarchyMgr utility only provides logging to the screen.

configCommitAsap

This utility should be started from the RpasDbServer application when the client requests
a workbook to be committed.
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Using Shell Scripts to Run Batch Processes

Batch processes should be written using scripts that call the RPAS 11 binaries found in
the SRPAS_HOME/bin/ directory. Any log files generated by scripts will be in the
[DOM]/scripts/err/ directory. Examples of tools include Korn shell, Python, and Perl.

A Sample Shell Script

The following is a sample shell script that loads the product and location hierarchies into
a domain. It is assumed that this script is invoked from the [DOM]/scripts/ directory.

1 #1/bin/ksh

2 loadHier —d .. —load prod > ./err/loadhier._prod.log

3 loadHier —d .. —load loc >> ./err/loadhier.loc.log

Line 1 defines the shell that will execute the script. In this example, it is defined to be the
Korn shell. Therefore, this script will always be executed from the Korn shell even if the
user’s shell is different.

Lines 2 and 3 call the loadHier utility to load the latest product and location hierarchy
information. Depending on the batch process to be performed by the shell script, lines 2
and 3 can be replaced by one or more lines to call one or more RPAS utilities.
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Common Information and Parameters for RPAS Utilities

A number of standard arguments are available for most RPAS utilities. Check the usage
of a specific utility to verify whether or not it is available.

Argument Description

—-version Use this argument to get the version information of the
utility (for instance, RPAS 11.2.0). It does not require —d
domainPath.

—d pathtodomain Common to most utility this specifies the path to the domain
against which the utility will run or from which data will be
used.

—loglevel See “RPAS Utilities Logging Options” for more information.

-n Certain utilities contain this parameter to perform a dry run.

Using this option will show the administrator what would
change, but makes no actual changes to the system or data.

See the usage of a specific utility to see whether this option is

applicable.
—noheader To disable the use of a timestamp in the header of the log file.
—help Any of these arguments will output the utility information
) and syntax to the terminal window. This can also be

_usage accomplished by running the utility with no arguments.

Logger verbosity levels determine how much information is generated on the terminal
when running a given utility. An administrator can set these levels for each RPAS utility.
The available logger verbosity levels are as follows:

* none — There should be no output if the utility successfully executes
= error — Outputs only error messages
* warning — Outputs warnings in addition to error messages

= information — Outputs status and progress of the operation in addition to the error
and warning messages

= all - Outputs all available information generated by the utility, including error,
warning, and informational messages

Each line, that contains the above type of feedback, is normally preceded with a code that
indicates what type of information is being output. Each code should have an angle
bracket (“<”) in front of it. E indicates the message is an error. W indicates the message is
a warning. I indicates the message is informational.

Configuration Tools Log Files

For the RPAS Configuration Tools, information is logged in the files stderr.txt and
stdout.txt, which are located in the bin sub-directory of the Tools directory. If a problem
with the configuration tools is encountered, send these two files to Oracle Retail
Customer Care along with a description of the problem.
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RPAS Intraday Enabler

The RPAS Intraday Enabler (ride) functionality enables batch operations to be run over
an RPAS domain while users are accessing workbooks and completing workbook
operations.

This functionality enables batch operations to be executed over a domain, but does not
prevent users from accessing other components that do not affect or interfere with the
batch operations. The running of an exclusive batch process will not cause any
pre-existing workbook operations that require domain access to fail or terminate. Users
in domains that are not part of the exclusive process will not be affected in any way.

In domains that have been locked by an exclusive batch process, the users are still able to
perform operations that only require access to the workbook. The operations include the
following:

=  Workbook Edits

=  Workbook Calculations
=  Workbook Saves

=  Workbook Opens

=  Workbook Navigation
= Commit ASAP Entry

= Commit Later Entry

Users that enter workbooks into the commit ASAP queue, while an exclusive lock is in
place, will have the entries processed once the exclusive process is complete.

In these same domains, users will not be able to perform operations that require access to
data within the domain. The access can be either read or write. The operations that are
prevented include the following:

=  Workbook Build

=  Workbook Refresh

=  Workbook Custom Menu (unless configured as intraday-concurrent)

=  Workbook Commit Now/Later

= Insert Measure

* Dynamic Position Maintenance (DPM)

When a user tries to access one of these operations after the exclusive lock is obtained, a
message is provided stating that an exclusive process is running. A default message is
provided or it can be replaced by providing a message as part of the call to the ride
utility.

When a user is working with a workbook in the master domain, a lock is required on the
master domain and all local domains that are needed for the operation. The workbook
operations in this domain are blocked when the master or local domain data is accessed
by the ride process. See the Examples section for more details on the domain access
during different types of ride processes.

Configuration functionality is provided so that a custom menu can be marked to run
concurrently with a ride process (intraday-concurrent).
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Note: See the RPAS Configuration Tools User Guide for details
on how to configure a custom menu to be
intra-day-concurrent. A custom menu that is configured to
run concurrently with a ride process should only access
workbook data, run a script that uses the ride utility, and/or
run commits using the commit ASAP functionality. Custom
menus that update or read directly from the domain should
not be configured as intra-day-concurrent as this would
conflict with the ride process.

In order for a batch job to run over a domain without interference by an online activity,
exclusive domain access must be granted to the job that is running. This is achieved by
creating a domain access control using a dual-lock control. The domain access control
manages the lock request from workbooks and ride processes.

Domain Access Control

z

workbook |

workbook

DualLock
Control

workbook |

Lockrequest

RPAS

Intra-Da Exclusive
y Lockrequest ——P
Process

Manager

Control

Intra-Day Batch
Executable /Script
e.g.— Intra-cay B T Y E T
Replenishment

- 4—>» T 4—>»  2epdp yooqyiop

Planning

This figure shows the process control that is in place with the locking schema. In this
case, an administrator requests exclusive access to a domain in order to run a batch job.
This requires an exclusive lock on the domain in order for the job to run. Once the lock is
received, no other workbook operations are able to get write access to the domain until
the process is complete. If the exclusive lock cannot be obtained, the process should time
out and the administrator notified based on the output of the ride utility. When the ride
utility times out, the domainStatus utility is automatically run to provide details of the
user workbook operations that are blocking the ride process. See the section on
domainStatus for details on that procedure.
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Usage

ride -d domain -process pname]-script sname -args args {-message messageString}
{-timeout minutes} {-wait minutes} {-partitions posl,pos2,.} {-masterinBatch}

The following table provides descriptions of the arguments used by the ride utility.

Argument Description

-d domain Refers to a simple or master domain. When master domain
is specified, all local domains in the global domain
environment are locked as well as the master domain.

—-process pname The name of the process to execute. This parameter cannot
be used with the —script parameter.

-script sname The name of the script to execute. This parameter cannot be
used with the —process parameter.

-args args Process arguments passed to the script or process to be
executed. The —args parameter must be the last parameter
or switch for this application. All parameters or switches
after the —args parameter are passed on to the process or
script to be started.

-message messageString This optional argument is the override message presented
to the user when trying to perform an operation blocked by
an intra-day batch process. A default message is provided
to the user if this argument is not provided.

—timeout minutes The utility will time out if it cannot get access to the
domains during this time. By default, there is no timeout.
The timeout starts when the control utility is executed.

-wait minutes Time to wait before starting the process or script. Even if
domain access is granted, the process does not start until
the end of wait time. The clock starts when the control
utility is executed. The default is 0.

—partitions posl,pos2,.. | Partition positions (such as deptl, dept2, and so on) that
determine the local domains that are accessed by the
process or script.

-master InBatch Indicates that, when running over a global domain
environment, the master domain will be accessed by the
process or script in addition to any local domains selected.

Note: If neither -partitions nor -masterlinBatch are provided
on the command line, the entire domain will be processed
when running over a global domain environment; that is, all
subdomains and the master.

Examples

This section outlines several scenarios that are possible with the ride utility. The
scenarios outline the domain access based on how the ride utility is executed. The tables
indicate whether the specific operations are blocked or allowed.
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Scenario 1

This scenario is an example of running ride specifying only the master domain. This will
lock all domains.

Usage example: ride —d master —script script.ksh

Workbook Operation Master Local Local Local
Domain Domain 1 Domain 2 Domain 3

Build HBI Measures | Blocked Blocked Blocked Blocked
No HBI Blocked Blocked Blocked Blocked
Measures

Refresh HBI Measures | Blocked Blocked Blocked Blocked
No HBI Blocked Blocked Blocked Blocked
Measures

Commit Now | HBI Measures | Blocked Blocked Blocked Blocked
No HBI Blocked Blocked Blocked Blocked
Measures

Custom Menu | HBI Measures | Blocked Blocked Blocked Blocked

(not ride

concurrent) No HBI Blocked Blocked Blocked Blocked
Measures

Insert HBI Measures | Blocked Blocked Blocked Blocked

Measure
No HBI Blocked Blocked Blocked Blocked
Measures

DPM NA Blocked Blocked Blocked

Scenario 2

This scenario is an example of running ride specifying only one local domain (local
domain with partition position 100).

Usage example: ride —d master —script script.ksh —partitions 100

Workbook Operation Master Local Local Local
Domain Domain 1 Domain 2 Domain 3

Build HBI Measures | Blocked Blocked Allowed Allowed
No HBI Blocked Blocked Allowed Allowed
Measures

Refresh HBI Measures | Blocked Blocked Allowed Allowed
No HBI Blocked Blocked Allowed Allowed
Measures

Commit Now | HBI Measures | Blocked Blocked Allowed Allowed
No HBI Blocked Blocked Allowed Allowed
Measures
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Workbook Operation Master Local Local Local
Domain Domain 1 Domain 2 Domain 3
Custom Menu | HBI Measures | Blocked Blocked Allowed Allowed
(not ride
concurrent) No HBI Blocked Blocked Allowed Allowed
Measures
Insert HBI Measures | Blocked Blocked Allowed Allowed
Measure
No HBI Blocked Blocked Allowed Allowed
Measures
DPM NA Blocked Allowed Allowed
Scenario 3

This scenario is an example of running ride specifying only one local domain (local
domain with partition position 100) and the masterInBatch option.

Usage example: ride —d master —script script.ksh —partitions 100 -masterinBatch

Workbook Operation Master Local Local Local
Domain Domain 1 Domain 2 Domain 3
Build HBI Measures | Blocked Blocked Blocked Blocked
No HBI Blocked Blocked Allowed Allowed
Measures
Refresh HBI Measures | Blocked Blocked Blocked Blocked
No HBI Blocked Blocked Allowed Allowed
Measures
Commit Now | HBI Measures | Blocked Blocked Blocked Blocked
No HBI Blocked Blocked Allowed Allowed
Measures
Custom Menu | HBI Measures | Blocked Blocked Blocked Blocked
(not ride
concurrent) No HBI Blocked Blocked Allowed Allowed
Measures
Insert HBI Measures | Blocked Blocked Blocked Blocked
Measure
No HBI Blocked Blocked Allowed Allowed
Measures
DPM NA Blocked Blocked Blocked
Scenario 4

This scenario is an example of running ride specifying two local domains (local domain 1
with partition position 100 and local domain 2 with partition position 200).

Usage example: ride —d master —script script.ksh —partitions 100,200
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Workbook Operation Master Local Local Local
Domain Domain 1 Domain 2 Domain 3

Build HBI Measures | Blocked Blocked Blocked Allowed
No HBI Blocked Blocked Blocked Allowed
Measures

Refresh HBI Measures | Blocked Blocked Blocked Allowed
No HBI Blocked Blocked Blocked Allowed
Measures

Commit Now | HBI Measures | Blocked Blocked Blocked Allowed
No HBI Blocked Blocked Blocked Allowed
Measures

Custom Menu | HBI Measures | Blocked Blocked Blocked Allowed

(not ride

concurrent) No HBI Blocked Blocked Blocked Allowed
Measures

Insert HBI Measures | Blocked Blocked Blocked Allowed

Measure
No HBI Blocked Blocked Blocked Allowed
Measures

DPM NA Blocked Blocked Allowed

Scenario 5

This scenario is an example of running ride specifying two local domains (local domain 1
with partition position 100 and local domain 2 with partition position 200) and the
master InBatch option.

Usage example: ride —d master —script script.ksh —partitions 100,200

-master InBatch
Workbook Operation Master Local Local Local
Domain Domain 1 Domain 2 Domain 3

Build HBI Measures | Blocked Blocked Blocked Blocked
No HBI Blocked Blocked Blocked Allowed
Measures

Refresh HBI Measures | Blocked Blocked Blocked Blocked
No HBI Blocked Blocked Blocked Allowed
Measures

Commit Now | HBI Measures | Blocked Blocked Blocked Blocked
No HBI Blocked Blocked Blocked Allowed
Measures

Custom Menu | HBI Measures | Blocked Blocked Blocked Blocked

(not ride

concurrent) No HBI Blocked Blocked Blocked Allowed
Measures
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Workbook Operation Master Local Local Local
Domain Domain 1 Domain 2 Domain 3
Insert HBI Measures | Blocked Blocked Blocked Blocked
Measure
No HBI Blocked Blocked Blocked Allowed
Measures
DPM NA Blocked Blocked Blocked
Scenario 6
This scenario is an example of running ride specifying and only locking the master
domain.

Usage example: ride —d master —script script.ksh -masterinBatch

Workbook Operation Master Local Local Local
Domain Domain 1 Domain 2 Domain 3

Build HBI Measures | Blocked Blocked Blocked Blocked
No HBI Blocked Allowed Allowed Allowed
Measures

Refresh HBI Measures | Blocked Blocked Blocked Blocked
No HBI Blocked Allowed Allowed Allowed
Measures

Commit Now | HBI Measures | Blocked Blocked Blocked Blocked
No HBI Blocked Allowed Allowed Allowed
Measures

Custom Menu | HBI Measures | Blocked Blocked Blocked Blocked

(not ride

concurrent) No HBI Blocked Allowed Allowed Allowed
Measures

Insert HBI Measures | Blocked Blocked Blocked Blocked

Measure
No HBI Blocked Allowed Allowed Allowed
Measures

DPM NA Blocked Blocked Blocked

Domain Lock Status Utility - domainStatus

The domainStatus utility provides a report on the processes that are locking the domains.
The purpose is to identify the user activities that are preventing a ride process from
running. This information is important since the ride process will not terminate any
existing workbook operation. The utility provides output that includes the process ID,
user ID, operation type, and operation start time.

With the output of this utility, the system administrator can determine the cause for the
ride process not running. This should provide them with enough information to either
notify the user that they are causing a delay or to manually terminate the process. That
will be driven by the specific client and their processes.

Note that this utility reports on domain-level locks used during the ride process. Low-
level data locks are not exposed by this utility.
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Usage

domainStatus -d domain —autoRefresh refreshPeriod

The following table provides descriptions of the arguments used by the domainStatus

utility.
Argument Description
-d domain Refers to a simple or master domain. When master domain is

specified, all local domains in the global domain environment
are locked as well as the master domain.

—autoRefresh refreshPeriod

Refreshes the lock status information every number of seconds
specified by the refreshPeriod.
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Overview

Hierarchy Management

There are a number of key concepts and processes that are critical to the hierarchy
management process:

* Hierarchy structures are loaded into a domain using the loadHier utility.

= The process of updating the data structures in the domain is commonly referred to as
“reshaping.” This process is handled automatically by the system.

* The length of position names is 24 characters or less by default. RPAS provides the
ability to increase this length using the dimensionMgr utility.

= RPAS provides the ability to have placeholder positions in the domain that can be
used when loading new hierarchy positions. Use of “dummy” positions defers the
time consuming process of “reshaping” until a scheduled time, thus saving valuable
time in the batch window for time-constrained batch processes.

= RPAS can automatically handle the movement of positions and their corresponding
data between local domains when their parent-child relationships change and cause
such a scenario. This requires the use of dummy positions and is only applicable in a
global domain environment.

» Positions at the partition level in a global domain environment can be moved
between local domains using the reconfigGlobalDomainPartitions utility.

* New local domains can be added to an existing global domain environment using the
reconfigGlobalDomainPartitions utility.

Placeholder Positions in the Domain

RPAS provides the ability for a domain to contain “dummy” hierarchy positions, which
are placeholder positions that allow new positions to be added to a hierarchy without
having to update the data structures in the domain (process referred to as “reshaping”).
These dummy positions are not visible to applications or users, so they cannot be seen in
workbooks. They should not be confused with any form of ‘dummy’ or ‘placeholder’
positions that are part of a business process and visible to users, such as in the process of
new store or item introductions.

RPAS provides the ability for any dimension, other than those in the calendar hierarchy,
to contain dummy positions. The number of dummy positions is a percentage of total
positions for a given dimension in the domain. For example, if the SKU dimension of the
PROD hierarchy contains 1 million positions; a dummy position buffer of 1% will allow
for 10,000 dummy SKU positions. When dummy positions are enabled for a dimension,
positions have an ‘internal” name (known only to RPAS and not visible to users or
applications) and an ‘external’ name. Dummy positions are positions with an internal
name, but no external name. Reshaping is required whenever the collection of internal
names changes.

New positions are added to a domain through the hierarchy load process (loadHier
utility). If a position is new, RPAS will map an existing unused dummy position to the
newly added position so that it can be used in the domain without having to “reshape”
the domain.
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Similarly, as old positions are deleted, the external name for the internal position is
removed from the mapping table (and data for the positions is removed from the arrays),
and the position effectively become a dummy position. Therefore, deletes can happen
without the need to “reshape” the domain.

As dummy positions are consumed, the number of available dummy positions will be
reduced. Dummy positions are held in the “buffer,” and the process of updating this is
“re-buffering.” The buffer can be updated automatically, but unpredictably, when
required (based on the lower and upper bounds that are defined for a PNI dimension). It
is recommended that the rebuffering process is scheduled to ensure that batch process
windows are predictable. The manual rebuffering process is executed with the
positionBufferigr utility.

Position Repartitioning

Position repartitioning is the automated process of moving positions and all
corresponding measure data between local domains. This functionality is only available
(and relevant) in Global Domain environments. Positions need to be moved between
local domains when they are assigned a new parent that exists in a different local
domain. Note that moving positions at the partitioning level is a manual process and
requires the use of the reconfigGlobalDomainPartitions utility.

For example, imagine Stylel belongs to Sub-Class1 in LocalDomain]1. If Stylel is
reassigned to be a child of Sub-Class2, which is located in LocalDomain2, RPAS will
move the Stylel position, Stylel’s children (if any), and all corresponding data to
LocalDomain2. This process is often referred to as “reclassification” by RPAS customers.
RPAS refers to this functionality as “Position Repartitioning” because it technically does
not handle the many complex functional requirements of true reclassification as most
retailers define the term to mean.

Loading RDF and Curve Parameters after Repartitioning

After repartitioning, default parameters for Curve and RDF are not automatically loaded
in new subdomain(s). To load these parameters, the following scripts, which are located
in the RPAS_HOME/bin directory, need to be executed:

= JoadCurveParameters.ksh — Used to load Curve parameters after a repartition.

= JoadRdfParameters.ksh — Used to load RDF parameters after a repartition.

These scripts are used to load RDF and Curve parameters to a subdomain that was
created as a result of repartitioning. These parameters are usually loaded during a full
installation by the plug-ins, but when performing a patchinstall, the parameters are not
loaded by default. These parameters include default required method, default source,
spreading profile, and others.

You need to run these scripts after repartitioning a domain on the new partition.

Syntax
scriptname -d <full path to domain> -s <full path to subdomain>

Example:

loadRdfParameters_ksh -d /vol _nas/forecast/domains/RDF_12 -s /vol _nas/forecast
/domains/RDF_12/1dom0/
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Enabling Dummy Positions

The use of dummy positions is enabled in a domain per dimension. Dimensions are
enabled for dummy positions using the Configuration Tools both before and after a
domain has been built. There are two properties in the Hierarchy Tool, and these
properties can be set for each dimension except the calendar hierarchy. These properties
are the “PNI Buffer Percent” for both the lower and upper bounds of dummy positions.

New positions are added to a domain by including new positions in the hierarchy data
input files, and then running loadHier. Newly added positions will be immediately
available for use unless all dummy positions have been consumed, which launches an
automatic rebuffering process. Positions that have been assigned a new parent that
require movement between domains will be automatically processed as part of the
position repartitioning process.

Configuring and Scheduling the Rebuffering Process

Administrators need to determine the process by which they wish to rebuffer the dummy
positions. Rebuffering can be completed automatically as part of the hierarchy load
process when a domain runs out of dummy positions, or it can be scheduled using an
RPAS utility.

If it is desired to have a predictable batch window, it is recommended that administrators
schedule the rebuffering process rather than use the automated process. Scheduling
rebuffering will minimize the possibility that the automated rebuffering process occurs
during a critical batch process. The automated rebuffering would then only be used as a
backup and run as an exception.

If customers do wish to reschedule the rebuffering, they will need to determine an
approach that fits their business and batch processes. One approach might be to schedule
all dimensions (with dummy positions enabled) in all domains to be rebuffered together
on a weekly or monthly basis when there is a large amount of system down-time.
Another approach could be to rebuffer a few domains on a cyclical basis, such as a few a
day or week.

There are high and low settings for the dummy position buffer. Within the Configuration
Tools, these settings are the Buffer % Low and Buffer % High. When executing a
scheduled rebuffering process using the positionBufferigr utility, the buffer for a
dimension in a given local domain is updated when the number of dummy positions
falls outside the high or low target buffer percentages. The number of dummy positions
is calculated by taking the average of the high and low percentages multiplied by the
total number of positions of the dimension in the local domain.

Deciding the buffer percentages will depend on a number of criteria. The goal is to have
sufficient dummy positions to allow for growth in the local domains without having to
execute an automated rebuffering process. Determining the targeted number of dummy
positions will be a product of the anticipated growth in a given time period (for instance,
100 SKU'’s per week) and the frequency of the scheduled rebuffering process (for
instance, rebuffering once a week or month).

These buffer settings and rebuffering processes are managed by the positionBufferigr
utility.
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Loading Hierarchies - loadHier

The loadHier utility is used to load and refresh a hierarchy. All hierarchy data files are
saved in fixed width (or space delimited) files with a .DAT file extension. The width of
positions (number of characters) is specified in a configuration file before a domain is
built. The width of positions can be increased after a domain has been built using the
dimensionMgr utility or by changing a property in the Configuration Tools and patching
the domain.

loadHier supports comma separated value (CSV) or fixed width flat files. The utility has
also been enhanced to allow a simple compression method that can skip duplicated
values line by line. To use a CSV file, instead of a fixed-width file, you must include .csv
before the file extension.

Example of loadHier using a CSV File:
loadHier —load calendar.csv.dat

loadHier allows the use of a simple compression technique to reduce the size of the input
file and to reduce the file I/O time. CSV input files can be prepared to substitute a
column’s value with a “?” character if it matches the value from the same column in the
previous row. The “?” character can be used for multiple consecutive rows to reuse the
value from the row preceding the first use of “?’. Note that loadHier assumes that the ?’
character will only be used to take advantage of RPAS’ proprietary CSV compression.
Therefore if a single ‘?’ is meant to be the value of a column, it should be enclosed
between opening and closing double quotes; e.g., “?”.

Due to the compression algorithms used in the CSV format, the —nosort argument is
automatically used when CSV is detected. This argument is used to prevent the
reordering of rows so that RPAS will not lose track of which column value is to be cached
for a subsequent row. If the order of records is important, CSV files should be sorted
before passing them to loadHier.

Note: The exportHier and loadHier utilities will skip any
user-defined dimensions. This is true for both fixed width
and CSV formats. At this time, there is no way to export or
import user-defined dimensions.

The hierarchy load utility also handles the process of “reshaping” data in the domain
after adding or removing positions. This reshaping process is required to update the
underlying data structures to reflect the hierarchical changes; however, note that the use
of dummy positions can reduce the frequency of reshaping (see Enabling Dummy
Positions for more information).

loadHier supports both the loading of hierarchy positions and purging data in parallel.
When RPAS deletes a partition position through purging, RPAS adjusts the cache data in
parallel to maintain the correct position/domain mapping.

RPAS allows for multiple input files to be loaded for the same hierarchy. The extra input
files should be named with a secondary extension (for example, ' msgs.dat.1'). The extra
input files can be loaded only with the main input file. For example, you cannot load
‘msgs.dat.1' in a separate loadHier call. Multiple files are often used when the hierarchy
load data comes from different sources.

RPAS automatically generates a backup copy of hierarchy files prior to performing a load
for a hierarchy. If any type of error occurs during the load process, the hierarchy is
restored from the backup copy.
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By default, loadHier stops with an error if the loadHierBk directory exists in the data
directory of any domain. If the domain is in a good state and the backup directory is not
valid, it is the responsibility of the user to remove the loadHierBk directory. The switch,
-useExistBackup, is used to indicate that the data in the backup directory is valid;
loadHier will not overwrite the data in the loadHierBk directory with the current
hierarchy data in the domain.

To optimize performance while moving or cleaning data during the hierarchy purging or
reclassification processes, the -excludeMeasList or -includeMeasList argument can be
specified. Both arguments specify a full path to an xml file, in the following format, that
contains a list of measures to either be excluded or included:
<?xml version="1.0" encoding="UTF-8" standalone="yes'" ?>

<I’paS>

<measures>measl,meas2,meas3..,measN</measures>
</rpas>

Note: It is very important to specify the measures wisely,
especially with the -includeMeasList option. Because, there
will no data moving for those measures not included in the
list, that data will be lost when loadHier completes.

Position Label Translation

To enable translation of position labels for the desired dimension(s) using the RPAS
Configuration Tools, check the box in the “Translate’ column of the Dimension definition
tools. Building or patching the domain with this configuration builds the necessary
infrastructure in the domain to manage translations for those dimensions. However, label
translations must be separately loaded.

Position label translations are loaded in dimension specific translation measures for
every language that will be used by the users. If translated labels are not loaded using
these measures, workbooks show position names wherever a label has to be shown.
Note that for a translatable dimension, RPAS never uses or shows the position labels
from the hierarchy load file but always refers to the labels in dimension specific
translation measures. This implies that if a domain were patched to make a dimension
translatable but the translation measures were not loaded, RPAS users would see
position names instead of position labels from the load file.

Dimension specific position translation measures are named as r_<dim name>label,
where <dim name> must be replaced with the name of the translated dimension. For
example, if the sku dimension were to be translated, load the r_skulabel measure with
translations. These measures must be loaded after loading the hierarchy because RPAS
can only load translations for already loaded positions.

The position label translation measure load files have three columns. The first column
has the position names, the second column has the language identifier, and the third
column has the translation for the language specified in that row. For example, a
translation measure file for the sku dimension will be named r_skulabel .csv.ovr and
will have the content formatted as shown below. Note that in the following example, the
same file contains labels in four languages.

10006782 ,ENGLISH,White Nike Running Shoe size 11

10006782 ,CHINESE_SIMPLIF, At re i/ Ml

10006782 ,FRENCH, Taille blanche 11 de chaussure de course de Nike
10006782, ITALIAN, Formato bianco 11 del pattino corrente di Nike
10004523 ,ENGLISH,Black leather shoe size 8

10004523, CHINESE_SIMPLIF, B pziEk/\8

10004523, FRENCH, Taille noire 8 de chaussure en cuir

10004523, ITALIAN,Formato nero 8 del pattino di cuoio
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The following table lists the supported languages and their identifiers.

Language ID Language
CHINESE_SIMPLIFIED Simplified Chinese
CHINESE_TRADITIONAL Traditional Chinese
DUTCH Dutch

ENGLISH English

FRENCH French

GERMAN German

GREEK Greek
HUNGARIAN Hungarian
ITALIAN Italian

JAPANESE Japanese
KOREAN Korean

POLISH Polish
PORTUGUESE Portuguese
RUSSIAN Russian

SPANISH Spanish

SWEDISH Swedish
TURKISH Turkish

Alternatively, you can manually enter or alter translated labels using the Translations
workbook in the Administration tab. In this workbook, a worksheet is available for each
dimension that has translations enabled. You can manually enter translated strings for
the language of interest. Once committed, these translations are available for every new
workbook.

It is possible that due to errors when preparing translation files, translated labels for
some positions may not be loaded. In a situation where RPAS is unable to look up the
label for the locale of the machine on which the RPAS client is being run, RPAS looks for
a non-empty label string for the ENGLISH language. If it fails to find a non-empty label
string for the ENGLISH language, it uses or shows the loaded position name of the
position.

Note: For the fixed-width format of translation measure load
files, RPAS limits the labels to 80 bytes (RPAS uses UTF-8
encoding). For CSV format files, there is no limit. To avoid
the complexity of calculating starting positions for fixed-
width format files and the limitation of translation string
length, it is recommended that CSV files be used.

Usage

loadHier —d domainPath —load hierName —loadAll {—purgeAge purgeage}
{—checkParents} {—noClean}{—loglevel level} {-defaultDomain Idom#, ldom#}
{-useExistBackup} {-excludeMeasList listName | -includeMeasList listName}
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The following table provides descriptions of the arguments used by the loadHier utility.

Argument Description

—d domainPath The domain in which to load the hierarchy data.
—load hierName The name of the hierarchy to load and refresh.
—loadAll Loads all hierarchy input files (with a .dat file

extension) that are located in the input directory of the
domain. Including this argument disables the
reshaping process until all files have been loaded.

—checkParents Verifies the one-to-one mapping of a child position
being loaded to its parent position.

—purgeAge purgeage Specifies the purgeage during loadHier.If not
specified, loadHier gets purgeage from domain. In
Global Domains, -purgeAge supports the purge of
partition positions when the purgeage is reached.

—noClean This is a switch that prevents the removal of input
files and temporary data files that are generated
during the hierarchy load process. Input files will
remain in the “input” directory of the domain after the
process is completed. This option is often used for
debugging or troubleshooting purposes.

-noSort Use this argument for instances when the RPAS
process of sorting the hierarchy file prior to loading
the values is not needed due to preprocessing
(external to RPAS). This flag will prevent the input
<hier.dat> file from being sorted while loading the
hierarchy.

This argument is often needed when loading calendar
hierarchy data. This option can be eliminated if an
alphabetic sort arranges calendar data in
chronological order.

Due to the compression algorithms used in the CSV
file format, the —noSort option will automatically be
used when CSV is detected. It is recommended that
you presort the data before exporting it into a CSV
format.

-logLoadedPositions This argument will enable the logging of successfully
loaded input file lines into a
“loaded[HIERNAME].dat” file under the processed
directory.

-maxProcesses count If specified, some parts of loadHier will run in
parallel, meaning that it will use a maximum of the
defined processes, which are specified by count.

—forcelnputRol lups This argument enforces new hierarchy roll-up
changes. New roll-up changes will override or
dominate existing hierarchy roll-ups in the event they
conflict with the rollups specified in the input file.
This allows you to load a hierarchy file that reclassifies
one or more upper level positions while removing one
or more discontinued base-level positions that roll-up
to the reclassified position.
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Notes

Argument Description

—forceNAConsistency Use this argument to force NA consistency when the
current NA value is different from the originally
defined NA value for the measure.

-defaultDomain Idom#, ldom#, | Use to specify comma separated default domain paths
that will be used for accommodating new partitions.
The domain paths can point to existing local domains
or to new (non-existing) local domain.

The local domain names are specified by a fully
qualified path. To specify more than one local domain,
separate local domain paths with a comma.

Example:

loadHier —defaultDomain Idoml, Idom2, Idom3

-returnReshapeFai lure Returns a non-zero value if one or more arrays fail to
reshape. The default behavior is to log a warning with
the array name and continue. The loadHier process
still runs to completion even if a non-zero value is
returned.

-useExistBackup Use this argument if the data in the loadHierBk
directory is valid. loadHier will not overwrite the
data in the backup directory with the current
hierarchy data in the domain.

-excludeMeasList listName Use one of these arguments to optimize performance
or i i while moving or cleaning data during the hierarchy
-includeMeasList listName purging or reclassification processes:

=  Use -excludeMeasList to optimize performance
by excluding the list of measures in listName.

=  Use -includeMeasList to optimize performance
by including only the list of measures in listName.

When using —defaultDomain, loadHier adds the new partition positions to the specified
default domains one by one. The list of default domains is performed in the given order
until each new partition positions is added.

Example:
Let’s say we have a global domain that consists of two local domains, ldom0 and ldom1.

Let’s assume we use the following loadHier command:
loadHier ... -defaultDomain Idoml,ldom2,ldom3 ...

Let’s say that in this call, there are three new partition positions (partl, part2, and part3)
in the input file. When the loadHier finishes, there will be two new local domains, Idom2
and ldom3, with the following new partition positions included in them:

Idoml --> partl

Idom2 --> part2

Idom3 --> part3

In the previous example, if we only add two new partition positions (partl and part2),
when the loadHier finishes there will only be one new local domain - ldom2. New
partition positions will be located as follows:

Idoml -—> partl
Idom2 --> part2
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Using the same example, if we add 5 partition positions (partl, part2, part3, part4 and
part5), when the loadHier finishes there will be two new local domains, ldom?2 and
ldom3. New partition positions will be located as follows:

ldoml --> partl,part4

ldom2 --> part2,part5
Idom3 -—> part3

FilterHier Utility

Sometimes, a retailer has a master file of hierarchy data that needs to be loaded into
multiple domains. Some of these domains may be missing one or more levels from the
master hierarchy, mostly because the planning levels in these domains are higher than
the lowest level in the master and the domains don’t need to have all the lower levels.
For example, a retailer may have one domain for Merchandise Financial Planning where
the lowest level is Category and another for Item Planning where the lowest level is Item.
The hierarchies in these two domains would have their relevant hierarchy load data in
one master file, but using loadhier, the retailer would not be able to load just what is
relevant to the domain from the master. System integrators would need to write custom
scripts to parse out irrelevant columns from the master file to prepare load files suited for
individual domains.

The filterHier utility does the filtering of columns for the system integrators ridding them
of the need to write custom scripts. The utility analyzes the target domain and trims
down the master file to only have those columns that are needed by the target domain.
The utility acts on CSV formatted files and requires the input file to contain a header line
containing the names of the columns, for example, SKU,SKU_label, STCO,STCO_label.

The output of the utility is file will be a .csv.dat file that can be subsequently used by the
loadHier utility.

Usage
filterHier -d domainPath -input inputPath [COMMAND] {OPTIONS}
The following table provides descriptions of the arguments used by the filterHier

utility.

Argument Description

—d domainPath The domain in which to load the hierarchy data.

—input inputpath The path to the folder where the master files are
located.

—Filter hiername Filters the hierarchy named in the parameter to the
command.

—FilterAll Filters all hierarchies in the input directory that are
relevant to the target domain.
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Argument Description

—-compress Creates a compressed .csv.dat output file.

RPAS has introduced a simple, proprietary
compression technique to help reduce the file size and
file I/O time during loads. This technique simply
replaces a column’s value with a “?” character to
indicate that the column’s value for the row matches
that of the row above. The compressed file continues
to print out “?’ characters for a column until a change
is encountered.

This kind of compression is useful for hierarchy files
where the lowest level positions are grouped by the
higher level positions. In such cases, the output file
will print out “?” characters for higher level positions
until a change is encountered, thus significantly
reducing the file size.

Note that compressed files should not be split up or
reprocessed in ways that change the order of rows.

Notes

This utility will combine one or more input files into an output file that can be imported
into the target domain using loadHier. The input files must be csv data containing a
comma separated header line listing the name of each column. Column names should be
in the format DIM,DIM_label.

Example: SKU,SKU_label, STCO,STCO_label,SIZ1,5171_label

The input files MUST have the extension .hdr.csv.dat. Optional extensions are allowed at
the end of the file.

Example: prod.hdr.csv.dat.fool

The columns in the output file will be arranged to match the hierarchy format of the
target domain. Any dimensions from the input files that are not present in the output
domain will be filtered out.

The output file will be a properly formatted .csv.dat file, and will be in the input
directory of the target domain.

Error Conditions
The following error conditions may occur during the operation of filterHier:

Dimension Not Found - If a dimension that exists in the domain is not found in
the header, the input file will be skipped.

No Usable Input Files — If filterHier cannot find a usable input file, it will exit
with error.

Parse Error in Data — If one or more data rows contain an error, filterHier will
display an error specifying which lines contain an error, and proceed processing
the rest of the file.

Conflicting Base Positions — If a base position has multiple definitions in the
input files, the first definition will be used and all others will be skipped.

84 Oracle Retail Predictive Application Server



Position Repartitioning

Reconfiguring the Partitions of a Global Domain - reconfigGlobalDomainPartitions

It is common for many customers to regularly add, remove, or change the parent-child
relationships for positions in hierarchies, most commonly for positions in the product
hierarchy. While this movement/reassignment of positions is normally handled
automatically within the loadHier utility, a special process must be followed for positions
at the partition level of a Global Domain environment.

The RPAS utility reconfigGlobalDomainPartitions is used for the following activities in a
global domain environment:

* Add anew position along the partition dimension and allocate it to an existing or
new local domain.

= Remove an existing position from the partition dimension.

* Remove local domains (this is automatic if all partition-level positions in a local
domain are removed or moved).

* Move an existing partition position from one local domain to an existing or new local
domain.

Runs loadHier to apply the position addition/removal to hierarchy.

Note: This utility can only be used on a master domain of a
global domain set.

The following processes must be followed to add, remove, or move positions at the
partition level in a Global Domain environment:

* The administrator must be notified in advance that positions at the partition level are
being added, removed, or moved.

* The administrator should run the utility reconfigGlobalDomainPartitions to by
specifying the sub-domain to which the positions do or will belong.

* This utility calls the loadHier utility at the end of the reconfiguration process to apply
the hierarchy changes to the domain. When adding positions (using the —add
argument) an updated hierarchy file must be available in the input directory when
the reconfigGlobalDomainPartitions utility is called. Otherwise the utility will fail.
Updated hierarchy files are not required to remove (using the —remove argument) or
move positions (using the —move argument).

Note: The use of this utility is only required for positions at
the partition level. Positions below the partition level can be
added, removed, or moved between local domains by
loading a modified hierarchy input file with these changes.

Usage

reconfigGlobalDomainPartitions —d pathToMasterDomain —add posNamel,posName2, ... —
sub pathToSubDomain
reconfigGlobalDomainPartitions —d pathToMasterDomain —remove posNamel, posName2,

reconfigGlobalDomainPartitions —d pathtoMasterDomain —move posNamel,posName2, ...

—sub pathToSubDomain
reconfigGlobalDomainPartitions —d pathToMasterDomain —input pathTolnputDir
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The following table provides descriptions of the arguments used by the
reconfigGlobalDomainPartitions utility.

Argument

Description

—d pathToMasterDomain

Specifies the path to the master domain in a Global
Domain environment.

—add posNamel, posName2, ..

Adds one or more positions at the partition level to
a specified local domain.

The path to the local domain must follow the list of
positions to add, using the —sub argument. If the
specified path is to a local domain that does not yet
exist, the system will create a new local domain
with the specified positions at the partition level.

This argument cannot be used with —remove or
—input.

—remove posNamel, posName2, ...

Removes the designated positions from the local
domain to which the positions belong. The path to
the local domain does not need to be specified with
this argument.

The local domain will be deleted if all the positions
at the partition level in a local domain are
removed.

This argument cannot be used with —add or —
input.

—move posNamel, posName2, ...

Moves the specified positions at the partition level
from the current domain in which the positions are
located to the specified local domain.

This argument requires specification of the —sub
argument. To move positions, all dimensions
below the partition level must be enabled for
dummy positions.

—sub pathToSubDomain

Specifies the path to the local domain to which
positions are being added or the destination local
domain for positions being moved.

When a new domain path is specified using -sub
option, a new local domain will be created.

This argument is required for the —add argument
and —move argument.

—input pathTolnputDir

Specifies the path to the input directory that
contains an xml configuration file
(reconfigpartdim.xml) to specify positions to either
add or move.

The file must have all the information to run the
process including the command name, position
names to add or move, and paths to the local
domains.

This option is useful for adding or moving
positions to multiple local domains. This argument
does not handle both adding and moving in the
same call.

This argument cannot be used with —add or
—remove.
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Argument Description

-maxProcesses count If specified, some parts of reconfig utility will run
in parallel, utilizing up to the given number of
processes.

=forcelnputRollups This argument will prevent this utility from failing

in instances where there is a roll-up conflict in the
input file provided to the utility. This argument
enforces new hierarchy roll-up changes such that
they dominate existing hierarchy roll-ups in case
they conflict with the roll-ups specified in the
input file.

Using an Input File

When using the —input argument, the file must be in a particular format and must
contain the “add” or “move” commands, the path to each local domain to which
positions are being added or the destination for positions being moved, and the list of
positions for each local domain. The file must be XML and named
“reconfigpartdim.xml”.

Note: The —input argument only supports the addition or
movement of positions.
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Below is the required format of the input file:
<?xml version="1.0" encoding=""UTF-8" standalone="yes" ?>

<rpas>
<command name="‘command_name"">
<subdomain>
<subpath>path_to_local_domain_1</subpath>
<subpositions>sample_pos_1</subpositions>
</subdomain>
<subdomain>
<subpath>path_to_local_domain_2</subpath>
<subpositions>sample_pos_2,sample_pos_3</subpositions>
</subdomain>
</command>
</rpas>

Note: The entries in bold are the parameters that must be
specified in the input file.

The following table provides descriptions of the arguments used by the input file.

Argument Description
command_name Valid values are “add” or “move.”
path_to_local_domain Path to the local domain to which positions are being

added or moved.

sample_pos One or more positions that are being added or moved

to the designated local domains.

Notes, Assumptions, and Limitations

Position names are separated by commas and must be valid external position names
without the prefix of a dimension (e.g., 0102,0144,0152,0160).

The utility backs up the required data and will automatically restore the domains to
the original state in case of failure.

In a single call to the utility without using the —input argument, positions can only be
added or removed or moved. That is, the —add, —remove, and —move arguments cannot
be mixed in the same call.

Multiple positions can be added or moved to a single local domain in a single call to
the utility using the —add or —move option, respectively.

Multiple positions can be added or moved to multiple local domains in a single call
to the utility using the —input option.

When adding positions at the partition level, an updated hierarchy file must be
available in the input directory when running this utility as the loadhier utility is
called after adding positions. If the updated hierarchy file is not present in the input
directory when attempting to add positions, the utility will fail.

No updated hierarchy file is required when moving or removing positions. If a
hierarchy file is in the input directory, the utility will back up this file.

A log file (loadHier.log) will be created in the root directory if loadHier fails.
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Updating or Reporting the Dummy Position Buffer — positionBufferMgr

The position buffer manager is used to manually rebuffer dummy positions in the
domain or to report on the status of dummy positions. This utility can only be used if
dummy positions have been enabled in the domain environment

Usage

positionBufferMgr -d pathtodomain [-rebuffer|-report] {-hier hierName}* {-
partitionPositions "'posl,pos2...'"}

The following table provides descriptions of the arguments used by the
positionBufferigr utility.

Argument Description

—d pathToDomain Specifies the path to the domain.

—hier hiername The hierarchy that will be rebuffered. If no hierarchy
is specified, the utility will rebuffer or report on all
hierarchies configured to have dummy positions other
than calendar.

—partitionPositions “posl, By specifying positions at the partition level, the
pos2, ..” utility will only rebuffer local domains to which the
specified positions belong.

Positions specified that are not at the partition level
will be ignored.

—rebuffer Adjust all dimensions of the specified hierarchy to
have the number of dummy positions based on the
configuration of the dimension for the environment.

If a hierarchy is not specified with this argument, the
utility will run on all hierarchies other than calendar
configured to have dummy positions.

—report Report the number of buffer positions for all
dimensions of the provided hierarchy. The minimum
buffer size is also displayed if applicable.

If a hierarchy is not specified with this argument the

utility will run on all hierarchies configured to have
dummy positions other than calendar.

-maxProcesses max If specified, some parts of positionBufferigr will
run in parallel, utilizing up to the given number of
processes.

Notes

The minimum buffer size appears as a new column when positionBufferMgr is called
with the -report argument. Also, the minimum buffer size is factored into the output
indicating whether rebuffering is needed by positionBufferigr.
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The following example of output from positionBufferMgr -report where the STYL
dimension needs to be rebuffered since it has 3 available positions but a minimum size of
4.

Example of positionBufferMgr —report:

Percent Percent Min Available Allocated Dimension

Low High Size

0 0 0 0 5 CLR

0 0 0 0 10 CLSS

0 0 0 0 DEPT

0 0 0 0 DVSN

0 0 0 0 2 PGRP

0 0 0 0 12 SCLS

0 0 0 0 SDCD

0 0 0 0 SI1Z1

0 0 0 0 Si1z2

25 35 0 6 24 SKU

0 0 0 0 12 SPLR

10 20 0 2 24 STCO

0] 0] 4 3 18 STYL §hould add 1
positions

0 0 0 0 5 S712
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Renaming Positions — renamePositions

RPAS provides the ability to change the name of a position using an RPAS utility named
renamePositions. Positions that are to be renamed should be included in a hierarchy data
file that is located in a designated input directory (specified when running utility) and
that follows the naming convention hierName.rn.dat (for instance, “prod.rn.dat”).

After the hierarchy data file(s) has been updated and placed in the designated location,
an administrator must run the renamePositions utility.

Usage
renamePositions —d domainPath —i inputDirectory —hier hierName {—log logFileName}
{—}
The following table provides descriptions of the arguments used by the renamePositions
utility.
Argument Description
—d domainPath Specifies the full path to the domain.
—i inputDirectory Input directory where input file with positions to
rename is located.
Utility looks for hierarchy data files with “rn” between
hierarchy name and .dat extension (for instance,
prod.rn.dat).
—hier hierName Hierarchy for which positions are being renamed.
—log logFileName Optional parameter to generate log file to file name
other than default. The default file name is
hierRename.log.
- Does not apply changes, but generates a report that
identifies changes that would be applied.
Notes:
The —nis a dry run, which means that it does everything as a
true run (for instance, writing to a log file) except that it does
not actually commit the changes to the domain.
—log is an optional argument that can be used to name the
log file other than the default, which will be created as
hierRename.log in the current directory.
Input File

There will be three columns of data in each input line. These columns correspond to the
dimension name, the old position name, and the new position name. The three fields will
be tab-delimited. Any line not formatted this way will be ignored, and empty lines are
also ignored.

Old position names must be an existing position name.

New position names cannot be an already used external name or an existing internal
name. Lines having invalid position names will be ignored and added to the log file.

Old Position Name and New Position Name should not be prefixed with the name of the
dimension.
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The 'width' attribute in the domain must be greater than or equal to the max length of the

new external names in the input file. If the width of the new name is greater than the

width attribute of the corresponding dimension, RPAS will print an error in the log file

and ignore the record.

Dimensions specified in the input file should belong to the hierarchy that is specified in
arguments. Otherwise, the record will be ignored, and RPAS will print an error in the log

file.

Setting Properties for Dimensions - dimensionMgr

The dimension manager utility is used for setting a number of parameters for dimensions
and positions. These parameters are set when using the functionality of Position Name
Indirection (PNI). This feature provides the ability to have position names that are longer

than the default 24 characters and for a dimension to have dummy positions.

Usage

dimensionMgr —d pathToDomain —dim dimensionName [COMMAND]

The table below provides descriptions of the arguments used by the dimensionMgr utility.

Note: This utility includes arguments that are not
documented in this guide as it is recommended that those
operations be configured using the Configuration Tools to
ensure consistency between the configuration and the

domain.

Argument

Description

—d pathToDomain

Specifies the path to the domain.

—dim dimensionName

Specifies the name of the dimension to which the
settings will apply.

—specs

This argument displays the properties of the specified
dimension. The dimension properties will indicate
whether the DPM is enabled for the dimension.

—width widthval

This argument sets the width of position names for the
specified dimension. The default width for positions
of a given dimension is 24 characters. Widths can only
be extended; they cannot be decreased.

-minBufferSize minSize

This argument sets the minimum number of unused
positions specified by minSize. Using this argument,
you can assign an absolute minimum size to a
dimension buffer. This feature is not available in the
Configuration Tools.

—bufPctMin minval

This argument sets the minimum percent of unused
positions.

—bufPctMax maxval

This argument sets the maximum percent of unused
positions.
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Argument Description

-enableDPM This argument enables Dynamic Position Maintenance
(DPM) for the specified dimension (-dim
dimensionName).

In order to enable DPM for a dimension, the specified
dimension (and all dimensions that roll up to it) must
be PNI enabled, meaning that buffer percent
minimum and buffer percent maximum are assigned
non-zero values.

Using this argument not only enables DPM for the
specified dimension, but for all dimensions that roll
up to it.

DPM cannot be enabled for any dimension in an
RPAS-internal hierarchy (DATA, META, RGPS,
ADMU, ADMW, MSGS, LNGS).

-enableTranslation width This argument enables the specified dimension to use
translated labels.

When enabling translated labels, the numeric
parameter passed in the argument (width) defines the
field width for the translated values in the data file,
which is loaded using the loadMeasure utility.

-maxProcesses max If specified, some parts of dimensionMgr will run in
parallel, using up to the given number of processes
defined by max.

Notes

To force the dimensionMgr utility to add positions to a dimension, both the —bufPctMin and
—bufPctax must be set. As long as minimum remains at zero, setting a higher maximum
has no effect.

Multiple command arguments are allowed.

Buffer Percent Minimum Size and Buffer Percent Maximum Size are specified as a
percentage of the total size of the dimension. For example, a dimension with 200 real
positions and a Buffer Minimum of 5 and Buffer Maximum of 20 could have between 10
and 40 extra buffer positions at any given time.

If buffers are defined, then the Buffer Maximum must be greater than the Buffer
Minimum and less than 10000. To turn off buffering for a dimension, set both Minimum
Buffer and Maximum Buffer to zero.

If both the minimum buffer size and buffer minimum percentage are defined, then
dimension is rebuffered to generate the appropriate buffer positions based on the higher
value. For example, on a dimension with 100 currently in-use positions, if the minimum
and maximum percentages were 10% and 20%, then about 15 available buffer positions
would be created. However, if minimum buffer size of 25 is defined, then the dimension
would get rebuffered to have 25 positions since that is the larger value. However, if the
dimension then grew to 200 current in-use positions, the percentage target would grow
to 30 buffer positions, and the 25 position minimum would no longer be relevant.

The primary advantage to the new minimum buffer size is that it works well for
dimensions which have very few current positions (or even none).
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The new minimum buffer size can be set in one of following ways:

= A new optional field is supported in the hierarchy.xml file at domain creation time as
shown below:

<buffer_size_min>20</buffer_size _min>
= Using the —minBufferSize minSize parameter, shown in the argument table above.

Deleting a DPM Position

When a DPM position is deleted, the underlying position is not automatically returned to
the buffer positions. The “prepForBatch” batch job has to be run to redeem those buffer
positions.

Setting Informal Positions to Formal — updateDpmPositionStatus

RPAS supports the ad hoc addition of non-calendar positions to the hierarchy by end
users in the RPAS Client. This functionality is referred to as “Dynamic Position
Maintenance” (DPM). Positions added outside of the loadHier process are assigned an
“informal” status. loadHier ignores “informal” positions when they are present in input
file. updateDpmPosi tionStatus changes the status of a position from “informal” to
“formal” and enable loading /purging that position through loadHier utility and will
disable further DPM activities on the position.

This utility cannot be run in subdomains in a global domain environment.
This utility can be run in parallel by specifying the processes option.

This utility expects an input file named as dpmposupdate.xml in the input directory of
the domain. Input file must be the XML file format as the following:
<?xml version="1.0" encoding="UTF-8" standalone="yes" ?>
<rpas>
<dimension name="‘diml">
<positions>posl,pos2,pos3. </positions>
</dimension>
<dimension name="‘dim2'>
<positions>posl,pos2,pos3..</positions>
</dimension>
<dimension name=""dim3">
<positions>posl,pos2,pos3..</positions>
</dimension>
</rpas>
Multiple positions, which belong to multiple dimensions, can be specified using this
input file in order to change their statuses from “informal” to “formal”.

In a global domain, the user will place an input file only to the input directory of the
master domain. An input file for each subdomain is not required. The utility will split the
input file and place it to each of the subdomains’ input directories. Only the positions
that reside in that subdomain will exist in that input file. The input file will be moved to
processed directory under the input directory of the domain. The input file name will be
appended with a timestamp.
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Usage
updateDpmPositionStatus -d domainPath [{PARAMETERS}] {OPTIONS}

The following table provides descriptions of the arguments used by the
updateDpmPositionStatus utility.

Argument Description

—d pathToDomain Specifies the path to the domain.

—-processes max When run on a Global Domain set defines the
maximum number of processes to run in parallel.

Exporting Hierarchy Data — exportHier

exportHier is a command-line utility used to export all the positions in a hierarchy,
including their rollup relations, from RPAS. By default, the utility assumes that the file
will have a CSV flat file format with fixed width format as an optional argument. The
utility will export all hierarchy positions, but the file may be specified to include only
formal or informal positions. The resulting file could then be used as a .DAT file with
loadHier.

Usage
exportHier -d domainPath —hier hier_name —datFile dat file [-FixedWidth]
[-onlyFormal | onlyiInformal]

The following table provides descriptions of the arguments used by the exportHier

utility.

Argument Description

—d pathToDomain Specifies the path to the domain.

—hier hier_name The name of a hierarchy in the domain from which the
DAT file will be generated.

-datFile dat File The path/location where the .DAT file will be created.
This .DAT file can then be used with loadHier to load
the hierarchy into a domain.

—FixedWidth This argument indicates that the output .DAT file is a
fixed-width file instead of a comma-separated value
(CSV) file format.

-onlyFormal This argument exports only formal positions to the
.DAT file. If this is option is specified, informal
positions will be skipped.

-onlylnformal This argument exports only informal positions to the
.DAT file. If this is option is specified, formal positions
will be skipped.

Note

The exportHier and loadHier utilities will skip any user-defined dimensions. This is true
for both fixed width and CSV formats. At this time, there is no way to export or import
user-defined dimensions.
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Managing Position Lists as PQDs - pqdMgr

padvgr is a command-line utility used to add and delete Position Query Definitions
(PQDs) using XML-formatted position lists. A position list is a multi-level listing of
positions along a non-Calendar RPAS hierarchy. For example, along the product
hierarchy, a position list could be a single-level listing of SKUs, or it could be a
multi-level list of classes, styles, and SKUs.

A PQD is used to represent a set of selected positions in a particular hierarchy. Each PQD
is identified by a unique name. A user can load the PQD instead of performing manual
selections on a two-tree wizard.

This utility can be used to load PQDs in master, local, and non-partitioned domains.
PQDs are not shared across local domains. Loading a PQD into a global domain does not
affect any local domain. Similarly, loading a PQD into a local domain does not impact the
master or other local domains.

The input file must be in the following XML file format. This example shows loading and
deleting lists for world and user access levels.

<? xml version=""1.0" encoding="UTF-8" ?>
<pqgdlists>
<pgdlist name="list_name" hier="hierarchy_name'>
<access level="user">
<comma_separated_user_names>
</access>
<dimension name="‘dimension_name'">
<pos>
<position_external_name>
</pos>
</dimension>
</padlist>
<pqdlist name="list _name" hier="hierarchy_name'>
<access level="world'">
</access>
<dimension name="‘dimension_name'>
<pOS>
<position_external_name>
</pos>
</dimension>
</padlist>
<pqgdlist name="list _name" hier="hierarchy_name' operation="'delete'>
<access level="world">
</access>
</padlist>
<pqgdlist name="list _name" hier="hierarchy_name' operation="'delete'>
<access level="user">
<comma_separated list of users>
</access>
</padlist>
</padlists>

Notes

= Input files are vailidated before loading. All dimensions, hierarchies, and user names
provided in the input file must be consistent with the existing hierarchies and
registered users in the domain. The utility fails (return a non-zero error code) if it
finds such inconsistencies in the input file. The errors are reported to the standard
output.

=  Multiple list operations are allowed in the XML input file.
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= The supported operations are load and delete. If no operation is specified for a list,
the default is load.

= The name list_name must be unique within an access level and, if the access level is
user, for the user name.

*  Each list definition consists of the list name, hierarchy, and access level. One or more
dimension definitions are allowed. One or more position definitions are allowed for
each dimension. Only external names are allowed to describe positions.

*  When specifying an access level of user, a single user name or a comma-separated list
of user names is required. A PQD file is created for each user name in the list.

*  For the access level of world, the PQD file that is created is saved in the following
path:
<domain_root>/wizardPQD/<hierarchy name>/ world/<list_name>

= For the access level of user, the PQD file that is created is saved in the following path:
<domain_root>/wizardPQD/<hierarchy_name>/<user_name>/<list_name>

Usage

pgdMgr —d domainPath —load xmlFile

pgdMgr —d domainPath —delete xmlFile

pgdMgr —d domainPath —deleteAll

pgdMgr —d domainPath —validate xmlFile

pgdVgr —d domainPath —export outFile [-user userName|-world]

The following table provides descriptions of the arguments used by the pagdMgr utility.

Argument Description
-d domainpath Specifies the path to the domain.
—load xmlFile Use this argument to load position lists from an input

XML file. Position lists with an operation attribute of
“delete” are ignored.

—delete xmlFile Use this argument to delete PQDs as specified in the
input XML file with an operation attribute of “delete”.
Position lists with an operation attribute of “load” are

ignored.

—deleteAll Use this argument to delete all PQD lists from the
domain.

—validate xmlFile Use this argument to validate the XML file and report
any errors. No impact on the existing PQD files in the
domain.

—export outFile Use this argument to export existing PQDs in the

[-user userName]-world] domain for a user or world access level. The file

specified by outFile is overwritten. Requires one of
the following options:

= -user userName exports PQDs for the provided
userName in the same XML format as used for a
load.

= —worldexports PQDs with world permission in
the same XML format as used for a load.
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Loading Measure Data — loadmeasure

The loadmeasure utility is used to load measure data from text files into the domain. The
administrator must specify the measure name(s) and the path to the domain that contains
the measure(s).

loadmeasure supports the use of fixed width and CSV (comma separated variable) files
for loading measure data. RPAS recommends the use of CSV files to reduce the size of
the load file and to reduce disk I/O time.

To load measure data, system administrators must copy or create one or more load files
in the input folder of the domain directory. The administrator can then call loadmeasure
to load data.

Load File Names and Load Behavior

System integrators must pay close attention to file naming. If a file name has not
specifically been configured in the domain configuration, the file must be named the
same as the same as the measure name, with the appropriate extension depending on the
type of the load.

For example, if the measure is named “rsal” and does not have a filename configured in
the domain configuration, then the basic filename will also be “rsal”. This name should
be appended with one of the following extensions to indicate the type of load. If the load
is an overwrite, then the filename should be “rsal.ovr”, if it is an increment the file name
should be “rsal.inc”, and so on. If a CSV file is being used, then the load type extension
should be prefixed with the .csv extension; e.g., “rsal.csv.ovr” and “rsal.csv.inc”.

RPAS supports the following types of loads (identified by file name extension):
= .ovr - (Overlay) Existing values in the measure are overlaid with the values in the
input file. Any values not included in the input file are not changed in the measure.

= 1pl-(Replace) The existing measure is cleared and the values in the input file are
taken as the new values for the measure. Existing values for cells that do not exist in
the load file will be switched to NA.

= .inc - (Increment) Increment mode should only be used with numeric measures
where the load file contains incremental values. Therefore, if a cell had a value of 2
and the .inc file provided a value of 3 for the cell, the new value for the cell would be
5 (2 incremented with 3).
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= .clr - (Clear) Clear mode is a variation of replace mode. It is meant to be used when
measure data is loaded in parts or staggered in time, such that data for all positions
grouped by an aggregate level position is replaced if one or more positions for that
group of positions are being loaded.

For example, assume that there are four regions, each with several stores, and we
load the data region by region or for a subset of regions at a time. When loading data,
we want to ensure that data for a region is completely replaced with the new load if
the load file has data for one or more stores from that region, but other regions
should be left untouched. This is made possible by clear loads where the clear
intersection (clearint) property of a measure specifies the aggregate level at which to
group positions for completely replacing the data. In this example, the clear
intersection would be at the region level. Clear intersection does not have to be
performed along one hierarchy, but can be performed at the intersection of multiple
hierarchies.

loadmeasure allows more than one load file to be present in the input folder at the same
time for the same measure. If more than one load file is present in the input folder at the
same time, each will be loaded. Since RPAS has a strict naming convention for measure
file names, in order to add more than one load file at the same time, integrators must
append the filenames as described above with file-distinguishing extensions.

For example, with the file names “rsal.csv.ovr.1” and “rsal.csv.ovr.2”, RPAS does not
care about the form of the multi-file extension. The extensions can be anything, number
or text, and RPAS will still load them.

Note: Backup files should not be named as
“rsal.csv.ovr.bak”, or they will be loaded as well.

Note: loadmeasure does not guarantee any specific ordering
of loads based on the appended extensions.

loadmeasure also allows multiple types of load files to be present in the input directory at
the same time. RPAS loads .rpl files first, then .ovr, .clr and .inc files. If fixed width and
CSV files are present, then fixed width files of a particular load type are loaded before
CSV files of that type; all files of one load type are loaded before moving on to the next
load type. Since .rpl files would completely erase existing measure data and then load the
given data, you should not have multiple .rpl files at the same time.

Loading Multiple Measures from One File

loadmeasure allows multiple measures to be loaded from a single file.

Note: Please refer to the Data Interface Tool section of the
RPAS Configuration Tools User Guide for more information.

If a CSV file is used for loading multiple measures, loadmeasure uses the start positions of
measures as defined in the Data Interface Tool for the fixed file format to determine the
order of columns in the CSV format. For example, if a file named “multiple”” is used to
load measures A, B, and C, where the start position (for fixed file format) for the measure
values have been configured to be 40, 110, and 70 respectively, then when using the CSV
file “multiple.csv.ovr”, loadmeasure will assume that after the dimension columns, the
first column is measure A, then C, and then B because 40 (A) is less than 70 (C) is less
than 110 (B).
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It is not necessary to load all measures in a multiple measure file. Administrators can
choose to load only a subset of measures from the multi-measure file. However, if
Administrators wish to reuse the same file for loading different measures at different
times in a batch, they must use the -noclean option to ensure that loadmeasure does not
move the file to the processed folder after processing the first load request.

Loading Data from Below the Base Intersection of the Measures

loadmeasure supports loading measure data from an intersection lower the base
intersection of the measure. The load intersection has to be pre-specified in the
configuration (loadint property) and the load time aggregation (loadagg property)
method must also be specified. Please refer to the RPAS Configuration Tools User Guide for
information on setting up measure properties.

When loadmeasure loads data from below the base intersection, all low-level data
corresponding to a cell at the base intersection must be available in the load file for RPAS
to be able to correctly aggregate the low-level data to the base level. A fault in values of a
subset of cells that aggregate up to one cell at the base level can only be corrected by
reloading the data for all low-level cells that correspond to the cell at the base level. If any
low-level cells are missing, RPAS substitutes their value with NA.

To perform a lower level load, RPAS first aggregates the data and then applies the
appropriate load type to update the measure value, overwriting the existing value with
the aggregate of the input cells if .ovr files were used, or incrementing the existing value
with the aggregate of the input cells if .inc files were used.

Staging Measure Loads

RPAS supports the notion of stage-only measures. For stage-only measures, loadmeasure
queues the loaded data in an intermediate staging area, but does not load it into the
measure until it is called with the —applyloads parameter. For stage-only measures,
loadmeasure should be called twice, once to stage the measures and then with the
—applyloads parameter to subsequently load the staged data in the measure arrays.
loadmeasure cannot simultaneously stage loads and apply the staged loads.

Measure staging should be performed when measure data can arrive from different
sources, in different load formats, and staggered in time, when system administrators
want to queue all these loads up and apply them at once while honoring the data arrival
queue. Measure staging can be performed while the system is online as it does not cause
measure data-related contention (it has the potential to cause metadata-related
contention). When staging measure data, loadmeasure splits the data and purges the data
files if data purging is enabled; it does not purge measure data until the loads are
applied. This staging time preprocessing significantly reduces the load time when the
loads are actually applied.

Note: The replace (.rpl) format cannot be used for staging.
Furthermore, data loads from below the base intersection of
the measure cannot be staged.

Data Management 101



Loading Measure Data — loadmeasure

Running Pre-Load or Post-Load Scripts

The loadmeasure utility provides the ability to automatically run scripts before and after
the utility is executed. These are referred to as “preprocessing” and “post-processing”
scripts.

When loadmeasure is called, the utility checks for the existence of scripts named
“pre<measurename>.sh” in the “./scripts” directory of the domain. If scripts exist, they
will be run prior to the execution of the utility. Similarly, after the utility has completed
running, the utility checks for the existence of scripts named “post<measurename>.sh”
and executes them.

When loading multiple measures in a single call, only the preprocessing script for the
first listed measure will have any effect on the data.

Purging Old Measure Data

System administrators can purge old measure data during a load. When the base
intersection of a measure involves the Calendar hierarchy, the setting for the purgeAge
measure property defines how and when existing data gets purged to a N/ A value. If
purgeAge has not been set, the data never gets purged. If a purge age of zero or more has
been set, data is purged for all dates that are before RPAS_TODAY — purgeAge days. That
is, if purgeAge is 5, then at data load time, all data that is older than 5 days before
RPAS_TODAY will be purged.

Behavior in a Global Domain Environment

Usage

In a global domain environment, loadmeasure is centralized and can only be called in the
master domain. The loadmeasure utility will load one or more input files that can contain
data from one or all of the local domains within the given global domain environment.
The utility will then split the input files and load them into the required domain, which is
the local domain to which the position belongs, or the master domain if the measure has
a base intersection above the partition level. The split will only occur once in the case of
multiple measures. Local domains will be checked for files even if there is no file in the
global domain. The utility can be run in parallel in a global domain environment.

loadmeasure —d pathToDomain —measure measureName{,measureName,..} {—applyloads}
{-processes max} {-noClean} {—forcePurge}

{-splitOnly | -noSplit} {-defragH{—loglevel level}{-recordLogLevel level}

The following table provides descriptions of the arguments used by the loadmeasure
utility.

Argument Description
—d pathToDomain Specifies the domain in which to load the measure.
—measure measureNames Specifies the name of the measure(s) to load.

Measure names must be lowercase (for example,
measurenamel, measurename2, measurename3).

If more than one measure is specified, all the measures
must be in the same input file.

102 Oracle Retail Predictive Application Server



Loading Measure Data — loadmeasure

Argument Description

-applyloads Use this argument to apply any staged loads for the
named measure.

If the measure is registered to be a stage-only
measure, loadmeasure will put the load in a staging
area but will not update the measure until
loadmeasure is called again with this argument. Upon
the use of this argument, loadmeasure will apply all
loads that have been queued up in the staging area. It
will clear out the staged loads unless the measure’s
loadsToKeep property has been set to a non-zero
number. In that case, it will not clear out the latest
loadsToKeep loads.

Note that only .ovr, .inc, and .clr loads can be staged.
.rplloads cannot be staged. Additionally, staging is
only allowed for base intersection loads. RPAS cannot
stage loads where load intersection is below the base
intersection of the measure.

This argument should not be used for measures that
are not stage-only.

—processes max Specifies the maximum number of child loadmeasure
processes to run concurrently across the local domains
in a global domain environment.

If this argument is omitted or if less than two
processes are specified, the application will do all
processing in a single process and no child processes
will be created.

This only specifies the number of child processes and
the controlling process is not included (max + 1 is the
actual number of processes).

-noClean Use this option to prevent the input files from being
moved to the processed directory.

This option is meant for use when a sing]le file is used
to load multiple measures, but not all measures from
the file are loaded at once. The use of this option
instructs loadmeasure to leave the load file behind for
subsequent loading of unloaded measures.

The user might want to use this option to perform
intermediate processing between loads of measures
available from the same file.
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Argument

Description

—forcePurge

Force the purge routine to run even if no new data is
loaded. This purges old measure data.

This option can be applied to stage-only measures
without having to apply loads.

When a measure has the Calendar hierarchy in its
base intersection, the setting for the purgeAge measure
property defines how and when existing data gets
purged to a N/A value. If purgeAge has not been set,
the data never gets purged. If a purge age of zero or
more has been set, data is purged for all dates that are
before RPAS_TODAY - purgeAge days. That is, if
purgeAge is 5, at data load time all data that is more
than 5 days before RPAS_TODAY will be purged.

This option does not require you to load any new
data.

-splitonly

This argument causes the input files in the global
domain to be split across the local domains, but does
not do any further processing of the input files.
Subsequently, loadmeasure can be used with the
—noSplitargument to load these pre-split input files
into the local domains.

File-splitting is a fairly time consuming activity and
can consume up to 80% of the load time. System
integrators may be able to improve batch performance
by breaking away file-splitting from actual measure
loading. This is specifically useful if a multi-measure
file is being used such that subsets of measures are
loaded at different steps in a batch process.

File-splitting is a single process procedure, so the
—splitOnly option is mutually exclusive with the
—processes argument.

This option should only be used in global domain
environments.

-noSplit

Use this argument to load the pre-split input files
(created by —splitOnly) into the local domains. This
option should only be used in global domain
environments.

-defrag

This argument can be used to defragment the domain
at the end of the measure loading process to reduce
the physical size of the domain. This space-saving is
achieved by replacing the existing fragmented pages
with copied, fully populated BTree database pages.

—loglevel level

Use this argument to set the logger verbosity level.

Possible values: all, profile, audit, information,
warning, error, or none.
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Argument Description

-recordLogLevel level This argument is used to set a logging level for record
loading issues. Issues such as parsing errors, missing
positions, and data conversion errors are evaluated for
every record in the measure load file. By default, these
are logged as errors in the log file of the loadmeasure
utility. However, customers might want to
downgrade the logging level for such record loading
issues. They can do that with the use of the -
recordLogLevel level argument.

The standard log levels, error, warning, information,
and profile, can be used as parameters to this
argument.

When logging, loadmeasure compares this logging
level to the utility’s logging level (set using
—loglevel). If the utility’s logging level is less verbose
than the record logging level, then record issues will
not be logged. If utility’s logging level is at same or
higher verbosity as the record logging level, the record
issues will be logged with the log indicator as set
using this argument.

Loading Image Paths for Positions

A configuration and backend process may also be used to support the load of image
paths for one or more positions of a dimension at a time. The paths of the images should
be stored in a measure called “r_images_<dimension name>" where “<dimension
name>" should be replaced with the RPAS Name of the image-enabled dimension (for
example, “r_images_sku” if loading image paths for the “sku” dimension). This measure
is single-dimensional, defined on the image enabled dimension. An .ovr file is required
with position names and the image paths for those positions formatted according to the
RPAS measure load formats. The loadVeasure utility is then used to load this data into
the domain.

Note: See the RPAS Configuration Tools User Guide and the
“Position Images” section in the RPAS User Guide for more
information on Image Display.

Example
loadmeasure —d <domain path> -measure r_images sku
<domain path> is the path to the domain.
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Exporting Measure Data - exportMeasure

Usage

exportheasure is a command-line utility that may be used to export domain or workbook

measure data from RPAS in either CSV or fixed width file format. A single measure, or

multiple measures, may be exported based a specified intersection. If the measure’s base

intersection is not the same as the export intersection, the measure’s default aggregation

method will be used to aggregate data to an intersection higher than base, or replication

will be used for spreading measure data if the data is required at an intersection lower

than base.

This utility:

= Supports export of data in a user specified range, which can be a single mask
measure, or a range specified on Calendar dimension, or a combination of the two.

= Supports multiple processes for better performance in a global domain environment.

exportMeasure —d pathToDomain —out outFile [COMMAND] [OPTIONS]
The following table provides descriptions of the arguments used by the exportMeasure
utility.

Argument Description

—d pathToDomain Specifies the path to the domain.

-out outFile Specifies the output file name. It is required and must
be a valid file name including the path.
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Argument Description

-meas “measSpec, measSpec ..” [ Must specify one. measSpec is measName .modifier.
The —meas argument may be repeated to export

multiple measure arrays to the same output file.
modifier include the following:

= .precision<double>, specify the precision for
numeric measure

= format<formatString>, specify the user defined
export format

The examples below provide valid measure
specifications given MeasNameA is a valid real type
measure.

Examples:

-meas MeasNameA

-meas MeasNameA.precision(0.0001)

-meas

MeasNameA. format(“%13.2F”) .precision(0.01)
-meas

MeasNameA.precision(0.01) . format(“%13.2F”)
For specifying date and time, the following formats
are supported:

%Y — four-digit year

%y — two-digit year

%m — month

%d — day

%B — full name of the month

%Db — three character abbreviation for the month
%H — hour

%M — minute

%S — second

%s — milli-second

The examples below provide valid measure
specifications given MeasNameB is a valid date/time
type measure.

Examples:

-meas MeasNameB
-meas MeasNameB . format(*%Y%md’”)
-meas MeasNameB . format(““%d%B%Y%HM%US ™)

-wb wbname If specified, exportMeasure exports data from the
specified workbook (wbname). A valid workbook name
must be used.

—-intx IntxString Specifies the export intersection. Measures will be
exported at this intersection. If measure’s baseint is
higher than export intx, measure’s defaff method will
be used for aggregation. If measure’s baseintx is lower
than export intersection, Replication will be used to
spread measure down to export intersection.

-mask measureName Specifies a mask measure which must be a valid
Boolean measure registered. In current measure store,
its baseintx must be at same export intx.
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Argument Description

-range start:end Specifies a range of positions along the innermost
dimension. Only values in the range are considered
for export.

—-processes max Defines the maximum number of processes to run in
parallel.

-append Appends new output to current output file. If not

specified, current output file will be erased and
replaced with new data.

-nomerge If run in a global domain environment and exporting
intersection below partition dimension, and have
processes set greater than 1, specifying nomerge will
stop exportMeasure from merging multiple output
files created from each local domain to the master
output file. Output files created from local domain
will be stored at
masterdomain/output/exportMeasure[TS] folder,
where [TS] represents a timestamp. Files are named as
out000X.txt, where 000X is the index of the local
domain.

—-compress Specifies the output file should be in the compressed
CSV format.

Exporting Measure Data - exportData

Use exportData to export measure data from RPAS into text files. Each line that is
exported contains the position name for the exported dimension followed by the value in
the cell for each array being exported.

Note: More than one array may be exported and more than
one dimension in each array can be exported.

The utility may be invoked by specifying all parameters on the command line or by
specifying an array that contains a list of the parameters.

When running this utility in a Global Domain environment, the utility should only be
called to export data from the master domain. The utility will extract the data from either
the local domains or the master domain depending on where the data resides, which
depends on the level at which the Global Domain environment is partitioned.
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Usage

The parameters specify what arrays and dimensions are exported and how to format the
data. It is best to specify the arrays first. An array specification begins with —array
followed by the array information. This includes the array name, formatting string, NA
cell value, and NA cell value formatting string. The formatting string for both the cell
value and NA value is based on the C language printf function formats. See the
documentation on the printf for more information on the possible values. The —array
parameter can be repeated as needed to export more than one array into the same export
file. Remember that the order the arrays appear in the —array parameter is the order that
they will appear in the export file.

After the arrays have been specified, the administration must specify the dimensions to
be exported within the arrays. The —dim parameter is used to specify a dimension in an
array. The —dim parameter is followed by the dimension name, a convert option, the
formatting string (just like an array), and the order the dimension appears in the export
file. Because arrays are not required to contain identical dimensions, it is important to list
all dimensions in all arrays with the —dim parameter. This makes it possible to track
dimensions across arrays and line the data up correctly. If a dimension in an array is not
to be in the export file, set the last value of this parameter to 0. The conversion option
specifies either the number of characters to be removed from the position name or it
specifies an array that contains the real position name. If an array name is given, this
array must be a vector. The function will go to this array and use the original position
name to jump to the cell of the same position name. It will then get the cell value and use
that as the position name in the export.

It is possible to specify the number of decimal places when exporting numeric measures
of data type “real.” This setting is defined in the specifications for measures, arrays, and
dimensions (measSpec, arraySpec, and dimSpec). The format is %[.precision]type where
[.precision] is the number of decimal places and type is the letter “f” (without quotes). For
example, the setting %.2f would export numbers with two decimal places. Other settings
are provided below.

If all parameters are contained in an array, after the export file name and source database
name, the -—params parameter is used to specify the database name and array name that
contains all of the parameters needed for the export.

Note: Either the —array, —meas, or —params parameters must
be specified when using this utility.

exportData —d domainPath —out outputFile —params db array

exportData —d domainPath —out outputFile —meas \'"measSpec\"

{~wb wbName} {options}

exportData —d domainPath —out outputFile —array \"arraySpec\" {options}

The following table provides descriptions of the arguments used by the exportData
utility.

Argument Description

—d domainPath Specifies the domain that contains the data that to
export.

—out outputFile Specifies the file that will contain the exported data.
The outputFileis relative to the domain unless the
full path is specified.
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Argument

Description

—meas \’measSpec\”

Specifies the measure(s) to export.

measSpec must be quoted, and the format is
\"measName cellFormat naValue naFormat\"

The —meas argument can be repeated to export
multiple measure arrays to the same output file.

Measures are exported at the base intersection.

—array \’arraySpec\”

Specifies the array to export.

arraySpec must be quoted, and the format is
\"dbName |arrayName cellFormat naValue
naFormat\"

= dbName can be a path to the database (relative
paths are relative to the domain root).

=  Both cellFormat and naFormat use printf
format commands. See the printf function for
more information on the possible values.

The —array argument can be repeated to export
multiple arrays to the same output file.

The order in which arrays are listed is the order in
which they will be exported.

Note: This argument cannot be used in a Global
Domain environment and can only be used in simple
domains. This argument cannot be used with
—uselLoadFormat.

—params db array

Instead of specifying all parameters on the command
line, this parameter allows the parameters to be read
from an array.

= dbspecifies the name of a Gem file where the
array of parameters is stored.

= array specifies the name of an array in the
specified database that has the above parameters.
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Argument Description

—dim \"dimSpec\" Specifies the dimension to be exported.

= dimSpec must be quoted, and the format is
\"dimName conversion format order\"

= conversionis either a count of the number of
characters to strip from the start of the position
name or the name of an array to be used to
translate the position name before writing to the
output file.

= formatis a printf-style format for the position
names. See the printf function for more
information on the possible values.

=  order indicates the order the dimension is listed
in the output file.

If the value is 0, then the dimension is not exported.
The —dim parameter can be repeated.

The -dim parameter is not allowed with the
-uselLoadFormat.

When using with the —wide parameter, the —dim
parameter should not be used for the innermost
dimension.

—skipNA Controls whether a line of data is exported based on
always]al Inajanynajarrayna having NAs in a cell.

= always exports data regardless of whether or not
it contains NAs.

= allnadoes not export a row of data if all columns
are NA (default).

= anynadoes not export a row of data if any cell
contains a NA value.

= arraynadoes not export a row of data if the value
in the given array name is NA (requires —
naArray).

—naArray arrayName When arrayna is specified using the —skipNA
parameter, this option specifies the export array that is
checked to determine if data is exported.

—index arrayName Controls whether arrays are indexed by looking at a
specified array.

Only export the non-NA cells in the given array and
each cell in the other arrays that have the same
position names.

If another array is at a higher dimension level,
translate the given arrays cell index to the other
arrays.

—append Specifies that output is appended at end of output file.
The default is to overwrite output file.
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Argument

Description

—wide

This parameter causes the data to be exported wide,
which means the innermost dimension will go across
the row instead of each cell on a separate line.

This is most useful when the innermost dimension is
time.

The —range parameter can be used in conjunction with
wide format (—wide) to specify a range along the
innermost dimension.

The —dim parameter should not be used for the
innermost dimension when —wide is being used.

—range start:end

Used to limit the export to positions in the range. The
range can only be specified for the innermost
dimension.

May be used in conjunction with the —wide parameter.

—time

Specifies the YYYYMMDD format for dates.

—precision precisionvalue

This parameter causes the utility to avoid exporting
values that differ from the NA value by the specified
value.

Any values smaller than the precision value are not
exported. For example, consider a measure with the
NA value of zero and a precision value of 0.01. A
value of 0.0034 would not be exported while a value of
0.34 would be exported.

The precision value must be less than one.

If a value greater than one is provided the utility
returns a warning.

—processes max

Defines the maximum number of processes to run in
parallel.

-useArrayNaValue This argument will enable the use the NA value of the
array instead of the NA value specified in measSpec or
arraySpec.

-uselLoadFormat This argument enables the use of the format as

specified by the measure property. The level at which
the data is stored in the domain will be used. The -dim
parameter is not allowed with the

-uselLoadFormat.
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-useLoadFormat Parameter

Use the format specified by the measure's loading format to export the measure. This
loading format includes Start and Width, which defines the column that corresponds to
this measure's data in the measure load file. The measure will be exported into the same
column in the output file. If the full measure export specs are not provided including the
cellFormat, naValue and naFormat, the default format will be used. The default export
format for each type of measure is listed below:

= Integer: %<width>.0f

= Real: %<width>f

= String: %<width>s

= Date: %Y%m%d

= Boolean: TRUE or FALSE as string

All value will be exported right aligned as in the measure loading file.

If users give a full measure specs, user-specified cellFormat, naValue, and naFormat will
be used rather than the default format.

Users can either use the default format by specify the measure name only, or give the full
specs. It is not allowed to give a partial measure spec.

If users specify multiple measures to be exported into the same file, these measures will
each occupy a column in the file defined by its start and width attributes. If two measures
occupy the same column, exportData will throw an exception with an error message
saying "overlapping measures in the output file" and exit. If a measure's column is
overlapping with the columns occupied by the position names, exportData will throw an
exception with an error message saying "measure column is overlapping with position
columns" then exit. Basically, if the measure cannot be exported correctly, exportData will
not try to export it but simply exit and alert user with a proper exception.

The -dimand —array parameters are not allowed if -uselLoadFormat is used. All
dimensions in the measure's base intersection will be exported by default. The external
position name will be exported to the export file, in the order specified by the hierarchy's
order attribute, usually in the order of CLND, PROD, and LOC. The position names will
be left aligned in the export file.
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Mapping Data Between Domains — mapData

Usage

The mapData utility is used to move data from one domain to another. Specifically, it
copies data from an existing domain, database, or array to a new domain, database or
array.

Before running this utility, the new hierarchy must be loaded in the destination domain.
After mapData has copied data, administrators can purge the source domain by calling
loadHier with a purge age of 0. Tasks such as hierarchy loading, hierarchy purging, and
the validation of source and destination domains are performed outside of this utility.

Note: This utility does not update buffer positions.

mapdata -d SrcPath -dest destPath [-db dbName [-array arrayName]]
{-db dbName {-array arrayName}} {-loglevel}

The following table provides descriptions of the arguments used by the mapData utility.

Argument Description

—d SrcPath Specifies the path to the source domain.

-dest DestPath Specifies the path to the destination domain.

—db dbName Apply mapdata only on the given database. Must be a

valid file. If this argument is not specified the entire
domain will be included in the operation.

—array arrayName Apply mapdata only on the given array. The database
in which the array resides must be specified with the —
db argument.

Moving Data between Arrays — updateArray

The updateArray utility moves data from a source array to a destination array. The
destination array must contain the superset of dimensions in both source arrays. The
source array’s dimensions may be at the same or higher level as mapped by the
dimension dictionary. If a dimension in the source array is at a higher level, the results
are spread across the lower level dimension in the destination. If there are extra
dimensions in the destination array, the results are replicated across these extra
dimensions. The NA value of the destination array remains unchanged.

To limit the scope of the update, a mask array and an innermost range may be specified.
If a mask array is given, the update is limited to cells in the source array for which the
corresponding mask cell is on. If an innermost range is given for source or destination
array, the update is limited to cells that are within the start and end of this range on the
innermost dimension. If the source and destination arrays are not in the same domain,
the measure store associated with the source domain is used to find hierarchy
information.

Note: This utility does not update buffer positions.
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Usage

updateArray —destArray dbPath.arrayName {—srcArray dbPath.arrayName}
{—destDomain domainPath {—srcDomain domainPath} {-maskDomain domainPath} {—
maskArray dbPath.arrayName} {—updateMethod method} {—srcRange first:last} {-
destRange first:last} {-srcScalar scalarCell} {—version} {—loglevel level}
updateArray —argFile filename {—version} {—loglevel level}

The following table provides descriptions of the arguments used by the updateArray
utility.

Argument Description

—destArray dbPath.arrayName Required argument to specify the destination
array where the data will be copied.

dbPath is relative to destDomain.

—srcArray dbPath.arrayName Optional argument. Default is no source array.

Note: This parameter cannot be used with
—srcScalar scalarCell.

—destDomain domainPath Optional argument.

Default is current working directory.

—srcDomain domainPath Optional argument.

Default is current working directory.

—maskDomain domainPath Optional argument.

Default is current working directory.

—updateMethod method Optional argument.

Default is OVERLAY.

The following update methods are available:

= SKIPNA - Omit NA cells in source.

= SKIPPOP - Omit populated cells in source.

OVERLAYNA - Update NA cells in
destination.

*  OVERLAYPOP - Update populated cells in
destination.

= OVERLAY - Update all cells in destination
with source.

—srcRange first:last Optional argument.
Default is no range.

Defines range along innermost dimension of
source array.

—destRange first:last Optional argument.
Default is no range.

Defines range along innermost dimension of
destination array.

The position names of the innermost dimension
are the range value. For example, if the range
values is one week, the range should be specified
as

-srcRange WEEK200811011:WEEK200811022
-destRange WEEK200811011:WEEK200811022
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Argument Description
—srcScalar ""TYPE:VALUE" Optional argument.
Default is NA cell.

Format for scalar cell is one of:
=  NUMERIC: numeric value
=  STRING: literal value

=  BOOL: Boolean value

= NA

Note: This parameter cannot be used with

—srcArray dbPath._arrayName.

Scan Domain Data - scanDomain

Usage

The scanDomain utility is a domain utility used for detecting data loss and repairing data
corruption in an RPAS database.

Data loss occurs when an RPAS process is abnormally terminated. This can happen when
an external mechanism, such as a power failure, causes a sudden termination of an RPAS
process. Data loss can also occur due to unexpected program breakdown.

Data corruption can occur if an external program modifies the RPAS database files or an
unforeseen defect occurs in the processes using the RPAS database (an extermely rare
event).

The scanDomain utility can detect both corruption and data loss, but it can only fix
corruption. This utility can operate on global, non-partitioned, and local domains. It
supports parallelization when repairing databases in a domain.

While attempting to perform a repair of the databases, the utility has a command line
option (-backup) to enable backing up the original databases. While running in detection
mode (—detectDataloss or —detectCorruption option), the utility does not change any of
the RPAS databases, and therefore, it does not create such backups.

In detection mode, the utility prints a list of databases with data loss or data corruption
to the screen. The output can be directed to a file.

scanDomain —version

scanDomain —d domainPath [-detectDataloss ] [-detectCorruption] [-loglevel level]
[-noheader]

scanDomain —d domainPath —repairCorruption [-backup]

[processes maximumNumberOfProcesses] [-loglevel level] [-noheader]

scanDomain [-?]-help]-usage]

If the user intends to detect both corruption and data loss, it is more efficient to run the
utility once with both the —detectDataloss and —detectCorruption options. The user
could run two consecutive commands for detecting corruption and data loss, although
this would be less efficient.
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The following table provides descriptions of the arguments used by the scanDomain
utility.

Argument Description

—version Prints the version of the utility.

—d domainPath Required argument to specify the path to a global,
non-partitioned, or local domain.

—detectDataloss Checks for data loss in the specified domain.

—-detectCorruption Checks for database corruption in the specified
domain.

—repairCorruption Repairs the database corruption in the specified
domain.

Note: This argument cannot be used with
-detectDataloss or —detectCorruption.

-backup Optional argument to back up database files
before attempting to repair them.

Note: This argument can only be used with
—repairCorruption.

—processes Optional argument to specify the maximum

maximumNumberOfProcesses number of processes to be started to repair Btree
database corruptions.

Note: This argument can only be used with
—repairCorruption.

-loglevel level Optional argument to set the logger verbosity
level. Possible values: all, profile, debug, audit,
information, warning, error, or none.

-noheader Optional argument to disable the timestamp
header.

-?]-help|]-usage Optional argument to get the usage text.
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Informal Position Manager

Informal Position Manager is a domain utility which can be used to maintain informal
positions for any dimension in a domain. Currently, it can convert positions from formal
to informal.

Usage

informalPositionMgr —d domainPath —hier hierName -operation informalize [dir
inputDir | -file inputFile] [-retain]

The following table provides descriptions of the arguments used by the
informalPositionNgr utility.

Argument Description

—d domainPath The domain to run the utility.

-hier hierName The hierarchy to apply the changes.

-operation informalize Convert formal positions to informal positions for the

given hierarchy.

One or more input files are required. Converting a
position to informal causes all its children to become
informal recursively down to the root dimension.

—File inputFile or The input files to use.

~dir inputDir If the —File option is used, only one input file is

processed and its file name does not matter.

If the —dir option is used, all files that match the
naming patterns described in the File Format section
are processed.

—retain Do not move input files to the “processed”
subdirectory after a successful run.

File Format

= Input file naming convention

hierName.informalize{.extraField}. The extraField is optional and can be appended
to allow multiple input files to be processed at one run.

For example: prod.informalize.20100220
= Content format

Each line is for one position specified by dimension name and external position
name. Comma delimited. No header line.

dimName, positionName

Error Handling

Input file does not exist: log error and stop execution.

= Any dimension specified in the input file is not DPM enabled or does not exist: log
error and stop execution.

*  One or more positions do not exist: log warnings, skip the line, and continue.

= Selecting to convert a position to informal that is already informal: no action will be
taken on that position. A warning message is logged.
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Find Alerts — alertmgr

Alerts are an exception management tool for users. An alert is a measure that evaluates a
business rule (returning a value of true or false). RPAS then notifies users of the “true”
conditions and allows users to build workbooks to resolve the scenario that drove the
alert.

Alert measures are first defined in the domain using the Configuration Tools. These
measures are of type Boolean, which means they have a value of true or false. Next, rules
(expressions) are registered in the domain for the alert measures to define the business
rules used to evaluate the alert.

Once the registration process is complete, the alert utility is run to “find” the alerts in the
domain. After the alert finder has been run, the identified alerts can be viewed in the
Alert Manager window in the RPAS Client.

The following is a summary of the process for defining and finding an alert:

1. Create an alert measure — This must be a Boolean measure (values are true-false, or
yes-no) and must be defined in the RPAS Configuration Tools.

2. Create the alert (the expression) for which the alert should be evaluated using the
Configuration Tools. This flags the registered measure as an alert so that it is
recognized when the “alert finder” is run.

3. Run the “alert finder” on the domain to evaluate the number of instances when one

or more alert expressions are true. This operation is completed using the RPAS utility
alertmgr.

Usage

alertmgr -d domainPath [COMMAND [parameters]]
alertmgr —d pathtodomain —findAlerts {-alerts “al a2 .”” | -categories “catl cat2 .”’}

Note: This utility includes arguments that are not
documented in this guide as it is recommended that those
operations be configured using the Configuration Tools to
ensure consistency between the configuration and the
domain.

The table below provides descriptions of the arguments used by the alertmgr utility.

Argument Description

—d pathToDomain Specifies the directory in which to run the utility. All
commands except —version require —-d domainPath.

—FindAlerts Finds alerts in the specified domain. The utility will find
all alerts in the domain if neither the —alerts or
—categories arguments are specified. If —alerts or
—categories list is not specified, FindAlerts is run on
all alerts. FindAlerts can be run from either Master or
Local Domains.
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Argument Description

—alerts al a2 . Evaluate specific alerts in the domain. al a2 .. must be
valid names of alerts that are defined in the domain.

—categories catl cat? .. [Evaluate all alerts in the domain that are associated with
specific categories of alerts. catl cat2 ..must be valid
names of alert categories that are defined in the domain.

-sumAlerts -sumAlerts sums up the hit counts of alerts across local
domains. It can be run based on a list of alerts or alert
categories. If none are provided, then the respective hit
count of each alert across all local domains is summed.
-sumAlerts can be used only from Master Domain.

Note: -findAlerts must be run first to generate hit
counts of alerts.

Note: alertmgr can be run on the local domains individually.
The administrator may spawn several processes in parallel,
and when needed, run alertmgr -sumAlerts again to
aggregate the results to the global domain. If parallelization
is desired, the administrator should create a script to spawn
the parallel processes.

Copying Domains - copyDomain
The copyDomain utility is used to copy a simple domain, all domains included in a global
domain environment, or a subset of domains in a global domain environment. Domains
are often copied before upgrading the domains after receiving a patch to RPAS.

For a standard, simple domain (in other words, not a global domain environment),
copyDomain copies the domain directory recursively from one location to another.

For a global domain environment copyDomain copies the master domain to the specified
destination, and then it copies each local domain into corresponding subdirectories of the
new location. As part of this particular replication process, the utility also updates all
relevant data structures so that the domains are properly connected together.

Relative paths are supported with this utility and are used when creating the new copies
of all the underlying data structures (arrays). Relative paths are based on the full
pathname of the domain’s root directory.
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Usage
copyDomain —d pathToSrcDomain —dest pathToDestDomain { -f }
copyDomain —xmlConFfigFile pathToXmlConfigFile._xml
copyDomain —version
The following table provides descriptions of the arguments used by the copyDomain
utility.

Argument Description

—d pathToSrcDomain Specifies the path of the domain to be copied. This
argument and —dest should not be used with
—xmlConfigFile.

—dest pathToDestDomain Specifies the path to where the domain is to be copied.
The copied domain can also be renamed in this step
by providing a name different than the source
domain.

This argument must be provided when using any
other option (other than -xmIConfigFile) of the
utility. If this argument is not provided then the
domain is updated to have relative paths.

-xmIConFigFi I(_a i This argument will allow copyDomain to copy each
pathToXmlConfigFile.xml sub-domain into user-instructed specific locations.

This argument should not be used with -d OR
—dest.

—force Deletes the existing domain at the specified
destination path before copying the source domain.

—-clone dimposlist Use this argument to copy a subset of a domain
environment. Copies only positions specified in a
format as diml,pos1, . . ,posn:dim2,posl, - . ,posn
where the sequence diml,posl, . . ,posn specifies the
selected positions along dim1. Multiple dimensions
may be specified, but only one dimension per each
hierarchy is allowed.

—pal_‘t!tionPOSitionS Limits the copying of local domains to the specified
posrtions positions at the partition level; positions is a comma-
separated list of positions at the partition level.

—copyWorkbooks workbookList [ Copies only the specified workbooks to the
destination location.

workbookList is either a comma-separated list of the
workbooks to copy, or the value “none” such that no
workbooks are copied. If this argument is not
specified all workbooks in the environment will be
copied.

—skiplnput Do not copy the “input” directory located in the
source domain.

—skipConfig Do not copy the “config” directory located in the
source domains.

—skipEmptyDir Do not copy the empty directory located in the source
domain.
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Argument Description

-maxProcesses count If this argument is specified, some parts of

copyDomain will run in parallel, utilizing up to the
given number of processes.

—noSubDomains Do not copy any local domains in the source domain.

—export

Export each database (.gem file) from the source
domain into a format that can be used on a UNIX
platform. This argument cannot be used when
specifying an —xmlConfigFile.

Compress the copied domain into a gzip format. This
argument cannot be used when specifying an
—xmlConfigFile.

Note: If the pathToSrcDomain argument is provided but the
pathToDestDomain is not, then the utility will update the
source domain environment to have relative paths to all the
local domains. This is commonly used to update a global
domain to have a recursive directory structure which is
useful when copying a domain environment.

Format of the XML configuration file

The XML configuration file contains source and destination fields for the location of the
master domain and each of the sub-domains. Here is a basic example:

<?xml version="1.0" encoding="UTF-8" standalone="yes" ?>

<rpas>

<globaldomain>

<srcPath>C:\usr\Rpas\Domains\GlobalDomain</srcPath>

<dstPath>C:\usr\Rpas\Domains\GlobalDomain2</dstPath>

<subdomain>
<srcPath>C:\usr\Rpas\Domains\GlobalDomain\ldomO</srcPath>
<dstPath>C:\usr\Rpas\Domains\GlobalDomain2\ldomO</dstPath>

</subdomain>

<subdomain>
<srcPath>C:\usr\Rpas\Domains\GlobalDomain\ldoml</srcPath>
<dstPath>C:\usr\Rpas\Domains\GlobalDomain2\ldoml</dstPath>

</subdomain>

<subdomain>
<srcPath>C:\usr\Rpas\Domains\GlobalDomain\ldom2</srcPath>
<dstPath>C:\usr\Rpas\Domains\ldom2</dstPath>

</subdomain>

<subdomain>
<srcPath>C:\usr\Rpas\Domains\GlobalDomain\ldom3</srcPath>
<dstPath>C:\usr\Rpas\Domains\ldom3</dstPath>

</subdomain>

</globaldomain>

</rpas>

The “globaldomain” tag should contain one “srcPath” tag, one “dstPath” tag, and a
“subdomain” tag for each sub-domain. Each “subdomain” tag should contain one “srcPath”
tag and one “dstpath” tag. Each “srcPath” tag should be a path to either the master or
sub-domain begins copied. Each matching “dstPath” tag should be a path to where to
copy that part of the domain.
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The copyDomain utility will validate the configuration xml file first before any files are
copied. If any of the sub-domain source paths do not match a sub-domain path of the
global domain being copied, a “can’t find source sub-domain ‘sub-domain” error will be
report. If the global domain being copied contains any sub-domain that doesn’t have a
matching “srcPath” tag, a “sub-domain ‘sub-domain’ doesn’t have a subdomain xml tag”
error will be reported. If the global domain “srcPath” tag doesn’t contain the path of a
valid global domain then an “invalid source path ‘srcPath” to global domain” will be
reported.

The destination paths in all cases will be validated when that part of the global domain is
being copied. Unless the switch -force is provided, the destination must not exist and
must be writable.

There are two options that control the number of sub-domains to be copied. These
options will still limit the number of sub-domains that are copied; however the
configuration file must still contain entries for all domains.

Move a Domain - moveDomain

Usage

The moveDomaiin utility provides the flexibility to move elements of global domains such
as individual local domains and the master domain to pre-specified locations based on a
given XML configuration file. The utility automatically updates RPAS metadata to reflect
the modified directory paths in local and master domains. This utility also ensures that
the globalDomainConfig.xml is updated as domains are moved.

The XML configuration being used will be simple and designed to fit the required task. It
will contain fields for the locations of the source master domain and destination master
domain as well as source and destination fields for each of the sub-domains that need to
be moved.

movedomain -version

movedomain -xmlConfigFile filename

movedomain -d master -srcSubDomain src -dstSubDomain dst

The following table provides descriptions of the arguments used by the moveDomain
utility.

Argument Description
-xmlConFigFi I(_a i This argument will allow movedomain to move a sub-
pathToXmlConfigFile.xml domain into user-instructed specific locations based

paths specified in an xml file. This argument should
not be used with the —d, -srcSubDomain, and
—dstSubDomain parameters.

—d pathTomaster This argument will allow movedomain to move each
sub-domain based on the user-specified paths. Enter
the path to the master domain.

—srcSubDomain src Path of the sub-domain to be moved.

—destSubDomain src Path where the sub-domain is to be moved.
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Format of the XML Configuration File

The XML configuration being used will be simple and designed to fit the required task. It
will contain fields for the locations of the source master domain and destination master
domain as well as source and destination fields for each of the sub-domains that need to
be moved. Here is a basic example of the XML configuration file.
<?xml version="1.0" encoding="UTF-8" standalone="yes" ?>
<rpas>
<globaldomain>
<srcPath>C:\usr\Rpas\Domains\GlobalDomain</srcPath>
<dstPath>C:\usr\Rpas\Domains\GlobalDomain2</dstPath>
<subdomain>
<srcPath>C:\usr\Rpas\Domains\GlobalDomain\ldom2</srcPath>
<dstPath>C:\usr\Rpas\Domains\ldom2</dstPath>
</subdomain>
<subdomain>
<srcPath>C:\usr\Rpas\Domains\GlobalDomain\ldom3</srcPath>
<dstPath>C:\usr\Rpas\Domains\ldom3</dstPath>
</subdomain>
</globaldomain>
</rpas>
The “globaldomain” tag must contain a “srcPath” tag and “dstPath” tag for the master
domain. The master domain will not be moved if “srcPath” and “dstPath” are the same.
It is essential to specify “srcPath” and “dstPath” for the master domain even if the master
is not intended to be moved; otherwise an error condition will be incurred.

“srcPath” and “dstPath” tags for local domains are required ONLY if the local domain is
intended to be moved; otherwise, the lack of tags for a specific local domain indicates
that the local domain will not be relocated. If “srcPath” and “dstPath” are identical for a
given local domain, it will not be moved.

When global domain “srcPath” and “dstPath” are different; i.e. when moving global
domains, all local domains that reside under the global domain folder and are not
included in the XML file, will be moved to the destination global domain folder. Other
local domains with a specified destination location will be moved according to the
configuration.

Assumptions and Requirements

The following rules apply to the XML configuration settings:

= All source and destination paths must be absolute.

= All source paths must correspond to existing directories.

= All destination paths must be valid, in the sense that:

= The parent of the destination directory must exist

=  The parent directory must be writable by the user.

= The destination directory itself must not exist.

=  The source and destination master domain paths are required.

= The source and destination sub domain paths are required only for the domains that
need to be moved.

*  The sub domains that need to be moved can be specified or those sub domains that
will remain under the master domain can be left out. If a sub domain is not specified,
it will be moved along with the master domain.

= If the xmlConfigFile contents do not abide by the above mentioned rules, the utility
does not clear the validation phase and terminates with the appropriate error
message.
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Minimum Space Requirement

Minimum space requirement for moving a global domain is the size of (just) master
domain plus the size of the largest local domain.

Setting Miscellaneous Domain Properties — domainprop

Usage

Use the domainprop utility to manipulate the properties of a domain. Specify password
properties, lock user accounts, and determine whether or not a daemon is currently
managing a domain. The domainprop utility can be run on a global domain master to set
values in all subdomains.

domainprop —d pathToDomain —expirePassword {days} {—passwordHistory
{oldPasswordCount}} {—property propertyname=value} {—lockAccount {failedLogins}}

The following table provides descriptions of the arguments used by the domainprop
utility.

Argument Description

—d pathToDomain Specifies the domain path.

—property propertyname=value | Used to specify the property to be changed.

See the table of available properties below that can be set with
this utility. To view the current property setting, use the
property command with no value.

Note: Do not use this argument with —expirePassword,
—passwordHistory, or —lockAccount.

-reportSubDomains Use this option to show property values for subdomains
(should all match).

Available Properties

Domain Property Name | Type Description

disable_commit_asap Boolean [ If this property is set to TRUE, the ability to use “Commit
ASAP” in the File menu of the RPAS Client is disabled.
Furthermore, the “Commit ASAP” radio button on the
workbook close dialog is disabled.

By default, this property is set to FALSE.

disable_commit_later Boolean [ If this property is set to TRUE, the ability to use “Commit
Later” in the File menu of the RPAS Client is disabled.
Furthermore, the “Commit Later” radio button on the
workbook close dialog is disabled.

By default, this property is set to FALSE.

domain_name String | If this property is set, the domain name is displayed on the
“About” page of the RPAS Client (menu Help->About).
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Domain Property Name

Type

Description

help_path

String

This property defines the path to the help files. It is set
when using custom help files for the RPAS Client instead of
the default help files that are provided with the RPAS
Client installation. These files need to be in “WebHelp”
format. This path would normally be a path to a network
folder where the common help files are located. The folder
must have a file named “Start.htm”. This file is the starting
point for the custom help.

The default RPAS help has several pages for context
sensitive help. Help searches for these folders in the preset
relative location from the root folder of WebHelp. If an
implementation uses custom help, it must locate the context
help files in the expected default locations relative to that
folder. Otherwise, context sensitive help will not be
available and an error will be raised every time the user
tries to invoke context sensitive help for a particular
function.

If this property is not set, the path specified in the
foundation.ini file of the Client machine is used. If a path is
not specified in that file, help looks in the default location
in the RPAS Client installation for help files. If the default
files have been removed, help is not available.

For the location of the foundation.ini file, see the
“Translation Administration” section.

insert_measure_disabled

Boolean

If this property is set to TRUE, the “insert measure...” item
under the Edit menu is disabled.

By default, this property is set to FALSE.

meas_fillclr_precedence

Boolean

By default, when deciding which color to fill a particular
cell with, RPAS grid uses the following order or formatting
settings: Read-only, Measure, Hierarchical, and then
Read/Write. That is, if the cell is in a read-only state, it will
use the read-only formatting setting. However, if that is not
the case, the grid will check if there is any Measure level
formatting. Failing to find it will fall through to checking
for the hierarchical setting and then the read-write setting.

However, some customers want RPAS to follow a different
priority order for fill color formatting decision making.
They want it to try Measure, then Read-only, then
Hierarchical, and finally Read /Write. This change from
default can be made by setting this domain property to
TRUE. To reset behavior, this domain property can be reset
to FALSE.

measure_locking_disabled

Boolean

If this property is set to FALSE, the user can lock a measure
on a work sheet. By default, this property is set to FALSE.
To disable measure locking, set this property to TRUE.

126 Oracle Retail Predictive Application Server




Calculation Engine — mace

Domain Property Name | Type Description

ovr_def_admin_privileges | Boolean | Using the Security Administration workbook,
administrators can set workbook template access for every
user in the system. Non-administrative users cannot access
the workbook templates to which they have not explicitly
been given access. However, if a user is an administrator,
by default they can see all the workbooks in the system.

Some retailers want to prevent this from happening.
Reasons for this include reducing clutter and having
different kind of administrators that manage different
administrative tasks in their RPAS systems.

Ability to control template access for administrators from
the Security Administration workbook is made possible by
setting this domain property to TRUE. By default, this
property is FALSE.

Calculation Engine - mace

The mace utility (Multi-dimensional Array Calculation Engine) allows the administrator
to evaluate rule groups or expressions in order to manipulate measures. mace supports
the use of the RPAS calculation engine in batch.

The mace utility is most commonly used to run a rule group or an expression, but can also
be used to:

= create rules and rule groups

= add rules to rule groups

= add expressions to rules

= delete rules not contained in a rule group
= remove any or all rule groups

* validate expressions

= print a list of rules or rule groups

Parallelization: The mace utility can execute in parallel under the following
circumstances:

1. The utility must be invoked on a master domain.

2. Parallelization is only applicable to single-expression evaluation (—run —expression
argument). Parallelization does not apply to rule group evaluation.

3. The evaluated expression cannot be a SpecialExpression.

4. All of the measures appearing on the left hand side of the expression must be non-
HBI; that is, the base intersection of the measures must be below the partition level.

The mace utility creates multiple child processes based on the “~processes” argument and
each child mace process evaluates the expression in one local domain. This functionality
enables mace to achieve higher levels of CPU utilization using parallelization on systems
with multiple CPUs. It also simplifies the user script when the same expression must be
evaluated in all local domains.

Centralization: When running mace on a master domain, the following command line
options apply to the master as well as all local domains. For example, running
mace —d domain —newRule .. creates a new rule in the master and all local domains.

= _newRule: create a new rule in the domain
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-delRule: delete an existing rule from the domain

-addRule: add a new rule to a specific rule group

-removeRule: remove an existing rule from a specific rule group

-newGroup: create a new rule group in the domain

-remove Group: remove an existing rule group from the domain
-addExpression: add an expression to a specific rule

-purgeRules: remove all rules not contained in any rule group from the domain
-removeAllRuleData: remove all rule and rule group data from the domain

The behavior and usage of the following commands is unchanged:

-find: search all expressions for the specific measure and print all rules / rule
groups that use it

-check: validate the specific expression

-resolve: order but do not evaluate expressions within the rule group
-transit: rule calc engine by transitting over a list of rule groups
-print: print all specific rules and groups

-validate: validate rule groups
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Usage

mace -version

mace -d domainPath -find string

mace -d domainPath -newRule {-ruleName ruleName} {-label rulelLabel}
{-processes numProcesses}

mace -d domainPath -delRule ruleName (-processes numProcesses}

mace -d domainPath -addRule groupName: ruleName {-processes numProcesses}
mace -d domainPath -removeRule groupName:ruleName {-processes numProcesses}
mace -d domainPath -newGroup groupName {-label groupLabel}

{-processes numProcesses}

mace -d domainPath -removeGroup groupName {-processes numProcesses}

mace -d domainPath -addExpression ruleName -expression exprString
{-processes numProcesses}

mace -d domainPath -check -expression exprString

mace -d domainPath -run -group groupName {-debugRuleEngine}

mace -d domainPath -run -expression expString {-processes numProcesses}
{-debugRuleEngine}

mace -d domainPath -resolve groupName -measures measList {-debugRuleEngine}
mace -d domainPath -transit workbookName -group groupList {-debugRuleEngine}
mace -d domainPath -print -rule rulelList

mace -d domainPath -print -group groupList

mace -d domainPath -print -allGroups

mace -d domainPath -purgeRules {-processes numProcesses}

mace -d domainPath -removeAl lRuleData {-processes numProcesses}

mace -d domainPath -validate calc —-ruleGroup groupName

mace -d domainPath -validate general -ruleGroup groupName

mace -d domainPath -validate refresh -ruleGroup groupName -calcRuleGroup calc

The following table provides descriptions of the arguments used by the mace utility.

Argument Description
—d domainPath Specifies the domain in which to load the measure.
—Find string Use this argument to search all expressions for the

specified string, printing all the rules and rule groups
that have these expressions.

—newRule {-ruleName Use this argument to create a new empty rule. If

ruleName} desired, use the —ruleName argument to specify a
name for the rule.

—label {rulelabel | Use this argument to specify the label of the rule with

groupLabel} the —newRule argument or label of the group with the
—newGroup argument.

—-processes numProcesses Use this argument to specify the number of child

processes to be run in parallel.

—-delRule ruleName Use this argument to remove the specified rule.

—addRulle groupName:ruleName | Use this argument to add the specified rule to the
group specified by groupName.

-removeRule Use this argument to remove the specified ruleName
groupName:ruleName from the group specified by groupName.
—ewGroup groupName Use this argument to create a new rule group with

the specified name.

—removeGroup groupName Use this argument to remove the specified group and
non-shared rules in it.
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Argument

Description

—addExpression ruleName

Use this argument to add an expression to the
specified rule. —expression should be used with this
argument.

—check Use this argument to validate the specified
expression. —expression should be used with this
argument.

—run Use this argument to evaluate the specified

expression or rule group. —expression should be
used with this argument.

—-resolve groupName

Use this argument to order (does not evaluate)
expressions within rule group.

Requires a comma-separated list of edited measures.

—transit workbookName

Use this argument to run a calc engine by
transitioning over a list of rule groups.

Requires the name of an existing workbook and a
comma-separated list of rule-group names.

—print {ruleList |
groupList | true}

Use this argument to print all the specified rules and
rule groups.

The ruleListis a comma-separated list of rule
names.

The groupList is a comma-separated list of group
names.

If "true" is supplied for either ruleListor
grouplList, all rules or rule groups are printed.

—purgeRules

Use this argument to remove all rules not contained
in any rule groups.

—removeAl IRuleData

Use this argument to remove all rule groups and all
rules.

—validate {calc | general |
refresh}

Use this argument to validate rule groups.
Use calc to validate a calc rule group.

To validate a refresh rule group, use the refresh
parameter along with —calcRuleGroup to specify the
corresponding calc rule group.

For all other types of rule groups, use general.

—debugRuleEngine

Use this argument to generate a file "mace.log" in the
working directory for logging RuleEngine specific
debug information.

—expression exprString

Use the argument to specify the expression.

This argument is used in conjunction with the
—addExpression, —check, and —run arguments.

—group groupName

Use this argument to specify the rule group to
evaluate using the —run argument.

—Mmeasures measurelList

Use this argument to specify the measures to resolve.
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Argument Description

—group grouplList Use this argument to specify a list of group names,
separated by commas.

Use this argument in conjunction with the
—transitand —print arguments.

—rule ruleList Use this argument to specify a list of rule names,
separated by commas.

Use this argument in conjunction with the —-print
argument.

—allGroups Use this argument in conjunction with the —-print
argument to print all rule groups.

—addGroup Use this argument to create a new rule group with
the specified name

Managing Users - usermgr

Use the usermgr utility to add and remove users and groups, copy user and group
information to other domains, edit user and group information, and convert that
information from XML files to database files and vice versa.

With the usermgr utility, you can create user and administrator accounts using the
—addGroup command. This allows you to add many accounts at once. When you create
accounts, you must supply a temporary password that is used for all user accounts and a
temporary password that is used for all administrator accounts. These temporary
passwords expire the first time the user or administrator logs in.

Note that you can only create temporary passwords; you cannot create real ones. This is
in order to protect the security of the user and administrator accounts. For the same
reasons, the default accounts “adm” and “usr” are no longer available.

To create users and groups, you must create a database file called users.db, which
contains user and group information. Once you have created and imported the users.db
file into RPAS, it contains all user, administrator, and group information, including the
true passwords for each account. This file is an encrypted binary file that you cannot edit.

To edit any account information, you must convert the database file to an XML file using
the —convertDbToXml command. This creates an editable XML file that contains all the
information in the user.db file except for the true passwords of the accounts. Again, this
is to ensure the security and safety of the account information. Once you edit the XML
file with the changes you need to make, you must convert it back to a database file in
order to import it into RPAS. To convert it, use the —convertXmlTobb command.

Once the users.db file is created, it can be shared across multiple domains. To
automatically import the user, administrator, and group information every time a
domain is created, place the users.db file in the rpaslnstall input directory of the domain.
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Usage

usermgr
usermgr
usermgr
usermgr
usermgr
usermgr
usermgr
usermgr
usermgr
usermgr
usermgr
usermgr
usermgr

—d
—-d
-d
-d
-d
-d
-d
-d
-d
-d
-d

domainPath -add userName -label label -group grp {-admin}
domainPath —addGroup groupName —label label
domainPath -remove username

domainPath -removelLabel label

domainPath —removeGroup groupName
domainPath -list

domainPath -print -user username
domainPath -print -group groupname
domainPath —importDb {-replace}

domainPath —exportXml path

domainPath —exportDb path

—convertXmlToDb —src pathToXml —dest pathToDb
—convertbbToXml —src pathToDb —dest pathToXml

Note: -convertDbToXml and —convertXmlToDb do not require a
domain.

The following table provides descriptions of the arguments used by the usermgr utility.

Argument

Description

—d domainPath Specifies the path to a domain to add, remove, or get

information about a user.

—add userName Use this argument to add a user with a specified name.

Use the other arguments specified in the usage to add
those attributes for that user.

This prompts you to enter the temporary password for the
user.

—label label Use this argument to specify the label of the user or group

to add to the domain.
Use this argument with —add and -addGroup

—group grp

Use this argument to specify the user group of the user to
add to the domain.

—admin

Use this argument to specify that the user to add to the
domain has administrative rights.

—-addGroup groupName Use this argument to add a group with a specified name.

Use —label to specify the label for the group.

—remove userName Use this argument to remove the user with the specified

name from the domain.

-removelLabel label Use this argument to remove all users with this label.

-removeGroup groupName | Use this argument to remove a group with this

groupName.

—list

Use this argument to list all the users registered to the
specified domain.

—print

Use this argument to print the specified user or group
information.

—user username Use this argument to specify the user name in the specified

domain to print.

This argument is only applicable to 4print option.
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Argument

Description

—group groupname

Use this argument to specify the group in the specified
domain name to print.

This argument is only applicable to 4print option.

—importDb

Use the argument to import the database. The database
must be located in the domain’s input directory. The
database is time stamped and moved to the processed
directory upon successful completion.

Existing user are skipped unless —replace is used.

-replace

Use this argument to update existing users when using
—importDb.

The user label, groups that user belongs to, admin status,
and account lock status is updated. Password information
is not affected by the update.

—exportXml path

Use this argument to create an XML file that contains all
users and groups in the selected domain. Passwords and
password histories are not exported.

—-exportDb path

Use this argument to create a database that contains all
users and groups in the selected domain. This prompts you
for new temporary passwords for admin and user
accounts.

—convertDbToxXml

Use this argument to convert a user database to a user
XML file. Passwords are not included in the conversion.

—convertXmlToDb

Use this argument to convert a user XML file to a user
database. This prompts you for temporary passwords for
admin and user accounts.

-src path

Use this argument to specify the source file used in
—convertbbToXml and —convertXmlToDb.

-dest path

Use this argument to specify the destination file used in —
convertbDbToXml and —convertXmlToDb.

XML Schema

The XML schema contains information for all groups and users that are imported into the
domain. Since this file can be edited, it does not contain any password information. Each
group and user contains an XML attribute with the group or user name as well as the
following inner tags:

Outer Tag | Inner Tag Description

GROUP LABEL The group’s label.

USER LABEL The user’s label.

USER DFLT_GRP The user’s default group.

USER OTHER_GRPS | A comma-separated list that contains all other groups that the user
is associated with.

USER ADMIN If this value contains T, this user is an admin.

USER LOCKED If this value contains T, the user is locked when the file is imported.
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Note: All XML tags must be in all caps.

Below is a sample users.xml file.

<?xml version="1.0" %2>
<VERSION>1.0</VERSION>
<GROUPS>
<GROUP HNAME="adms">
<LABEL>Administrators</LRBEL>
</GROUE>
<GROUP NAME="grpl">
<LABEL>Group 1</LALEBEL>
</GROUP>
<GROUP NAME="grp2">
<LABEL>Group 2</LLBEL>
«/GROUP>
<GROUP NAME="grp3">
<LABEL>Group 3</LABEL>
</GROUP>
</GROUES >
<USERS>
<USER NZME="adml">
<LABEL>admin_ 1</LABEL>
(DFLT_GRF}adms{/DFLT_GRP}
<ADMIN>T</ADMIN>
< /USER>
<USER NMNZME="adm2">
<LAEEL}admin_2<ILA3EL}
(DFLT_GRF}adms{/DFLT_GRP}
<ADMINST</ADHMIN
<LOCKED>T</LOCKED>
< /USER>
<USER NZME="unsrl">
<LABEL>user 1</LABEL>
(DFLT_GRF}grpl{/DFLT_GRP}
<OTHER_GRFS>grp2<KOTHER_GRP5>
< /USER>
<USER NZME="nsr2":>
<LABFL>user 2</LABFL>
(DFLT_GRF}grpQ{/DFLT_GRP}
<OTHER_GRFS>grp1,grp3<fOTHER_GRP5>
< /USER>
<USER HNZME="usr3">
<LABEL>user 3</LABEL>
(DFLT_GRF}grpl{/DFLT_GRP}
<OTHER_GRPS}grpl</OTHER_GRP5}
< /USER>
< /USERS>

Use Cases

Below is a list of common use cases for the XML and database files.

Exporting from an Existing Domain

You can export from an existing domain using —exportDb or —exportXml. Exporting is
useful for sharing users with another domain or for creating backups.

Use —exportxml if you need to edit the users or groups. This can be used when you are
making bulk updates that apply to many users or groups. Once you have made changes
to the file, you must convert it back to a database by using the —convertxmlToDb and then
import the updated file using —importDb —replace.
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Use -exportDb if you do not need to edit the users or groups. This method produces a
binary file that is ready for import.

Importing into a Domain

You can import existing users.db by using —importDb. Importing is useful for bulk
insertion or updates of users and groups.

By default, existing users and groups are skipped. However, if —replace is used, existing
users are updated with the following information: user label, groups that the users
belong to, admin status, and account lock status. Group labels are updated for existing
groups.

Password information for existing users is not affected by the update. New users receive
temporary passwords that are stored in users.db.

Note that new users may not be created if the following conditions exist:
= A group already exists with the user name.

= If the user’s default group does not exist.

New groups are skipped if the following conditions exist:

* A user already exists with the group name.

Note: If a users.db is placed inside the rpaslnstall input
folder, the users within that file are automatically imported
upon domain creation.

Converting Between XML and Database

Since only users.xml can be edited and only users.db can be imported, it is necessary to
convert between the two formats when you need to edit and import users and groups.
For example, if you are creating users for the first time, you must first create those users
an XML file. Then you must convert that XML file to a database file using —
convertXmlToDb in order import the file. If you have an existing users.db that you need to
edit, convert it to xml using —convertDbToxml.

When converting from an XML to a database file, the following validation rules apply:
= The file must be a properly formatted XML file, otherwise the operation fails.
=  Groups and users without a NAME attribute are skipped.

=  Duplicate groups and users are skipped. Duplicate groups and users are those that
share the same NAME attribute of an existing group or user within the same XML
file. For instance, a new group called Sales cannot be created if a user or group
named Sales already exists.

=  Users without a DFLT_GRP field are skipped.

Note: If a user or group is skipped, a warning is logged.
Since warnings are not included in the default log level, you
should run this utility with warnings visible.
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Managing the Workbook Batch Queue — wbbatch

Usage

The wbbatch utility is used to manage workbooks in the workbook batch queue. The
workbook batch queue is updated by using the standard RPAS wizard Auto-Workbook
Build or using various options of the wbbatch utility.

The most common use of this utility is to build workbooks that have been scheduled to
be automatically built using the Auto-Workbook Build wizard in the RPAS Client.

When a user defers a workbook commit (using Commit Later), that workbook commit
process is added to the Commit Later queue which is committed using this utility. An
administrator can also add a workbook to the commit later queue with this utility.

RPAS provides the ability to update workbook data with domain data without having to
rebuild the workbook; this refreshing process is completed using a workbook’s default
refresh rule group. Workbooks are added to the queue to be refreshed and refreshed
using this utility.

The build and refresh operations can be executed in multiple, parallel processes using the
—processes argument.

Update Auto-Workbook Build Tasks when Using PNI Functionality

If PNI positions in a domain are changed, any auto-workbook build tasks in the
workbook batch queue for that domain need to be removed and recreated. If this is not
done, the positions in the domain hierarchies that were changed will not be included in
the workbook. The following steps illustrate this situation:

1. An auto-workbook build task is in the workbook batch queue.

2. Changes are made to the domain hierarchies. For example, PNI positions are deleted
and then reloaded.

An auto-workbook build task is created using the wbbatch utility.

The workbook will not include the PNI positions that were deleted and then
reloaded.

wbbatch -version

wbbatch -d pathToDomain -build workbookName

wbbatch -d pathToDomain —refresh workbookName

wbbatch -d pathToDomain —commit workbookName

wbbatch -d pathToDomain —scheduleRefresh workbookName

wbbatch -d pathToDomain —unscheduleRefresh workbookName

wbbatch -d pathToDomain —scheduleCommit workbookName

wbbatch -d pathToDomain —unscheduleCommit workbookName

wbbatch -d pathToDomain -startQueue [all]build]refreshjcommit] [-processes max]
wbbatch -d pathToDomain -printQueue [all]build]refresh]|commit]

The following table provides descriptions of the arguments used by the wbbatch utility.

Argument Description
—d pathToDomain Specifies the domain containing the workbooks.
—build workbookName Runs workbook build for provided workbookName.
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Argument Description

—refresh workbookName | Refreshes workbooks scheduled to be refreshed using this
utility.

To refresh a single workbook in the queue, specify the
name of the workbook.

If no name is provided, all workbooks scheduled to be
refreshed will be completed.

—commit workbookName Commits workbooks with deferred commits.

To commit a single workbook in the commit later queue,
specify the name of a workbook.

If no name is provided, all workbooks in the commit later
queue will be committed.

—processes count Used with either —bui Id or —refresh to build or refresh
workbooks in the auto-workbook queue in parallel using
the specified number of parallel processes.

—scheduleRefresh Schedules a workbook to be refreshed later by adding it to
the workbook batch queue.

—unscheduleRefresh Removes a workbook from the workbook batch queue.

workbookName

—scheduleCommit Schedules a workbook to be committed later by adding it

workbookName to the workbook batch queue.

—unscheduleCommit Removes a workbook from the workbook batch queue.

workbookName

-startQueue Runs all workbooks in provided queue.

-printQueue Prints the contents of the queue argument.
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Workbook Manager — wbmgr

Use the Workbook Manager utility to inspect or remove the existing workbooks. It is
recommended that administrators use this utility to remove workbooks rather than
doing so manually.

Usage

wbmgr -version

wbmgr -d pathToDomain -list -all

wbmgr -d pathToDomain -list -user userName

wbmgr -d pathToDomain -print -wbList wbl,wb2, ...

wbmgr -d pathToDomain -remove -all

wbmgr -d pathToDomain -remove -user userName

wbmgr -d pathToDomain -remove -user userName -wbList wbl,wb2,...

The following table provides descriptions of the arguments used by the womgr utility.

Argument Description

—d pathToDomain Specifies the domain that contains the workbooks.

—list —all Lists all workbooks in the domain.

—list —user userName Lists all workbooks belonging to the user.

—print —wbList wbl,wb2,... |Prints detailed information about workbooks in the
list.

—remove —all Removes all workbooks from the domain.

—remove —user userName Removes all workbooks from the domain belonging
to the specified user.

—remove —user userName Removes all the workbooks in the specified list for

—wbList wbl,wb2 the specified user.

Register Measure — regmeasure

The regmeasure utility is used for batch measure registration. The following functionality
is included:

Register a new measure in the user-specified domain with the user-specified measure
properties. If the domain specified by the user is a global domain, this measure will
be registered in the master domain and all its local domains. The user must provide a
minimum set of measure properties, type and base intersection. Other measure
properties are optional, such as default aggregation and spreading method. If the
user omits an optional measure property, the measure will be registered with default
value of that property.

Unregister an existing measure identified by its name, from the user-specified
domain. If the specified domain is a global domain, this measure will be removed
from the master domain and all local domains. Unregistering a measure from a
domain will cause the measure definition and all the related measure data arrays and
supporting arrays to be removed from the domain.

Modify measure properties of an existing measure. Not all measure properties can be
modified, such as type, base intersection, and database name. These properties
cannot be changed once the measure is registered. Measure properties such as
default aggregation method, default spread method, base state, agg state, and so on
can be modified after the measure is registered.

138 Oracle Retail Predictive Application Server



Register Measure — regmeasure

Usage

regmeasure —version

regmeasure -d pathToDomain —add measureName —type typeName

(—baseint baselntersection]-scalar) {-label labelString} {-db dataDbPath}
{-navalue naValue} {-defagg aggType} {-defspread spreadType}

{-allowedaggs "aggTypel aggType2''}

{-refreshable (true|false)} {-insertable (true|false)}

{-basestate (read|write)} {-aggstate (read|write)}

{-stageonly (true|false)} {-Filename fileName}

{-loadint loadIntersectionString} {-clearint clearIntersectionString}
{-loadstokeep loadsToKeep} {-start fieldStart} {-width FieldWidth}
{-loadagg loadAgg} {-range range} {-purgeage purgeAge} {-viewtype viewType}
{-syncwith syncWith} {-description descriptionString} {-picklist}
{-materialized (persistent|display)}

{-lowerbound measurename} {-upperbound measurename}

{-attr attrName -attrpos attrPosName} {-scriptname scriptName}
{-specialval action:specval:behavior,action:specval:behavior, ...} {-fnhbi}
{-hybridaggspec hiername:aggop,hiername:aggop, ---}

{-periodstartvalue (true|false)}

regmeasure -d pathToDomain —modify measureName {-label labelString}
{-defagg aggType} {-defspread spreadType} {-allowedaggs "‘aggTypel aggType2..."}
{-refreshable (true|false)} {-insertable (true|false)}

{-basestate (read|write)} {-aggstate (read]write)}

{-stageonly (true|false)} {-filename fileName}

{-clearint clearintersectionString}

{-loadstokeep loadsToKeep} {-start fieldStart} {-width fieldWidth}
{-loadagg loadAgg} {-range rangeString} {-purgeage purgeAge]-clearPurgeAge}
{-viewtype viewType} {-syncwith syncWith} {-description descriptionString}
{-picklist]|-nopicklist} {-materialized (persistent|display)}

{-lowerbound measureName} {-upperbound measureName}

{-attr attrName -attrpos attrPosName} {-scriptname scriptName}

{-specialval action:specval:behavior,action:specval:behavior, ...}
{-hybridaggspec hiername:aggOp,hiername:aggop, ---}

{-periodstartvalue (true|false)}

regmeasure -d pathToDomain —remove measureName
The following table provides descriptions of the arguments used by the regmeasure

utility.

Argument Description

—d pathToDomain Specifies the path to the domain. A valid
domain path must be specified.

—add measureName Adds a measure with the specified name. Set
the values for the measure by using the
required arguments and any of the optional
arguments.

-type typeName Specifies the measure data type. It can be set to
int, real, string, date, or boolean.

Required with the —add option. Not available
with the —-modify option.
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Argument

Description

-baseint baselntersection|-scalar

Specifies the base intersection of the measure.
Non-scalar measures must use the —baseint
option. Scalar measures must use the —scalar
option.

Required with the —add option. Not available
with the —modify option.

-label labelString

Specifies the measure label. If not specified, it
defaults to the measure name specified for the
—add option.

-db dataDbPath

Specifies the database path for the measure’s
data arrays. A valid database path name must
be specified. If not specified, the measure will
be registered without a database. As a result,
the measure will not be able to store any data
in the domain. However, if the measure is not
a Display only type, it will still be assigned a
database in the workbook.

Not available with the —modify option.

-navalue navValue

Specifies the na value for the measure’s base
level data array. The navalue must be the same
type as the measure. For date, the navalue
must be formatted as
YYYYmmddHHMMSSsss'. If not specified, it
defaults to the type’s default value: 0 for
numeric type, false for boolean type, an empty
string for string type, and 0001/01/01 for date

type.
Not available with the —modify option.

-defagg aggType

Specifies the default aggregation method for
the measure. It must be an aggregation name
valid for the type of measure. For a list of valid
aggregation type names, see the RPAS
Configuration Tools User Guide. If not specified,
it defaults to the measure type’s default
aggregation method: Total for int and real,
Ambig for string and date, and OR for
boolean.

-defspread spreadType

Specifies the default spread method for the
measure. It must be a spread method valid for
the type of measure. For a list of valid spread
methods, see the RPAS Configuration Tools User
Guide. If not specified, it defaults to the
measure type’s default spread method: Ratio
for int and real, and Replicate for string, date,
and boolean.
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Argument Description
-allowedaggs ““aggTypel Specifies a list of aggregation methods that are
aggType2...” allowed for this measure. The aggregation

methods must be valid for the type of
measure. If not specified, it defaults to the
default allowed aggs for the type of measure.

For numeric (int or real type) measures: total,
total_pop, first, first_pop, last, last_pop, min,
min_pop, max, max_pop, average,
average_pop, popcount, nobcount, ambig,
ambig_pop, none, period_start_total,
period_end_total, period_start_average,
period_end_average, median, median_pop,
recalc, hybrid.

For string type measures: ambig, ambig_pop,
none, popcount, nobcount, first, first_pop, last,
last_pop, recalc, hybrid.

For date type measure: ambig, ambig_pop,
pop_count, nob_count, first, first_pop, last,
last_pop, min, min_pop, max, max_pop, non,
recalc, hybrid.

For boolean measure: boolean_and,
boolean_or, pop_count, nob_count, ambig,
ambig_pop, none, first, first_pop, last,
last_pop, recalc, hybrid.

-refreshable (true|false) Note: This option is no longer supported but is
kept for compatibility.
-insertable (true|false) Specifies whether the measure can be

dynamically inserted into the workbook. If not
specified, it defaults to true.

-basestate (read|write) Specifies the workbook access right for the
base array of the measure. If not specified, it
defaults to read. The access rights of this
measure will be further restricted by the RPAS
security features. As a result, write access
specified by this option does not guarantee
write access of this measure in a specific
workbook.

-aggstate (read|write) Specifies the workbook access right for the
aggregated level of the measure. If not
specified, it defaults to read. The access rights
of this measure will be further restricted by the
RPAS security features. As a result, write
access specified by this option does not
guarantee write access of this measure in a
specific workbook.
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Argument

Description

-stageonly (true|false)

Specifies whether the measure is a stage only
measure. If not specified, it defaults to false.
Measure data loaded by loadmeasure for stage
only measures will not be automatically
applied to the measure’s base data array. User
intervention is usually required to manually
approve the loaded measure data and apply
the approved loads to the measure’s base data
array.

—Filename fileName

Specifies the file name of this measure’s
loading file. It should not inlcude any
extensions. If not specified, it defaults to the
measure name in lower case.

-loadint loadIntersectionString

Specifies the intersection to load data for this
measure. It must be a valid intersection string
which is either the same or lower than the base
intersection of this measure. If loadintis
lower than the base intersection of the
measure, the aggregation method specified by
the —loadagg option will be used to aggregate
the loaded data to the base array of the
measure.

Not available with the —modify option.

—-clearint clearintersectionString

Specifies the clear intersection for the clear
load of this measure. For more information on
the various loading methods including clear
load, refer to the Loading Measure Data —
loadmeasure section in this guide.

-loadstokeep loadsToKeep

Specifies the number of temporary measure
load arrays to be kept in the staging database.
If not specified, it defaults to 1.

-start fieldStart

Specifies the starting column of this measure’s
data in the measure loading file. If not
specified, it is calculated based on the loadint
of the measure.

-width fieldWidth

Specifies the number of characters this
measure’s data occupies in the measure
loading file. If not specified, it defaults to the
default width of the measure type: 8 for
integer, real, and date, 24 for string, and 1 for
boolean.

-loadagg loadAgg

Specifies the aggregation method used to
aggregate the temporary load array to the
measure’s base array if the measure’s loadint
is lower than its baseint. If not specified, it
defaults to the measure type’s default
aggregation method: Total for int and real,
Ambig for string and date, and OR for
Boolean.
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Argument Description

-range rangeString Specifies the valid range for the measure. The
value of the range parameter depends on the
measure type.

For int or real types, the format is min:max
where min is the lowest possible value of the
measure and max is the highest possible value
of the measure.

For picklist measures, to give the allowed
options, the format of the string argument is
'a(Label A),b(Label B),c,d', where a, b, ¢, and d
are allowed measure values and Label A and
Label B are optional labels for the values. In
addition, the list of allowed options can be
changed dynamically with the cell the user is
clicking in. For this functionality, the
measure's range is specified as
‘measurerange=measurename’ where measure
name is the name of the measure that contains
strings in the above format of value/label
pairs.

For date types, the range must be in the format
‘mmddyyyy:mmddyyyy', where the first date
is the starting date of the range and the second
date is the ending date of the range. If the
range begins with a negative number (which
may confuse the command-line argument
parser), enclose the entire range string in
square brackets, such as -range [-10:10].

-purgeage (purgeAge) Specifies the number of days (or whatever the
base dimension of the calendar hierarchy is) of
measure data that should be kept in the
measure’s base data array after measure load.
This is used to keep the measure’s data size
small. If not specified, it defaults to -1 in which
case the measure data will never be purged.

When using the —-modify option, -purgeage or
—clearPurgeAge can be specified.

—-clearPurgeAge Resets the number of days (or whatever the
base dimension of the calendar hierarchy is) of
measure data that should be kept in the
measure’s base data array after measure load
to -1. This means that the measure data will
never be purged.

clearPurgeAge is only available with the
—modify option. When using the —modify
option, —purgeage or —clearPurgeAge can be
specified.
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Argument

Description

-viewtype viewtype

Specifies the view type of this measure on the
RPAS Client. The valid values are: 0 for none,

1 for view_only, 2 for sync_first_lag, 3 for
sync_lead_last, 4 for sync_first, and 5 for
sync_last. If not specified, it defaults to none. If
the view type starts with “sync”, the measure
is called a ‘Virtual Measure’.

A measure of sync_first_lag type must have
two sync measure names specified by the
-syncwith option. The first syncwith measure
name is a ‘Period Start Value’ type of measure,
like opening stock. Measure data at the
beginning period of the calendar is
synchronized with this period start value kind
of measure. The subsequent measure data is
synchronized with the other measure data but
lagged one period.

A measure of sync_lead_last type must have
two sync measure names specified by the
-syncwi'th option. The first measure is a
‘Period End Value’ type of measure. Measure
data at the last period of the calendar is
synchronized with this period end value.
Measure data of previous periods is
synchronized with the other measure lead one
period data.

A measure of sync_first type must have one
measure name specified by the -syncwith
option. The data of the beginning period is
synchronized with this syncwith measure.

A measure of sync_last type must have one
measure name specified by the —syncwith
option. The data of the ending period is
synchronized with this syncwith measure.

Measures of view_only type are
non-persistent. View only measures can only
be used in workbooks. Their measure data is
calculated during the Fetch process using a
calc expression usually specified in the
workbook’s calc rule group.
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Argument Description

-syncwith syncWith Specifies the measures that the measure must
be synchronized with. This option must be
specified if the measure is not a virtual
measure.

For sync_first_lag and sync_lead_last
measures, the syncwith option must have two
measure names separated by a comma. The
first measure is used to synchronize the data at
the first or the last calendar period. The second
measure is used to synchronize data at other
periods.

For sync_first and sync_last measures, the
syncwith option must be specified with a
single measure name that will be used to
synchronize the first or last calendar period.

-description descriptionString Specifies the description of the measure.

-picklist]-nopicklist Specifies whether the measure is displayed as
a picklist in the Client. The actual value of the
picklist is specified by the —range option of the
measure.

-nopicklistis only available with the

—modify option. It means the measure should
not be displayed as a picklist measure in the

RPAS Client.
-materialized Specifies whether the measure is persistent or
(persistent|display) display only on the RPAS Server side.

Persistent measures must have a valid
database and arrays to store the measure data.

Display only measures do not have permanent
data arrays associated with it. The data for a
Display only measure must be calculated on
the fly. As a result, Display only measures can
not be used on the RHS of any expression.
Display Only measures can still be used on the
LHS of a calc expression used in a workbook,
in which case a temporary array will be
created in the workbook to hold the temporary
data for the Display measure.

-lowerbound measureName Specifies a measure name that defines the
lower bound for each cell of the measure. The
difference between the —lowerbound and
-range options is that the —range option
specifies a single scalar as the lower bound for
all cells of the measure, but the lower bound
value specified by the —lowerbound option can
be different from cell to cell.
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Argument

Description

-upperbound measureName

Specifies a measure name that defines the
upper bound for each cell of the measure. The
difference between the -upperbound and
-range options is that the —range option
specifies a single scalar as the upper bound for
all cells of the measure, but the upper bound
value specified by the —upperbound option can
be different cell to cell.

-attr attrName

Specifes the measure attribute name. If not
specified, it defaults to no attribute is assigned
to the measure.

Note: If this option is specified, the —attrpos
option must also be specified.

-attrpos attrPosName

Specifies the measure attribute position name.
Combined with the —attr option, the measure
attribute provides a way to group measures
together based on measure attributes.

Note: If this option is specified, the —attr
option must also be specifed.

-scriptname scriptname

Specifies a shell script that must be executed as
part of a specific event. Currently, the only
script that is handled is to give the option of
selecting a hierarchy position name as the
content of a string measure. In other words,
when a user clicks in a cell, the user is
presented with a hierarchy dimension single-
tree pop-up. The format for this is
'SingleSelect(HIER="<HIER>", DIM="<DIM>")
where <HIER> and <DIM> should be replaced
with the actual names of the hierarchy and
dimension for which the single-tree pop-up
should be created.

-specialval
action:specval :behavior,

action:specval :behavior, . ..

Specifies a list of measure special values in the
form of “Action:SpecialValue:Behavior,...”.
The special values are stored in the domain’s
meta data database.

For Action, the only action supported is:
“DISPLAY”.

The only SpecialValue supported is
“NAVAL”.

For Behavior, “NULL” means translate any na
cell to a blank cell for display. “CELLVALUE”
means no translation, just display the navalue
as a regular value.

—fnhbi

Specifies that this measure is a “Forced
non=HBI"” measure, which means that
although the base intersection of this measure
is above the partition dimension, the measure
data must still be stored in each local domain.

Not available with the —modify option.
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Argument Description
-hybridaggspec Specifies the aggregation method to be used
hiername:aggOp,hiername:aggop, - - - | for each hierarchy in the base intersection. This

option is only valid when the default
aggregation method for the measure is hybrid.

-periodstatevalue (true|false) Specifies that this measure stores a “Period
Start” type of data, like beginning inventory.
PeriodStart measures usually use Period Start
Total or Period Start Average for the default
aggregation method. It also has different
behavior in elapsed lock. At the aggregated
calendar level, if the starting period is elapse
locked, then the whole aggregated period is
locked.

—modify measureName Modifies the measure with the specified name.
Set the updated values for the measure by
using any of the optional arguments.

—remove measureName Removes the measure with the specified name.

Register Token Measure - regTokenMeasure

The regTokenMeasure utility is used to register, list, and remove RPAS Token Measures.

RPAS Token Measure provides placeholder functionality for measure names in RPAS
expressions. An RPAS Token Measure is a special RPAS measure.

An RPAS Token Measure is always registered as a scalar measure of string type, with the
measure property called “tokenmeas” set to true. Its measure data holds a valid value
measure name as a single string. The data arrays for all token measures are stored in one
database called “token” under the data directory in the RPAS domain.

Token measure can be used in RPAS expressions by prefixing “@” in front of the token
measure name, either on the LHS or RHS of the expression. Before evaluation,
“@TokenMeasName” in the expression is replaced with the value measure name that is
associated with the token measure. As a result, the expression will be evaluated against
the value measure. A token measure name cannot be used in expression without the
prefixing “@”.

In the following example, TM1 is a token measure registered with the value measure
name VML.

The following expression:
@IMl=a+b

Will be evaluated as:
VMl=a+b

The following expression is not valid, because TM1 is used without prefixing it with “@":
TM1 = “sth”

If evaluated using mace, mace will throw a ParserException with the message that the
token measure “TM1” is used without prefixing “@”. This functionality prevents the

modification of the token measure’s data, which is actually the value measure’s measure
name.
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Usage

regTokenMeasure -version

regTokenMeasure -d pathToDomain —add tokenMeasure=valueMeasure {-fnhbi}
regTokenMeasure -d pathToDomain —list

regTokenMeasure —d pathToDomain —remove tokenMeasure=valueMeasure

The following table provides descriptions of the arguments used by the regTokenMeasure
utility.

Argument Description

—d pathToDomain Specifies the path to the domain. A valid
domain path must be specified.

—add tokenMeasure=valueMeasure Adds a token measure with the specified
token measure name and value measure that
the token measure points to.

—fnhbi If specified, the token measure will be
registered as an fnhbi measure in the global
domain. Its data will be stored in each local
domain rather than the global domain,
although by definition the token measure
should be always be HBI measure since its
scalar type.

—list Prints all token measure names and the value
measure names associated with the token
measure, which are registered in the domain
specified by the —d option.

—remove tokenMeasure=valueMeasure | Removes the token measure with the
specified token measure name and value
measure. The token measure is unregistered
from the domain specified by —d option.
Unregistering the token measure has no side
effect to the value measure that the token
measure is associated with.
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Informational Utilities

There are numerous RPAS utilities that can be used for finding information about many
of the different components of a domain or domain data. The following utilities are solely
for retrieving information and to not make any changes to a domain or data in a domain.

Retrieving Domain Information — domaininfo

The domaininfo utility is used to provide miscellaneous details about a domain, such as
the type of domain (simple, master, or sub/local), and the upgrade/version history of the
domain.

The domain path (-d) is required for all commands except —expectedversion.

Usage

domaininfo —d pathToDomain [Command]
domaininfo —expectedversion

The following table provides descriptions of the arguments used by the domaininfo
utility.

Argument Description

-d Path to the domain. Required for all options except
—expectedversion.

—domainversion Display the RPAS version of the specified domain.

—expectedversion Displays the expected RPAS version of the domain that the
utility expects to find.

—-apptag Displays the application associated with domain.

—history Displays the version history of the domain, specifically
when the domain was upgraded to new versions of RPAS
(patches or releases).

—xXnames Lists dimensions which use external names.

—type Command to display the type of the domain. Possible
values are Simple, Global, and Sub.

A Simple domain is a traditional, non-partitioned (non-
global) domain.

A Global domain is the central /master domain of a global
domain environment.

A Sub domain is one local domain in a global domain
environment that can contain one or more partitions.

—listsubdomains Displays a list of all the local domains in a global domain
environment, and indicates which positions at the partition
level are in each local domain. This argument is only valid
when run on a global domain.

-showrelativepaths When listing subdomains, indicates if paths are relative.
Only relevant in combination with —listsubdomains or
—all.
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Checking the Validity of a Domain — checkDomain

Argument Description

-masterdomaininfo Lists the master domain path and partition dims for
subdomains.

—subdomain dim,pos Indicates to which local domain the specified position

belongs. The position can be at or below the partition level.

—all Displays all of the above information about the domain.

-version Displays the version of this utility.

Checking the Validity of a Domain — checkDomain

Usage

This utility is used to check the validity of an existing domain. Its primary purpose is to
verify that a master domain matches its respective local domains and report all
discrepancies to the administrator.

checkDomain —d pathToDomain —type expectedType {-q}

The following table provides descriptions of the arguments used by the checkDomain
utility.

Argument Description

—d pathToDomain Path to the domain that needs to be validated.
—type expectedType Expected type of domain: simple, master, or sub.
—q Quiet mode. Do not display progress messages.

When checkDomaiin is run on a simple domain the following two items get validated:
* The domain directory exists
» Itis of type "simple"
If checkDomaiin is run on a Global Domain, it verifies the following:
* The global domain exists
= The global domain is of type "master"
* The global domain checks all of the sub-domains for:
— The sub-domain directory exists and is of type "sub"
— If the master domain and the sub-domain have a repos directory

— The measures, rules, rule groups, templates, and functions are the same in the
global and sub-domain

If it is run on a sub-domain, it checks all of the items listed above for the global domain,
but the validation is only performed between the global domain and the specified sub-
domain.

150 Oracle Retail Predictive Application Server



Determining RPAS Server Version — rpasversion

Determining RPAS Server Version - rpasversion

Use the rpasversion utility to determine which version of the RPAS Server is running in a
particular location.

Usage

rpasversion —l pathToLibrary

List Contents of a Database - listDb

Use listDb to list the basic information of all arrays contained in the databases provided.

Usage
listDb pathToDb*
listDb -row -db pathToDb*
listDb -row -pageUsage -db pathToDb*
listDb -row -standardOptions -db pathToDb*
listDb -standardOptions -db pathToDb*
listDb —version

The following table provides descriptions of the arguments used by the listDb utility.

Argument Description

—db pathToDb Specifies the database to list the contents.

-row List array information in a row format.

-pageUsage Show btree page usage. Requires —row switch to be active.
-standardOptions | List only standard options.

Printing Data from Arrays - printArray

Use printArray to print the contents of an array.

Usage

printArray —array db.array —specs {-maxpos num}

printArray —array db.array {—cell "diml:posl,dim2:pos2,..."

{—format "formatString'}

printArray —array db.array —slice "diml:posl,dim2:pos2,..."

{—format "formatString'"} {—cellsperrow num} {—noposnames}

printArray —array db.array —allpopulatedcells {—format "formatString''}
{——cellsperrow num} {—noposnames}
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The following table provides descriptions of the arguments used by the printArray
utility.

Argument Description

—array db.array Specifies the array to print.
Specify the full path to the database containing the array.
Required for all commands except —version.

dbis a full or relative path to a database. Do not specify the
.gem suffix. If no other commands are included, the array
defaults to —al Ipopulatedcel Is with cells per row 1. The
—-allpopulatedcel Is command is still available, but now
functions as a useful default action. The —noposnames,
—-cellsperrow, and —format parameters may still be specified
when relying on the implicit —al lpopulatedcells behavior.

—specs Prints the specifications of the array and positions along each
dimension.

—popcount Outputs only the popcount of the specified array. Useful to
shell script writers to get the popcount value into a shell script
variable. For example, export POPCOUNT="printArray -
array hmaint.dim_year -popcount™

—cell CELLSPEC Prints a specific cell value from the array. Must not contain
spaces. Must identify a single of 1-D slice. Specify using the
format “diml:posl,dim2:pos2,..”

-cellplain CELLSPEC | Outputs a specific cell value with no space padding.

Useful for scripts when capturing cell values into shell
variables. Must not contain spaces. Must identify a single of 1-
D slice. Specify using the format “diml:posl,dim2:pos2,..”

—slice CELLSPEC Prints a one-dimensional slice from the array. Must not contain
spaces. Must identify a single of 1-D slice. Specify using the
format “diml:posl,dim2:pos2,..”

—allpopulatedcells | Print all populated cells including the navalue of the array.

—format “fmtstr” If —Format is specified, any cells with numeric values are
interpreted as dates.

fmtstr (formatString) determines how dates are interpreted,
and can include:

= %Y -4 digit year

*  %m - month number (01 to 12)

*  %d - numeric day of month (01 to 31)
= %H - 24 hour clock (00 to 23)

= %M - minute (00 to 59)

= %S -seconds (00 to 61)

=  %s —milliseconds

—cellsperrow num For multi-cell output commands (-slice and
—-allpopulatedcel Is), indicates how many cells should be
printed on each line.

—noposnames Suppresses the output of position names, only cell values are
shown.
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Printing Data from Measures - printMeasure

Use the printMeasure utility to print measure information.

Usage
printmeasure -d domainPath {-wb wbName} {-m measure} [COMMAND]
The following table provides descriptions of the arguments used by the printVeasure

utility.

Argument Description

—d pathToDomain Specifies the domain that contains the measure
to print. Requires the -m parameter.

—Mm measure Specifies the measure to print.

-wb workbookName Specifies the workbook associated with the
measure to print.

If -wb is not used, the domain measure
information is printed. Requires the -m
parameter.

—list printMeasure will return a list of all registered
measures in the domain. This argument does
not require —d domainPath.

-listHBIMeasures In a global domain, printMeasure will return a
list of all measures registered at or above the
partition dimension.

—specs printMeasure returns the list of measure
properties. Requires the -m parameter.

—listDatalntersections printMeasure will return the base intersection
of the measure

—printData aggType. intersection | Prints out the nobs and nods format of the
measure array at the specified intersection and
agg type.
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RPAS ODBC/JDBC Driver

The RPAS ODBC/JDBC Driver provides a SQL interface to the Oracle RPAS embedded
database (OREDB), which includes both domain data and workbook data. This driver
presents OREDB as a relational database to ODBC and JDBC client applications. The
RPAS ODBC/JDBC Driver enables ODBC 3.51 Oracle Corporation JDBC 3.0 compatible
applications to connect to OREDB. Connectivity has been verified with the following
applications:

*  Oracle Business Intelligence Enterprise Edition
= Interactive SQL (ISQL) Utility
= JDeveloper

The RPAS ODBC/JDBC Driver enables system users to read measure data for stored
measures in an RPAS domain.

* Ina global domain environment, connection to local domains is not supported.
Access to local domain data is possible through queries in global domains.

= The ODBC/JDBC Driver does not provide support for Forced Non-HBI (FNHBI) and
non-materialized measures.

* The ODBC/]JDBC Driver reports only external position names in both dimension
tables and fact tables. Internal position names are not reported.

* Limited support is provided for conditional queries on measure data.

= The driver is not intended to replace the exportData utility, which is used for high-
speed data export to ASCII files.

Note: For information on installing the RPAS ODBC/JDBC
Driver, see the RPAS Installation Guide.

= The ODBC driver inherits the RPAS user privilege. Note that if a user is not allowed

to view any measures in RPAS, the user cannot view any measures through the
ODBC driver either.

ODBC Configuration

Overview

On Windows, UNIX, and Linux platforms, configuring the system to connect the ODBC
drivers and a domain environment consists of the following steps.

1. Install the ODBC server components. Refer to the RPAS Installation Guide.
Install the ODBC client components. Refer to the RPAS Installation Guide.
Start the RPAS ODBC Agent.

Configure the ODBC server components.

Configure the ODBC client components.

Create the ODBC data source name (DSN). This enables ODBC applications, such as
OBIEE, to connect to the domain environments configured in the ODBC server and
client configuration.

o o~ wbd
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7. Start the RPAS ODBC Data Service.

8. Test the connection using Interactive SQL.

Defining the ODBC Server Configuration Settings

On UNIX/Linux platforms, upon completion of the ODBC server installation, a directory
named odbcserver should be created under $RPAS_HOME. An RPAS ODBC Agent
process should be started automatically. This Agent process works with the GUI ODBC
Management Console installed on Windows PC to perform management and
configuration tasks. The Windows version of RPAS ODBC Server must be installed on
the Windows PC to make the ODBC Management Console available.

To define the ODBC Server configuration settings:
1. Add RPAS ODBC Manager in the Management Console.

a. From the Start menu, select Oracle RPAS ODBC Server and then Management
Console. The Oracle RPAS ODBC Management Console appears.

Note: When you start the Management Console for the first
time, an error message appears indicating the snap-in is not
registered.

‘i oaadmin60 - [Console RootiManager (localhost)] E|[E|rz|
Bﬁn File Action View Favorites Window Help = ﬂ
¢ & m @

(L3 console Root

Manager (Jocalhost]
ﬁ ger { ) @ MMC could not create the snap-in.

Console Manager Window Opened for First Time

b. To create a new work space, select File and then New.
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i Console1 - [Console Root] EE

Bﬁ File Action View Favorites Window Help .= H
mR @
be= | Console Root Marme

There are no items to show in this view.

Console Manager Window Showing Console Root Directory

To connect to a remote host, the Management Console is installed on a Windows PC
and the Agent service is installed on a remote server.
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c. Toadd a new snap-in, select File and then Add/Remove Snap-in to start the
wizard to add a new snap-in.

Add/Remove Snap-in

Standalone | Extensions |
|Use this page to add or remove a stand-alone snap-in from the console,
Snap-ins added to: |ﬁ "
Description
Add.. Remove Abo
Ok ] [ Cancel

Add/Remove Snap-in Dialog Box
d. Toadd a new snap-in, click Add.
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Add Standalone Snap-in

Available standalone snap-ins:

Snap-in Vendaor e
@, IP Security Monitor Microsoft Corpora’
@;, IF Security Policy Management Microsoft Corpora’
@ Link to Web Address Microsoft Corpora
ﬁmcal |Jsers and Groups Microsoft Corpora’
[EAorade Primary MMC Snap-In Cracle Corp.

(A oracle Retail RPAS 13.1 Manager 9

. Orade Retall RPAS ODBC Server 13.1.1M... EalEtaSy==e
ﬁ Performance Logs and Alerts Microsoft Corpora’
@Remuvable Storage Management Microsoft Corpora’ hd
< | =
Description
RPAS ODBC Server Manager

Add ] [ Close

Add Standalone Snap-in Dialog Box
e. Select Oracle Retail RPAS ODBC Server Manager and click Add.

Add Manager

Welcome to the RPAS ODBC Server Manager Snap-In

This wizard will guide yvou through the process of setting up 2 new Manager,
Choose one of the following modes and click Nesdt.

" Local Host

@ Ilze this option if pou want to administer
Services on the local host

f+ Hemate Host

@ |1z this option if pou want to administer
Services on a remate host

" Offline Configuration

& Troublezhooting only. Use thiz mode only
if you don't have a running Agent
available

%)

Mesd = ] [ Cancel

Add Manager Dialog Box Showing Selection of the Mode for a New Manager
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f. Select Local Host or Remote Host depending on the location of the server you
want to manage and then click Next.

Add Manager §|

Agent
Please enter the connection information to your Agent.
Click Finish to complete the wizard,

Specify the host on which your Agent is running.
The hozt can be zpecified by either the host name or the host address.

Huat: |

The part iz the TCP paort on which pour Agent iz istening.
The TCP port must be in the range 1024 to 65534,

TCF Part; |

Encrypted [55L): |

Add Manager Dialog Box Showing Connection Information to be Added for the Agent

g. On the Add Manager window, enter the address of the server host machine and
the TCP port number at which the RPAS ODBC Agent is listening.

h. If the Agent is not SSL enabled (which is the default), uncheck “Encrypted(SSL)”.
If the Agent is SSL enabled, check “Encrypted(SSL)”.

i. Click Finish. You are returned to the previous window. You can click Close or
OK to close the windows.
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2. From the Management Console, use the ODBC Manager to perform the required
configuration.

a. To configure for a remote host, click + to expand the ODBC Manager you just
added.

‘i Console1 - [Console Root] |Z”E| fgl

Bﬁu File Acton View Favorites Window Help

= x|
B 2
=] Corsole Root Name

= ﬁ Manager (localhost)

ﬁ Manager {Jocalhost)
M Mot connected to Unknown Service

Console Manager Window Showing Expanded Console Root Directory

b. To connect to the Agent service, click + in front of “not connected to Unknown
Service”. If the Logon to Service dialog box is displayed, log on using the user

name and password of a user who can administer the service on the local or
remote server.
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c. Expand Services by clicking +.

‘i Console1 - [Console Root] ._ E|&|

% File Action Wew Favorites Window Help _
m R @

=] Console Root Name

= ﬁ Manager {Jocalhost)
= ﬁ Connected to RPAS_ODBC_Agent
-3 Services
Ry RPAS_ODEC_Agent [active]
'% RPAS_Data_Service [active]
3 service Templates

[l Manager Jacalhost)

Console Manager Window Showing Expanded Connected to RPAS_ODBC_Agent Directory
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d. Set up the environment variables.

Note: This step only applies to RPAS_Data_Service running
on a Windows platform.

The “PATH” environment variable must be configured to include the following
paths:

— Path to the RPAS home library
— Path to the ODBC server binary
— Path to the ODBC server IP binary

i. Navigate to the following screen. The following figure shows the exact
screen you should see.

‘i oaadminé0 - [Console Root\Manager (localhost)\Connected to RPAS... |Z||E|r$__(|

[E‘n File  Action \Wiew Favorites Window Help - | H
c- B@EER2E YWmB
(21 Console Root Mame
= [ Manager (localhost) (5] General
= [l Conmected to RPAS_ODBC_Agent (5] Advanced
s guﬂlﬁ:s ODBC_Agent [active] @IP‘ Parameters
+ _ _Agent [active (& )
Installat te
= % RPAS_Data_Service [active] @L”S ] alion parameters
= Q Configuration & ngglng-
=B cervice Settings 5L Engine Parameters
(2] Ceneral (] service Se:.:urity
(=] advanced (5] User Security

@ IP Parameters
[5] Installation parameters
(=1 Logging
[EI S0L Engine Parameters
@ Service Security
[EI User Security
@I Data Source Settings
(=9 Profiles
Manitor
Service Event Trace
23 service Templates

Console Manager Window for Configuration

ii. Right-click on the blank space of the right panel.
iii. Select New/Attribute in the menu.

iv. Select “ServiceEnvironmentVariable” from the list for “Attribute”. In the
“Value” field, enter the following:
PATH={pathToRpasHomeLib};{pathToODBCServerBin};{pathToODBCServe
rIPBin}
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In the sample shown in the following figure, the following values are set:
— {pathToRpasHomeLib} is set to D:/src/rpas_head/rpasHome/lib

— {pathToODBCServerBin} is c:/odbcserver/bin

— {pathToODBCServerIPBin} is c:/odbcserver/ip /bin

New Attribute
Attrbute: |5 erviceEnvionmenty ariable -l
Type: String: (4096 characters)

Walue: PATH=D: /zrcd1paz_head/rpasHomedibe:/
odbezerver/bin:d /odbozerverfipdbin

k. | Cancel

New Attribute Dialog Box

v. Click OK.
e. [Expand Data Source Settings on the Console Manager window. You should find
a pre-configured data source named “gdom”.

Note: When you create a new data source, make sure that
most parameters of the new data source are identical to the
parameters of the pre-configured data source “gdom”,
except for DataSourcelPProperties and
DataSourcelPCustomProperties.

The DataSourcelPCustomProperties attribute contains pre-registered property names,
which are NOT to be modified.
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f. Under gdom, select IP Parameters.

‘il oaadminé0 - [Console Root\Manager (localhost)\Connected to RPAS_ODBC_Agent\Services\RPAS_Data_Service [a...

Bﬁ] File Action \View Favorites Window Help ;Iilil
€ 9 BHEEBE 2H V8

(Z3 Canscle Root # || Attribute Type Value

= [ Manager (ocalhost) b2 DataSourcelPType String  DAMIP

= 9 Connected to RPAS_ODBC_Agent
-0 services
4y RPAS_ODBC_Agent [active]
= % RPAS_Data_Service [active]
28, Configuration
= @ Service Settings
[ General
(50 Advanced
[ 1P Parameters
(3 1nstallation paramets
(= Logging
E) SQL Engine Paramet
(3 service Security
[5] User Security
=[50 Data Source Settings
HF Default
=-#2 gdom
[ 1P Parameters
[ User Security
(58 workarounds
[ Profiles
Monitor -
< | B = I

ﬁDataSourceIPProperﬁes String  DOMAIN_PATH=full_path_to_RPAS_domain
bz DataSourcelPCustomProperties  String WORKBOOK _SCHEMA=;LANGUAGE=;SHORT_DATE_FCR...

|

Console Manager Window with IP Parameters Selected under gdom

g. On the right panel of the window, double click DataSourcelPProperties attribute.
The following window appears.

DataSourcelPProperties Properties

General |

Attribute: D ataSourcel PPoperties

Type: String: [1024 characters]

Walle:

QK l [ Cancel Apph

DataSourcelPProperties Properties Dialog Box

Make sure the Value field has the keyword “DOMAIN_PATH=", and the string
after the “=" sign is the absolute path to the RPAS domain you want connect to
on the server side.

To connect to a domain on the local host, the following is an example of the path:
“DOMAIN_PATH=C:\RPAS\11\Test\ODBC\nt_testGlobalDomain”
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h. On the right panel of the window, double click the
DataSourcelPCustomProperties attribute. The following window appears.

DataSourcelPCustomProperties Properties E|PE|

General

Attribute:  |DataS ourcel PCustomProperties

Type: String: (16384 characterz]

Walue:

[ oK l [ Cancel

DataSourcelPCustomProperties Properties Dialog Box
Copy the value from the DataSourcelPCustomProperties of the sample “gdom”
data source to make sure all pre-registered properties are included.

3. Import the configuration changes:

a. To save the configuration, right click “Services” in the Console Manager
window. In the menu, select All Tasks and then Save Configuration.

b. To save the snap-in configuration, select File and then Save as. Select
<installdir>\admin\ oaadmin60.msc for the file name. This will overwrite the
original file (which was basically empty).

c. Stop and start the RPAS Data Service.

Right-click RPAS_Data_Service. In the menu, click “Stop RPAS_Data_Service” or
“Start_RPAS_Data_Service”. If you have made changes to any of the service
attributes, you need to restart the Data Service.

The RPAS ODBC Data Service is now ready to accept connections.

Defining the ODBC Client Configuration for Windows
To define the ODBC Client configuration settings:

1. From the Start menu, select “ODBC Administrator” under the “Oracle RPAS odbc
driver” menu item.

Note: Upon successful installation of RPAS ODBC Client, a
sample DSN named “SampleRPAS” is automatically created
and configured to connect to the data source “gdom” on the
server side. To create a new DSN, see the following steps.
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2. In the ODBC Data Source Administrator window, select Add to add a data source.

" ODBC Data Source Administrator

User DSN  System DSN l File DSM ] Drivers ] Tracing ] Connection Pooling ] About ]

System Diata Sources:

Mame | Driver |#_\ Add...
gdom COracle RPAS

lirt4 Cracle RPAS Bemove
ritBChom Cracle RPAS

ritrtf COracle RPAS Corfigure...
mas12124_db Oracle RPAS

Oracle RPAS

testfAog Cracle RPAS

test Domain Oracle RPAS B

test Hpwo COracle RPAS

testLinwx Oracle RPAS

unittest Dom Cracle RPAS b’

An QDBC System data source stores information about how to connect to
the indicated data provider. A System data source is visible to all users
on this machine, including NT services.

] | Cancel | | Help |

ODBC Data Source Administrator Dialog Box

3. In the “Create New Data source” window, select “Oracle RPAS”.

Create New Data Source [5__<|

Select a driver for which you want to set up a data source.

>

[Name

Microsoft ODBC for Oracle
Microsoft Paradox Driver (".db ]
Microsoft Paradow-Treiber (".db )
Microsoft Test Driver ("hi: ~.osv)
Microsoft Test-Treiber ™ bd; ~.csv)
Microsoft Visual FoxPro Driver
Microsaft Visual FoxPro-Treiber
Oracle RPAS

SGL Server

<

[ S o o S S ] e

|

|

| Finish | Cancel

Create New Data Source Dialog Box
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4. In the Oracle Retail RPAS ODBC Driver Setup window, enter the following

information:

* Name and description of the ODBC data source.

= Inthe “Service Host” field, enter the name of the server. If connecting to a service
running on a local host, enter “localhost” or the name of the local host server. If
the Agent service is running on a remote server, enter the name of the remote

host server.

= In the “Service Port” field, enter the port number that the data service is listening

on.

Note: This is the port number of the data service and not the
Agent service port number.

= In the Service Data Source field, enter the name of the service data source that
has been configued for the data service. The default for this field is “gdom”.

=  If the data service is not SSL enabled, uncheck “Encrypted(SSL)”. If the data
service is SSL enabled, check “Encrypted(SSL)”.

= Enter custom properties, if needed. Custom properties are entered in the format
of [name]=[value]. Multiple properties should be separated by a semicolon. For
example: LANGUAGE=]apanese;WORKBOOK_SCHEMA=DOMAIN_TO0

= The following table lists the available custom properties (all optional):

Property Name

Description

LANGUAGE

Name of the language you use. The RPAS ODBC/JDBC driver is
multi-language enabled. If data is in any language other than
English, the LANGUAGE property should be set to the name of
that language. If multiple languages are used in the domain, set
this property to the name of the language other than English. For
example, if some position names are in English and some are in
Japanese, then LANGUAGE should be set to Japanese.

The default is English.

WORKBOOK_SCHEMA

Name of the workbook you wish to connect to. If not set, the
driver connects to the domain.

SHORT_DATE_FORMAT

Valid short date format used in RPAS.

DEFAULT_SCHEMA

Default schema name if the table name in query is not qualified.
This property is set to DOMAIN by the default configuration.

AGG_TABLE_NAMES

This property can be set to a list of valid aggregate table names
separated by commas. When this is set, the driver will present
the tables specified in the system tables. When this property is
not set, the valid aggregate tables can still be queried even
though they do not exist in the system tables.

NORMALIZE_DIM_TABLES

Valid values are Yes and No. The default value is No.

If set to Yes, the dimension tables will only contain columns for
this dimension and its immediate parent dimension.

If set to No, the dimension tables will contain columns for this
dimension and all parent dimensions within the hierarchy.
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Oracle Retail RPAS ODBC Driver Setup

General lFaill:wer] About ]

Data Source Mame: |S ampleR PAS Help
Dezcription: |EIran::Ie RPAS ODBCAIDELC Driver Tranzlate. .
[ Use LDAP

Service Host: |I|:u:.alh|:|st

Service Part: |54321

Service Data Source; |gd|:|m J

[ Encrypted [S5L]

Cusztom Properties; |

Test Connect QK | Cancel Apphy

Oracle Retail RPAS ODBC Driver Setup Dialog Box

5. Click Test Connect. If the user security of the “gdom Data source setting” has been
set to DBMSLogon, the Logon to Data Source dialog is displayed. Enter the data
source user name and password configured for the data source.

Logon to Data Source [E|
Data Source User Mame: |adm OK
Data Source Password: | Cancel

Cuztom Properties: |DE FAULT _SCHEMA=DOMAIM

Logon to Data Source Dialog Box
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If the connection is successful, the following dialog box is displayed.

Oracle Retail RPAS ODBC Driver Setup

Connection test was successful,

Oracle Retail RPAS ODBC Driver Setup Dialog Box for Successful Connection
6. Click OK.

Starting the RPAS ODBC Server Process

The RPAS ODBC Agent and Data Services should have automatically started after
successful completion of the server installation.

The RPAS ODBC Data Service should be stopped and restarted using the Management
Console.

1. To stop a data service, right-click the service name and then click Stop in the menu.

2. Right-click RPAS_Data_Service and then click Start RPAS_Data_Service in the
menu.

‘7t 0aadmin60 - [Console Root\Manager (localhost)\Connected to RPAS_ODBC_Agent\Services\RPAS_Data_.. [= |[B)[X]

Bﬁ] File Action WView Favorites Window Help - = ﬂ
e BEEFRR 20 Va8
(2 console Root Mame Type
= § Manager Jocalhost) @\, configuration Folder
=] ﬁ Connected to RPAS_ODBC_Agent Monitor Folder
=0 senvices Service Event Trace Folder

iy RPAS_ODBC_Agent [active]

LM RPAS_Data_Service [active]

(3 service Templates

Console Manager Window with Data Service Selected

170 Oracle Retail Predictive Application Server



ODBC Client Configuration for UNIX

Testing the Connection Using Interactive SQL

Once the ODBC Server and ODBC Client have been configured, you can test the
connection using Interactive SQL. The RPAS ODBC Server process must be running.

1.

Select Start, All Programs, Oracle RPAS ODBC driver, and then Interactive SQL
(ODBCQ). The Interactive SQL command window appears.

Enter ‘connect <user name>*<password>@<dsn_name>" where <dsn_name> is the name
of the connection defined in the ODBC Server and ODBC Client configuration. The
following is an example.

‘connect adm*adm@SampleRPAS’

If the configuration is defined correctly, no errors are displayed.

ODBC Client Configuration for UNIX

Overview

Configuring the UNIX system to connect the ODBC drivers and a domain environment
consists of the following steps:

AU

Install the ODBC Server components. Refer to the RPAS Installation Guide.
Install the ODBC Client components. Refer to the RPAS Installation Guide.
Configure the ODBC Server components.

Configure the ODBC Client components.

Start the RPAS Data Service if it is not already started.

Test the connection using Interactive SQL.

Client Configuration

Both 32-bit and 64-bit ODBC Clients are available. They are delivered in directories
named odbcclient32 and odbcclient64 respectively. The configuration steps are identical
for 32 and 64-bit ODBC Client.

Note: For the remainder of this chapter, the 32 or 64-bit
ODBC Client are referred to as ODBC Client, and
odbcclient32 or odbceclient64 are referred to as odbcclient.

If it comes with RPAS, then odbcclient directory is under your $RPAS_HOME. If it comes
separately, the installer determines its location.

1.

Set up the environment for the ODBC Client.

If the ODBC client does not come with RPAS (meaning the odbcclient directory is not
under $RPAS_HOME), edit the oaodbc.sh file (oaodbc64.sh for 64-bit Client) in
odbcclient:

a. Make sure the following environment variables are set correctly:

— LIBPATH and OASDK_ODBC_HOME are set to the full path of the lib
directory inside the odbcclient directory

— ODBCINI is set to the full path of the odbc.ini file (odbc64.ini for 64-bit
Client), including the file name, inside the odbcclient directory

b. Source oaodbc.sh by running the following command in the odbcclient directory:
../oaodbc.sh
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2. Create and configure the data sources in odbc.ini.

The odbec.ini file in the odbcclient directory has three sections: [ODBC], [ODBC Data
Sources], and [SampleRpas] which is a section for the sample RPAS data source.

a. Edit the [ODBC] section: Set TraceDII to the full path to lib/odbctrac.so and
InstallDir to the full path of the odbcclient directory.

b. Edit the [ODBC Data Sources] section: Add an entry for the new data source you
are creating. The entry has the following format:
MyRPASDataSource= Oracle RPAS ODBC Driver
c. Create a new [MyRPASDataSource] section: The [SampleRPAS] section can be
copied and modified. In the new [MyRPASDataSource] section:
—  Set Driver to the full path of odbcclient/lib/ivoa22.so.
— Set Host to the name or IP address of the server.

— Set Port to the port number the RPAS_Data_Service listens at. This is not the
port number used by the RPAS ODBC Agent.

— ServerDataSource should be set to the name of the data source you created in
the server configuration. For [SampleRPAS], this entry is set to “gdom”,
since that is the data source created on the server as an example. This is
shown in the following figure.

i oaadmin60 - [Console Root\DpenAccess SDK 6.0 Manager (tcp:/imspdev43. .. |:||E|P5__(|
Bﬁn File Action View Favorites Window Help - |7 ﬂ
& 5]jea) XER EE VOGO

[£3 consale Roat
ﬁ Openaccess DK 6.0 Manager {ocalhost)

= [l Openaccess SOK 6.0 Manager {top: f/fmspde Eoz Type
= A Connected to RPAS_ODBC_Agent 8 1P Parameters Falder
=-E3 Openaccess SDK Services (59 User Security Folder

% RPAS_ODBC_Agent [active] (0 workarounds Falder

= % RPAS_Data_Service [active]
= “—S\L Configuration
@ Service Settings
= IEI Data Source Settings
= Default
=174 qdom
= IF Parameters
IEI User Security
[58 Workarounds
(58] Profles
Monitor
Service Event Trace
[[1 service Templates
[+ ﬁ Openaccess DK 6.0 Manager {top: /fatdev
Bl OpenAccess SDK 6.0 Manager {top: fjmspde

o

| #

| >

Console Manager Window with gdom Selected
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Testing the Connection

Once the ODBC Server and ODBC client have been configured, you can test the
connection using Interactive SQL. The RPAS ODBC Data Service must be started.

1. In the odbcclient directory, source oaodbc.sh if you have not already done so.

2. Change to the tools directory, run the executable odbcisql. Then at the ISQL prompt,
enter ‘connect <user Name>*<password>@<DataSourceName>" where
<DataSourceName> is the name of the data source you defined in odbc.ini as
described in the previous section. The following is an example.

‘connect adm*adm@MyRPASDataSource’

If the configuration is correctly defined, no errors are displayed.

Installing and Using the RPAS JDBC Driver

This section describes how to install, set up, and use the RPAS JDBC driver on all
UNIX/Linux and Windows platforms.

The RPAS JDBC driver is delivered in a single (zipped) jdbcclient directory. The user has
full control on the location of the jdbcclient directory. For installation guidelines, refer to
the RPAS Installation Guide.

Once the JDBC driver is installed on your system, you need to update the CLASSPATH
environment variable. This variable ensures that the JDBC client can access the
appropriate Java classes needed to connect to the database.

Updating Environment Variables for the JDBC Driver on Windows

1. Open System in the Control Panel. The System Properties window appears.

2. On the Advanced tab, click Environment Variables. The Environment Variables
dialog appears.

Environment Variables

User variables for gohsss

ariable

Value

C:\Documents and Settings\gohsss
C:\Documents and Settings\gohsss \Loc. ..
C:\Documents and Settings\gohsss \Loc. ..

)X

new || Edt || Deete |
System variables
Variable Value 3
ComSpec C:\WINDOWS \system32iemd. exe —
DISPLAY :0.0
FP_NO_HOST C... NO
JAVA_HOME C:\Program Files\JavaljZrel.4.2_10
MAN_CHM_INDEX ~ C:/PROGRA~1MKSTOO~1/mksntftkuti... &
new |[ Edt || Deete |
[ oK ” Cancel

)

Environment Variables Dialog Box
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3. Select the CLASSPATH from the System variables list and click Edit. The Edit
System Variable dialog box appears.

Edit System Variable

Variable name: CLASSPATH

Variable value:

Edit System Variable Dialog Box

4. Add the current working directory “.”,driver_home/driver/lib/ORjc jar,
driver_home/driver/ORssl14.jar, and driver_home/driver/ iaik_jce_fulljar to the
CLASSPATH environment variable and click OK.

Where driver_home is the location where the jdbcclient was installed. If your
jdbcclient was installed in C:/jdbcclient, you would have the following in your
CLASSPATH:

.;C:/jdbcclient/driver/lib/ORjc.jar; C:/jdbcclient/driver/lib/ORssl14._jar;
C:/jdbcclient/driver/lib/iaik_jce full_jar

Note: Separate paths with semi-colons ;).

5. After updating the environment variable, restart your PC.

Once you have updated the environment variables and restarted your PC, you are
ready to use the RPAS JDBC driver with any JDBC client.

Updating Environment Variables for JDBC Driver on UNIX/Linux

On UNIX/Linux systems, use “export” (or “set”, depending what shell you use) to add
the following to your CLASSPATH:

export CLASSPATH=.:jdbc_home/driver/lib/ORjc.jar:
Jjdbc_home/driver/l1ib/ORssl14_jar:
Jdbc_home/driver/lib/iaik_jce full._jar:$CLASSPATH

where jdbc_home is the full path of the directory where jdbcclient is installed. If you
installed jdbcclient at /usr/products/oracle, then you should replace jdbc_home with
/usr/products/oracle/jdbcclient.

The above export command can be added to your .profile.

Using the RPAS JDBC Driver

Any JDBC client needs the following information to use a JDBC driver to connect to a
database:

= A driver class

= A URL to the database specified in a form that the particular JDBC driver
understands
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For the RPAS JDBC driver, this information is specified as follows:

Driver Class: com.oracle.ard.jdbc.openaccess.OpenAccessDriver
URL: "jdbc:RPAS:/ / <host>:<port>;ServerDataSource=<DataSourceName>"

<host> is the name or IP address of the server, <port> is the port number the RPAS
Data Service listens at, and <DataSourceName> is the name of data source you
created for the RPAS Data Server (it is “gdom” in the default configuration).

Enabling Spy for RPAS JDBC Driver

Spy is a logging facility for JDBC driver. To enable spy for the RPAS JDBC connection:

1.

Add jdbc_home/spy/lib/ORy jar to your CLASSPATH where jdbc_home is the
installation directory of jdbcclient.

Set your driver class to com.oracle.ard.jdbcspy.SpyDriver

Use the following URL:

“jdbc:spy:{jdbc:RPAS:/ / <host>:<port>;ServerDataSource=<DataSourceName>};load
=com.oracle.ard.jdbc.openaccess.OpenAccessDriver;[key=value];...”

<host> is the name or IP address of the server, <port> is the port number the RPAS
Data Service listens at, and <DataSourceName> is the name of data source you
created for the RPAS Data Server (it is “gdom” in the default configuration). The key
and value pairs are the attributes of the Spy class.

The following table lists the available attributes:

Key and Value Description
log=System.out Redirects logging to the Java output standard, System.out.
log=(file)filename Redirects logging to the file specified by filename. For example,

C:\temp\spy.log

linelimit=numberofchars | The maximum number of characters, specified by numberofchars, that

Spy will log on one line.

When set to no (the default), there is no maximum limit on the number
of characters.

logLobs={yes | no} Specifies whether Spy logs activity on Blob / Clob. The initial default is
no.

logIS={yes | no | Specifies whether Spy logs activity on InputStreams.

nosingleread} When logIS=nosingleread, logging on InputStream and Reader objects

is active; however, logging of the single-byte read InputStream.read or
single-character Reader.read is suppressed to prevent generating large
log files that contain single-byte or single character read messages.

When set to no (the default), Spy does not log activity on InputStreams.

logTName={yes | no} Specifies whether Spy logs the name of the current thread.

When set to no (the default), Spy does not log the name of the current
thread.

timestamp={yes | no} Specifies whether a timestamp should be included on each line of the

Spy log.
When set to no (the default), Spy does not include a timestamp on each
line.
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Using the jdbcisql Utility Provided with RPAS JDBC Driver
Oracle Retail suggests that you use the jdbcisql.bat (for Windows) or jdbcisql.sh (for
UNIX/Linux) located in jdbcclient/isql to start jdbcisql. Edit jdbcisql.bat or jdbcisql.sh to
make sure it uses the appropriate URL (the argument of —u option):

jJava jdbcisgl -d com.oracle.ard.jdbc.openaccess.OpenAccessDriver -u
*"Jdbc:RPAS://<host>:<port>;ServerDataSource=gdom'*

Note: The value of the ServerDataSource setting in the URL
is case-sensitive on Windows and UNIX systems and has to
match the “Data source setting” defined for the data service.

When the application starts, enter the following to log in and make the connection (user
name = adm; password = adm) as shown below.
Connect adm*adm@

To enable Spy for jdbcisql, use a command line similar to the following:

java jdbcisql -d com.oracle.ard.jdbcspy.SpyDriver -u "jdbc:spy:{jdbc:RPAS:/ /
:/ / <host>:<port>;;ServerDataSource=gdom};load=com.oracle.ard.jdbc.openaccess.Open
AccessDriver;log=(file)C:\temp \spy.log;loglS=yes;logTName=yes;timestamp=yes"

Using Oracle SQL Developer

Create an XML file with the following content:

<?xml version = "1.0"?>
<IDOCTYPE connections>
<connections>
<connection>
<URL>"jdbc:RPAS: //<host>: <port>; ServerDataSource=<DataSourceName>""</URL>
<ConnectionName>MyConnection</ConnectionName>
<user>adm</user>
<ConnectionType>0THER_JDBC</ConnectionType>
<JdbcDriver>com.oracle.ard. jdbc.openaccess.-OpenAccessDriver</JdbcDriver>
</connection>
</connections>
= The URL should correspond to the URL specification required by the RPAS JDBC

Driver as specified in the preceding sections.

*  ConnectionName can be anything you like. This field can be changed later using the
client application.

= Enter a user name for the connection. This field can also be changed later using the
application.

= Leave the remaining information as shown in the code sample above.
To set up the connection:
1. Save this XML file with any name you like.

2. InSQL Developer, using the Tools/Preferences/Database/Third Party Drivers, add
the ORjc jar, Orssll4.jar, and iaik_jce_full jar files to the list of third party drivers
used by SQL Developer (SQL Developer does not look in the classpath for drivers).

3. Go to the Connection Navigator and right-click on Connections. Select Import
Connections.

4. Browse to the XML file. The dialog displays the list of connections you specified in
the file. Choose your connection, in the sample code, MyConnection.

176 Oracle Retail Predictive Application Server



Installing and Using the RPAS JDBC Driver

Using Oracle JDeveloper
Perform the following procedure to use Oracle JDeveloper with the JDBC driver:

1.
2.
3.

Start JDeveloper.
From the JDeveloper left panel, select the Connections tab.

Right-click on Databases, and select New Database Connection. The Create New
Database Connection wizard appears.

On the first screen of the Create New Database Connection wizard, enter a
connection name, and choose Third Party JDBC driver for Connection Type.

On the second screen, enter the user name and password, and then click Next.
On the third screen, perform the following:
a. Click New to add the driver.

b. Locate the library ORjc.jar, Orssll4 jar, and iaik_jce_fulljar files and their path.
These jar files are available from the installation of the RPAS JDBC Client.

c. Enter the RPAS JDBC Driver connection URL as specified at the beginning of this
section.

d. In the Driver Class field, enter
com.oracle.ard.jdbc.openaccess.OpenAccessDriver.

Follow the instructions to finish creating the connection.
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Using a Java Program
You can instantiate oadriver in your application by one of following methods:
* new oadriver();
= Class.forName
("com.oracle.ard.jdbc.openaccess.OpenAccessDriver') .newlnstanceQ) ;
Make sure driver_home/driver/lib/ORjc jar, driver_home/driver/lib/Orssl14.jar, and
driver_home/driver/lib/oaik_jce_fulljar are included in the CLASSPATH.
The Java code snippet below shows you how you can write a program that uses the
driver.
Java Code Sample:

import java.sql.*;
import jdbc.sql.*;

public class RPASDriverTest {
public RPASDriverTest() {

}
public static void main(String[] args) {
try {
if (args.length 1= 3) {
System.out.printin(C'Format:\n" +
"java RPASDriverTest <Database> <UID> <PWD>\n'");
return;
}
Connection conn = null;
Driver d =
(DOriver)Class.forName(*'com.oracle.ard. jdbc.openaccess.OpenAccessDriver') .newlnstan
ceQ:
String url = "jdbc:RPAS:";
String database = args[0];
String uid = args[1]:;
String pwd = args[2];

url += database;
conn = DriverManager .getConnection(url, uid, pwd);

DatabaseMetaData dma = conn.getMetaData();

System._out._printIn(C'"\nConnected to " + dma.getURL());

System.out._printin('Driver "o+
dma.getDriverName());
System.out.printIn(*'Version "o+

dma.getDriverVersion());
System.out.printin(""");

// sample query

String query = "SELECT * FROM DIM_ITEM";
Statement stmt = conn.createStatement();
ResultSet rs = stmt.executeQuery(query);
rs.close();

stmt.close();

} catch (SQLException ex) {
System_out._printin ('"\\n*** SQLException caught ***\n'");
while (ex = null) {
System._out._println ('SQLState: ' +
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Limitations

ex.getSQLState ());
System.out.println ("Message: ' + ex.getMessage ()):;
System.out._println ("Vendor: ' +
ex.getErrorCode );
ex = ex.getNextException ;
System.out.printin ('"");
}

catch (Java.lang.Exception ex) {
//Got some other type of exception. Dump it.
ex.printStackTrace ;

}
}

It is important to note the following limitations when performing data queries.

Contention

All domain data queries are allowed only in batch mode. The driver should not be
expected to query a domain while users are connected and commit changes to the
domain using the RPAS client. This limitation is due to the fact that the RPAS platform
implements an exclusive lock policy that allows either a single write process to a measure
or one or more read processes to a measure. This lock policy prohibits querying from a
domain during online operations.

The queries starve all workbook commits and other domain updates. In order to query
data during periods of online operations, a copy of the queried data must be created, and
all queries must be made against the copy. The copy of data should be refreshed during a
nightly batch.

Workbook Queries

All workbook queries must be performed against saved workbooks. The workbook can
be open or closed. The user has to save the workbook before reporting.
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Metadata

The following figure shows the metadata tables available in a domain or workbook.
These tables can be used to examine the structure of the domain, such as:

=  Which measures and dimensions exist within the database
=  Which hierarchies exist and what is their rollup structure

=  Which fact tables are available

Which measures exist at the intersections that they represent

When connected to a domain, an additional table (MD_WORKBOOK_SCHEMAS) is
available to list all accessible workbooks within the domain with their schema names.

MD_MEASURES MD_DIMENSIONS MD_FACT_TABLES MD_HIERARCHIES

PK | NAME PK |DIM_TABLE_NAME PK | NAME PK |NAME

LABEL DIM_LABEL DESCRIPTION
DATA_TYPE A A A

DEFAULT_AGG 4 T
DESCRIPTION

MD_HIERARCHY_SPECS

PK,FK1 |HIERARCHY NAME
PK,FK2 |DIMENSION NAME
PK,FK3 |ROLL UP NAME

MD_THBLE._MEASU RES MD_TABLE_INTERSECTIONS

PK,FK2 |FACT TABLE_NAME PK,FK1 |FACT TABLE_NAME
PK,FK1 | MEASURE_NAME PK.,FK2 |DIM_TABLE_ NAME

MD_WORKBOOK_SCHEMAS
PK |SCHEMA NAME

OWNER_NAME
WORKBOOK_LABEL
TEMPLATE_LABEL
CREATION_TIME
MODIFICATION_TIME

Database Diagram for All Metadata Tables in a Domain or in Each Workbook

Note: The MD_WORKBOOK_SCHEMAS table is not
included in workbooks.
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Fact and Dimension Tables

The following figure shows an example of the structure of fact and dimension tables and
the relationships between them. A fact table represents an intersection where one or
more measures’ data is stored. Each measure is represented by a column in the table.
Additionally, each dimension on the intersection is represented by a column. A record in
the fact table is uniquely identified by a unique combination of position names for the
intersecting dimensions.

A dimension table represents a dimension. It includes a column to list all position names,
their labels, and their rollup mapping to each dimension at higher levels in the hierarchy.

The fact and dimension tables have foreign key relationships between them to represent
the intersection and maintain data integrity between the dimensions and the facts.
Dimension tables have foreign key relationships with other dimension tables to represent
the hierarchical relationships between them.

DIM_RGN DIM_STYL DIM_CLSS
P PK | POSITION _NAME PK |POSITION NAME [—p» PK | POSITION _NAME
POSITION_LABEL POSITION_LABEL POSITION_LABEL
T FK1 | CLSS
DIM_AREA ?
DIM_SKU

PK | POSITION_NAME

PK | POSITION_NAME

POSITION_LABEL

FK1 | RGN CP:OSSéTION_LABEL
FK1 | CL
A P e [ STVl
DIM_STR
PK | POSITION_NAME
POSITION_LABEL DIM_DAY DIM_WEEK
FK1 | RGN PK | POSITION NAME PK | POSITION_NAME
FK2 | AREA POSITION _NAME EOSITION_NAME
POSITION_LABEL POSITION_LABEL
FK1 | YEAR FK1 | YEAR
FK2 | MNTH
FACT_STR_SKU_DAY_ > Eﬁ \’\/"V’\E‘E;
PK,FK3 |STR
PK,FK2 | SKU ¢
PK,FK1 | DAY
DIM_YEAR DIM_MNTH
STR_LABEL PK | POSITION NAME E PK | POSITION_NAME
SKU_LABEL R
EA&LQEEEW Low POSITION_LABEL POSITION_LABEL
-0 - FK1 | YEAR
R_EX_HDPSV_LOW —P
R_EX_LBLOWINTR
R_EX_UBLOWINTR

Example of Star — De-normalized Schema to Represent Facts and Dimensions in RPAS
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At connection time, all intersections at which any measure is stored at its base level are
available as fact tables within the database. Additional aggregate level intersections may
be made available in the database by specifying them in a custom connection property.
These fact tables are a part of the set of database entities that will be visible to reporting
tools at connection time. However, the RPAS ODBC/JDBC driver supports dynamic
aggregate level fact tables that can be queried even though they are not available at
connection time. These tables include all intersections that are logically above the base
intersection fact tables and have at least one measure in them when manifested. If the
measure existence condition is not met, the driver returns an error that the fact table
could not be found.

These dynamic fact tables are queried in the same fashion as the tables that are available
at connection time. The name of the fact table can be constructed by piecing together
dimension names (not labels) that make up the intersection in the order in which they
would exist within the domain. For example, if someone wants to query facts at the
store/class/day level but the fact table is not available at connection time, they can
construct the fact table name as: FACT_STR_CLSSDAY _. Note that dimension names
have been concatenated in the same order as the intersection and have been prefixed
with ‘FACT_". Also, note that a dimension name is assumed to be four characters long
and if the dimension name is less than four characters, it is padded with “_’ characters to
make it four characters long.

For information on limitations when performing queries, see the “Limitations” section.

Measure Security in the ODBC Driver

Before the existence of the ODBC/JDBC driver, an RPAS user could only use RPAS
workbooks to access measures. Consequently, the ODBC/JDBC driver emulates the
RPAS workbook security model to manage access rights to RPAS measures. It allows
users to view all measures that they could view using the templates to which they have
access.

This means that when users connect to a domain, they can see all the measures that they
could insert into a workbook. These include all measures that their templates have access
rights to (managed through the use of the Workbook Template Measure Rights
worksheet in the Security Administration workbook) and all measures to which the users
have explicitly been given access rights using the Measure Rights worksheet in the
Security Administration workbook. All other measures are not accessible to the users.

When users connect to a workbook, they can access all measures in the workbook,
irrespective of how those measures were brought into the workbook and irrespective of
whether access rights to some of those measures were removed after the workbook was
created. Since those measures exist in the workbook that the users can access, those
measures (their workbook copies) are accessible to the users.
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Use Cases

Using Metadata Tables to Explore the Structure of a Domain or a Workbook
1. Fetch the list of workbook schema names. In this example, the workbook is owned by
‘USERO01’, built using the template “TestTemplate’, and labeled ‘MyWorkbook'.
Select
SCHEMA_NAME, CREATION_TIME, MODIFICATION_TIME
From
MD_WORKBOOK_SCHEMAS
Where
OWNER_NAME = “USERO1” and
WORKBOOK_LABEL = “MyWorkbook” and
WORKBOOK_TEMPLATE = “TestTemplate’
The SCHEMA NAME obtained using this query can be directly used in the custom
properties of the driver configuration to enable direct connection to a workbook
instead of a domain.
2. List all measures in the domain or workbook (default schema).
Select
From
MD_MEASURES
3. Listall measures in a specific schema (for example, ' DOMAIN_T0").
Select
From
DOMAIN_TO.MD_MEASURES
4. Listall dimensions in the domain or workbook (default schema).
Select
From
MD_DIMENSIONS
5. Listall fact tables in the domain or workbook (default schema).
Select
From
MD_FACT TABLES
6. Listall hierarchies in the domain or workbook (default schema).
Select
From
MD_HIERARCHIES
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7. List all fact tables with the measures that are represented in those tables (default
schema).
Select
*
From
MD_TABLE_MEASURES
List all fact tables with the dimension table names that intersect in the fact table
(default schema).
Select
*
From
MD_TABLE_INTERSECTIONS
8. To understand the structure of a particular hierarchy (for example: CLND) the
following table will list the hierarchy with each of its dimensions and the roll up
dimension name for each one of them (default schema).
Select
*
From
MD_HIERARCHY_SPECS
Where
HIERARCHY_NAME = “CLND”

Querying Fact Data

1. Query fact data for all measures at the STR-SKU-DAY intersection with the unique
position names for these dimensions
Select
From

FACT_STR_SKU_DAY_

2. Query fact data for specific measures at the STR-SKU-DAY intersection and list them
with the position labels for each dimension
Select

DS.POSITION_LABEL, DU.POSITION LABEL, DD.POSITION LABEL, R EX LBLOWINTR,
R_EX_UBLOWINTR

From
FACT_STR_SKU DAY_ F,
DIM_STR DS,
DIM_SKU DU,
DIM_DAY DD
Where
DS_POSITION_NAME = F.STR and
DU_POSITION_NAME = F.SKU and
DD_.POSITION_NAME = F_DAY
Hint Join (FACT_STR_SKU DAY_, DIM_STR, DIM_SKU, DIM_DAY);
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Note: The optional “Hint” clause in the above SQL statement
is not ANSI SQL standard, but the ODBC /JDBC Driver
supports it. This “Hint” tells the driver to process the join
tables in the specified order (fact table first, and then
dimension tables).

Connecting to a Workbook

1.

4,

Select Start, Settings, Control Panel, Administrative Tools, and then Data Sources
(ODBO).

Select the System DSN tab. Select the appropriate DSN and click Configure.

In the Options fram, enter WORKBOOK_SCHEMA=<workbook schema name>.
Replace ‘<workbook schema name>" with the workbook schema name for the
workbook to which you want to connect. The workbook schema names can be
obtained by first connecting to the domain and then examining the
MD_WORKBOOK_SCHEMAS table to obtain the schema name for the appropriate
workbook (may be identified by owner name, template, creation and last
modification time). For example: ‘WORKBOOK_SCHEMA=DOMAIN_T0’ or
‘WORKBOOK_SCHEMA=SD0_T0’

Click OK.

Requesting Additional Aggregate Tables

1.

Select Start, Settings, Control Panel, Administrative Tools, and then Data Sources
(ODBQ).

Select the System DSN tab. Select the appropriate DSN and click Configure.

In the Options frame, enter AGG_TABLE_NAMES=<comma-separated list of any
additional aggregate fact table names>.

By default, the database includes every fact table (a fact table represents an
intersection) that one or more measures have as their base intersection. Any other
fact tables can be specifically requested by adding a comma-separated list as the
value for this custom property. For example, to see a fact table for the intersections
‘DEPT’ and ‘DEPT_YEAR’, the value of this custom property would be
‘AGG_TABLE_NAMES=FACT_DEPT, FACT_DEPT_YEAR'.

Click OK.

If entering more than one connection property (that is, both the
WORKBOOK_SCHEMA and AGG_TABLE_NAMES properties), the property key
value pairs must be separated by a semicolon. Using examples above, the content of
the custom properties input box would appear as follows:
WORKBOOK_SCHEMA=DOMAIN_T0,;AGG_TABLE_NAMES= FACT_DEPT,
FACT_DEPT_YEAR
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This section lists some sample ODBC/JDBC client applications that can connect to the
RPAS datastore through the RPAS ODBC/JDBC Driver. The examples in this section do
not include all client applications that can connect to the RPAS ODBC/JDBC Driver.

Note: In client/server configuration, the server (executable)
must be started before a client can connect to it.

Oracle Business Intelligence Enterprise Edition (OBIEE)

This section outlines how to connect to the defined DSN using the OBIEE Administration
Tool and how to import data from the DSN. For more information about OBIEE, refer to
OBIEE documentation. The user must install and configure the ODBC client first on the
OBIEE server host (refer to section ODBC Client Configuration for UNIX) and test the
connection. The ODBC client and the OBIEE server must both be 32-bit or 64-bit. The
administrator must source the oaodbc.sh or oaodbc64.sh script under the ODBC client
home directory before (re)starting the OBIEE server.

Configuring the ODBC Client for OBIEE

The following example provides a sample of configuring the ODBC client for OBIEE.

This example was developed for OBIEE on AIX, but the process is the same for other

environments.

1. Open the $BIEE_HOME/setup/odbc.ini file where $BIEE_HOME is the directory
where OBIEE is installed.

2. Set the TraceDII to the odbctrac.so that comes with RPAS odbcclient. Set InstallDir to
the RPAS odbcclient installation directory.

3. In the [ODBC Data Sources] section, insert an entry for RPAS domain.
Example:
rpas_domain=This is the name of the data source for RPAS.

The name here (rpas_domain) should be the same as the data source name configured
in the RPAS ODBC Server.

4. Create a section in the file for the rpas_domain. The following example is subject to
changes. Refer to the [SampleRPAS] section in odbc.ini or odbcé4.ini under ODBC
client home directory for all up-to-date settings.

Example:

[rpas_domain]

Driver= absolute_path to_odbc_client/lib[64]/ivoa22.so
Description=Oracle Retail RPAS ODBC Driver
Host=<RPAS ODBC Server host>
Port=<odbc_data_service_port>
ServerDataSource=<data_source_nhame>
UselDAP=0

DistinguishedName=

Encrypted=0

LoadBalancing=0

AlternateServers=

ConnectionRetryCount=0
ConnectionRetryDelay=3

CustomProperties=
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Save your changes to the file.

Connecting OBIEE to an RPAS Domain
To connect OBIEE to a predefined DSN for an RPAS Domain:

1.

Make sure the following Windows services are running:
=  QOracle BI Java Host
= Oracle BI Server

Start the OBIEE Administration Tool. Select Start, All Programs, Oracle Business
Intelligence, and then Administration.

From the File menu, select open — online. A window appears to enter login
credentials.

Enter the administrator’s user name and password, and then click open.

Three panels now appear in the Admin Tool window: Presentation, Business Model
and Mapping, and Physical.

From File menu, select Import-From database. A window appears to select the
connection type and RPAS user information.

Select ODBC 3.5 for Connection Type, choose the appropriate DNS for the RPAS
domain, enter the RPAS user name and password, and then click OK.

The RPAS schemas and tables appear in a new window.

Select the objects you want to import, and then click import. Once the import is
complete, click Close.

A new physical model is created and listed in the Physical panel of the Admin Tool
window.

Expand the physical model. Double-click on connection to open “connection”
properties. Make sure the Connection Type is set to ODBC 3.5. Click OK to exit.

In the Admin Tool window, click Save to save your physical model.

Now that you have a basic physical model, you can build the business model and
presentation layer on top of it. For more information on the business model,
presentation layer, and OBIEE Web interface, refer to OBIEE documentation.

Microsoft Access
To connect using Microsoft Access:

1.
2.
3.

Start Microsoft Access.
Create a new (or open an existing) Access file (.mdb file).

From the File menu, select Get External Data— Link Tables (or Import if you want to
import the data from RPAS datastore to Access). A dialog box appears.

In the Files of type box, select ODBC Databases().

Click the Machine Data Source tab, and then double-click the pre-configured ODBC
data source from which you want to link.

At the logon prompt, enter your user ID and password, and then click OK.

At this point, MS Access connects to the RPAS data source and displays the list of
schemas/tables that you can import or link.

Click each table that you want to import or link, and then click OK. If you are linking
a table that does not have an index that uniquely identifies each record, then
Microsoft Access displays a list of the fields in the linked table. Select a field, or a
combination of fields, that will uniquely identify each record, and then click OK.
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JDeveloper

JDeveloper works best with a native JDBC driver, which is included in the RPAS
ODBC/]JDBC Driver package.

To connect using JDeveloper:

1. Start JDeveloper.

2. On the JDeveloper left panel, select the Connections tab.

3. Right-click on Databases, and select New Database Connection.
4

On the first screen of the Create New Database Connection wizard, enter a
connection name and select Third Party JDBC driver for Connection Type.

a

On the second screen, enter the user name and password, and then click Next.

6. On the third screen, click New to add the driver. It opens up the following dialog.
You need to find the jar files ORjc.jar, ORssl14 jar, iaik_jce_fulljar, and ORy jar and
their paths (they are made available from the installation of the JDBC Driver). Then,
create a library group “RPAS JDBC Driver” with those four jar files.

In the Driver Class field, enter com.oracle.ard.jdbc.openaccess.OpenAccessDriver.

Then enter in the URL field:
jdbc:RPAS://{host_name}:{port_number};ServerDataSource={data_source_name},
where host_name is the host name or IP address of the ODBC server, port_number
is the RPAS_Data_Service port number and data_source_name is the Data Source
Name which is configured on the ODBC server.

® Register JOBC Driver

Driver Class: |u:u:um.u:urau:le.ard.jdbc.openaccess.Open.ﬁ.ccessDriver |

Library: |RPF\SJDBCDriver | | Erowse... |

Classpath: | CHRPASIDEC \driveribyORssll 4. jar; CARPASIDEC spyiibl ORy . jar ; CARPASIDEC \Wdrivert ibyORjc. jar |

| Help | | (04 J | Cancel |

Register JDBC Driver Dialog Box

7. Follow the instructions to finish creating the connection.

Once the connection is established, a user can expand the Connection (and the nodes
under the Connection) to browse the objects in the RPAS datastore. A user can also
open a SQL worksheet (by selecting SQL Worksheet from the Tools menu) to
write/execute SQL statements.

XML Publisher

This section describes how to make the connection from XML Publisher to RPAS using
JDBC driver (XML only supports JDBC).

1. Install and configure the J]DBC client driver and ODBC/JDBC server. Start the server.

2. Copy the JDBC client jar files ORjc.jar, ORssl14 jar, iaik_jce_full jar, and ORy jar
(from JDBC client installation) to D:\OraHome_1\oc4j\j2ee\home\applib, where
D:\OraHome_1 is the root directory where XML Publisher was installed.

3. Start the XML Publisher server (Select Start, All Programs, Oracle XML Publisher
Server, OUIHomel, and then Oracle XML Publisher Enterprise Start).
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4, Starta Web browser and go to the URL: http:/ /localhost:15101/xmlpserver/

This URL is only an example. Contact the XML Publisher administrator/installer for
the actual URL. The actual URL is recorded in
D:\OraHome_1\xmlpserver\setupinfo.txt file of the XML Publisher server machine.

5. Login as admin/admin.

Select the Admin tab and then select JDBC Connection under Data Sources to create
a JDBC connection.

7. Click Add Connection to create a new connection and provide the following
information:

* Enter a display name for Data Source Name.

= Enter
jdbc:RPAS://{host_name}:{port_number};ServerDataSource={data_source_nam
e} for the URL, where host_name is the host name or IP address of the ODBC
server, port_number is the RPAS_Data_Service port number and
data_source_name is the Data Source Name which is configured on the ODBC
server.

* Enter adm for user name and password.

= Enter “com.oracle.ard.jdbc.openaccess.OpenAccessDriver” for Database Driver
Class.

8. Click Test Connection. The confirmation message: “connect established
successfully” should appear.

9. Click Apply to save the connection.

Interactive SQL (ISQL) Utility
ISQL is an interactive SQL tool that is provided by the ODBC/JDBC SDK.

To connect to remote ODBC/JDBC server, use odbcisql.exe (with ODBC client installed)
or jdbcisgl.class (with JDBC client installed).

Note: Users are expected to know basic SQL to use ISQL.

To connect to the ODBC/JDBC server using odbcisq], start odbcisql and then, at the SQL
prompt, issue the connect command as follows:

connect john/doe@rpasDomain

Where john/doe is a predefined administrator account in RPAS, and rpasDomain is a pre-
configured Data Source Name.

Issue the connect command for jdbcisql.class as follows:
connect john*doe@rpasDomain

Once connected, users can issue various SQL DML and DDL statements to inspect and
modify the data in the RPAS datastore.

Supported and Unsupported SQL Functions

This section contains the following information:
* Detailed descriptions of various functions supported by the RPAS ODBC Driver.
= Descriptions of the SQL92 and SQL99 functionalities that are not supported.
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Supported SQL Functions
Use extreme caution when applying functions to any dimension name or label columns,
because the driver is not able to use the corresponding internal indexes to optimize row
selection when functions are applied to those columns (which could be a significant
performance hit).

It is suggested that users avoid applying functions to dimension name or label columns,
whenever possible.
Consider the following query:

Select * from fact_str_sku day
where convert(day, SQL DATE) = curdate();

Even though this query selects the data for only one day, the driver has to scan the entire
fact table, and then apply the convert function to every row of the table.

Working with OBIEE, the same can be achieved using a variable, which holds the
converted string value of the current date (in the same format as the “day” column). The
query then becomes:

Select * from fact_str_sku day
Where day = @curDateString;

The driver only reads the rows that meet the condition.

Numeric functions

Function Description

ABS(numeric_exp) Returns the absolute value of numeric_exp. For example:

SELECT ABS(-1.0), ABS(0.0), ABS(1.0) FROM emp WHERE empno
=1;

This returns 3 result columns with values 1, 0, and 1.

ACOS(float_exp) Returns the arccosine of float_exp as an angle, expressed in radians.
For example:

SELECT ACOS(-1) FROM emp WHERE empno = 1;
This returns 3.14159.

ASIN(float_exp) Returns the arcsine of float_exp as an angle, expressed in radians.
For example:

SELECT ASIN(-1.0) FROM emp WHERE empno = 1;
This returns -1.57079.

ATAN(float_exp) Returns the arctangent of float_exp as an angle, expressed in
radians. For example:

SELECT ATAN(45.0) FROM emp WHERE empno = 1;
This returns 1.54857.

ATAN2(float_exp1, Returns the arctangent of the x and y coordinates, specified by
float_exp2) float_exp1 and float_exp2, respectively, as an angle, expressed in
radians. For example:

SELECT ATAN2(35.175, 129.44) FROM emp WHERE empno = 1;
This returns 0.2653399.
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Function

Description

CEILING(numeric_exp)

Returns the smallest integer greater than or equal to numeric_exp.
The return value is of the same data type as the input parameter.
For example:

SELECT CEILING(123.45), CEILING(-123.45), CEILING(0.0) FROM
emp WHERE empno = 1;
This returns 124, -123 and 0.

COS(float_exp)

Returns the cosine of float_exp, where float_exp is an angle expressed
in radians. For example:

SELECT COS(14.78) FROM emp WHERE empno = 1;
This returns -0.59946542.

COT(float_exp)

Returns the cotangent of float_exp, where float_exp is an angle
expressed in radians. For example:

SELECT COT(124.78) FROM emp WHERE empno = 1;
This returns -0.82045588.

DEGREES(numeric_exp)

Returns the number of degrees converted from numeric_exp
radians. For example:

SELECT DEGREES(3.143) FROM emp WHERE empno = 1;
This returns 180.0806.

EXP(float_exp)

Returns the exponential value of float_exp. For example:
SELECT EXP(378.615) FROM emp WHERE empno = 1;
This returns 2.69404760606322E+164

FLOOR (numeric_exp)

Returns the largest integer less than or equal to numeric_exp. The
return value is of the same data type as the input parameter. For
example:

SELECT FLOOR(123.45), FLOOR(-123.45) FROM emp WHERE
empno = 1;

This returns 123 and -124.

LOG(float_exp)

Returns the natural logarithm of float_exp. For example:
SELECT LOG(5.175643) FROM emp WHERE empno = 1;
This returns 1.64396358.

LOG10(float_exp)

Returns the base 10 logarithm of float_exp. For example:
SELECT LOG10(145.175643) FROM emp WHERE empno = 1;
This returns 2.161893758.

SELECT LOG10(0), LOG10(-1), LOG10(1) FROM emp WHERE
empno =

1;
This returns -1.#INF, -1.#IND and 0

MOD(integer_exp1,
integer_exp2)

Returns the remainder (modulus) of integer_expl divided by
integer_exp2. For example:

SELECT mod(empno, 2) FROM emp WHERE empno = 11;
This returns 1.
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Function

Description

PI()

Returns the constant value of pi as a floating-point value. For
example:

SELECT PI() FROM emp WHERE empno = 1;
This returns 3.14159265358979.

POWER (numeric_exp,
integer_exp)

Returns the value of numeric_exp to the power of integer_exp. For
example:

SELECT POWER(2, -5), POWER(2, 5) FROM emp WHERE empno
=1,

This returns 0, 32.

RADIANS(numeric_exp)

Returns the number of radians converted from numeric_exp
degrees. For example:

SELECT RADIANS(45.0) FROM emp WHERE empno = 1;
This returns 0.785398.

RAND([integer_exp])

Returns a random floating-point value using integer_exp as the
optional seed value. For example:

SELECT RAND(0) FROM emp WHERE empno = 1;
This returns 38.

ROUND(numeric_exp,
integer_exp)

Returns numeric_exp rounded to integer_exp places right of the
decimal point. If integer_exp is negative, numeric_exp is rounded to
linteger_exp | places to the left of the decimal point. For example:

SELECT ROUND(123.344, 2), ROUND(123.345, 2) FROM emp
WHERE

empno = 1;

This returns 123.34 and 123.35.

SELECT ROUND(748.58, -1), ROUND(748.58, -2), ROUND(748.58,
3), FROM emp WHERE empno = 1;

This returns 750, 700 and 1000.

SIGN(numeric_exp)

Returns the positive (+1), zero (0), or negative (-1) sign of the given
expression. For example:

SELECT SIGN(empno) FROM emp WHERE empno = 11;

This returns 1.

SELECT SIGN(-1 * empno), SIGN(0) FROM emp WHERE empno =
1;

This returns two result columns with values -1 and 0.

SIN(float_exp)

Returns the sine of float_exp, where float_exp is an angle expressed
in radians. For example:

SELECT SIN(1.570796) FROM emp WHERE empno = 11;
This returns 0.999999.

SQRT(float_exp)

Returns the square root of float_exp. For example:
SELECT SQRT(45.35) FROM emp WHERE empno = 11;
This returns 6.7342.
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Function

Description

TAN(float_exp)

Returns the tangent of float_exp, where float_exp is an angle
expressed in radians. For example:

SELECT TAN(0.785398) FROM emp WHERE empno = 11;
This returns 0.999999.

TRUNCATE(numeric_exp,
integer_exp)

Returns numeric_exp truncated to integer_exp places right of the
decimal point. If integer_exp is negative, numeric_exp is truncated to
linteger_exp | places to the left of the decimal point.

NCHAR(code)

Returns the Unicode character that has the specified code as a
SQL_WCHAR value. The valued of code should be between 0 and
65535. Example: “SELECT NCHAR(945)” returns the character o.

String Functions

Function

Description

ASCII(string_exp)

Returns the ASCII code value of the leftmost character of
string_exp as an integer. For example:

SELECT ASCII(ename) FROM emp WHERE ename =
'Adam’;

This returns 65 which is the ASCII code of A.

BIT_LENGTH(string_exp)

Returns the length in bits of the string expression. For
example:

SELECT BIT_LENGTH(ename) FROM emp WHERE
ename = John';

This returns 32, which is the number of bits.

CHAR(code)

Returns the character that has the ASCII code value
specified by code. The value of code should be between 0
and 255; otherwise, the return value is data source-
dependent. For example:

SELECT CHAR(65) FROM emp;

This returns A which is the character for ASCII code A.

CHAR_LENGTH(string_exp)

Returns the length in characters of the string expression, if

CHARACTER_LENGTH(string_exp) the string expression is of a character data type; otherwise,

returns the length in bytes of the string expression (the
smallest integer not less than the number of bits divided by
8). (This function is the same as the
CHARACTER_LENGTH function.) For example:

SELECT CHAR_LENGTH(ename) FROM emp where
ename = 'John';

This returns 4.
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Function

Description

CONCAT(string_exp1, string_exp2)

Returns a character string that is the result of
concatenating string_exp?2 to string_exp1. If either of
string_exp1 or string_exp2 is NULL value, it returns NULL
string.

If either of string_exp1 or string_exp2 is wide character
string, the return value is a wide character string. For
example:

SELECT CONCAT('Name is: ', ename) FROM emp
WHERE ename =

Tohn';

This returns 'Name is: John'

SELECT CONCAT(N'Name is: ', ename) FROM emp
WHERE ename

=N'ohn’;

This returns wide character string N'Name is: John'.

INSERT (string_exp1, start, length,
string_exp2)

Returns a character string where length characters have
been deleted from string_exp1, beginning at start, and
where string_exp2 has been inserted into string_exp,
beginning at start.

If string_exp1 is wide character string, the return value is a
wide character string. Offsets (start and length) must be
specified in number of characters. For example:

SELECT INSERT(ename, 1, 0, Name is: ') FROM emp
WHERE

ename = 'John';
This returns 'Name is: John'

SELECT INSERT(ename, 1, 0, N'Name is: ') FROM emp
WHERE

ename = N'John';

If ename is a column of wide character data type, this
returns wide character string: N'Name is: John'.

LCASE(string_exp)
LOWER(string_exp)

Returns a string equal to that in string_exp, with all
uppercase characters converted to lowercase. For example:

SELECT LCASE(ename) FROM emp WHERE ename is
V]’Oth;
This returns ‘john'.

LEFT(string_exp, count)

Returns the leftmost count characters of string_exp.

If string_exp is wide character string, the return value is a
wide character string. Offset (count) must be specified in
number of characters. For example:

SELECT LEFT(ename, 2) FROM emp WHERE ename =
Tohn';

This returns ‘jo'.

SELECT LEFT(ename, 2) FROM emp WHERE ename =
N'Tohn';

If ename is a column of wide character data type, this
returns wide character string N'jo'".

194 Oracle Retail Predictive Application Server




Supported and Unsupported SQL Functions

Function

Description

LENGTH(string_exp)

Returns the number of characters in string_exp, excluding
trailing blanks.

If string_exp is wide character string, the return value is a
number of wide characters in string_exp. Trailing blanks
are not checked in wide character implementation. For
example:

SELECT LENGTH(John '), LENGTH(John') FROM emp;
This returns 4 for both result columns as trailing blanks are
excluded.

SELECT LENGTH(N'John '), LENGTH(N'John') FROM
emp;

This returns 7 for the first result column and 4 for the

second result column. Trailing blanks are not checked in
wide character implementation.

LOCATE(string_exp1, string_exp2|[,
start])

Returns the starting position of the first occurrence of
string_exp1 within string_exp2. The search for the first
occurrence of string_exp1 begins with the first character
position in string_exp2 unless the optional argument, start,
is specified. If start is specified, the search begins with the
character position indicated by the value of start. The first
character position in string_exp2 is indicated by the value
1. If string_exp1 is not found within string_exp2, the value
0 is returned.

If string_exp?2 is a wide character string, returns the
starting position of the first occurrence of string_exp1
within the wide character string string_exp2. Offset (start)
must be specified in number of characters. If string _exp2
is a wide character exp, the result is computed by treating
both arguments as wide character string. For example:
SELECT LOCATE('h', Tohn', 1) FROM emp;

This returns 3 as 'h' is the found at the third position.
SELECT LOCATE(N'h', N'John', 1) FROM emp;

This returns 3 as N'h' is the found at the third position.

LTRIM(string_exp)

Returns the characters of string_exp, with leading blanks
removed. For example:

SELECT LTRIM(' ABC') FROM emp;
This returns 'ABC'.

OCTET_LENGTH(string_exp)

Returns the length in bytes of the string expression. The
result is the smallest integer not less than the number of
bits divided by 8. For example:

SELECT OCTET_LENGTH(ename) FROM emp WHERE
ename =

John’;
This returns 4.
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Function

Description

POSITION(character_exp1
character_exp2)

Returns the position of the first character expression in the
second character expression. The result is an exact numeric
with an implementation-defined precision and a scale of 0.

If character_exp1 and character_exp2 are wide character
strings, returns the position of the first wide character
expression in the second wide character expression. If
character_exp2 is a wide character string, the result is
computed by treating both arguments as wide character
strings. For example:

SELECT POSITION('abc', '1234abc def') FROM emp;
This returns 5.

SELECT POSITION(N'abc', N'1234abc def’) FROM emp;

This returns 5.

REPEAT((string_exp, count)

Returns a character string composed of string_exp
repeated count times.

If string_exp is wide character string, the return value is a
wide character string. For example:

SELECT REPEAT(ename, 2) FROM emp WHERE ename =
John;

This returns 'JohnJohn'

SELECT REPEAT(ename, 2) FROM emp WHERE ename =
N'John';

If ename is a column of wide character data type, this
returns N'JohnJohn'.

REPLACE(string_expl, string_exp?2,
string_exp3)

Search string_exp1 for occurrences of string_exp2, and
replace with string_exp3.

If string_exp1 is wide character string, the return value is a
wide character string. For example:

SELECT REPLACE(address, 'San Francisco', 'SFO') FROM
emp

where address = '100 Vanness, San Francisco';
This returns '100 Vanness, SFO'.

SELECT REPLACE(address, N'San Francisco', N'SFQO')
FROM

emp WHERE address = N'100 Vanness, San Francisco';

If address is a column of wide character data type, this
returns N'100 Vanness, SFO'.

RIGHT (string_exp, count)

Returns the right-most count characters of string_exp.

If string_exp is wide character string, the return value is a
wide character string. Offset (count) must be specified in
number of characters. For example:

SELECT RIGHT(ename, 2) FROM emp WHERE ename =
'Tohn';

This returns 'hn'.

SELECT RIGHT(ename, 2) FROM emp WHERE ename =
N'John';

If ename is a column of wide character data type, this
returns N'hn'.
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Function

Description

RTRIM(string_exp)

Returns the characters of string_exp with trailing blanks
removed. For example:

SELECT RTRIM('abc ') FROM emp;
This returns 'abc'.

SPACE(count)

Returns a character string consisting of count spaces. For
example:

SELECT ename+space(5)+ename FROM emp WHERE
ename =

John';
This returns 'John John'.

SUBSTRING(string_exp, start, length)
SUBSTR(string_exp, length)

Returns a character string that is derived from string_exp,
beginning at the character position specified by start for
length characters.

If string_exp is wide character string, the return value is a
wide character string. Offset (start and length) must be
specified in number of characters. For example:

SELECT SUBSTR(ename, 1, 3) FROM emp WHERE ename
="Tohn';

This returns 'Joh'

SELECT SUBSTR(ename, 1, 3) FROM emp WHERE ename

N'John';
If ename is a column of wide character data type, this
returns N'Joh'

UCASE(string_exp)
UPPER(string_exp)

Returns a string equal to that in string_exp, with all
lowercase characters converted to uppercase. For example:

SELECT UCASE(ename) FROM emp WHERE ename =
']-Olm';
This returns JOHN'.

UNICODE(string_exp)

Returns the Unicode code of the first character of the
string_exp as a SQL_INTEGER value. Example: “SELECT
UNICODE('afy')” returns an integer value of 945.
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Time / Date Functions

Function Description
CURDATE() Returns the current date. For example:
SELECT CURDATE() FROM emp;
Returns the current date as: 2008-10-25
CURTIME() Returns the current local time. For example:
SELECT CURTIME() FROM emp;
Returns the current time as: 10:20:05
CURTIMESTAMP() Returns the current local date and local time as a timestamp value.

For example:
SELECT CURTIMESTAMP() FROM emp;
Returns current date and time as: 2003-03-31 14:08:57

DATEADD( datepart , number
date)

TIMESTAMPADD( datepart ,
number , date )

Returns a new date time value based on adding an interval to the
specified date. The return date-time data type is same as the input
date value.

datepart: the parameter that specifies on which part of the date to
return a new value. Both ODBC notation and SQL Server notation
for datepart are supported.

Datepart Abbreviations

Year SQL_TSI_YEAR, year, yy, yyyy,
quarter SQL_TSI_QUARTER, quarter, qq, q
Month SQL_TSI_MONTH, month, mm, m
dayofyear DAYOFYEAR, dy, y

Day SQL_TSI_DAY, day, dd, d

Week SQL_TSI_WEEK, week, wk, ww
Hour SQL_TSI_HOUR, hour, hh

minute SQL_TSI_MINUTE , minute, mi, n
second SQL_TSI_SECOND, second, ss, s

The current implementation does not support millisecond and
fractional second specifications.

number: the value used to increment the datepart. If value is not an
integer, the fractional part of the value is discarded. For example,
if you specify day for datepart and1.75 for number, date is
incremented by 1.

date: an expression that returns a date or timestamp value or a
character string in a date-time format.
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Function

Description

DATEDIFF( datepart ,
startdate , enddate )

TIMESTAMPDIFFE( datepart ,
startdate , enddate )

Returns the number of date and time boundaries crossed between
two specified dates. startdate is subtracted from enddate. If startdate
is later than enddate, a negative value is returned.

datepart: the parameter that specifies on which part of the date to
calculate the difference. Both ODBC notation and SQLServer
notation for datepart are supported.

Datepart Abbreviations

Year SQL_TSI_YEAR, year, yy, yyyy,
quarter SQL_TSI_QUARTER, quarter, g4, g
Month SQL_TSI_MONTH, month, mm, m
dayofyear DAYOFYEAR, dy, y

Day SQL_TSI_DAY, day, dd, d

Week SQL_TSI_WEEK, week, wk, ww
Hour SQL_TSI_HOUR, hour, hh

minute SQL_TSI_MINUTE , minute, mi, n
second SQL_TSI_SECOND, second, ss, s

The current implementation does not support dayofyear,
millisecond and factional second specifications. For example:

SELECT DATEDIFE(year, hiredate, curdate())
FROM emp WHERE hiredate = '2000-10-01';

SELECT DATEDIFF(SQL_TSI_YEAR, hiredate, curdate())
FROM emp WHERE hiredate = '2000-10-01";

This returns 2 (assuming that the curdate() returns year 2002).

DAYNAME(date_exp)

Returns a character string containing the data source-specific name
of the day (for example, Sunday through Saturday or Sun. through
Sat. for a data source that uses English, or Sonntag through
Samstag for a data source that uses German) for the day portion of
date_exp. For example:

SELECT DAYNAME(2002-01-01"), DAYNAME('2002-01-02")
FROM

emp;

This returns 'Tuesday' and 'Wednesday'.

DAYOFMONTH((date_exp)

Returns the day of the month based on the month field in date_exp
as an integer value in the range of 1-31. For example:

SELECT DAYOFMONTH('2002-01-05") FROM emp;
This returns 5.

DAYOFWEEK((date_exp)

Returns the day of the week based on the week field in date_exp as
an integer value in the range of 1-7, where 1 represents Sunday.
For example:

SELECT DAYOFWEEK('2002-01-05") FROM emp;

This returns 7.

DAYOFYEAR(date_exp)

Returns the day of the year based on the year field in date_exp as an
integer value in the range of 1-366. For example:

SELECT DAYOFYEAR('2002-01-05") FROM emp;
This returns 5.
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Function

Description

HOUR(time_exp)

Returns the hour based on the hour field in time_exp as an integer
value in the range of 0-23. For example:

SELECT HOUR('22:20:20') FROM emp;
This returns 22.

MINUTE(time_exp)

Returns the minute based on the minute field in time_exp as an
integer value in the range of 0-59. For example:

SELECT MINUTE('22:21:20") FROM emp;
This returns 21.

MONTH(date_exp)

Returns the month based on the month field in date_exp as an
integer value in the range of 1-12. For example:

SELECT MONTH('2002-01-05") FROM emp;
This returns 1.

MONTHNAME (date_exp)

Returns a character string containing the data source-specific name
of the month (for example, January through December or Jan.
through Dec. for a data source that uses English, or Januar through
Dezember for a data source that uses German) for the month
portion of date_exp. For example:

SELECT MONTHNAME('2002-01-05) FROM emp;

This returns January.

NOW( )

Returns current date and time as a timestamp value. For example:
SELECT NOW() FROM emp;
This returns the current date and time: 2002-10-25 10:20:05.

QUARTER(date_exp)

Returns the quarter in date_exp as an integer value in the range of
1-4, where 1 represents January 1 through March 31. For example:

SELECT QUARTER('2002-01-05") FROM emp;
This returns 1.

SECOND(time_exp)

Returns the second based on the second field in time_exp as an
integer value in the range of 0-59. For example:

SELECT SECOND('22:21:20") FROM emp;
This returns 20.

WEEK ((date_exp)

Returns the week of the year based on the week field in date_exp as
an integer value in the range of 1-53. For example:

SELECT WEEK('2002-01-05") FROM emp;

This returns 1.

YEAR(date_exp)

Returns the year based on the year field in date_exp as an integer
value. For example:

SELECT YEAR('2002-01-01") FROM emp;
This returns 2002.
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System Functions

Function Description

DATABASE() Returns the name of the database corresponding to the connection
handle. (The name of the database is also available by calling
SQLGetConnectOption with the SQL_CURRENT_QUALIFIER
connection option.)

USER() Returns the user name in the DBMS. (The user name is also

available using SQLGetInfo by specifying the information type:
SQL_USER_NAME.) This can be different than the login name.

Aggregate Functions

Aggregate functions return a single row based on groups of rows, rather than on single

Trows.

Function

Description

AVG([ALL | DISTINCT]
expression)

Returns the average of the values in a group. Null values are
ignored.

SUM([ALL | DISTINCT]
expression)

Returns the sum of all the values, or only the DISTINCT
values, in the expression. SUM can be used with numeric
columns only. Null values are ignored.

COUNT({[ALL | DISTINCT]
expression] | *})

Returns the number of items in a group.

COUNT(*) returns the number of items in a group, including
NULL values and duplicates.

COUNT(ALL expression) evaluates expression for each row in a
group and returns the number of non-null values.
COUNT(DISTINCT expression) evaluates expression for each
row in a group and returns the number of unique, non-null
values.

MAX([ALL | DISTINCT]
expression)

Returns the maximum value in the expression.

MIN([ALL | DISTINCT]
expression)

Returns the minimum value in the expression.

Aggregate functions can appear in SELECT lists and HAVING clauses. If you use the
GROUP BY clause in a SELECT statement, OpenAccess SDK divides the rows of a
queried table or view into groups. In a query containing a GROUP BY clause, all
elements of the SELECT list must be expressions from the GROUP BY clause, expressions
containing aggregate functions, or constants. OpenAccess SDK applies the aggregate
functions in the SELECT list to each group of rows and returns a single result row for

each group.

If you omit the GROUP BY clause, OpenAccess SDK applies aggregate functions in the
SELECT list to all the rows in the queried table or view.

Many aggregate functions accept these options:

= DISTINCT causes an aggregate function to consider only distinct values of the

argument expression.

= ALL causes an aggregate function to consider all values, including all duplicates.
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For example:

SELECT max(sal), MIN(sal), AVG(sal) FROM emp;
SELECT deptno, MAX(sal), SUM(sal) FROM emp GROUP BY deptno;
SELECT deptno, COUNT(empno) FROM emp GROUP BY deptno;

= QOther Functions
DECODE

Syntax
DECODE (expr, [search, result]..., default)

Example

SELECT DECODE (deptno,10, “ACCOUNTING®,

20, “RESEARCH",

30, "SALES-|,

40, "OPERATION",

*NONE®)
FROM dept

To evaluate this expression, the OpenAccess SDK SQL engine compares expr to each
search value one by one. If expr is equal to a search, the OpenAccess SDK SQL engine
returns the corresponding result. If no match is found, the OpenAccess SDK SQL engine
returns default, or if default is omitted, returns null. The return value is the same data
type as the first result expression. The search, result, and default values can be derived
from expressions.

The OpenAccess SDK SQL engine evaluates each search value only before comparing it
to expr, rather than evaluating all search values before comparing any of them with expr.
Consequently, OpenAccess SDK SQL engine never evaluates a search if a previous search
is equal to expr.

The OpenAccess SDK SQL engine automatically converts expr and each search value to
the datatype of the first search value before comparing. The OpenAccess SDK SQL
engine automatically converts the return value to the same datatype as the first result. If
the first result has the datatype CHAR or if the first result is null, then the OpenAccess
SDK SQL engine converts the return value to the datatype of CHAR.

In a DECODE expression, the OpenAccess SDK SQL engine considers two nulls to be
equivalent.

If expr is null, the OpenAccess SDK SQL engine returns the result of the first search that
is also null. The maximum number of components in the DECODE expression, including
expr, searches, results, and default is 255.

Examples:

SELECT DECODE(empno, 1, "E1", 2, "E2", "DEFAULT") FROM emp;

# First Result expression is NULL. Result should be type
XO_TYPE_CHAR
SELECT DECODE(empno, 1, NULL, 2, "E2, "DEFAULT") FROM emp;

# Input expression is NULL, Result should match the result
of NULL search expr

SELECT DECODE(ename, "Bob®", *"My Bob®, "Mary®", "My Mary"®,
NULL, “New Name®", "Default Name®) FROM emp;

# no default value, so return NULL for non-match values
SELECT DECODE(empno, 1, "E1", 2, "E2") FROM emp;

# ERROR CHECKING
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# Invalid number of arguments

# Invalid syntax used with scalar function:DECODE. Function
expects 3 arguments.

SELECT DECODE() FROM emp;

SELECT DECODE(empno, 1) FROM emp;

# Conversion errors
# decode() Error converting value of result expression to
XoType:<4>

SELECT DECODE(empno, 1, 10, 2, 20, "abc®) FROM emp;

IFNULL, ISNULL, NVL

These functions allow NULL value to be replaced by a default value. OpenAccess SDK
supports IFNULL as defined by ODBC, ISNULL as defined by SQL Server, and NVL as
defined by Oracle.

Syntax

IFNULL (expr, default val)
ISNULL (expr, default val)
NVL (expr, default val)

The OpenAccess SDK SQL engine evaluates the input expression and returns the
expression value if it is non-NULL. If the expression value is NULL, default_val is
returned. The return value is of the same data type as the input expression.

Example

SELECT ename, IFNULL (sal, 1000) FROM emp;
SELECT ename, ISNULL (sal, 1000) FROM emp;
SELECT ename, NVL (sal, 1000) FROM emp;

SELECT ename, IFNULL (hiredate, "2001-01-01") FROM emp;

CAST

Syntax
CAST (value_exp AS data_type)

Example

SELECT empno, CAST(empno AS VARCHAR) FROM emp
SELECT empno, CAST(empno AS SMALLINT) FROM emp

The function returns the value specified by value_exp converted to the specified
data_type, where data_type is one of the following:

= CHAR

= NUMERIC
= DECIMAL
= INTEGER

= SMALLINT
= FLOAT

= REAL

= DOUBLE

= DATE

RPAS ODBC/JDBC Driver 203



Supported and Unsupported SQL Functions

= TIME

= TIMESTAMP

= VARCHAR

= LONGVARCHAR
= BINARY

= VARBINARY
= LONGVARBINARY

=  TINYINT
= BIT
= WCHAR,

= WVARCHAR
= WLONGVARCHAR
The following table defines the precision, length, and scale keywords of the CAST

function.
Keyword Value
CHAR 255
BINARY 255
BIT 1
DATE 6
DOUBLE 8
FLOAT 8
INTEGER 4
LONGVARBINARY 1000000
LONGVARCHAR 1000000
NUMERIC 34
SMALLINT 2
REAL 4
TIME 6
TIMESTAMP 16
TINYINT 1
VARBINARY 1024
VARCHAR 1024
WLONGVARCHAR 2000000
WVARCHAR 512
WVARCHAR 2048
CHAR, BINARY 255
DATE 10
DOUBLE 15
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Keyword Value
FLOAT 15
INTEGER 10
LONGVARBINARY 1000000
LONGVARCHAR 1000000
NUMERIC 32
REAL 7
SMALLINT 5

TIME 6
TINYINT 3
VARBINARY 1024
VARCHAR 1024
WCHAR 255
WVARCHAR 1024
WLONGVARCHAR 1000000
NUMERIC 5

All other types 0
CONVERT
Syntax

CONVERT (value_exp, data_type)

Example

SELECT empno, CONVERT(empno, SQL_VARCHAR) FROM emp

SELECT empno, CONVERT(empno, SQL_SMALLINT) FROM emp
The function returns the value specified by value_exp converted to the specified

data_type, where data_type is one of the following:

SQL_CHAR
SQL_NUMERIC
SQL_DECIMAL
SQL_INTEGER
SQL_SMALLINT
SQL_FLOAT
SQL_REAL
SQL_DOUBLE
SQL_DATE
SQL_TIME
SQL_TIMESTAMP
SQL_VARCHAR
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* SQL_LONGVARCHAR

= SQL_BINARY

= SQL_VARBINARY

* SQL_LONGVARBINARY

=  SQL_TINYINT

= SQL_BIT

* SQL_WCHAR

= SQL_WVARCHAR

* SQL_WLONGVARCHAR

The following tables define the length, precision, and scale keywords of the CONVERT

function.
Keyword Length
SQL_CHAR 256
SQL_BINARY 256
SQL_BIT 1
SQL_DATE 6
SQL_DOUBLE 8
SQL_FLOAT 8
SQL_INTEGER 4
SQL_LONGVARBINARY 1000000
SQL_LONGVARCHAR 1000000
SQL_NUMERIC 34
SQL_SMALLINT 2
SQL_REAL 4
SQL_TIME 6
TIMESTAMP 16
TINYINT 1
VARBINARY 1024
VARCHAR 1024
WLONGVARCHAR 2000000
WVARCHAR 512
WVARCHAR 2048
Keyword Precision
SQL_BINARY 255
SQL_BIT 1
SQL_CHAR 255
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Keyword Precision
SQL_DATE 10
SQL_DOUBLE 15
SQL_FLOAT 15
SQL_INTEGER 10
SQL_LONGVARBINARY 1000000
SQL_LONGVARCHAR 1000000
SQL_NUMERIC 32
SQL_REAL 7
SQL_SMALLINT 5
SQL_TIME 8
SQL_TINYINT 3
SQL_VARBINARY 1024
SQL_VARCHAR 1024
SQL_WCHAR 255
SQL_WVARCHAR 2048
SQL_WLONGVARCHAR 1000000
Keyword Scale
SQL_NUMERIC 5

All other types 0

Unsupported SQL Functions

The SQL engine of the RPAS ODBC Server implements a large portion of the entry level
SQL as defined in the X3.135-1992, "Database Language SQL" specification and
commercial databases like SQL Server and Oracle. It is compliant with the ODBC
minimal grammar specification.

This section describes the un-supported features.

Handling of NULLS

NOT IN should return FALSE if any member of the set is NULL. When evaluating the IN
condition, the OpenAccess SDK SQL engine treats the comparison of any value with
NULL as FALSE, so NOT IN will become TRUE.

SELECT * FROM emp WHERE job NOT IN
(SELECT job FROM emp WHERE job IS NULL)
This example should return no results if there is an emp record with NULL value for Job.
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Schema Information

The SQL engine of the RPAS ODBC Driver does not support the following:
= Collate sequence and character set

= DEFAULT clause for column values

Data Definition Language (DDL)
The only DDL that is supported is “create view”.

Insert
= Insert statements are not supported.
= Update measure data on fact table is supported.

SELECT Syntax

Subqueries are not supported in a SELECT list.

Example:

SELECT

(SELECT a.empno FROM emp a WHERE a.deptno = b.deptno)
FROM

deptb

Value Expressions
Special Values

The SQL engine does not support the use of special values (CURRENT_USER,
SESSION_USER, CURRENT_TIMESTAMP) in value specification.

Value Functions

The SDK SQL engine does not support the following functions:

= TRANSLATE

= TRIM

NOTE: The OpenAccess SDK SQL engine supports LTRIM and RTRIM.)
= DIFFERENCE

= SOUNDEX

Date/Time Functions
The OpenAccess SDK SQL engine does not support the following Date/Time functions:

= CURRENT_TIME][(time-precision)] - The SQL engine does not support time-precision
argument.

=  CURRENT_TIMESTAMP|(time-precision)]
= EXTRACT(extract-field FROM extract-source)

Advanced Value Expressions

NULLIF
NULLIF is shorthand for a frequently used variation of CASE.
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Syntax:

NULLIF(valuel, target value)
is equivalent to
CASE
WHEN valuel = = target _value THEN NULL
ELSE valuel
END
Example:
.. WHERE sales_revenue / NULLIF(our_cost, -1) > 50

COALESCE

Coalesce is shorthand for a frequently used variation of CASE.
Syntax:

COALESCE (valuel, value2, value3)

is equivalent to:

CASE

WHEN valuel IS NOT NULL THEN valuel

WHEN value2 IS NOT NULL THEN value2

ELSE value3

END

Example:

SELECT name, job_title, COALESCE (salary, commission,
subsistence)

FROM job_assignments

Row Value Constructor

A row value constructor is a parenthesized list of values.
Example:

The following expression:

WHERE ¢1=CA AND c2=CB AND c3=CC

can be written using row value constructor as:

WHERE (c1, ¢2, c3) = (CA, CB, CC)

Predicates
The SQL engine does not support the following predicates.

= OVERLAPS predicate: Determines whether two intervals of time overlap with one
another.

event-information OVERLAPS event-information
* MATCH predicate
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Join Operators

This section explains which Join operations are supported by the RPAS SQL engine, and
which are not.

Supported Join Operators
The OpenAccess SDK SQL engine supports the following join operations:

Implicit JOIN. The WHERE clause explicitly specifies the join condition.

INNER JOIN. All joins that are not OUTER JOINS are considered in SQL
terminology as INNER joins. The use of keyword INNER has no additional effects,
but helps the statement to be completely self-documenting.

SELECT * FROM t1 INNER JOIN t2 ON t1.cl = t2.c3 WHERE search-LEFT OUTER
JOIN - This join preserves unmatched rows from the left table.

SELECT * FROM t1 LEFT OUTER JOIN t2 ON tl.c1 = t2.c3 WHERE search-condition

UNION and UNION ALL operators. UNION is used for combining two result tables
that are union compatible.

SELECT c1, 2 FROM t1 UNION SELECT c3, c4 FROM t2

Unsupported Join Operators
The following join operations (syntax) are not supported in this release:

CROSS JOIN: Functionally similar to the implicit joins.
SELECT * FROM t1 CROSS JOIN t2

NATURAL JOIN: Also referred to as natural, equi-join selects rows from the tables
that have same value for columns with the same name.

SELECT * FROM t1 NATURAL JOIN t2

Condition JOIN: Uses the keyword ON to specify the JOIN condition between tables.
The scope of fields referred in the ON condition is restricted.

SELECT * FROM t1 JOIN t2 ON tl.cl = t2.c3 WHERE search-condition

Column Name JOIN: Specifies a more restricted form of NATURAL join. NATURAL
joins use all columns with the same names to manage the matching process. The
column name JOIN specifies which column values should be matched.

SELECT * FROM t1 JOIN t2 USING (cl1, c2)
RIGHT OUTER JOIN: Preserves unmatched rows from the right table.

SELECT * FROM t1 RIGHT OUTER JOIN t2 ON tl.cl = t2.c3 WHERE search-
condition

FULL OUTER JOIN: Preserves unmatched rows from both the left and right tables.
SELECT * FROM t1 FULL OUTER JOIN t2 ON tl.c1 = t2.c3 WHERE search-condition

UNION JOIN: Creates a new virtual table with the union of all columns from the
source tables. The UNION join has no provision for column matching.
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Publishing Measure Change Events

Introduction

Event driven planning requires the ability to identify events when they arise. This
includes events that result from changes in plans and those that arise because of
advancement in the planning activity, for example, approval of a plan or creation of new
items. The ability to get notification of the event when it occurs is therefore essential. In
the context of RPAS applications, many measure changes result from business activities
and therefore fall into the category of notification-worthy events.

RPAS Publishing Measure Changes (PMC) provides a mechanism to monitor measure
changes and receive notification messages through a standard JMS messaging service. A
measure change event is defined as the measure data being written by any means. The
following is the list of the sources for PMC events:

1. MACE: all left hand side measures in the expression or expressions of the rule group
specified in the command line.

Workbook Commit: all left hand side measures in the commit rule group.
loadMeasure: all successfully loaded measures.

loadHier: measures whose base intersection contains at least one affected dimension.
“Affected” means adding and deleting one or more logical positions.

5. Dynamic Position Management (DPM): measures whose base intersection contains a
dimension affected by DPM. Adding or removing positions to a dimension or its
lower level children constitutes a change in the measure.

The following diagram demonstrates a JMS system in the context of RPAS. The JMS
system consists of four basic components:

* JMS Provider: The central daemon which accepts connections from clients and routes
and queues messages. It is sometimes called JMS Broker.

= Java Naming and Directory Interface (JNDI) Service: A service that provides
mapping between names and objects. It adds abstraction to the more complex
structure of underlying objects.

= JMS Client (Publisher): A standalone daemon process running with the other RPAS
server side processes such as DomainDaemon and RpasDbServer.

= JMS Client (Subscriber): Any applications interested in getting notifications of
measure changes.
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Configuring Subjects and Measures for Monitoring

A subject is defined as a logical grouping of measures. A subject is mapped to one or
more measures in one domain, while a measure can belong to one or more subjects. For
example, a subject named “PlanningMeasures” can include all measures associated with
planning.

The configuration file of measure change monitoring serves two purposes:

= Defines the mappings between subjects and measures.

= Defines the inclusion filters for monitored measures.

By default, no measures are monitored unless they are specifically included in the
configuration.

For each domain, there is one measure change monitor configuration file. It is named
MeasureChangeMonitor.properties and must be located under {domainPath}/config/.

Note: There is only one property file for a global domain. It
is placed under the config directory of the master domain.

This configuration file is in standard Java properties file format. Each line defines the

relationship between one subject and one measure:

Subject.MeasureName=true

= “true” means inclusion in monitoring.

= “false” is used to exclude a subject/measure from monitoring. Use of false is not
recommended since, by default, a measure is not monitored and such a line can be

deleted or commented out from the file. Comments are any contents on a line from
“#” to the end of the line.
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Example:

TestMeasures.R_EX_DEMOA=true
TestMeasures.R_EX_DEMOB=true
LanguageMeasures._R_MsgLabel=true

The following are defined in the above example:
= Two subjects: “TestMeasures” and “LanguageMeasures”.

= The subject “TestMeasures” represents two measures: “R_EX_DEMOA" and
“R_EX_DEMOB”.

= The subject “LanguageMeasures” represents one measure: “R_MsgLabel”.

A subject name must be a valid hierarchical variable name, that is, consists of only

alphanumeric characters, underscores, and periods. RPAS does not enforce any naming
convention for a subject. It is up to the retailer to define their own naming convention.

After the configuration file is modified, RPAS processes can detect that the file has
changed and automatically reload it. There is no need to restart any RPAS processes.

Configuring the RPAS JMS Publisher

JMS Publisher for measure change events is implemented in Java and runs as a
standalone process. It is decoupled from any other RPAS server side processes in terms
of interprocess communications and domain data file locking.

Each JMS Publisher process is tied to a domain and a JMS topic. When the publisher
detects an event for its domain, it generates a JMS message and sends the message to a
JMS provider. The format of the JMS message is defined by a template file which can
contain any of the macros listed in the following table. The macros are replaced by actual
values at run time.

Macro Name Format Notes

__EventDateTime YYYY-MM-DDThh:mm:ss Local time of the server.

__SourceURI__ RPAS/JMS/{hostname} {hostname} is the name of the server
where the publisher is running.

__SUBJECT__ String Subject of the event as defined in
MeasureChangeMonitor.properties.

_TYPE__ “MeasureChange” Type is a constant string.

_ DOMAIN__ String Path to the domain.

_ MEASURE__ String RPAS internal measure name.

__ ORIGINUSER__ String RPAS User ID, only available for

workbook commit or DPM. Use “-” if
not available.

Following are two examples of a JMS message template.

Example 1 - Simple name/value pairs:
type=_TYPE _
domain=__DOMAIN__

measure=__ MEASURE

time=__EventDateTime__

user=__ ORIGINUSER
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Example 2 — XML-based Notification Event Architecture for Retail (NEAR) format:

<?xml version="1.0" encoding=""UTF-8" ?>

<AlertEvent MajorVersion=""1" MinorVersion="0" TypeCode=""RPASEvent"
Priority="0" Severity="Information" Mode=""Test" FixVersion=""0"
xmIns:xsi="http://ww.w3.0org/2001/XMLSchema-instance""

xsi :schemalLocation="http://ww.retail .oracle.com/workspace/alerts/AlertEventv1.0.0
_xsd"
xmins="http://ww.retail .oracle.com/workspace/alerts/'>
<SequenceNumber>0</SequenceNumber>
<EBEventDateTime>__EventDateTime__</EventDateTime>
<EventDescription>RPAS Measure Change Event</EventDescription>
<SourceName>RPAS</SourceName>
<SourceURI>__SourceURI__</SourceURI>
<Instance>1</Instance>
<RoutinglInfo TypeCode="'Subjectinfo'>_ SUBJECT _ </Routinginfo>
<AlertData><![CDATA[<type>_ TYPE__</type>
<domain>__DOMAIN__</domain>
<measure>__MEASURE _</measure>
<originUser>__ORIGINUSER__</originUser>]]></AlertData>
</AlertEvent>

Command Line
The following command line is used for J]MS Publisher:

java -cp {classpath} oracle.rpas.pmc.MCPublisher -d {domainPath} [-c {configFileName}] [namel=valuel
[name2=value2 [...]]]

The following table provides descriptions of the arguments used in the command line.

Argument Description

classpath Should include rpaspmc.jar and jms.jar under
$RPAS_HOME/lib and any vendor-specific J]MS
implementation jar files.

—d domainPath Path to the monitored domain. It must be a simple or
master domain.

—c configFileName Configuration file in Java properties file format. This
argument is optional.

namel=valuel name2=value2 .. [name/value pairs.If the configuration file is not
specified, the name/value pairs are used.

If the configuration file is specified, the name/value
pairs are added to the configuration and overwrite
any value with the same name already present in the
file. This argument is optional.

214 Oracle Retail Predictive Application Server



Configuring the RPAS JMS Publisher

Configuration Settings

The configuration settings for the JMS Publisher can be categorized into general and

vendor_specific settings.

General Settings

The following table lists all vendor neutral configuration settings for the J]MS Publisher:

Setting Name Description Required | Value
topic JMS topic lookup Yes A string with only alphanumeric
name. characters, underscores, and
periods. Maximum length is 100
bytes.
topicConnectionFactory | JMS topic Yes A string with only alphanumeric
connection factory characters, underscores, and
lookup name. periods. Maximum length is 100
bytes.
messageTemplate Template file name | Yes Standard template file
for the J]MS PMCMessageTemplate.xml is
message. This file available under
must be placed $RPAS_HOME/domain/config.
under the config This file needs to be copied to the
directory of the config directory of the domain.
domain.
logLevel Logging level. A log [ No Specify one of the following values,
level is a cut-off in low to high order.
ievel V‘{h}ilchlmeans “VERBOSE”: All logs.
ogs with a lower " .
level are filtered DEBUG”: Debug logs.
out. “INFO”: Informational logs.
“WARN": Warning logs.
“ERROR”: Error logs.
“SUPPRESS”: No logs.
If not specified, the default is
“INFO”.
logFile The path to thelog | No If not specified, output to the
file. Can be a console.
relative or absolute
path.
restartAfterException Flag to restart after | No If true, the publisher will try to
encountering any restart after catching any JMS
JMS related related exceptions. Interval
exceptions. between retries is 180 seconds. To
stop the publisher from trying to
restart, the process must be ended
manually.
Default is true.
message.deliveryMode Delivery mode. No “NON_PERSISTENT” or

“PERSISTENT”. Default is
“PERSISTENT”
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Setting Name

Description

Required | Value

message.priority A priority number | No 0to 9. Default is 4.
for the J]MS
message.

message.timeToLive Time to live in No 0 or any positive integer. Default is
milliseconds. 0 (unlimited).

Vendor-Specific Settings

Sun Open Message Queue is used as an example for these settings. For further details,
consult the vendor documentation for your JMS implementation.

File Based JNDI Object Store

File based JNDI object store is used primarily for development and testing. It is very easy
to set up, but has weak built-in security.

Property Name Description | Required | Value

java.naming.factory.initial | Initial Yes For Open Message Queue, it must be:
context for com.sun.jndi.fscontext. RefFSContextFactory
JNDI
lookup.

java.naming.provider.url | Directory Yes Example:
path to the file:/ / /C:/myapp/mqobjs
object store.

LDAP Based JNDI Object Store

An LDAP server is the recommended object store for production JMS messaging systems.
LDAP servers are designed for use in distributed systems and provide security features
that are required in production environments.

object store.

Property Name Description Required | Value
java.naming.factory.initial Initial context | Yes For Open Message Queue, it
for JNDI must be:
lookup. com.sun.jndi.ldap.LdapCtxFact
ory
java.naming.provider.url Server URL Yes Example:
and directory ldap://myD.com:389/ou=mql,
path to the o=App

where administered objects are
stored in the directory
/App/mql
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Property Name Description Required | Value
java.naming.security.principal Identity of the | No The format of this attribute
principal for depends on the authentication
authenticating scheme.
callers.

For example:
uid=homerSimpson,ou=People,
o=mq

If this attribute is not specified,

the behavior is determined by
the LDAP service provider.

for

authentication.

java.naming.security.credentials Credentials of | No The value of this attribute
the depends on the authentication
authentication scheme. For example, it might
principal. be a hashed password, clear-text
password, key, or certificate.
If this property is not specified,
the behavior is determined by
the LDAP service provider.
java.naming.security.authentication | Security level | No Specify one of these options:

“none”: No security

“simple”: Simple security
“strong”: Strong security

For example, if you specify
“simple”, you are prompted for
any missing principal or
credential values. This enables a
more secure way of providing
identifying information.

If this property is not specified,
the behavior is determined by
the LDAP service provider.

The following is a sample configuration file for RPAS JMS Publisher:

Java.naming. factory. initial=com.sun. jndi . fscontext.RefFSContextFactory
Java._naming.provider._url=File:///C:/Temp

topic=RPASEventTopic

topicConnectionFactory=RPASEventTopicConnectionFactory

messageTemplate=PMCMessageTemplate . xml

Publishing Measure Change Events 217




Configuring the RPAS JMS Subscriber

Configuring the RPAS JMS Subscriber

A sample JMS Subscriber is implemented to use for testing or trouble-shooting. This
subscriber is packaged and deployed along with the publisher. It simply writes the
messages it receives to logging output which can be console or a log file.

Command Line

Here is the command line for the sample JMS Subscriber:
java -cp {classpath} oracle.rpas.pmc.MCSubscriber [-c {configFileName}] [namel=valuel [name2=value2 [..]]]

* ({classpath} should include rpaspmc.jar and jms.jar under $RPAS_HOME/lib and any
vendor-specific JMS implementation jar files.

= {configFileName} is a configuration file in Java properties file format. It is optional.

* name/value pairs - If the configuration file is not specified, the name/value pairs are
used. Otherwise, the name/value pairs are added to the configuration file and any
value with the same name already present in the file is overwritten.

Configuration Settings

Vendor-specific settings are the same as the JMS publisher. Refer to the “Configuring the
RPAS JMS Publisher”section for details.

The following table lists all the general settings for the JMS Subscriber:

Property Name

Description

Required

Value

topic

JMS topic lookup name.

Yes

A string with only
alphanumeric characters,
underscores, and periods.
Maximum length is 100
bytes.

topicConnectionFactory JMS topic connection Yes A string with only
factory lookup name. alphanumeric characters,
underscores, and periods.
Maximum length is 100
bytes.
logLevel Logging level. A log No Specify one of the following
level is a cut-off level values, in low to high
which means logs with a order.
lower level are filtered “VERBOSE”: All logs.
out. “DEBUG”: Debug logs.
“INFO”: Informational
logs.
“WARN”: Warning logs.
“ERROR”: Error logs.
“SUPPRESS”: No logs.
If not specified, default is
“INFO”.
logFile The path to the log file. No If not specified, output to
Can be a relative or the console.
absolute path.
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durable subscription.

Property Name Description Required | Value

clientID JMS Client ID. Only No This must be a unique
required for a durable string for all JMS clients
subscription. Not using the same connection
recommended for other factory.
use.

durableSubscriptionName A unique name for a No If a name is not provided,

the subscription will be a
transient subscription. This
means messages are not
queued up if the connection
for the subscriber is lost or
the subscriber is not
running.

The following is a sample configuration file for RPAS JMS Subscriber:

Java.naming. factory. initial=com.sun. jndi . fscontext.RefFSContextFactory
Java._naming.provider._url=File:///C:/Temp

topic=RPASEventTopic

topicConnectionFactory=RPASEventTopicConnectionFactory
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In-Context Launch

In-Context Launch (ICL) is an RPAS feature that provides retailers with a planning
centered, integrated Ul solution for responding to events by adjusting the affected plans
within the context of the changed circumstances and interacting plans. A planner’s
workspace can be developed where relevant events are announced in role-specific
dashboards. The planner can drill down into the event report to identify the context of
the event. Appropriate planning applications can be launched to react to the event by
either replanning or deriving further insight from the plans, in order to justify the event.

RPAS launches a planning application given a context, that is, the template or workbook
to launch and the wizard parameters that define the scope if a new workbook is to be
built. Launching the planning application involves the following steps:

1. Start the RPAS client if it is not already running.

2. Log in the user, if the user is not already logged in.

3. Create the workbook, if a new workbook is being built.

4. Open the new or existing workbook, if that is what the context specified.
The following topics are covered in this chapter:

* Opening a pre-built workbook.

* Building a new workbook given a specification of the wizard parameters.

= Issuing the open or build requests from a web application running in Oracle Retail
Workspace or other Web portal.

Launching RPAS

A system integrator is responsible for creating a Workspace or Web-based application
that can launch RPAS. Creating a Workspace application involves the following steps:

1. Configure the navigational pane in Workspace to appropriately launch RPAS.

2. Create static or dynamic Web reports and dashboards, including OBIEE and other
Oracle Fusion technologies, to present integrated data to the end-user with links or
buttons that launch RPAS in-context.

3. Create alerts or alert reports, using BPM, OBIEE, or other Oracle Fusion technologies,
that have links or other Ul mechanisms that can launch RPAS in-context.

RPAS provides the framework that system integrators can use to launch any RPAS-based
workbook, independent of whether the workbook uses a standard wizard or a custom
wizard.

RPAS supports launching workbooks that are built using the dynamic-template APL
This includes all templates built using RPAS Configuration Tools, but does not include
templates that have been coded in C++ using an API lower that the Dynamic Template.

Note: Successfully launching RPAS administrative templates
that are not built using RPAS Configuration Tools is not
guaranteed.
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Issuing a Launch Request from a Web Page

RPAS ICL is implemented as an extension of the RPAS Web Launch feature. As a
prerequisite, RPAS Web Launch Servlet and RPAS Client web installation package must
be deployed to a Web server and made available to system integrators. For more
information, see the “RPAS Web Deployment” chapter in the RPAS Installation Guide.

System integrators must design the report page to have a link, or other web GUI widget,
which invokes client-side JavaScript code to initiate an RPAS ICL. The page embeds a
Java applet from RPAS Web Launch (RWL Applet).

Note: Java 1.6_10 or above is required.

The applet performs the following operations:

1.

Find the required RPAS client installation on the user’s workstation, if it was
installed by the applet in a previous Web session.

Note that a standalone RPAS client installation is not recognized because the
installation is tracked by a browser cookie. However, the applet can be forced to use
a preinstalled client by setting a parameter for the applet.

Download and install the appropriate version of the RPAS client if the required
RPAS client installation cannot be found or a new build of the client is available on
the Web server.

Start up the RPAS client.
Route the ICL request to the RPAS server through the RPAS client and wait for a

response. The response can be a success or failure code, and a corresponding
message.

The applet makes a call back to a JavaScript function to return the response. It is the
responsibility of the system integrators to provide code to handle the response in the
JavaScript function.

Embedding an RWL Applet on a Web Page

System integrators can embed the applet in a Web page using the regular HTML
<Applet> tag. The following attributes are required in the <Applet> tag:

Attribute Description Value
code Applet class com.retek.mdap.client. launch.LaunchApplet.class
name
codebase URL location to | The URL must point to the RPAS Web Launch Web server
download the instance, for example:
applet archive | “http://mspdev43.us.oracle.com:7777/RPAS4/”
archive Applet archive |mdap.jar
file name
mayscript Enable NA
JavaScript
interaction
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The following parameters are used to control the behavior of the RWL Applet:

Parameter

Description

Required

Example

AutoStart

Launch the client automatically when
the applet starts. Must be set to false
for ICL.

Yes

Must be set to false if the launch is
initiated by JavaScript code.

defaultInstallDir

Default installation location for the
RPAS client. The client version
number is automatically appended to
the end of this string.

No

C:\Oracle RPAS Client

Debug

Debug flag. If true, more logging
information is printed in the Java
Console of the Web browser.

No

true

launchPreinstalledOnly

Launch the preinstalled RPAS client
only. Do not install an RPAS client.
The preinstalled path is determined
by the server side setting in the
configuration file clientPath.txt.
For more information, refer to the
RPAS Installation Guide.

No

false

supportMultipleVersions

Support multiple RPAS client versions
on the same workstation. Must be set
to true for ICL.

Yes

Must be set to true.

WebLaunchBase

The URL for the Web Launch Servlet.
If not specified, the applet will
generate a URL by appending “/web”
to it’s codebase property.

No

http://mspdev43._us.oracle.com
1 7777/RPAS4A/ web

It is recommended that the applet is embedded with the height and width set to zero.
When the height and width are set to non-zero values, a text area is shown that gets

updated with status information from the RPAS client.

The following figure shows the applet Ul if the RWL Applet is embedded in the Web
page with non-zero width and height. The message window in the applet is updated
with status information from the RPAS client. Status information includes the success or
failure of building or opening a workbook and any error messages returned by RPAS.

It is assumed that when using non-zero height and width, system integrators
appropriately size the applet in order for the Ul to be user-friendly. For example, a width
and height of 5 is unrealistic for any user interface returning messages to the end-user.
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/= Launch RPAS Client - Windows Internet Explorer

@"C_./' - |E http: ffmspdev43.us.orade.c V| 1| % | ‘ L~
. File Edit View Favorites Tools Help
W R [@Launch RPAS Client ] ] - B - & - [hPage - (i Toos - @-

’rLaunching RPAS Client .. ‘

RPAS Client Status:

RPAS Web Launch Applet is ready ‘:g Local intranet #1008 -

Ul of the RWL Applet when Height and Width Values are Non-zero

Using JavaScript with the RWL Applet
System integrators embed the RWL Applet in an HTML web page. The launch context
can be passed to the applet by the JavaScript-enabled active content of the Web page.
Real-time status is passed back. The communication between the applet and the active
content is achieved by a JavaScript invocation of an applet method.
To launch an instance of an RPAS client, the active content makes a JavaScript call:
document._appletName. launchRPASClient(id, xmlstring [, user, password]);
= id- RPAS client process identifier, which can be any string.
= xmlstring - launch context in XML format encoded by Base64 scheme. Base64
encoding is a popular scheme used in e-mail contents, readily available in JavaScript
public domain source code.
For purposes of quick manual testing or prototyping, the MIME Tools plug-in in
Notepad++ 4.8.5 and above may be used to encode any text to Base64 and back.

= user and password - optional arguments. For details on ICL supported mechanisms
for user authentication, see the “User Authentication” section.
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The applet notifies active content regarding the status of the RPAS client through a
JavaScript callback function. The following JavaScript function may be defined if a
custom callback is desired:

function RPASStatusListener(id, code, message)
{

}
= id-same RPAS client process identifier previously passed by the
launchRPASClient()call.

* code - status code (0 — success, 1 — failure, -1 — applet exception)
* message - a descriptive status message.

If the callback function is not defined, RWL Applet displays status messages on the status
bar of the browser in the following format: “id — [OK | Error | Exception] — message”.

The following figure shows the interactions between Active Content, RWL Applet, and
RPAS client processes. Note that one embedded RWL applet can be invoked multiple
times using JavaScript to launch multiple RPAS client processes using different context
XML data. The figure shows the case where two RPAS client processes are launched.

2. launch contextual data

RPAS Web
Launch Applet 2. launch
- ~ contextual RPAS
1. launchRPASClient() Mai data .
- ain Loop —> Client
Thread ) Process 1
JavaSl;:Irlp t 4. RPASStatusListengr() - ~N
enable . .
Antive Status Listener ’ 3. status messages
Thread 1
Content > /
4 - ~, 3. sfatus
4. RPASStatusListener() Status Listener mefssages RPAS Client
Thread 2 Process 2
J

Interaction between RWL Applet, Active Content of the Web Page, and RPAS Client

Since the status listener function RPASStatusListener(id, code, message) can be invoked
multiple times by multiple status listener threads in the applet, the JavaScript developer
should use the function id argument to identify where the status message came from and
act accordingly.

The Web page must stay active to enable the communication between the RPAS client
processes and RWL Applet. The Web page can become inactive, for example, if the user
clicks the Back button of the Web browser or closes the active tab or window.

If the Web page becomes inactive, the communication channel between the applet and
client process is terminated and cannot be recovered. If this happens, the RPAS client
process becomes orphaned and then acts like a regular RPAS client. It will continue to
function, but its status will not be displayed on the Web page.
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The following sample code demonstrates the integration of RWL Applet and JavaScript-
enabled active content. Note that the width and height of the applet are set to zero so that
the applet is hidden on the web page. The JavaScript function launchRPASClient() simply
invokes the corresponding applet method. The status callback function
RPASStatusListener() is implemented to display the status information in the Web
browser status bar which is generally at the bottom of the browser window.

<HTML>

<HEAD>

<META http-equiv=Content-Type content=""text/html; charset=UTF-8">
<TITLE>Launch RPAS Client</TITLE>

</HEAD>

<SCRIPT>

var idcomplete = "BuildComplete™;

var xmlcomplete =

"PD94bWwgdmVvyc2vbj0iMS4wl iBIbmNvZGluZzOiVWRGLTgi 1D8+DQo8UIBBUOXN\
dW5 jaENvbnR 1eHQ+ 1 CAgDQo8U2VydmVyPgOKCTxkZXN j cmiwdG I vb j SUZXNORGIT\
YWIuPCOKZXNjcmiwdG Ivb jANCi Ag I CASCHIVZMISZT5mYWxzZTwvcHIVZmISZTANN
Cgk8ZGVidWc+ZmFsc2UBL2R IYNVNPgOK I CAg I DxkYKRhZW1vb IBvenQ+MT 1zNDg8\
L2RiRGFIbWOuUGOydDANCgK8ZGITZXJI2ZXJI 1b3NOTmFEZT5tc3BkZXYOMy51cy5v\
cmFJbGUUY29tPCOKY INIcnZ I ckhve3ROYWLIPgOKCTXKY INIcnZIcIBvenRTAGRY\
dD4xmMD11PCOKY INIcnZ I c1BvenRTAGFydDANCgk8ZGITZXI2ZXIQb3IORWSKPJ YIN
NTM1PCOKY INIcnZ1clBvenRFbmQ+DQoJPGRIZMF1bHREY 1VZZX 1gLz4ANCgk8ZGVm\
YXVsdER 1UGFzc3dvemQgLz4NCgk8ZGotYWIuUmOvdERpcmV jdGOyeSAVPgOKPCIT\
ZXJ32ZX1+DTxDbG 1 1bnQ+DSAg 1Dx2ZXJzaWouPj EzL j EuMDwvdmVyc2 vl 4NPCOD\
bG 1 1bnQ+DQoBRGILYWIUPGOKCTXKZXN j cmiwdG Ivh j SUZXNORGOTYWIUPCOKZXN\
cmiwdGIvbj4aNCgk8ZG 1yZWNOb3J5TmFtZT4vdmIsL m5Shey9ycGFzX3NIL2h1YWs5n\
bWEVZGOtYWIucy9QUZXNORGItYWIUPCOkaXJ 1Y3Rven10YW1 1PgOKICAgPHVZZX 1+\
YWRtPCI1c2VyPgOKCTxwYXNzd29yZD5hZGO8L3Bhc3N3b3IKPgOKPCOEL21haW4+\
DQo8V29ya2Jvh2s+DQoIPGJI1alxkPgOKCQk8dGY tcGxXhdGVOYWL IPK1FQVNVUKVB\
TKFMWNIUZWvdGV tcGxhdGVOYW1 1 PgOKCQk8V216YXIKUGFNZXM+DQoJCQk8V216\
YXIKUGFNZSBpZDO0 i RXhOCcmFNZWFzdXJ 1c1BhZ2U i 1GZhbGx i YWNrPSJub251 1 j4AN\
CgkJCQK8TGIzdGIveCBUYWLIPSJISY jE i PgOKCQkJICQk8dmFsdWU+DQoJCQKJICQkS\
Cc2VsZWNOaWOuUP 1 IFRVhTREVNTOESL3NIbGVjdGIvhjaNCiAgICAgICAgICAgICAQ\
1CAgI1DxzZWx1Y3Rpb24+UI9FWFOERUIPQjwvc2VsZWNOaW9uPgOK 1CAg I CAg ICAg\
1CAgICAgICAgPHNIDGVjdGIvb j5SX0VYXORFTUIDPCIzZWx T Y3Rph24+DQoJCQKIN
CTwvdmFsdWU+DQoJCQkJIPCIOMaxXNOYmI4PgOKCQkJIPCOXaXphcmRQYWd I PgOKCQKJIN\
PFdpemFyZFBhZ2UgalWQ9 1 KRBWS 1 gZmFsbGJIhY2s9 Im5vbmU i PgOKCQKJICTXTAXBIN\
cIRyZWUgbmFtZTO 1 dHIIZTE 1 1GZhbGx i YWNrPSIhbGw i PgOKCQkJCQk8dmFsdwU+\
DQoJCQkJICQK8ZGIt1G5hbWU9 1 1dFRUs 1 PgOKCQkJICQKICTXzZWx 1'Y3Rpb24+VzAX\
XzE50Tc8L3NIbGVjdGIvh jANCgkICQkICQk8c2VsZWNOaWOuP 1cwMVBXxOTk4PCOz\
2Wx1Y3Rpb24+DQoJCQkICQkIPHN LGV jdG Ivh j SXMDFMTKS0Twvc2VsZWNOaWwOu\
PgOKCQkJCQkJICTxzZWx 1Y3Rph24+VZAxXZ IMVMDASL3N 1bGVj dG Ivb jANCgkJCQKkIN
CTwvZG 1tPgOKCQkJICQKJIPGRpbSBUYW1IPSIEQVK 1 PgOKCQKJICQkICTXZZWx 1 Y3Rp\
b24+MTk5NzAXMDg8BL3NIbGVjdGIvb jANCgkICQKICTwvZG I tPgOKCQKICQK8L3Zh\
bHVIPgOKCQKJICQk8ZGVMYXVsdDANCgkJCQKJICTxkaWOgbmFEZTOTREFZ 1 j4ANCgkJ\
CQKJICQk8c2VsZWNOaWIuP jESOTewMTAAPCOzZWx 1'Y3Rph24+DQoJCQkJICQKSL2Rp\
bT4NCgkJICQKJIPCOKZWZhdWxOPgOKCQkJICTwwvU3ViwZXJUcmV IPgOKCQkJIPCOXaXph\
cmRQYWd 1 PgOKCQkJIPFdpemFyZFBhZ2UgaWQ9 I INUUT 1gZmFsbGJhY2s9 ImSvbmUi\
PgOKCQkJICTXTAXBIcIRyZWUgbmFtZTO1dHI 1 ZTE 1 PgOKCQKJICQk8dmFsdWU+DQoJ\
CQkJICQK8ZGIt1G5hbWU9 T INUUT 1+DQoJCQkJICQkIPHNIDLGVjdGIvhj4awMTAYPCIZ\
2Wx1Y3Rpb24+DQoJCQkICQkIPHN LGV jdG Ivh jAWMTQOPCIZzZWX T Y3Rph24+CQkI\
CQkJIDQoJICQKICQkIPHNIBGVjdG IV j4wMTUyPCIZzZWx T Y3Rph24+CQkICQKIDQoI\
CQkJICQKIPHNIDGVjdG Vb j4wNTU3PCIZZWx 1'Y3Rph24+CQkJICQkIDQOICQKICQKIN
PHNIbGVjdGIvhjawNTKOPC9zZWx 1Y3Rph24-+CQkJICQkIDQoICQkICQKIPHNILGV\
dGIvbj4nwoTUSPCOZZWxX Y 3Rph24+CQkJICQkIDQOJICQKICQKSL2Rpb TANCgKJICQKIN
PC92YWx1ZTANCgkJCQk8LIN1cGVYVHIIZTANCgkICTwwV216YXIKUGFNZTANCgkJ\
CTxXaXphcmRQYWd 1 IGIKPSITS1U 1GZhbCx i YWNrPSJub251 1 j4NCgkJCQK8U3W\
ZXJUcmV 1 1G5hbWU9 InRyZWUx I j4NCgkJCQkJIPHZhbHV IPgOKCQKJICQKJIPGRpbSBUN\
YWLIPSIDTENT I j4NCgkJICQkJICQK8c2VsZWNOaW9uP j AyMTwvc2VsZWNOaWOuPgOK\
CQkJCQkJIPCOkaWO+DQoJICQkICTwvdmFsdWU+DQoJCQkJIPCITAXB I c IRyZWU+DQoJ\
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CQk8L1dpemFyZFBhZ2U+DQoJICTwWV216YXIKUGFNZXM+DQoJICTXZYXZIPgOKCQkJI\
PGxhYmVsPIRIc3R3Y jwwbGFi ZWw+DQoJCQK8YWN j ZXNzPkdyb3WPCOhY2NIc3M+\
DQoJCQk8Z3IvdXA+QURNSU48L2dyb3VinPgOKCQk8L3NhdmU+DQoJPCO 1 dWISZDAN\
CwV29ya2Ivb2s+DQo8L1IQQVNMYXVuY2hDb2502Xh0PgOK"* ;

function launchRPASClient(id, xmlstring)

{
}

function RPASStatusListener(id, code, message)
{

document.LaunchApplet. launchRPASClient(id, xmlstring);

status = id + " - Status: code(*" + code + ') message('' + message + 'M)';

}
</SCRIPT>
<BODY>
<CENTER>

<H3>Launch RPAS Client</H3>

Click on the button to launch RPAS client and build a new workbook!

<pP>

<INPUT type="button" value="Build A New Measure Analysis Workbook""
onClick = ""launchRPASClient(idcomplete, xmlcomplete)'>

<APPLET name=""LaunchApplet"
code=""com.retek.mdap.client.launch.LaunchApplet.class"
codebase=""http://mspdev43_us.oracle.com:7777/RPAS4/""
archive=""mdap.-jar"'
align="center" width=""0"" height=""0"" mayscript VIENASTEXT>

<PARAM name=""AutoStart"” value=""false'">

<PARAM name=""supportMultipleVersions' value=""true'>

<PARAM name=""launchPreinstal ledOnly" value=""false'">

<PARAM name="Debug" value=""true'>

<PARAM name=""defaultinstallDir" value=""C:\Oracle RPAS Client'>
Your web browser is not currently Java-enabled.

</APPLET>

</CENTER>

</BODY>

</HTML>

The following figure shows this sample code rendered by a Web browser. Note that the
status bar shows the current status of the RPAS client.
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{= Launch RPAS Client - Windows Internet Explorer |Z||E|r5__(|
@.\-4__‘_/. ~ | Di\sreipasiportalipublic_himiYeunchstart. heml | 42| [x] | [[2]-

: FEle Edit Wew Favorites Tools Help

e I@Launoﬁ RPAS Client [_I -~ B - &= - [ZkPage - {F Toos - @-

Launch RPAS Client

Click on the button to lannch RPAS client and build a new workbook!

[ Build A New Measure Analysis Workbook ]

BuildComplete - Status: code(0) message(Workbook build was succe 3 My Computer * 100% -

Example HTML Code Rendered by a Web Browser

User Authentication

This section describes Oracle Single Sign-On (OSSO) and non-OSSO authentication of
users.

0SS0-Based Authentication

If the HTML active content is protected by OSSO, it can be assumed that the user has
already been authenticated when the applet is started. However, it cannot be assumed
that the user has the privileges to launch the RPAS client. The privileges can only be
confirmed by RWL Servlet. The applet, therefore, makes a query to the servlet to confirm
the privileges of the user before launching the RPAS client.

When OSSO is being used, a user name and password is not needed and should not be
used for the call to document.appletName. launchRPASClient(). System integrators should
rely on OSSO credentials and mechanisms to authenticate the user.
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The following figure shows the flow of OSSO support for ICL.

Browser Session
OSSO

Authentication Display Web Page
with embedded

RWL Abpplet

\ 4

\ 4

Applet contacts
Servlet to Check
User Privileges

Display Error
Message Success
Yes
No
v
Launch RPAS Launch RPAS
Client and Ask Client and
for Login Info Automatically
Log on

0SSO0 Support Flowchart for ICL

Non-0SSO Authentication

When OSSO is not used, the authentication for the RPAS client login is done by RPAS

itself. There are several ways to pass user credentials, user name and password, to the

RPAS client via the RWL Applet:

= Directly embed the user name and password in the XML data. The domain section of
launch context can contain user and password information.

Note: This may pose a security issue depending on the
lifecycle of the launch contextual data.

* Do not pass the user name and password to the applet. The RPAS client will prompt
the user to log in every time the client starts. This may be inconvenient, but may be
acceptable if only one RPAS session is needed.

= Use JavaScript code to pass in the user name and password in the applet method call
launchRPASClient(id, xmlstring, user, password). The user name and password
can be obtained from the user input fields of the Web page. The user only needs to
enter the user name and password once for one browser session. Multiple RPAS
client sessions can then be launched without entering the user name and password
again.

In-Context Launch 229



Launching RPAS

Deploying In-Context Launch

The following diagram shows how an RPAS In-Context Launch enabled application is
deployed. Note that the RPAS Web Launch Servlet has to be deployed on a Web server.
This Web server does not have to be the same as the Web server that is used for
Workspace or for any reporting, dashboard or BAM applications. In this release, RPAS
ICL is able to interact with the dynamic content of the Web page using mechanisms
described in the previous sections. As long as system integrators can ensure that the
RPAS Web Launch Servlet is available, ICL can be achieved from any Web-based
application.

Oracle Retail Workspace (Web Browser) RPAS Client
Active Content X
(JavaScript enabled) RPAS Web Launch 3 RPAS Client
Applet < P> Process
A A
A
6 4 . .
Client Side
N Server Side
A 4 A 4
| RPAS DB Server 5 Domain Daemon
| h
<
A 4
Workspace A
Content RPAS Web 7
Provider Launch Servlet ‘¥
Domain Data
OBIEE and Web Server
SO on. — RPAS Server

ICL Deployment Diagram
Use Cases

Launching without Context

A system integrator may want to launch RPAS without any context. This means starting
up an RPAS client and logging on automatically, but without opening or building a
workbook. This type of launch is required to support a generic link in the navigation
pane where an end-user can simply launch RPAS to do planning using RPAS Today. The
Workspace navigation pane only serves as a launchpad for RPAS where RPAS can be
started and logged into by clicking a static link or button.

To code this type of launch, the user must either remove the <Workbook> tag from the
context or ensure that the <Workbook> tag does not include an <open> or <build> request.

Launching With Context

An RPAS launch that includes more than a simple login into RPAS is considered an
in-context launch. This includes launching an RPAS client to open an existing workbook
or build a workbook given the template and wizard parameters.
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Opening an Existing Workbook

A system integrator may want to design an application that opens a pre-built workbook.
This workbook may have been built by a system integrator, the user, workbook build
batch, or previous in-context launch request.

It is assumed that system integrators are aware of either the internal, unique workbook
name that RPAS uses or the workbook label, and optionally, the template name and
creation datetime of the workbook. These parameters can be specified in the XML context
specification to have RPAS open the workbook. For information, see the “Open
Workbook” section.

To enable opening the latest workbook from a nightly auto-workbook-build batch,
system integrators can provide the label and template name. ICL will automatically
default to the latest workbook of the same label.

Note: The last workbook that was created is opened; not the
last workbook that was modified.

Building a New Workbook

A system integrator may want to ensure that a new workbook is built for the end-user
depending on what the end-user is or has been doing in the Workspace or other Web
application. The following examples illustrate this concept.

= Ifalink for “Merchandise Financial Planning” is clicked in the navigation pane,
RPAS is launched to build a workbook for the “Merchandise Financial Planning”
template. The end-user is required to make all the wizard selections.

= If the user is navigating a report and had drilled down to identify some outliers at
the SKU/Store level, RPAS is launched to automatically build a workbook for those
SKU/Stores without requiring the end-user to reselect them in the wizard.

This can be achieved using the build context detailed in the “Build Workbook” section.
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RPAS Launch Context Format

The launch context is described in XML format. It consists of four components: client,
server, domain, and workbook.

= The client component identifies the RPAS client to be launched. It is needed to
support multiple client versions on the same workstation.

= The server component identifies the server to connect to.

* The domain component identifies the domain to log in to.

= The workbook component contains information for opening or building a workbook.

Client Settings

Setting

Description

Type Required

version

RPAS client version number. RPAS Web
Launch supports multiple client versions. This
version number is used to determine which
client binary will be launched. If not specified,
the default client for RPAS Web Launch is
used.

String No

allowConcurrentSessions

Allow the same user to open multiple
concurrent RPAS client sessions connecting to
the same domain without prompting for
confirmation.

Boolean |No

Server Settings

specified, it is prepended to the
directoryName in Domain Settings.

Setting Description Type Required

description Descriptive name for this server String No
configuration.

profile Enable profiling for the RPAS client. Boolean No

debug Enable debug logging for the RPAS client. Boolean No

dbDaemonPort The port number of DomainDaemon. Integer Yes

dbServerHostName The host name where DomainDaemon is Integer Yes
running.

dbServerPortStart The starting port number of the Integer No
RpasDbServer listening port range.

dbServerPortEnd The ending port number of the Integer No
RpasDbServer listening port range.

defaultDbUser The default user ID for RpasDbServer. String No

defaultDbPassword The encrypted password for the default user | String No
ID.

domainRootDirectory | The root directory of RPAS domains. If String No
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Domain Settings

Setting Description Type Required

description Descriptive name for this domain String Yes
configuration. It is displayed as the title of
the RPAS client main window.

directoryName The domain path. String Yes

user The user ID used to log in. If not specified, a | String No
login dialog prompts for user input.

password The encrypted password for the user ID. If String No
not specified, a login dialog prompts for
user input.
Workbook Settings

The Workbook section has two options to open or build a workbook. If the options or the
whole Workbook section is not specified, the RPAS client logs in to the domain without
any workbook operation. For information on opening a workbook, see the “Open
Workbook” section. For information on building workbook, see the “Build
Workbook”section.

XML Schema

The following is the full schema for RPAS Launch Context.
<?xml version="1.0" encoding=""UTF-8" ?>

<xs:schema xmlns:xs="http://mw.w3.0org/2001/XMLSchema’'">

<xs:complexType name=""BooleanDataType"">
<xs:seguence>
<xs:element name="value" type="xs:boolean" />
<xs:element name="'default’ type="'xs:boolean" minOccurs="0"/>
</xs:sequence>
<xs:attribute name="name" type=''xs:string' use="required" />
<xs:attribute name="fallback type="xs:string" use="optional" />
</xs:complexType>

<xs:complexType name="'StringDataType'">
<xs:seguence>
<xs:element name="value" type=""xs:string" />
<xs:element name="‘default” type="xs:string" minOccurs="0"/>
</xs:sequence>
<xs:attribute name="name" type=''xs:string' use="‘required" />
<xs:attribute name="fallback type="'xs:string" use="'optional" />
</xs:complexType>

<xs:complexType name=""SelectionType'>
<Xs:sequence>
<xs:element name="'selection™ type="'xs:string" maxOccurs="unbounded" />
</xs:sequence>
</xs:complexType>

<xs:complexType name="'StringSetDataType'>
<xs:seguence>
<xs:element name="‘value" type="'SelectionType" />
<xs:element name="'default” type=""SelectionType' minOccurs="0" />
</xs:sequence>
<xs:attribute name="name" type='"xs:string" use=""required” />
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<xs:attribute name="fallback type="xs:string" use="optional" />
</xs:complexType>

<xs:complexType name="DimDataType"'">
<xs:sequence>
<xs:element name="'dim"" maxOccurs=""unbounded'>
<xs:complexType>
<xs:complexContent>
<xs:extension base=""SelectionType'>
<xs:attribute name="name" type=''xs:string' use="‘required" />
</xs:extension>
</xs:complexContent>
</xs:complexType>
</xs:element>
</xs:sequence>
</xs:complexType>

<xs:complexType name=""PQDDataType"'">
<xs:seguence>
<xs:element name="'pqd'>
<xs:complexType>
<xs:simpleContent>
<xs:extension base=''xs:string'>
<xs:attribute name=""type" type='‘xs:string' use="‘required" />
</xs:extension>
</xs:simpleContent>
</xs:complexType>
</xs:element>
</xs:sequence>
</xs:complexType>

<xs:element name=""Checkbox" type='""BooleanDataType" />
<xs:element name="RadioButton" type="BooleanDataType" />
<xs:element name="DatePicker' type="StringDataType" />
<xs:element name="DropDownList" type="'StringDataType" />
<xs:element name="Edit" type="'StringDataType" />
<xs:element name="'Listbox"" type="'StringSetDataType" />
<xs:element name="'SingleHierSelect" type="'StringDataType" />
<xs:element name=""Tree" type="'StringSetDataType" />

<xs:element name="'SuperTree'">
<xs:complexType>
<xs:choice>
<xs:sequence>
<xs:element name="‘value" type="DimDataType"'/>
<xs:element name="'default" type="DimDataType" minOccurs="0" />
</xs:sequence>
<xs:seguence>
<xs:element name="value" type="PQDDataType"'/>
<xs:element name="'default’ type="'PQDDataType" minOccurs="0" />
</xs:sequence>
</xs:choice>
<xs:attribute name="name" type=''xs:string' use="‘required" />
<xs:attribute name="fallback type="'xs:string" use="'optional" />
</xs:complexType>
</xs:element>

<xs:element name="'open'">
<xs:complexType>
<xs:choice>
<xs:element name=""name' type=''xs:string" />
<xs:seguence>
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<xs:element name=""templateName" type=""xs:string" minOccurs="0"/>
<xs:element name="‘createdTime" type=""xs:string' minOccurs="0"/>

</xs:sequence>
</xs:choice>
</xs:complexType>
</xs:element>

<xs:element name="build">
<xs:complexType>
<xs:seguence>

<xs:element
<xs:element
<xs:element
<xs:element

name=""templateName' type='"xs:string" />

name="al lomManualOverride" type="xs:boolean'* minOccurs="0"/>
name=""customErrorMessage" type="xs:string"' minOccurs="0"/>
name=""customWaitMessage' type='"xs:string" minOccurs="0"/>

<xs:element
<xs:element
</xs:sequence>
</xs:complexType>
</xs:element>

réf="WizardPages" />
réf=""save" minOccurs="0"/>

<xs:element name="'save'>
<xs:complexType>
<xs:seguence>
<xs:element name="label" type=""xs:string" />
<xs:element name="‘access" type=""xs:string' minOccurs="0"/>
<xs:element name="'group' type=""xs:string" minOccurs="0"/>
</xs:sequence>
</xs:complexType>
</xs:element>

<xs:element name="WizardPage'>
<xs:complexType>
<xs:sequence>
<xs:choice minOccurs="0"" maxOccurs=""unbounded'>
<xs:element ref=""Checkbox" />
<xs:element ref="DatePicker" />
<xs:element ref=""DropDownList" />
<xs:element ref="Edit" />
<xs:element ref="Listbox" />
<xs:element ref="RadioButton’ />
<xs:element ref="SingleHierSelect" />
<xs:element ref="SuperTree" />
<xs:element ref="Tree" />
</xs:choice>
</xs:sequence>
<xs:attribute name="id" type="'xs:string" use='"required"” />
<xs:attribute name=""option' type='"xs:string" use="‘optional’ />
<xs:attribute name="fallback' type="'xs:string" use="'optional" />
</xs:complexType>
</xs:element>

<xs:element name="WizardPages'>
<xs:complexType>
<xs:sequence>
<xs:element ref="WizardPage" maxOccurs="unbounded" />
</xs:sequence>
</xs:complexType>
</xs:element>

<xs:element name="'Client'>
<xs:complexType>
<Xs:sequence>
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<xs:element name="'version" type="xs:string" />
<xs:element name=""al lowConcurrentSessions' type=""xs:boolean"
minOccurs=""0""/>
</xs:sequence>
</xs:complexType>
</xs:element>

<xs:element name="'Server''>
<xs:complexType>
<xs:sequence>
<xs:element name="'description" type=''xs:string" />
<xs:element name="profile" type=""xs:boolean™ />
<xs:element name="'debug" type=""xs:boolean" />
<xs:element name="dbDaemonPort" type="'xs:integer' />
<xs:element name="'dbServerHostName" type=''xs:string" />
<xs:element name="'dbServerPortStart'" type=''xs:integer" />
<xs:element name="'dbServerPortEnd" type='xs:integer" />
<xs:element name="'defaultDbUser" type='"xs:string" />
<xs:element name="‘defaultDbPassword" type="'xs:string" />
<xs:element name="‘domainRootDirectory" type="xs:string"” />
</xs:sequence>
</xs:complexType>
</xs:element>

<xs:element name="Domain'">
<xs:complexType>
<Xs:segquence>
<xs:element name="'description’ type='""xs:string" />
<xs:element name="'directoryName" type='"xs:string' />
<xs:element name="'user" type='"xs:string" minOccurs="0"/>
<xs:element name=""password" type='"xs:string" minOccurs="0"/>
</xs:sequence>
</xs:complexType>
</xs:element>

<xs:element name=""Workbook'">
<xs:complexType>
<xs:choice>
<xs:element ref="open’ />
<xs:element ref=""build" />
</xs:choice>
</xs:complexType>
</xs:element>

<xs:element name=""RPASLaunchContext'>
<xs:complexType>
<XSs:sequence>
<xs:element ref="Client" />
<xs:element ref=""Server" />
<xs:element ref=""Domain' />
<xs:element ref="Workbook' minOccurs=""0""/>
</xs:sequence>
</xs:complexType>
</xs:element>
</Xs:schema>
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Open Workbook

Description

In any retail planning scenario, a particular workbook or, more likely, an auto-build
workbook may be used to plan for a specific grouping of products and locations. When
reacting to an event or alert related to these products and locations, it may be necessary
to always open a particular workbook or auto-build workbook. System integrators
configuring a Workspace application can configure and code an in-context opening of the
specific workbook.

System integrators can programmatically specify the parameters that RPAS needs to
open a pre-built workbook. Programmatically does not imply the use of an API, but
implies program application logic that constructs the XML specification that ICL can use
to identify and open the desired workbook.

System integrators can identify the target workbook by either of the following ways:
* By the RPAS name of the workbook.

= By the auto-build parameters, that is, user, template name, label, and creation date.
Template name and creation date are optional parameters. If template name or
creation date are not specified and multiple workbooks with the same label are
found, RPAS chooses the workbook that was created last and then further breaks the
tie based on alphabetical ordering of the template name.

Specifications
There are two options that can be specified when a workbook is opened.

Option 1
Setting Description Type Required
name The RPAS name of the workbook (also String Yes
known as the “gem name”, such as “t1” and
“t18” which is the root directory name of the
workbook)
Option 2
Setting Description Type Required
label The workbook label String Yes
templateName The template name of the workbook String No
createdTime The created time of the workbook in the String No
format “YYYY-MM-DD hh:mm:ss”
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Examples
Here is sample launch context for opening a workbook by RPAS name:

<?xml version="1.0" encoding="UTF-8" ?>
<RPASLaunchContext>
<Server>
<description>TestDomain</description>
<profile>false</profile>
<debug>false</debug>
<dbDaemonPort>12348</dbDaemonPort>
<dbServerHostName>mspdev43.us.oracle.com</dbServerHostName>
<dbServerPortStart>1025</dbServerPortStart>
<dbServerPortEnd>65535</dbServerPortEnd>
<defaultDbUser />
<defaultDbPassword />
<domainRootDirectory />
</Server>

<Client>
<version>13.2</version>
</Client>

<Domain>
<description>TestDomain</description>
<directoryName>/vol .nas/rpas_se/huangma/domains/TestDomain</directoryName>
<user>adm</user>
<password>..</password>
</Domain>

<Workbook>
<open>
<name>tl</name>
</open>
</Workbook>
</RPASLaunchContext>

Here is sample launch context for opening a workbook by label and template name:

<RPASLaunchContext>
...... (Same as above, omitted here.)
<Workbook>
<open>
<label>wb2</label>
<templateName>MEASUREANALYS1S</templateName>
</open>
</Workbook>
</RPASLaunchContext>

238 Oracle Retail Predictive Application Server



Launching RPAS

Build Workbook

RPAS users generally build workbooks through a manual process using RPAS Wizard
Pages from workbook templates. This process is automated in ICL by specifying the
contents and selections of the wizard pages in the launch context.

The automated process enables system integrators to programmatically specify the
parameters that RPAS needs to build a new workbook. The integrator can program RPAS
web launch to build virtually any workbook from any workbook templates, simple or
complex, by constructing an XML string according to the launch context schema and the
configuration of the wizard pages.

Users can think of the XML specifications as macro definitions of what they do when
they build the same workbook manually. The specifications for building workbook start
from a workbook template, which contains a list of wizard pages. Each wizard page has a
set of pre-defined widgets:

= RadioButton

= Checkbox

= Edit

=  DropDownList

= SingleHierSelect

= DatePicker

= Listbox

=  Tree

=  SuperTree

Each widget has its own specifications depending on its type.

The fallback option can be specified on the widget and wizard page level. The widget
level fallback option is considered first when the specifications for that widget are
incomplete or incorrect. If a specification cannot be resolved on the widget level, the
wizard page fallback option is used. If the fallback option on the wizard page is not
specified or the option has errors, an error message is displayed to the user.

If any unrecoverable errors occur on a wizard page, the workbook build process falls
back to manual mode if the allowManualOverride option is set to true. The wizard starts
from the first page. All selections prior to the problematic page are preserved and the
user can click Next to skip them and go to the page with errors, which is blank along
with all subsequent pages.
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Specifications

The specifications to build a workbook consist of basic settings and a list of wizard pages.
Each wizard page contains a list of widget specifications.

Basic Settings
Setting Description Type Required
templateName The template name for the workbook to be String Yes
built.
allowManualOverride | Allow manual override in case of fatal errors | Boolean No
in the XML data. The default is true. The
wizard starts from the first page.
customErrorMessage | Custom error message to display in case of | String No
fatal errors in the launch context data.
customWaitMessage | Custom wait message to display while the String No

workbook is being built.

Wizard Page Specifications

Setting Description Type Required
id (attribute) Wizard page internal identifier. String Yes
option (attribute) Wizard page handling option. Can be one of | String No

the following values:

=  “manual”: forces manual selection for
all widgets. This option forces manual
input for this and all subsequent pages.
However, the wizard still starts from
the first page.

= “skippable”: this page can be skipped.
Normally used for a conditional wizard
page. This page only exists if some
particular value is selected for some
widget on the previous page.

fallback (attribute) Wizard page level fall back option. Canbe | String No
one of the following values:

= “default”: use values from the default
settings for all widgets.

= “cache”: use selections from the cache
selection file. Cache files are from last
successful workbook build of the same
template.
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Wizard Widget Specifications

RadioButton and Checkbox

String Set type.

Setting Description Type Required
name (attribute) Widget name. String Yes
fallback (attribute) Widget level fallback option. Can be: String No
“default”: use value from the default setting.
value Boolean type: selected value for the widget. | XML section | Yes
Value must be either “false” or “true”.
default Default value for the widget. Must be a XML section | No
Boolean type.
Edit, DropDownList, SingleHierSelect, and DatePicker
Setting Description Type Required
name (attribute) Widget name. String Yes
fallback (attribute) Widget level fallback option. Can be: String No
“default”: use value from the default setting
value String type: selected value for the widget. XML section | Yes
default Default value for the widget. Must be a XML section | No
String type.
Listbox and Tree
Setting Description Type Required
name (attribute) Widget name. string Yes
fallback (attribute) Widget level fall back option. Can be one of | string No
the following values:
= “default”: use value from the default
setting.
= “all”: select all available items or
positions.
*  “intersection”: use intersection of the
specified items/positions and all
available items/positions if any of the
specified items/positions do not exist.
value String Set type: selected value for the XML section | Yes
widget. Value is a set of selections.
default Default value for the widget. Must be a XML section | No
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SuperTree
Setting Description Type Required
name (attribute) Widget name. String Yes
fallback (attribute) Wizard page level fallback option. Can be String No
one of the following values:
= “default”: use value from the default
setting.
=  “all”: select all available positions.
=  “intersection”: use intersection of
specified positions and all available
positions if any of the specified
positions do not exist.
value String to String Set Map Type/PQD File XML section | Yes
Type: selected value for the widget. Can be
one of the following values:
*  Value is one or more dimensions, each
having a set of selections.
*  Value is a Position Query Definition
(PQD) file name in the format:
<pad type="{pad_type}">
pqd_file_name
</pqd>
where {pgd_type} must be either
PointAndClickPQD or
RollingCalendarPQD.
default Default value for the widget. Must be a XML section | No
String to String Set Map type or PQD file
type.

Workbook Save Specifications
These save specifications are optional. If specified, the workbook is immediately saved

after it is built.

Setting Description Type Required
label Workbook label. String Yes
access Workbook access. Must be “user”, “group” | String No
or “world”. If not specified, the default is
“user”.
group Workbook group. Required when String Conditional
workbook access is “group”. There is no
default.
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Example

The following example shows a sample launch context for building a workbook. It
specifies a new “Measure Analysis” workbook for a simple domain (“TestDomain”). The
domain is created by using the RPAS utility createRpasDomain with the command line
option “-x”.
<?xml version="1.0" encoding=""UTF-8" ?>
<RPASLaunchContext>
<Client>
<version>13.2</version>
</Client>
<Server>
<description>mspdev43-65535</description>
<profile>false</profile>
<debug>false</debug>
<dbDaemonPort>12348</dbDaemonPort>
<dbServerHostName>mspdev43.us.oracle.com</dbServerHostName>
<dbServerPortStart>1025</dbServerPortStart>
<dbServerPortEnd>65535</dbServerPorteEnd>
<defaultDbUser />
<defaultDbPassword />
<domainRootDirectory />
</Server>
<Domain>
<description>TestDomain</description>
<directoryName>/vol .nas/rpas_se/domains/TestDomain</directoryName>
</Domain>
<Workbook>
<build>
<templateName>MEASUREANALYS1S</templateName>
<WizardPages>
<WizardPage id=""ExtraMeasuresPage' fallback=""none"">
<Listbox name=""1bl"">
<value>
<selection>R_EX DEMOA</selection>
<selection>R_EX DEMOB</selection>
<selection>R_EX DEMOC</selection>
</value>
</Listbox>
</WizardPage>
<WizardPage id="DAY"" fallback=""none"">
<SuperTree name="‘treel' fallback=""all"'>
<value>
<dim name="WEEK''>
<selection>W01 _1997</selection>
<selection>W01_1998</selection>
<selection>W01 _1999</selection>
<selection>W01_2000</selection>
</dim>
<dim name="DAY'">
<selection>19970108</selection>
</dim>
</value>
<default>
<dim name="DAY'">
<selection>19970108</selection>
</dim>
</default>
</SuperTree>
</WizardPage>
<WizardPage id=""STR" fallback=""none"">
<SuperTree name=""treel'>
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<value>
<dim name=""STR'">
<selection>0102</selection>
<selection>0144</selection>
<selection>0152</selection>
<selection>0557</selection>
<selection>0594</selection>
<selection>0959</selection>
</dim>
</value>
</SuperTree>
</WizardPage>
<WizardPage id=""SKU" fallback=""none"">
<SuperTree name=""treel'">
<value>
<dim name=""CLSS'">
<selection>021</selection>
</dim>
</value>
</SuperTree>
</WizardPage>
</WizardPages>
<save>
<label>Testwb</label>
<access>Group</access>
<group>ADMIN</group>
</save>
</build>
</Workbook>
</RPASLaunchContext>

buildWorkbookContext Utility

The buildWorkbookContext utility is a server side command line utility. It runs under
both global domains and local domains.

Before running this utility, you should first manually create a workbook using the
workbook template you intend to use in the context. This step generates selection files. In
order to capture as much information as possible in the selection files, you can choose to
select all for the widgets on wizard pages. This is especially useful for listbox widgets.
After the XML file is generated, you can use the data in the file directly if you want to
build an identical workbook. Or, you can use it as a starting point and tailor it to meet
some specific requirements.

Command Line Usage

bui ldWorkbookContext -d [domain_path] -user [user_name] -wbt [wbt name] —out
[output_File]

* [domain_path]: The path to the global or local domain.

=  [user_name]: The username whose selection files are used. This is the user who has
manually run the workbook template wizard.

*  [wbt_name]: The name of the workbook template for which the XML context is built.
This is the internal name for the template. It can be identified by looking at the
selection files under DOMAIN_PATH /users/[user]/selections. The names of the
selection files are in this format: [templateName]_[wizpagelD].sel.

= [Joutput_file]: Output file name for the XML context.
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Appendix: Workspace and Oracle Single
Sign-On

Integration with Oracle Retail Workspace

The Oracle Retail Workspace installer prompts you to enter the URL for your supported
Oracle Retail applications. However, if a client installs a new application after Oracle
Retail Workspace is installed, the retail-workspace-page-config.xml file needs to be
edited to reflect the new application.

The file as supplied comes with all appropriate products configured, but the
configurations of non-installed products have been "turned off". Therefore, when
"turning on" a product, locate the appropriate entry, set "rendered"” to "true", and enter
the correct URL and parameters for the new application.

The entry consists of the main URL string plus one parameter named "config". The value
of the config parameter is inserted by the installer. Somewhere in the installer property
files there is a value for the properties "deploy.retail.product.rms.url" and
"deploy.retail.product.rms.config".

The entry consists of the main URL string plus one parameter named "config". The value
of the config parameter will be inserted by the installer. Somewhere in the installer
property files there will be a value for the properties "deploy.retail. product.rms.url" and
"deploy.retail.product.rms.config".

For example, suppose RMS was installed on mycomputer.mycompany.com, port 7777,
using a standard install and configured with the application name of
"rms121sedevhpsso". If you were to access RMS directly from your browser, you would
type in:

http://mycomputer _mycompany .com:7777/forms/frmservlet?config=rms121sedevhpsso

The entry in the retail-workspace-page-config.xml after installation would resemble the

following:
<urI>http://mycomputer .mycompany .com:7777/forms/frmserviet</url>
<parameters>
<parameter name="‘config'">
<value>rms121sedevhpsso</value>
</parameter>
</parameters>

Oracle Single Sign-on Overview

What is Single Sign-On?
Single Sign-On (SSO) is a term for the ability to sign onto multiple Web applications via a
single user ID/Password. There are many implementations of SSO — Oracle currently
provides three different implementations: Oracle Single Sign-On (OSSO), Java SSO (with
the 10.1.3.1 release of OC4J) and Oracle Access Manager (provides more comprehensive
user access capabilities).

Most, if not all, SSO technologies use a session cookie to hold encrypted data passed to
each application. The SSO infrastructure has the responsibility to validate these cookies
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and, possibly, update this information. The user is directed to log on only if the cookie is
not present or has become invalid. These session cookies are restricted to a single
browser session and are never written to a file.

Another facet of SSO is how these technologies redirect a user’s Web browser to various
servlets. The SSO implementation determines when and where these redirects occur and
what the final screen shown to the user is.

Most SSO implementations are performed in an application’s infrastructure and not in
the application logic itself. Applications that leverage infrastructure managed
authentication (such as deploying specifying “Basic” or “Form” authentication) typically
have little or no code changes when adapted to work in an SSO environment.

What Do | Need for Oracle Single Sign-On?

The nexus of an Oracle Single Sign-On system is the Oracle Identity Management

Infrastructure installation. This consists of the following components:

* An Oracle Internet Directory (OID) LDAP server, used to store user, role, security,
and other information. OID uses an Oracle database as the back-end storage of this
information.

* An Oracle HTTP Server 11g Release 1 as a front end to the Oracle WebLogic Server.
The Oracle HTTP Server is included in the Oracle Web Tier Utilities 11g Release 1
(11.1.1).

* An Oracle Single Sign-On Plug-in, used to authenticate the user and create the OSSO
session cookie. This is available in the Oracle Fusion Middleware 11g Web Tier
Utilities (11.1.1.20) package.

* The Delegated Administration Services (DAS) application, used to administer users
and group information. This information may also be loaded or modified via
standard LDAP Data Interchange Format (LDIF) scripts.

* Additional administrative scripts for configuring the OSSO system and registering
HTTP servers.

For more information on setting up single sign on, refer to the Oracle Retail Predictive
Application Server Installation Guide.

Additional WebLogic managed servers will be needed to deploy the business
applications leveraging the OSSO technology.

Can Oracle Single Sign-On Work with Other SSO Implementations?

Yes, OSSO has the ability to interoperate with many other SSO implementations, but
some restrictions exist.

Oracle Single Sign-on Terms and Definitions

Authentication

Authentication is the process of establishing a user’s identity. There are many types
of authentication. The most common authentication process involves a user ID and
password.

Dynamically Protected URLs

A “Dynamically Protected URL” is a URL whose implementing application is aware
of the OSSO environment. The application may allow a user limited access when the
user has not been authenticated. Applications that implement dynamic OSSO
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protection typically display a “Login” link to provide user authentication and gain
greater access to the application’s resources.

Identity Management Infrastructure

The Identity Management Infrastructure is the collection of product and services
which provide Oracle Single Sign-on functionality. This includes the Oracle Internet
Directory, an Oracle HTTP server, and the Oracle Single Sign-On services. The Oracle
Application Server deployed with these components is typically referred as the
“Infrastructure” instance.

MOD_0SSO

mod_osso is an Apache Web Server module an Oracle HTTP Server uses to function
as a partner application within an Oracle Single Sign-On environment. The Oracle
HTTP Server is based on the Apache HTTP Server.

MOD_WEBLOGIC

mod_weblogic operates as a module within the HTTP server that allows requests to
be proxied from the Apache HTTP server to the WebLogic server.

Oracle Internet Directory

Oracle Internet Directory (OID) is an LDAP-compliant directory service. It contains
user ids, passwords, group membership, privileges, and other attributes for users
who are authenticated using Oracle Single Sign-On.

Partner Application

A partner application is an application that delegates authentication to the Oracle
Identity Management Infrastructure. One such partner application is the Oracle
HTTP Server (OHS) supplied with the Oracle Application Server. OHS uses the
MOD_OSSO module to configure this functionality.

All partner applications must be registered with the Oracle Single Sign-On server. An
output product of this registration is a configuration file the partner application uses
to verify a user has been previously authenticated.

Realm

A Realm is a collection users and groups (roles) managed by a single password
policy. This policy controls what may be used for authentication (for example,
passwords, X.509 certificates, and biometric devices). A Realm also contains an
authorization policy used for controlling access to applications or resources used by
one or more applications.

A single OID can contain multiple Realms. This feature can consolidate security for
retailers with multiple banners or to consolidate security for multiple development
and test environments.

Statically Protected URLs

A URL is considered to be “Statically Protected” when an Oracle HTTP server is
configured to limit access to this URL to only SSO authenticated users. Any attempt
to access a “Statically Protected URL” results in the display of a login page or an
error page to the user.

Servlets, static HTML pages, and JSP pages may be statically protected.
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Note: Dynamically Protected URL and Statically Protected
URL are within the context of the Oracle Software Security
Assurance (OSSA). The static protection for URLs is a
common JEE feature.

What Single Sign-On is not
Single Sign-On is NOT a user ID/password mapping technology.

However, some applications can store and retrieve user IDs and passwords for non-SSO
applications within an OID LDAP server. An example of this is the Oracle Forms Web
Application framework, which maps OSSO user IDs to a database logins on a per-
application basis.

How Oracle Single Sign-On Works

Oracle Single Sign-On involves a couple of different components. These are:

The Oracle Single Sign-On (OSSO) servlet, which is responsible for the back-end
authentication of the user.

The Oracle Internet Directory LDAP server, which stores user IDs, passwords, and
group (role) membership.

The Oracle HTTP Server associated with the Web application, which verifies and
controls browser redirection to the OSSO servlet.

If the Web application implements dynamic protection, then the Web application
itself is involved with the OSSO system.

Statically Protected URLs

When an unauthenticated user accesses a statically protected URL, the following occurs:

1.

The user’s Web browser makes an HTTP request to a protected URL serviced by the
Oracle HTTP Server (OHS).

The Oracle HTTP Server processses the request and routes it to the mod_oss module.

This module determines whether the user is already authenticated. If the
authentication is required, it directs the browser to the OSSO server. The OSSO
server checks for a secure cookie containing the authentication information. If the
cookie is not found, the following occurs:

a. The OSSO servlet determines the user must authenticate, and displays the OSSO
login page.

b. The user must sign in via a valid user ID and password. If the OSSO servlet has
been configured to support multiple Realms, a valid realm must also be entered.
The user ID, password, and realm information is validated against the Oracle
Internet Directory LDAP server. The browser is then redirected back to the
Oracle HTTP Server with the encrypted authentication credentials. It does NOT
contain the user’s password.

The mod_osso module then decrypts the user credentials and sets HTTP headers
with relevant user attributes, marking the user’s session as authenticated.

The mod_weblogic module (within the Oracle HTTP Server) then forwards the
request to the Oracle WebLogic Server.

The Oracle WebLogic Server then invokes the configured authentication providers
that decode the headers and provide the user’s role membership. In an OSSO
implementation, ensure that the OSSO Identity Asserter is invoked and Oracle
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Internet Directory (OID) Authenticator is executed to provide the user’s role
membership.

Once the authentication is established, the relevant application logic is initiated and
the response is sent back to the user through the Oracle HTTP Server.

Because the Web browser session is now authenticated, subsequent requests in that
session are not redirected to the OSSO server for authentication.

Dynamically Protected URLs

When an unauthenticated user accesses a dynamically protected URL, the following
occurs:

1.

The user’s Web browser makes an HTTP request to a protected URL serviced by the
Oracle HTTP Server (OHS). The Oracle HTTP server recognizes the user has not been
authenticated, but allows the user to access the URL.

The application determines the user must be authenticated and send the Oracle
HTTP Server a specific status to begin the authentication process.

The Oracle HTTP Server processses the request and routes it to the mod_oss module.

This module determines whether the user is already authenticated. If the
authentication is required, it directs the browser to the OSSO server. The OSSO
server checks for a secure cookie containing the authentication information. If the
cookie is not found, the following occurs:

a. The OSSO servlet determines the user must authenticate, and displays the OSSO
login page.

b. The user must sign in via a valid user ID and password. If the OSSO servlet has
been configured to support multiple Realms, a valid realm must also be entered.
The user ID, password, and realm information is validated against the Oracle
Internet Directory LDAP server. The browser is then redirected back to the
Oracle HTTP Server with the encrypted authentication credentials. It does NOT
contain the user’s password.

The mod_osso module then decrypts the user credentials and sets HTTP headers
with relevant user attributes, marking the user’s session as authenticated.

The mod_weblogic module (within the Oracle HTTP Server) then forwards the
request to the Oracle WebLogic Server.

The Oracle WebLogic Server then invokes the configured authentication providers
that decode the headers and provide the user’s role membership. In an OSSO
implementation, ensure that the OSSO Identity Asserter is invoked and Oracle
Internet Directory (OID) Authenticator is executed to provide the user’s role
membership.

Once the authentication is established, the relevant application logic is initiated and
the response is sent back to the user through the Oracle HTTP Server.

Because the Web browser session is now authenticated, subsequent requests in that
session are not redirected to the OSSO server for authentication.

Appendix: Workspace and Oracle Single Sign-On 249



Oracle Single Sign-on Overview
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Installation Overview

Installing Oracle Single Sign-On consists of installing the following components:

1. Installing the Oracle Internet Directory (OID) LDAP server and the Infrastructure
Oracle Application Server (OAS). These are typically performed using a single
session of the Oracle Universal Installer and are performed at the same time. OID
requires an Oracle relational database and if one is not available, the installer will
also install this as well.

The Infrastructure OAS includes the Delegated Administration Services (DAS)
application as well as the OSSO servlet. The DAS application can be used for user
and realm management within OID.

2. Installing additional midtier instances (such as OAS 10.1.4) for the Oracle Retail
applications, such as RMS, that are based on Oracle Forms technologies. These
instances must be registered with the Infrastructure OAS installed in step 1.

3. Installing additional application servers to deploy other Oracle Retail applications
and performing application specific initialization and deployment activities.

Infrastructure Installation and Configuration

The Infrastructure installation for OSSO is dependent on the environment and
requirements for its use. Deploying an Infrastructure OAS to be used in a test
environment does not have the same availability requirements as for a production
environment. Similarly, the Oracle Internet Directory (OID) LDAP server can be
deployed in a variety of different configurations. See the Oracle Application Server
Installation Guide and the Oracle Internet Directory Installation Guide for more details.
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OID User Data

Oracle Internet Directory is an LDAP v3 compliant directory server. It provides
standards-based user definitions out of the box.

The current version of Oracle Single Sign-On only supports OID as its user storage
facility. Customers with existing corporate LDAP implementations may need to
synchronize user information between their existing LDAP directory servers and OID.
OID supports standard LDIF file formats and provides a JNDI compliant set of Java
classes as well. Moreover, OID provides additional synchronization and replication
facilities to integrate with other corporate LDAP implementations.

Each user ID stored in OID has a specific record containing user specific information. For
role-based access, groups of users can be defined and managed within OID. Applications
can thus grant access based on group (role) membership saving administration time and
providing a more secure implementation.

OID with Multiple Realms

OID and OSSO can be configured to support multiple user Realms. Each realm is
independent from each other and contains its own set of user IDs. As such, creating a
new realm is an alternative to installing multiple OID and Infrastructure instances.
Hence, a single Infrastructure OAS can be used to support many development and test
environments by defining one realm for each environment.

Realms may also be used to support multiple groups of external users, such as those
from partner companies. For more information on Realms, see the Oracle Internet
Directory Administrators Guide.

User Management

User Management consists of displaying, creating, updating or removing user
information. There are two basic methods of performing user management: LDIF scripts
and the Delegate Administration Services (DAS) application.

OID DAS

The DAS application is a Web-based application designed for both administrators and
users. A user may update their password, change their telephone number of record, or
modify other user information. Users may search for other users based on partial strings
of the user’s name or ID. An administrator may create new users, unlock passwords, or
delete users.

The DAS application is fully customizable. Administrators may define what user
attributes are required, optional or even prompted for when a new user is created.

Furthermore, the DAS application is secure. Administrators may also what user
attributes are displayed to other users. Administration is based on permission grants, so
different users may have different capabilities for user management based on their roles
within their organization.

LDIF Scripts

Script based user management can be used to synchronize data between multiple LDAP
servers. The standard format for these scripts is the LDAP Data Interchange Format
(LDIF). OID supports LDIF script for importing and exporting user information. LDIF
scripts may also be used for bulk user load operations.
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User Data Synchronization

The user store for Oracle Single Sign-On resides within the Oracle Internet Directory
(OID) LDAP server. Oracle Retail applications may require additional information
attached to a user name for application-specific purposes and may be stored in an
application-specific database. Currently, there are no Oracle Retail tools for
synchronizing changes in OID stored information with application-specific user stores.
Implementers should plan appropriate time and resources for this process. Oracle Retail
strongly suggests that you configure any Oracle Retail application using an LDAP for its
user store to point to the same OID server used with Oracle Single Sign-On.
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curvevalidate

Usage

Curvevalidate automatically executes during the domain install, and it can also be run at
any time against a Master or one subdomain. If run against the Master Domain, it checks
the master and all subdomains. If run against a subdomain, it checks the Master and only
the subdomain (not all other subdomains). This function verifies that:

= Profile and Source intersections and source data are properly defined
* Profile intersections respect the partition dimension

curvevalidate -d domainpath [-s]

The following table provides descriptions of the arguments used by the curvevalidate
utility.

Argument Description

—d domainpath Path to the domain.

-s Set defaults.

-debug This argument causes temporary measures to be

retained for debugging purposes.

-h Standard information argument to display
information about curvebatch in the terminal screen.

-version Standard argument that displays version information.
-loglevel Used to set the logger verbosity level. Available
verbosity levels are as follows:
= all
= profile

= information
= warning

= error

=  none

-noheader Standard argument to disable the use of timestamp
header.

1. Each Profile must have at least one Source Level.
2. For each Profile:

a. For global domains, ALL intersections {Data Intersection, Profile Intersection,
Stored Intersection, Aggregation Intersection, and Approval Intersection} must
be below the partition (NOT HBI).
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b. Data Intersection (if a data source is specified) must conform to X in {Profile
Intersection, Stored Intersection, Aggregation Intersection, and Approval
Intersection}.

Profile Intersection must conform to the Stored Intersection.
Aggregation Intersection must conform to the Approval Intersection.
Aggregation Intersection must not be below the Approval Intersection.

-0 o0

Aggregation Intersection must be above the Data Intersection (if data source
specified).

If the Aggregation Intersection conforms to Profile Intersection:

i. The Profile Type must NOT be diff(8).

ii. The Aggregation Intersection must be above the Profile Intersection.

iii. The Aggregation Intersection must be above the Stored Intersection.

h. If Aggregation Intersection does not conform to Profile Intersection:

i. The Profile Type must be Diff (8).

ii. There must be at least one common hierarchy between the Aggregation
Intersection and X in {Profile Intersection, Stored Intersection}.

iii. For each common non-PROD hierarchy H of Aggregation Intersection and X
in {Profile Intersection, Stored Intersection}:
Aggregation Intersection’s H dimension must not be below X’s H dimension.

3. For each Source Level:

a. For global domains, ALL intersections {Profile Intersection, Stored Intersection,
and Aggregation Intersection} must be below the partition (NOT HBI).

b. Parent Profile’s Data Intersection (if data source specified) must conform to X in
{Profile Intersection, Stored Intersection, and Aggregation Intersection}.

c. Profile Intersection must conform to Stored Intersection.

Aggregation Intersection must be above parent Profile’s Data Intersection (if data
source specified).

e. If Aggregation Intersection conforms to Profile Intersection:
i. The Profile Type must NOT be diff(8).
ii. The Aggregation Intersection must be above the Profile Intersection.
iii. The Aggregation Intersection must be above the Stored Intersection.
f. If Aggregation Intersection does not conform to Profile Intersection:
iv. The Parent Profile Type must be Diff (8).

v. There must be at least one common hierarchy between the Aggregation
Intersection and X in {Profile Intersection and Stored Intersection}.

vi. For each common non-PROD hierarchy H of Aggregation Intersection and X
in {Profile Intersection and Stored Intersection}:
Aggregation Intersection’s H dimension must not be below X’s H dimension.
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curvebatch

Usage
curvebatch -d domainpath [-level # ] [-debug] | -h | -version
The following table provides descriptions of the arguments used by the curvebatch

utility.
Argument Description
—d domainpath Path to the domain.
-level # The # signifies the profile ID. When using level, a
valid profile ID must be provided.
-debug This argument causes temporary measures to be
retained for debugging purposes.
-h Standard information argument to display
information about curvebatch in the terminal screen.
-version Standard argument that displays version information.
-loglevel Used to set the logger verbosity level. Available
verbosity levels are as follows:
= all
= profile
= information
= warning
= error
u none
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Appendix: RPAS Test Driver

This appendix describes the RPAS Test Driver (RTD).

Support for the RTD library is limited to its basic understanding and usage of the
published XML-based APIs. This library is available on specific versions of the Windows
platform where the RPAS release is officially supported.

Oracle does not provide support for compilation or linkage of this library. Also, Oracle
does not support LoadRunner scripts or any other scripts used to run the rtd.dll library.

Introduction

Audience

This appendix covers the use of rtd.dll provided for the purpose of performance testing
of the Oracle Retail RPAS server. This DLL allows a user to create, open, alter, save,
commit, and refresh workbooks by sending commands directly to the RPAS server
through an XML structure.

Knowledge of the usage of the Oracle Retail RPAS client is assumed. A user must have a
working domain, which can be connected to with a client. A user must also know the
internal names of dimensions, positions, workbook templates, worksheets, and windows.

Although the interface provided by this library could be used by any testing tool, it has
most frequently been used with HP LoadRunner. The use of RTD with LoadRunner is
outlined in later sections.

Finding Required Information

Compatibility

The majority of interactions with RTD assume knowledge of internal names. In order to
easily find dimensions and position internal names, the RPAS client (foundation.exe) can
be made to display the internal names rather than labels.

This is accomplished by adding “ShowPositionNames=1" under the [Options] section in
%windir% \Foundation.ini , for example, C:\Windows\Foundation.ini. Then, when
building and displaying a workbook, the client displays position names instead of labels.
To find template, worksheet, and window names, make a search under your domain's
“repos” directory for files named “tmpl.cfg” with the label (displayed name) of your

template. The template name, worksheet, and window names are contained within this
file.

The version of RTD must be compatible with the RPAS server version. If an RPAS hot fix
or upgrade requires a client update, then it is likely a matching RTD build will be
required. Contact support for further information.
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Interface

The C interface provided by the library is simple to interact with, the majority of
interactions being with rtd_send() and rtd_getResponse() functions. The complexity
arises in the messages sent and received by these functions, detailed in the next section.
To log on to the server:

int rtd_logon(const char* user,const char* password,const char* connection,const
char* domain,const char* fcfPath,const char* language,const char*)

The following table provides descriptions of the arguments used by int rtd_logon.

Argument Description
const char* user User name.
const char* password User password.

const char* connection | Connection defined in the .fcf file.

const char* domain Domain defined in the .fcf file.

const char* fcfPath Path to the .fcf file.

const char* language Language of the domain, usually “english”. (Currently
unused.)

const char* logLevel Log level of the RPAS server, defaults to “debug” if blank.

To log off the server:
void rtd_logoffQ)

To send an XML request to the server:
int rtd_send(const char* request)

To get the XML response from the server request:
char* rtd_getResponse()

To get a particular property from the response XML tag:
char* rtd_getResponseProperty(const char* property)

To free the char buffer that was allocated by rtd_getResponse() or
rtd_getResponseProperty():
void rtd_freeCharPtr(char®*)

Note: Freeing the char buffer is necessary to prevent
memory leaks.

Functions returning an int indicate success by returning 1 and failure by returning any
other value.
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The following figure shows an example of the expected use of the library. RTD function

calls are indicated in the shaded blocks.
Figure 1 — RTD Example Workflow
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XML Requests

This section describes requests that can be sent as XML strings to the server. All tags and
attributes are case-sensitive.

Connection Messages
<Logon>

Description:
Log a user into a domain, alternative to rtd_logon().

Properties:
user, password, connection, domain, fcfPath, logLevel , and language.

<Logoff>

Description:
Log the current user off, alternative to rtd_logoffQ.

Wizard Messages

The messages below appear in the order in which they are called. They are repeated as
necessary for the wizard pages. The wizard pages can be determined by creating the
same workbook in the client.

<WizardlInitialize>

Description:
Start wizard to create a new workbook.

Properties:
templateName — Internal name of the workbook template, as defined in tmpl .cfg.

<GetNextWizardDialog>

Description:
Move to the next page in a wizard. This must be called after <WizardInitialize>
to navigate to the first wizard page.

Properties:
templateName — Internal name of the workbook template, as defined in tmpl .cfg.
currentDialog [optional] — Not currently used.

forward — Direction to move the wizard. Values are “true” to go forward or
“false” to go backward, but this should almost always be true.
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<GetWizardLayout>

Description:

Gets the wizard layout. <GetNextWizardDialog>automatically calls this. Users
should not need to call it directly.

Properties:
templateName — Internal name of workbook template, as defined in tmpl.cfg.

currentDialog -Name of wizard page as defined in tmpl.cfg.
<SelectPositions>

Description:

Select which positions should be included in the workbook. The <position> child
tags are sent in the same message as the <SelectPositions> tag.
<GetNextWizardDialog> must be called to navigate to the correct wizard page
before calling <SelectPositions>. This is typically used on two-tree wizard

pages.

Properties:
templateName — Internal name of workbook template, as defined in tmpl .cfg.
currentDialog — Name of wizard page defined by the template configuration file.

Children:
<position>

Properties:
dimension — Dimension that contains the position.

name — Name of the position.
<SetWizardData>

Description:

This allows explicit control over the UI elements within each page of the wizard.
This enables operations beyond simple workbook builds. This is typically used
on custom wizard pages.

Properties:

templateName — Internal name of workbook template, as defined in tmpl.cfg.
currentDialog — Name of wizard page defined by the template configuration file.
name — Ul control name.

class — UI control class.

The control classes are specified in:
$RPAS_HOME/devkit/include/rpas/UlControls.h and include:

Edit, DropDownlList, Listbox, Groupbox, Checkbox, RadioButton, Text,
SingleHierSelect, Tree, SuperTree, DatePicker

The string "true" or "false" is used set radio buttons and checkboxes.
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The following example illustrates this use in the context of AutoWorkbook
builds.

<I-- Create the workbook -->
<WizardInitialize templateName=""AutoWb" />

<I-- AutoWorkbookPageO - select action -->

<GetNextWizardDialog templateName=""AutoWwb" forward=""true" />
<SetWizardData templateName=""AutoWb" currentDialog=""AutoWorkbookPageO"
name=""addWb" class=""RadioButton'>true</SetWizardData>

<I-- AutoWorkbookPagel - select template -—>

<GetNextWizardDialog templateName=""AutoWwb' forward=""true" />
<SetWizardData templateName=""AutoWb' currentDialog=""AutoWorkbookPagel"
name=""ListBox"" class=""Listbox'">R_TEST</SetWizardData>

<I1-- AutoWorkbookPage2 - select owner ——>

<GetNextWizardDialog templateName=""AutoWwb' forward=""true" />
<SetWizardData templateName=""AutoWb' currentDialog=""AutoWorkbookPage2"
name=""ListBox"" class=""Listbox ">adm</SetWizardData>

<I-- AutoWorkbookPage3 - enter scheduling data -->
<GetNextWizardDialog templateName=""AutoWwb" forward=""true" />
<SetWizardData templateName="AutoWb" currentDialog=""AutoWorkbookPage3"
name=""Bui ldLabel"" class=""Edit''><value>RTD Auto Build
WB</value></SetWizardData>

<SetWizardData templateName=""AutoWb' currentDialog=""AutoWorkbookPage3"
name=""Bui ldFrequency" class="Edit'">1000</SetWizardData>
<SetWizardData templateName=""AutoWb' currentDialog=""AutoWorkbookPage3"
name=""NextBui ldDate" class="Edit ">05/05/2010</SetWizardData>
<SetWizardData templateName=""AutoWb' currentDialog=""AutoWorkbookPage3"
name=""GroupAccess" class="RadioButton'>true</SetWizardData>
<SetWizardData templateName=""AutoWb' currentDialog=""AutoWorkbookPage3"
name=""groupNames"'" class=""Listbox'">adm</SetWizardData>

<I—— .. workbook build details omitted .. -—>

<WizardFinish templateName="Auto\wb />
<WizardFinish>

Description:

Finish the wizard and build the workbook. After calling this, call
rtd_getResponseProperty(‘workbookName™) to get the internal name of the newly
created workbook.

Properties:
templateName — Internal name of workbook template, as defined in tmpl .cfg.
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Workbook Messages

Once a workbook has been created via the wizard process, it must be opened and
manipulated. These functions do this for any created workbook.

<OpenWorkbook>

Description:
Open an existing workbook.

Properties:

workbookName — Internal name of a stored workbook of the form “txxx” where
the x's represent a variable number of digits. If the workbook was just created by
the wizard process, use the value returned by rtd_getResponseProperty(). See
<WizardFinish> above.

access [optional] — Currently unused.
<Fetch>

Description:
Fetch data from the workbook.

Properties:
workbookName — Internal name of a stored workbook. See <OpenWorkbook> for
more information.

windowName — Internal name of the window on which this measure is located
as defined by tmpl .cfg.

Children:

<WindowContext> — Tag that defines what hierarchies and dimensions would be
visible if there was a screen. At a minimum, the dimensions of the current cell
need to be specified. There should only be one tag per hierarchy.

Properties:
hierarchy — Name of hierarchy.

Children:
<dimension> — Tag that represents the name of a dimension.

Properties:
value — Name of the dimension.

<position> — Tag that represents a position of the cell.

Properties:

dimension — Dimension that contains the position.

name — Name of the position.

hier — Hierarchy that contains the dimension.

axis — Location of this position in the grid if this was on the screen.

voou

Values are “row”, “column” or “page”.
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<SetValues>

Description:
Set the values of cells in the workbook.

Properties:

worksheet — Name of sheet as defined in tmpl .cfg.
measure — Measure whose value should be set.
spreadMeasure [optional] — Currently unused.

spreadMethod — Method to use when spreading this cell to lower level cells. See
Oracle Retail RPAS documentation for more information.

value — Desired value of the cell.

type — Type of cell. More accurately, this is the type of the measure. Locate this
by examining the configuration of the domain with the Oracle RPAS
Configuration Tools.

Children:

<WindowContext> — Tag that defines what hierarchies and dimensions would be
visible if there was a screen. At a minimum, the dimensions of the current cell
need to be specified. There should only be one tag per hierarchy.

Properties:
hierarchy — Name of hierarchy.

Children:
<dimension> — Tag that represents the name of a dimension.

Properties:
value — Name of the dimension.
<position> — Tag that represents a position of the cell.

Properties:
dimension — Dimension that contains the position.

name — Name of the position.

<CommitWorkbook>

Description:
Transfer the data in the workbook back to the domain.

Properties:

synchronous [optional] - If “true”, the workbook commits the data now.
Otherwise, it is the same as “commit later”.

asap [optional] — If “true”, the workbook is added to the server’s commit ASAP
queue.

If the ‘synchronous’ option is “true”, then the ‘asap’ option is ignored. If both
‘synchronous’ and ‘asap”’ are omitted or blank, then the default is to commit data
now.
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<RefreshWorkbook>

Description:
Overwrite the data in the workbook with data from the domain.

Properties:

refreshGroup [optional] — If a workbook has several refresh groups, you may
specify the one to use here. If omitted or blank, the default group is used.

<MenuEvent>

Description:
Execute a custom menu event in the current workbook.

Properties:

id — The numeric ID of the custom menu event. The IDs start at 1 and are in the
same order as they appear in the Dynamic Template configuration file.

<CreatePOPMeasure>

Description:
Create a new percent of parent measure (also known as percent participation).

Properties:
window — The name of the window that the new measure will be added to.

measure — The name of the “parent” measure for the new percent of parent
measure.

hier [optional] — Specifies the hierarchy name for a relative percent of parent
measure.

hiers [optional] — Specifies all hierarchies for an absolute percent of parent
measure. Hierarchy names are delimited by a space.

dims [optional] — Specifies all dimensions for an absolute percent of parent
measure. Dimension names are delimited by a space.

Note: Either ‘hier’ or both ‘hiers” and ‘dims’ must be
specified. Both may not be specified. Specifying ‘hier’
indicates that the percent of parent measure will be relative.
Specifying both ‘hiers’ and ‘dims’ indicates that the percent
of parent measure will be absolute. ‘hiers” and ‘dims’ are
parallel arrays and their order must match.

Appendix: RPAS Test Driver 265



RTD use with HP LoadRunner

<SaveWorkbook>

Description:
Save the workbook to work on later.

Properties:
workbookLabel — Label (displayed name) for the workbook

workbookName — Internal name of a stored workbook. See <OpenWorkbook> for
more information.

user — Access for the current user. Values are “NONE”, “READ” or “WRITE”.

group — Access for the named group. Values are “NONE”, “READ” or
“WRITE".

groupName — Name of the group for the above access value.

world — Access for the rest of the world. Values are “NONE”, “READ” or
“WRITE”.

close — Close workbook. Values are “true” or “false”.
<CloseWorkbook>

Description:
Close the currently open workbook.

Properties:

method — If “forward”, save and close the workbook. If “backward”, close but
do not save the workbook.

RTD use with HP LoadRunner

In this section, familiarity with HP LoadRunner is assumed. For further information on
this topic, consult the HP LoadRunner documentation.

The RTD library is not a LoadRunner extension, and as such does not provide support
for record/replay functionality. Scripts must be hand-coded to suit the RPAS workflow
under test and only then can they be replayed using the message passing functions
outlined in the previous section.

Prerequisites

RTD functions can be called from any C-based virtual user (vuser). The script needs to
reference a header which contains the RTD function prototypes. Additionally, certain
LoadRunner replay settings must be set in order to assure correct behavior.
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Header File

This file contains the functions exported by the RTD library; these are in a format usable
by the LoadRunner C runtime engine.

Ir_rtd.h

#ifndef RTD RTD H_
#define _RTD RTD_H_

int rtd_logon(const char* user,
const char* password,
const char* connection,
const char* domain,
const char* fcfPath,
const char* language,
const char* logLevel);

void rtd_logoffQ);

int rtd_send(const char* request);

char* rtd_getResponse();

char* rtd_getResponseProperty(const char*);

void rtd_freeCharPtr(char®);

#endif // RTD RTD H_
LoadRunner Scripting

Script Settings

RTD is not thread-safe and so the virtual user script must be run as a process rather than
a thread:

= Open run-time settings
= Miscellaneous section

= Select “Run Vuser as a process”

Note: Failure to do this will result in unpredictable and often
inexplicable failures at runtime.

Script Sections
All LoadRunner C-based scripts consist of three sections:
= vyuser_init
= Actions
= vuser_end

It is advised that the vuser_init section is used for initialization, and the body of the test
placed in the Actions section. The vuser_end section is typically left unused.
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Script Implementation

This section walks through two examples which validate that LoadRunner and RTD are
working correctly together.

Script Section: vuser_init

The vuser_init section, which can be common to all RTD scripts, deals with the DLL load.
In order for it to load correctly, the directory containing the library should be in your
system PATH. The DLL load should work without the PATH setting, but results can vary
from machine to machine. Explicitly setting the PATH guarantees success.

#include Ir_rtd.h
#define RTD_LIBRARY ““c:\\path\\to\\rtd.dIl”

wvuser_init {
int rc = Ir_load dII(RTD_LIBRARY);
if (rc!=0) {
Ir_error_message(’'rtd library did not load (rc=%d). Not in your %PATH%?', rc);
Ir_abort();
}
}
This section references the Ir_rtd.h interface file defined previously. If it is not in the
script directory, it should be prefaced by the full path.

Script Section: Action (simple test)

The Actions section contains user actions; these will vary on a case-by-case basis. This
example uses a simple script to check that the RTD and LR integration is working
correctly.

Action {

rtd_logon(*‘user”, “pwd”, “connect”, “dom”, “‘c:\\path\\to\\Foundation.fcf’,
“english”, “debug™);

Ir_think_time(60);

rtd_logoff(Q;
}
This example causes the virtual user to log on, sleep 60 seconds, and then log off. The
login details should be altered to suit the RPAS environment under test. If this succeeds,
then RTD is correctly installed.

The following is a more realistic example.

Script section: Action (real-world)

In this more complicated example, a workbook is created and the name retrieved. It is
then opened and closed. Additionally, rather than having multiple rtd_send() calls in-
line, the XML is placed within a LoadRunner parameter file. This is then iterated over
within the LoadRunner script.

The parameter file should consist of one complete XML entity per line, single column
called “command” with the following contents.

<Logon .. />

<WizardInitialize templateName="perftest''/>

<GetNextWizardDialog templateName=""perftest' forward=""true"/>
<SelectPositions templateName=""perftest' currentDialog="wiz_PerfTestphsd"
hierarchy="PHSH" dimension=""PHSD'"><position dimension=""PHSD"
name=""PHSDPO01"'/></SelectPositions>

<GetNextWizardDialog templateName=""perftest’ forward=""true'/>
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<SelectPositions templateName="perftest’ currentDialog="wiz_PerfTestweek"
hierarchy=""CLND"" dimension="WEEK''><position dimension="WEEK"
name="WEEK200801"'/><position dimension=""WEEK"
name=""WEEK200802"'/></SelectPositions>

<GetNextWizardDialog templateName=""perftest' forward=""true"/>
<SelectPositions templateName=""perftest' currentDialog="wiz_PerfTestitem"
hierarchy=""PROD"" dimension=""ITEM "><position dimension=""1TEM"
name=""1TMO00"'/><position dimension=""ITEM" name=""1TMOO1"/></SelectPositions>
<WizardFinish templateName=""perftest''/>

get_wb_name

<OpenWorkbook workbookName="{ wb}" access="write'/>

<CloseWorkbook method="backwards”/>

<Logoff/>

The vuser_init section should be identical to the prior example.
The Actions section should contain the following;:

Action {
char *wb_name, *xml, *response;
int success;

while(.) {
if (O=stricmp(“‘get_wb_name”, script.param)) {
wb_name=rtd_getResponseProperty(*‘workbookName™) ;
Ir_save_string(wb_name, “ wb’);
rtd_freeCharPtr(wb_name);
}else {
rc=rtd_send(lr_eval_string(xml));
if ('ro) {
response=rtd_getResponse();
Ir_error_message(“error — response was: %s’, response);
rtd_freeCharPtr(response);
Ir_abort(Q);
}
}
}

The above section accomplishes a number of things:

=  Uses parameters instead of hard-coded calls

=  Builds a workbook via the wizard

= (Obtains the workbook name

= Saves the workbook name to the _wb parameter name

= Replaces subsequent instances of the _wb parameter with the workbook name,
through Ir_eval_string()

Considerations for Scenario use

=  When RTD is used in a scenario orchestrated by the LoadRunner controller, it is
necessary to have RTD on each of the load generators (injectors). RTD should be in
the same path, referenced in the LoadRunner script, on each generator.

= Check the script runtime settings for the scenario. Match those used within the
virtual user generator (vugen) environment.

* Ensure that if RTD is upgraded, it is upgraded on each generator.
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